**Legal notice**

Nokia is a registered trademark of Nokia Corporation. Other products and company names mentioned herein may be trademarks or tradenames of their respective owners.

The information presented is subject to change without notice. No responsibility is assumed for inaccuracies contained herein.

© 2018 Nokia.
Contents

About this document ........................................................................................................................................13

Part I: NFM-P system administration overview ................................................................................................15
  1 Safety information ........................................................................................................................................17
    1.1 Structure of safety statements ..............................................................................................................17
  2 NSP NFM-P System Administrator Guide overview ..................................................................................19
    2.1 Overview ............................................................................................................................................19
    2.2 NSP NFM-P System Administrator Guide overview ..........................................................................19
    2.3 NFM-P system administrator tasks and information map .....................................................................20
    2.4 Administrator tasks for application management .............................................................................22

Part II: Security management ............................................................................................................................23
  3 NFM-P user security ....................................................................................................................................25
    3.1 Overview ............................................................................................................................................25
    3.2 Overview ............................................................................................................................................27
    3.3 User account and group management ...............................................................................................28
    3.4 User activity logging ..........................................................................................................................32
    3.5 Sample span rule configuration ........................................................................................................35
    3.6 Remote NFM-P user access ..............................................................................................................36
    3.7 Sample NFM-P user authentication configuration ............................................................................39
    3.8 Workflow to configure and manage NFM-P user security .................................................................42
    3.9 To reserve an admin account login ...................................................................................................45
    3.10 To create a scope of command role ................................................................................................45
    3.11 To create a scope of command profile .............................................................................................46
    3.12 To create a span of control ...............................................................................................................47
    3.13 To create a span of control profile ...................................................................................................48
    3.14 To create a span rule ......................................................................................................................48
    3.15 To create an NFM-P user group .......................................................................................................49
    3.16 To add or remove workspaces for a user group .............................................................................51
    3.17 To create an NFM-P user account ..................................................................................................52
    3.18 To copy an NFM-P user account ....................................................................................................54
    3.19 To configure global user account, password ..................................................................................54

Release 18.3
March 2018
Issue 1 3HE-14090-AAAA-TQZZA
3.20 To configure the GUI client inactivity timeout .......................................................... 55
3.21 To configure the minimum allowable user name length ......................................... 56
3.22 To configure authentication failure actions ............................................................... 56
3.23 To configure suspended account actions ................................................................. 57
3.24 To configure automated E-mail notification ............................................................... 57
3.25 To list inactive user accounts .................................................................................... 58
3.26 To suspend or reinstate an NFM-P user account ...................................................... 58
3.27 To administratively change the password of an NFM-P user .................................... 59
3.28 To disable an NFM-P user password ......................................................................... 60
3.29 To change the password of the current NFM-P user ................................................ 61
3.30 To export the local tab preferences of one or more users ........................................... 61
3.31 To assign local tab preferences to users ..................................................................... 62
3.32 To send a broadcast message to GUI clients .............................................................. 63
3.33 To view and manage the active GUI client sessions .................................................. 64
3.34 To disconnect an XML API JMS client connection or remove a durable subscription 64
3.35 To view the user activity log ..................................................................................... 65
3.36 To view the user activity associated with an object ................................................... 67
3.37 To change the maximum number of concurrent NFM-P admin operator positions 68
3.38 To configure the number of allowed client sessions for a client delegate server 69
3.39 To enable secure access for remote LDAP users ....................................................... 70
3.40 To enable remote user authorization via RADIUS ................................................... 71
3.41 To enable remote user authorization via TACACS+ .................................................. 73
3.42 To configure the NSP user-authentication timeout .................................................. 74
3.43 To configure NFM-P remote user authentication .................................................... 76
3.44 To change the NFM-P Task Manager settings .......................................................... 78
3.45 To export all workspaces and local tab preferences .................................................. 79
3.46 To import workspaces and local tab preferences ...................................................... 80

4 NE user and device security ......................................................................................... 83

4.1 Overview ..................................................................................................................... 83
4.2 RADIUS, TACACS+, and LDAP ............................................................................... 84
4.3 CPM filters and traffic management .......................................................................... 85
4.4 DoS protection ............................................................................................................ 86
4.5 DDoS protection ......................................................................................................... 87
4.6 IP security .................................................................................................................. 89
NE user and device security procedures

4.7 Workflow to manage NE user and device security ........................................................................... 90
4.8 To configure a MAF ............................................................................................................................. 92
4.9 To configure a CPM filter .................................................................................................................. 93
4.10 To configure an NE DoS protection policy ...................................................................................... 96
4.11 To view NE DoS protection violations ............................................................................................ 97
4.12 To configure an NE DDoS protection policy ................................................................................ 98
4.13 To configure NE TLS authentication ............................................................................................. 100
4.14 To configure a site user profile ....................................................................................................... 101
4.15 To configure a user account on a managed device ....................................................................... 102
4.16 To configure an NE password policy ........................................................................................... 104
4.17 To configure an LDAP site authentication policy ........................................................................ 105
4.18 To configure an NE RADIUS authentication policy .................................................................... 106
4.19 To configure an NE TACACS+ authentication policy .................................................................... 107
4.20 To configure an OmniSwitch RADIUS, TACACS+, or LDAP security authentication policy .... 108
4.21 To configure device system security settings ................................................................................ 109
4.22 To configure and manage PKI site security on an NE ................................................................. 112
4.23 To configure a PKI certificate authority profile ........................................................................... 115
4.24 To create a file transmission profile ............................................................................................ 116
4.25 To perform CMPv2 actions ........................................................................................................... 116
4.26 To delete a security policy ............................................................................................................ 119
4.27 To manually unlock a user account .............................................................................................. 120
4.28 To clear the password history of a user on a managed device .................................................... 121
4.29 To clear collected statistics on a CPM filter .............................................................................. 122
4.30 To manage OCSP cache entries on an NE .................................................................................. 123

5 TCP enhanced authentication ............................................................................................................. 125
5.1 Overview ........................................................................................................................................... 125
5.2 TCP enhanced authentication ......................................................................................................... 125
5.3 Workflow to configure TCP enhanced authentication for NEs ..................................................... 127
5.4 To configure a global TCP key chain ............................................................................................. 127
5.5 To distribute global key chains to NEs ......................................................................................... 128
5.6 To verify the distribution of a global key chain to NEs ................................................................. 130
5.7 To identify differences between a global and local key chain policy or two local key chains ...... 131

Part III: NFM-P advanced configuration .......................................................................................... 133

6 NFM-P component configuration ..................................................................................................... 135
6.1 Overview ........................................................................................................................................... 135
**NFM-P component configuration** ............................................................................................................ 137
6.2 Overview .................................................................................................................................................. 137
6.3 Changing default text-field and ID ranges ............................................................................................... 137
6.4 NFM-P license management ..................................................................................................................... 142
6.5 Configuring Analytics functions .............................................................................................................. 143
6.6 To create and manage custom auxiliary database table attributes ......................................................... 145
6.7 Workflow to configure NFM-P components ............................................................................................ 147

**Software and license configuration procedures** ...................................................................................... 150
6.8 To view the NFM-P license information ................................................................................................... 150
6.9 To export the NFM-P license information or create a license point inventory ........................................ 151
6.10 To update the NFM-P license in a standalone deployment .................................................................... 151
6.11 To update the NFM-P license in a redundant deployment ...................................................................... 152
6.12 To list the backed-up NFM-P license files .............................................................................................. 155
6.13 To change the default NFM-P license expiry notification date ............................................................... 156

**System component configuration procedures** ....................................................................................... 158
6.14 To modify the base configuration of all GUI clients ............................................................................. 158
6.15 To configure the display of multiple NFM-P systems as client GUI login options ............................... 159
6.16 To change the default user file locations on a client delegate server .................................................. 160
6.17 To change the IP address or hostname of an NFM-P system component .............................................. 161
6.18 To enable main database backup file synchronization ......................................................................... 162
6.19 To modify the default time period of statistics displayed by the Statistics Manager search filters .. 164
6.20 To modify the default time period of statistics displayed on object properties forms .......................... 165
6.21 To enable the preservation of the XML API statistics pool size ............................................................ 166
6.22 To configure auto-assigned service ID ranges and uniqueness checking ............................................ 168
6.23 To create or configure a format policy .................................................................................................. 170
6.24 To create or configure a range policy .................................................................................................... 172

**Network management configuration procedures** .................................................................................. 174
6.25 To configure automatic device configuration backup file removal ...................................................... 174
6.26 To enable alarm reporting to identify duplicate NE system IP addresses ........................................ 175
6.27 To enable dynamic system IP address updates for 7705 SAR nodes .................................................. 177
6.28 To enable LSP on-demand resynchronization ...................................................................................... 178
6.29 To enable debug configuration file reloading on an NE for mirror services .................................... 179
6.30 To configure throttle rates for subscriber trap events .......................................................................... 181
6.31 To configure the windowing trap delay option for subscriber table resyncs ..................................... 182
6.32 To create a default SNMPv2 OmniSwitch user ..................................................................................... 184
6.33 To enable telemetry reporting for a managed NE .................................................................................. 185
6.34 To configure NFM-P system preferences ................................................................. 191

7 NFM-P database management .......................................................................................... 199
  7.1 Overview ..................................................................................................................... 199
  7.2 Overview ..................................................................................................................... 201
  7.3 Main database ........................................................................................................... 201
  7.4 Auxiliary database .................................................................................................... 202

NFM-P database management procedures ............................................................................ 203
  7.5 Workflow for NFM-P database management .............................................................. 203
  7.6 To view the main database properties ...................................................................... 205
  7.7 To view the auxiliary database status using the client GUI ...................................... 206
  7.8 To view the auxiliary database status using a CLI .................................................. 207
  7.9 To configure the allowed number of Oracle database login attempts .................... 208
  7.10 To unlock the Oracle database user account ......................................................... 210
  7.11 To configure Oracle database error monitoring .................................................... 211
  7.12 To configure a size constraint policy ...................................................................... 212
  7.13 To configure an ageout constraint policy ................................................................ 213
  7.14 To create a database file policy to manage database log or core dump files .......... 215
  7.15 To configure the purging of scheduled NSP Analytics reports ............................ 216
  7.16 To configure the statistics data retention period for the main database ............... 217
  7.17 To back up the main database from the client GUI ............................................... 217
  7.18 To back up the main database from a CLI ............................................................ 220
  7.19 To back up an auxiliary database ........................................................................... 222
  7.20 To schedule main database backups ..................................................................... 223
  7.21 To schedule auxiliary database backups ................................................................ 224

8 NFM-P system redundancy ............................................................................................ 227
  8.1 Overview ..................................................................................................................... 227
  8.2 Overview ..................................................................................................................... 228
  8.3 NFM-P system redundancy models ........................................................................ 228
  8.4 Redundancy functions .............................................................................................. 233
  8.5 Redundancy failure scenarios ................................................................................. 240

NFM-P system redundancy procedures ............................................................................ 245
  8.6 Workflow to perform NFM-P system redundancy functions .................................. 245
  8.7 To view the NFM-P system redundancy status ...................................................... 246
### Part IV: NFM-P routine maintenance

#### 8.8 To view the NFM-P auxiliary server status ................................................................. 249
#### 8.9 To perform a server activity switch ............................................................................... 250
#### 8.10 To configure main database switchover behavior ...................................................... 251
#### 8.11 To perform a main database switchover using the NFM-P client GUI ....................... 252
#### 8.12 To perform a main database switchover using a CLI script ...................................... 253
#### 8.13 To enable or disable automatic database realignment ............................................... 254
#### 8.14 To configure the IPDR file transfer policy ............................................................... 257

#### 9 NFM-P routine maintenance overview ........................................................................ 261

- **9.1 Routine maintenance overview** .............................................................................. 261
- **9.2 Routine maintenance guidelines** ............................................................................. 261
- **9.3 Obtaining technical assistance** ............................................................................... 262
- **9.4 Routine maintenance checklist** .............................................................................. 262

#### 10 NFM-P maintenance base measures ........................................................................ 265

- **10.1 Overview** ............................................................................................................. 265
  - **Maintenance base measures** .................................................................................... 266
  - **10.2 Base measures overview** .................................................................................. 266
  - **10.3 Base measures guidelines** ................................................................................ 266
  - **10.4 Platform base measures** .................................................................................. 267
  - **10.5 Inventory base measures** ................................................................................ 268
  - **10.6 Performance and scalability base measures** ....................................................... 269
  - **10.7 Reachability base measures** .......................................................................... 271

#### 11 Daily maintenance ..................................................................................................... 273

- **11.1 Overview** ............................................................................................................. 273
  - **Daily maintenance information** ............................................................................... 274
  - **11.2 Viewing and filtering alarms** .......................................................................... 274
  - **11.3 Backing up the main database** ......................................................................... 274
  - **11.4 Collecting and storing NFM-P log and configuration files** .......................... 275
  - **Daily maintenance procedures** ............................................................................. 276
  - **11.5 To monitor incoming alarms** ......................................................................... 276
  - **11.6 To verify main database information** .............................................................. 277
  - **11.7 To back up the NFM-P log and configuration files** ....................................... 278

#### 12 Weekly maintenance .................................................................................................. 281

- **12.1 Collecting device hardware inventory data** ......................................................... 281
- **12.2 Checking scheduled device backups** ............................................................... 281
<table>
<thead>
<tr>
<th>Section</th>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>12.3</td>
<td>Managing main database audit logs</td>
<td>281</td>
</tr>
<tr>
<td>12.4</td>
<td>To check for performance monitoring statistics collection</td>
<td>282</td>
</tr>
<tr>
<td>12.5</td>
<td>To gather port inventory data for a specific managed device</td>
<td>283</td>
</tr>
<tr>
<td>12.6</td>
<td>To test a main database restore</td>
<td>284</td>
</tr>
<tr>
<td>12.7</td>
<td>To check scheduled device backup status</td>
<td>289</td>
</tr>
<tr>
<td>12.8</td>
<td>To reduce the number of Oracle audit logs</td>
<td>290</td>
</tr>
<tr>
<td>13</td>
<td>Monthly maintenance</td>
<td>293</td>
</tr>
<tr>
<td>13.1</td>
<td>Performing main server and database redundancy switches</td>
<td>293</td>
</tr>
<tr>
<td>13.2</td>
<td>Checking the NFM-P platform performance</td>
<td>293</td>
</tr>
<tr>
<td>13.3</td>
<td>Checking Windows client platform performance</td>
<td>293</td>
</tr>
<tr>
<td>13.4</td>
<td>Checking LAN TCP/IP connections between network-management domain elements</td>
<td>294</td>
</tr>
<tr>
<td>13.5</td>
<td>Generating and storing a user account list</td>
<td>294</td>
</tr>
<tr>
<td>13.6</td>
<td>Verifying documentation and support contact list updates</td>
<td>294</td>
</tr>
<tr>
<td>13.7</td>
<td>Setting the time and date</td>
<td>294</td>
</tr>
<tr>
<td>13.8</td>
<td>To measure NFM-P platform performance</td>
<td>295</td>
</tr>
<tr>
<td>13.9</td>
<td>To check Windows client station performance</td>
<td>297</td>
</tr>
<tr>
<td>13.10</td>
<td>To check network management connections</td>
<td>298</td>
</tr>
<tr>
<td>13.11</td>
<td>To generate and store user account data</td>
<td>300</td>
</tr>
<tr>
<td>13.12</td>
<td>To check for documentation and support updates</td>
<td>300</td>
</tr>
<tr>
<td>14</td>
<td>As required maintenance</td>
<td>303</td>
</tr>
<tr>
<td>14.1</td>
<td>NFM-P platform modification and replacement</td>
<td>303</td>
</tr>
<tr>
<td>14.2</td>
<td>Overview</td>
<td>303</td>
</tr>
<tr>
<td>14.3</td>
<td>To reconfigure a main server after a platform modification</td>
<td>304</td>
</tr>
<tr>
<td>14.4</td>
<td>To reconfigure a main database after a platform modification</td>
<td>305</td>
</tr>
<tr>
<td>14.5</td>
<td>To reconfigure an auxiliary server after a platform modification</td>
<td>306</td>
</tr>
<tr>
<td>14.6</td>
<td>To reconfigure an NSP Flow Collector</td>
<td>307</td>
</tr>
<tr>
<td>14.7</td>
<td>To test NFM-P disk performance</td>
<td>308</td>
</tr>
<tr>
<td>14.8</td>
<td>To relink the Oracle executable files</td>
<td>311</td>
</tr>
<tr>
<td>14.9</td>
<td>Changing NFM-P system passwords</td>
<td>321</td>
</tr>
<tr>
<td>14.10</td>
<td>Overview</td>
<td>321</td>
</tr>
<tr>
<td>14.11</td>
<td>To change the nsp user password</td>
<td>321</td>
</tr>
<tr>
<td>14.12</td>
<td>To change a database user password in a standalone NFM-P system</td>
<td>322</td>
</tr>
<tr>
<td></td>
<td>To change a database user password in a redundant NFM-P system</td>
<td>325</td>
</tr>
</tbody>
</table>
## Auxiliary server administration

<table>
<thead>
<tr>
<th>Section</th>
<th>Description</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>14.13</td>
<td>To start an auxiliary server</td>
<td>332</td>
</tr>
<tr>
<td>14.14</td>
<td>To stop an auxiliary server</td>
<td>333</td>
</tr>
</tbody>
</table>

## NSP Flow Collector administration

<table>
<thead>
<tr>
<th>Section</th>
<th>Description</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>14.15</td>
<td>To start an NSP Flow Collector</td>
<td>334</td>
</tr>
<tr>
<td>14.16</td>
<td>To stop an NSP Flow Collector</td>
<td>334</td>
</tr>
<tr>
<td>14.17</td>
<td>To display the NSP Flow Collector status</td>
<td>335</td>
</tr>
</tbody>
</table>

## Analytics server administration

<table>
<thead>
<tr>
<th>Section</th>
<th>Description</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>14.18</td>
<td>To start an analytics server</td>
<td>336</td>
</tr>
<tr>
<td>14.19</td>
<td>To stop an analytics server</td>
<td>336</td>
</tr>
</tbody>
</table>

## Auxiliary database administration

<table>
<thead>
<tr>
<th>Section</th>
<th>Description</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>14.20</td>
<td>To start an auxiliary database</td>
<td>338</td>
</tr>
<tr>
<td>14.21</td>
<td>To stop an auxiliary database</td>
<td>338</td>
</tr>
<tr>
<td>14.22</td>
<td>To change an auxiliary database user password</td>
<td>339</td>
</tr>
<tr>
<td>14.23</td>
<td>To restore an auxiliary database</td>
<td>339</td>
</tr>
<tr>
<td>14.24</td>
<td>To replace an auxiliary database station</td>
<td>344</td>
</tr>
<tr>
<td>14.25</td>
<td>To remove an auxiliary database station</td>
<td>347</td>
</tr>
</tbody>
</table>

## Backing up and restoring NE configuration files

<table>
<thead>
<tr>
<th>Section</th>
<th>Description</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>14.26</td>
<td>Overview</td>
<td>350</td>
</tr>
<tr>
<td>14.27</td>
<td>To back up the NE configuration files</td>
<td>350</td>
</tr>
<tr>
<td>14.28</td>
<td>To restore the NE configuration files</td>
<td>351</td>
</tr>
</tbody>
</table>

## Restoring and reinstating the main database

<table>
<thead>
<tr>
<th>Section</th>
<th>Description</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>14.29</td>
<td>Overview</td>
<td>352</td>
</tr>
<tr>
<td>14.30</td>
<td>To restore a standalone main database</td>
<td>352</td>
</tr>
<tr>
<td>14.31</td>
<td>To restore the primary main database in a redundant system</td>
<td>362</td>
</tr>
<tr>
<td>14.32</td>
<td>To reinstantiate the main database from the client GUI</td>
<td>373</td>
</tr>
<tr>
<td>14.33</td>
<td>To reinstantiate the main database from a CLI</td>
<td>374</td>
</tr>
</tbody>
</table>

## Main database export and import

<table>
<thead>
<tr>
<th>Section</th>
<th>Description</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>14.34</td>
<td>To export a main database</td>
<td>377</td>
</tr>
<tr>
<td>14.35</td>
<td>To import a main database</td>
<td>380</td>
</tr>
</tbody>
</table>

## Clearing inactive residential subscriber instances

<table>
<thead>
<tr>
<th>Section</th>
<th>Description</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>14.36</td>
<td>Overview</td>
<td>385</td>
</tr>
<tr>
<td>14.37</td>
<td>To delete the inactive residential subscriber instances</td>
<td>385</td>
</tr>
</tbody>
</table>

## Listing customer service information

<table>
<thead>
<tr>
<th>Section</th>
<th>Description</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>14.38</td>
<td>Overview</td>
<td>388</td>
</tr>
<tr>
<td>14.39</td>
<td>To save a list of service information</td>
<td>388</td>
</tr>
<tr>
<td>Topic</td>
<td>Page</td>
<td></td>
</tr>
<tr>
<td>----------------------------------------------------------------------</td>
<td>------</td>
<td></td>
</tr>
<tr>
<td>Checking for duplicate service or resource names</td>
<td>390</td>
<td></td>
</tr>
<tr>
<td>14.40 Overview</td>
<td>390</td>
<td></td>
</tr>
<tr>
<td>14.41 To check for duplicate port descriptions</td>
<td>390</td>
<td></td>
</tr>
<tr>
<td>Alarm management</td>
<td>392</td>
<td></td>
</tr>
<tr>
<td>14.42 Description</td>
<td>392</td>
<td></td>
</tr>
<tr>
<td>14.43 Alarm thresholds</td>
<td>392</td>
<td></td>
</tr>
<tr>
<td>14.44 Alarm suppression</td>
<td>394</td>
<td></td>
</tr>
<tr>
<td>14.45 Automatic purging of alarms</td>
<td>394</td>
<td></td>
</tr>
<tr>
<td>14.46 Automatic deletion of correlated alarms</td>
<td>395</td>
<td></td>
</tr>
<tr>
<td>14.47 Alarm debouncing</td>
<td>396</td>
<td></td>
</tr>
<tr>
<td>14.48 Filtering alarms for XML API clients using the NFM-P GUI</td>
<td>397</td>
<td></td>
</tr>
<tr>
<td>Alarm management workflow and procedures</td>
<td>398</td>
<td></td>
</tr>
<tr>
<td>14.49 Workflow to manage alarms</td>
<td>398</td>
<td></td>
</tr>
<tr>
<td>14.50 To customize the default behavior of alarm policies</td>
<td>398</td>
<td></td>
</tr>
<tr>
<td>14.51 To configure alarm severity and deletion behavior</td>
<td>400</td>
<td></td>
</tr>
<tr>
<td>14.52 To configure alarm history database management behavior</td>
<td>401</td>
<td></td>
</tr>
<tr>
<td>14.53 To display the Additional Text Find button on object properties forms</td>
<td>402</td>
<td></td>
</tr>
<tr>
<td>14.54 To configure alarm debouncing</td>
<td>402</td>
<td></td>
</tr>
<tr>
<td>14.55 To configure alarm filters for XML API clients using the NFM-P GUI</td>
<td>403</td>
<td></td>
</tr>
<tr>
<td>14.56 To reload all alarms from the historical alarm database</td>
<td>404</td>
<td></td>
</tr>
<tr>
<td>14.57 To manually promote or demote the severity of an alarm</td>
<td>405</td>
<td></td>
</tr>
<tr>
<td>14.58 To configure alarm filters for XML API clients using the NFM-P GUI</td>
<td>406</td>
<td></td>
</tr>
<tr>
<td>14.59 To create an alarm e-mail policy</td>
<td>407</td>
<td></td>
</tr>
<tr>
<td>14.60 To optimize alarm event notifications</td>
<td>409</td>
<td></td>
</tr>
<tr>
<td>Configuring OLC states</td>
<td>410</td>
<td></td>
</tr>
<tr>
<td>14.61 Introduction</td>
<td>410</td>
<td></td>
</tr>
<tr>
<td>14.62 To display equipment or service OLC states</td>
<td>412</td>
<td></td>
</tr>
<tr>
<td>14.63 To display the OLC state change schedules</td>
<td>412</td>
<td></td>
</tr>
<tr>
<td>14.64 To change the OLC state of one or more objects</td>
<td>413</td>
<td></td>
</tr>
<tr>
<td>14.65 To lock the OLC state</td>
<td>414</td>
<td></td>
</tr>
<tr>
<td>14.66 To schedule an OLC state change</td>
<td>415</td>
<td></td>
</tr>
<tr>
<td>14.67 To change the OLC state assigned to one or more alarms</td>
<td>415</td>
<td></td>
</tr>
<tr>
<td>14.68 To add the OLC state property to a manually created service template</td>
<td>416</td>
<td></td>
</tr>
</tbody>
</table>
About this document

Purpose

The NSP NFM-P System Administrator Guide provides information about NFM-P system management, and is intended for a user assigned with an Administrator scope of command role. The guide describes functions that include the following:

• NFM-P system and user security management tasks
• NFM-P advanced configuration tasks
• NFM-P routine maintenance tasks to maintain hardware and system integrity and efficiencies

Safety information

For your safety, this document contains safety statements. Safety statements are given at points where risks of damage to personnel, equipment, and operation may exist. Failure to follow the directions in a safety statement may result in serious consequences.

Document support

Customer documentation and product support URLs:

• Customer Documentation Welcome Page
• Technical support

How to comment

Documentation feedback
Part I: NFM-P system administration overview

Overview

Purpose

This part provides information about the system administrator role and the tasks described in this guide.

Contents

<table>
<thead>
<tr>
<th>Chapter 1, Safety information</th>
<th>17</th>
</tr>
</thead>
<tbody>
<tr>
<td>Chapter 2, NSP NFM-P System Administrator Guide overview</td>
<td>19</td>
</tr>
</tbody>
</table>
1 Safety information

1.1 Structure of safety statements

1.1.1 Overview
This topic describes the components of safety statements that appear in this document.

1.1.2 General structure
Safety statements include the following structural elements:

<table>
<thead>
<tr>
<th>Item</th>
<th>Structure element</th>
<th>Purpose</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Safety alert symbol</td>
<td>Indicates the potential for personal injury (optional)</td>
</tr>
<tr>
<td>2</td>
<td>Safety symbol</td>
<td>Indicates hazard type (optional)</td>
</tr>
<tr>
<td>3</td>
<td>Signal word</td>
<td>Indicates the severity of the hazard</td>
</tr>
<tr>
<td>4</td>
<td>Hazard type</td>
<td>Describes the source of the risk of damage or injury</td>
</tr>
<tr>
<td>5</td>
<td>Safety message</td>
<td>Consequences if protective measures fail</td>
</tr>
<tr>
<td>6</td>
<td>Avoidance message</td>
<td>Protective measures to take to avoid the hazard</td>
</tr>
<tr>
<td>7</td>
<td>Identifier</td>
<td>The reference ID of the safety statement (optional)</td>
</tr>
</tbody>
</table>
### 1.1.3 Signal words

The signal words identify the hazard severity levels as follows:

<table>
<thead>
<tr>
<th>Signal word</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>DANGER</td>
<td>Indicates the described activity or situation may, or will, represent a potential for a serious injury.</td>
</tr>
<tr>
<td>WARNING</td>
<td>Indicates the described activity or situation may, or will, cause equipment damage or serious performance problems.</td>
</tr>
<tr>
<td>CAUTION</td>
<td>Indicates the described activity or situation may, or will, cause service disruption.</td>
</tr>
<tr>
<td>NOTICE</td>
<td>Indicates the described activity or situation may, or will, cause minor performance problems.</td>
</tr>
</tbody>
</table>
2 NSP NFM-P System Administrator Guide overview

2.1 Overview

2.1.1 Purpose
This chapter describes the system administrator roles and tasks documented in this guide.

2.1.2 Contents

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>2.1 Overview</td>
<td>19</td>
</tr>
<tr>
<td>2.2 NSP NFM-P System Administrator Guide overview</td>
<td>19</td>
</tr>
<tr>
<td>2.3 NFM-P system administrator tasks and information map</td>
<td>20</td>
</tr>
<tr>
<td>2.4 Administrator tasks for application management</td>
<td>22</td>
</tr>
</tbody>
</table>

2.2 NSP NFM-P System Administrator Guide overview

2.2.1 NFM-P system administrator tasks
The NSP NFM-P System Administrator Guide describes the tasks that are typically performed by a user with an Administrator scope of command role. Information in this guide includes:

• NFM-P security management tasks including:
  - planning and implementing the user security measures required to protect all NFM-P data, software, and hardware and monitor the system/network for any security threats.
  - setting up all required NFM-P user accounts and user groups with the required scope of command roles and span of control permissions and the ongoing monitoring and management of those accounts.
  - providing security support information for accessing and securing managed devices in your network.
  - configuration and management requirements for TCP enhanced authentication for NEs based on the MD5 encryption mechanism.

• advanced configuration tasks including:
  - configuring, maintaining, and administering the NFM-P operational environment including software licenses, system components, network functions, and system preferences.
  - performing the required tasks to establish and maintain NFM-P system redundancy; and as required, monitor/perform any maintenance activity switching or switchovers.
  - using the NFM-P Database Manager to configure and monitor the main database.

• maintenance tasks to maintain hardware and system integrity and efficiencies including:
  - collecting baseline information to evaluate the activity and performance of the NFM-P and the various network components.
  - performing daily, weekly, monthly and as-required maintenance such as maintaining data backups and disaster recovery operations.
2.2.2 NFM-P system administrator role

NFM-P system administration includes the following responsibilities:

- system startup, monitoring, and shutdown
- planning and implementing user security measures
- setting up all required NFM-P user accounts with the required scope of command roles and span of control permissions and monitor the system/network for any security threats
- configuring, maintaining, and administering the NFM-P environment including computer hardware, software, and management network
- performing data backups and disaster recovery operations
- performing the required tasks to establish and maintain NFM-P system redundancy; and as required, monitor/perform any maintenance activity switching or switchovers
- monitoring the performance of the NFM-P to ensuring it operates and functions within set operational guidelines
- performing daily, weekly, monthly and supplementary routine maintenance on the NFM-P
- diagnosing any system-related alarm activity and solving unique problems identified by service and network operators
- diagnosing and troubleshooting platform, service, and connectivity problems
- integrating the NFM-P and other systems

2.3 NFM-P system administrator tasks and information map

2.3.1 Documentation reference

The following table provides a high-level navigation aid to help you locate specific system administrator tasks or information contained in this guide and other NFM-P customer documentation.

<table>
<thead>
<tr>
<th>Task or information</th>
<th>Information location</th>
</tr>
</thead>
</table>
| Installation and upgrades | Provides NFM-P system deployment requirements and restrictions, and procedures for the following:  
- NFM-P software installation, upgrade, and uninstallation for a standalone or redundant system  
- conversion from a standalone to a redundant system  
- configuring SSL inter-component communication | NSP NFM-P Installation and Upgrade Guide |
Table 2-1  NFM-P system administrator task or information location  (continued)

<table>
<thead>
<tr>
<th>Task or information</th>
<th>Information location</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Security management</strong></td>
<td></td>
</tr>
<tr>
<td>Provides information about the following NFM-P user security elements and functions:</td>
<td>Chapter 3, “NFM-P user security”</td>
</tr>
<tr>
<td>• creating and managing NFM-P user groups and accounts</td>
<td></td>
</tr>
<tr>
<td>• monitoring and managing client sessions</td>
<td></td>
</tr>
<tr>
<td>• managing NFM-P security functions</td>
<td></td>
</tr>
<tr>
<td>Provides security information for managed device access, including the following:</td>
<td>Chapter 4, “NE user and device security”</td>
</tr>
<tr>
<td>• create and manage users, profiles and passwords for access to NEs</td>
<td></td>
</tr>
<tr>
<td>• configure RADIUS, TACACS+ or LDAP authentication to control access to the managed devices using NFM-P user accounts</td>
<td></td>
</tr>
<tr>
<td>• configure device system security through CPM traffic filtering and management</td>
<td></td>
</tr>
<tr>
<td>• configure DoS and DDoS protection to protect NEs from high and potentially malicious incoming packet rates</td>
<td></td>
</tr>
<tr>
<td>Describes the configuration and management requirements for TCP enhanced authentication for NEs based on the MD5 encryption mechanism</td>
<td></td>
</tr>
<tr>
<td>Provides a listing of the permissions, access levels, and descriptions of all pre-defined scope of command roles and profiles</td>
<td>Appendix A, “Scope of command roles and permissions”</td>
</tr>
<tr>
<td><strong>Advanced configuration</strong></td>
<td></td>
</tr>
<tr>
<td>Describes how to configure the following:</td>
<td>Chapter 6, “NFM-P component configuration”</td>
</tr>
<tr>
<td>• NFM-P software and licenses</td>
<td></td>
</tr>
<tr>
<td>• NFM-P system components</td>
<td></td>
</tr>
<tr>
<td>• Network management functions</td>
<td></td>
</tr>
<tr>
<td>• System preferences</td>
<td></td>
</tr>
<tr>
<td>Describes how to use the NFM-P Database Manager to perform the following:</td>
<td>Chapter 7, “NFM-P database management”</td>
</tr>
<tr>
<td>• view the main database properties</td>
<td></td>
</tr>
<tr>
<td>• configure statistics data retention criteria</td>
<td></td>
</tr>
<tr>
<td>• manage database log storage</td>
<td></td>
</tr>
<tr>
<td>• perform database backups and restores</td>
<td></td>
</tr>
<tr>
<td>• schedule regular database backups</td>
<td></td>
</tr>
<tr>
<td>• configure error monitoring for increased security</td>
<td></td>
</tr>
<tr>
<td>• troubleshoot database problems</td>
<td></td>
</tr>
<tr>
<td>Describes how to perform the following redundancy tasks:</td>
<td>Chapter 8, “NFM-P system redundancy”</td>
</tr>
<tr>
<td>• Check the NFM-P server and database redundancy status.</td>
<td></td>
</tr>
<tr>
<td>• Perform a manual activity switch from the primary to standby server</td>
<td></td>
</tr>
<tr>
<td>• Enable or disable automatic main database realignment.</td>
<td></td>
</tr>
<tr>
<td>• Restore redundancy after a component failure.</td>
<td></td>
</tr>
<tr>
<td><strong>Routine maintenance</strong></td>
<td></td>
</tr>
<tr>
<td>Provides an overview of all NFM-P routine maintenance tasks and their suggested application.</td>
<td>Chapter 9, “NFM-P routine maintenance overview”</td>
</tr>
</tbody>
</table>
### Table 2-1  NFM-P system administrator task or information location (continued)

<table>
<thead>
<tr>
<th>Task or information</th>
<th>Information location</th>
</tr>
</thead>
<tbody>
<tr>
<td>Provides a list of baseline information to collect for NFM-P applications to evaluate the performance of activity and performance of network components.</td>
<td>Chapter 10, “NFM-P maintenance base measures”</td>
</tr>
</tbody>
</table>
| Describes the daily, weekly, monthly, and as-required routine maintenance activities | Chapter 11, “Daily maintenance” (daily)  
Chapter 12, “Weekly maintenance” (weekly)  
Chapter 13, “Monthly maintenance” (monthly)  
Chapter 14, “As required maintenance” (as-required) |

#### Troubleshooting

Provides task-based procedures and user documentation to:

- help resolve issues in the managed and management networks
- identify the root cause and plan corrective action for:
  - alarm conditions on a network object or customer service
  - problems on customer services without associated alarms
- list problem scenarios, possible solutions, and tools to help check:
  - network management LAN
  - network management platform
  - NFM-P GUI and XML API clients
  - NFM-P servers
  - NFM-P databases

NSP NFM-P Troubleshooting Guide

#### Diagnosing alarms

Provides a description of all NFM-P alarms.

NSP NFM-P Alarm Search Tool

#### Integration tasks

Provides the procedures for NFM-P integration with other products.

NSP NFM-P Integration Guide

---

### 2.4 Administrator tasks for application management

#### 2.4.1 Applications online help

The online help on the NSP Launchpad describes the administration of browser-based NFM-P applications.

See Chapter 3, “NFM-P user security” for information about how to create user groups and users with the appropriate permissions for access to the required applications.
Part II: Security management

Overview

Purpose

This part provides information about configuring user and device security.

Contents

<table>
<thead>
<tr>
<th>Chapter 3, NFM-P user security</th>
<th>25</th>
</tr>
</thead>
<tbody>
<tr>
<td>Chapter 4, NE user and device security</td>
<td>83</td>
</tr>
<tr>
<td>Chapter 5, TCP enhanced authentication</td>
<td>125</td>
</tr>
</tbody>
</table>
3 NFM-P user security

3.1 Overview

3.1.1 Purpose
This chapter describes user security mechanisms and procedures.

3.1.2 Contents

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>3.1 Overview</td>
<td>25</td>
</tr>
<tr>
<td>NFM-P user security</td>
<td>27</td>
</tr>
<tr>
<td>3.2 Overview</td>
<td>27</td>
</tr>
<tr>
<td>3.3 User account and group management</td>
<td>28</td>
</tr>
<tr>
<td>3.4 User activity logging</td>
<td>32</td>
</tr>
<tr>
<td>3.5 Sample span rule configuration</td>
<td>35</td>
</tr>
<tr>
<td>3.6 Remote NFM-P user access</td>
<td>36</td>
</tr>
<tr>
<td>3.7 Sample NFM-P user authentication configuration</td>
<td>39</td>
</tr>
<tr>
<td>NFM-P user security procedures</td>
<td>42</td>
</tr>
<tr>
<td>3.8 Workflow to configure and manage NFM-P user security</td>
<td>42</td>
</tr>
<tr>
<td>3.9 To reserve an admin account login</td>
<td>45</td>
</tr>
<tr>
<td>3.10 To create a scope of command role</td>
<td>45</td>
</tr>
<tr>
<td>3.11 To create a scope of command profile</td>
<td>46</td>
</tr>
<tr>
<td>3.12 To create a span of control</td>
<td>47</td>
</tr>
<tr>
<td>3.13 To create a span of control profile</td>
<td>48</td>
</tr>
<tr>
<td>3.14 To create a span rule</td>
<td>48</td>
</tr>
<tr>
<td>3.15 To create an NFM-P user group</td>
<td>49</td>
</tr>
<tr>
<td>3.16 To add or remove workspaces for a user group</td>
<td>51</td>
</tr>
<tr>
<td>3.17 To create an NFM-P user account</td>
<td>52</td>
</tr>
<tr>
<td>3.18 To copy an NFM-P user account</td>
<td>54</td>
</tr>
<tr>
<td>3.19 To configure global user account, password</td>
<td>54</td>
</tr>
<tr>
<td>3.20 To configure the GUI client inactivity timeout</td>
<td>55</td>
</tr>
<tr>
<td>3.21 To configure the minimum allowable user name length</td>
<td>56</td>
</tr>
<tr>
<td>3.22</td>
<td>To configure authentication failure actions</td>
</tr>
<tr>
<td>------</td>
<td>-------------------------------------------</td>
</tr>
<tr>
<td>3.23</td>
<td>To configure suspended account actions</td>
</tr>
<tr>
<td>3.24</td>
<td>To configure automated E-mail notification</td>
</tr>
<tr>
<td>3.25</td>
<td>To list inactive user accounts</td>
</tr>
<tr>
<td>3.26</td>
<td>To suspend or reinstate an NFM-P user account</td>
</tr>
<tr>
<td>3.27</td>
<td>To administratively change the password of an NFM-P user</td>
</tr>
<tr>
<td>3.28</td>
<td>To disable an NFM-P user password</td>
</tr>
<tr>
<td>3.29</td>
<td>To change the password of the current NFM-P user</td>
</tr>
<tr>
<td>3.30</td>
<td>To export the local tab preferences of one or more users</td>
</tr>
<tr>
<td>3.31</td>
<td>To assign local tab preferences to users</td>
</tr>
<tr>
<td>3.32</td>
<td>To send a broadcast message to GUI clients</td>
</tr>
<tr>
<td>3.33</td>
<td>To view and manage the active GUI client sessions</td>
</tr>
<tr>
<td>3.34</td>
<td>To disconnect an XML API JMS client connection or remove a durable subscription</td>
</tr>
<tr>
<td>3.35</td>
<td>To view the user activity log</td>
</tr>
<tr>
<td>3.36</td>
<td>To view the user activity associated with an object</td>
</tr>
<tr>
<td>3.37</td>
<td>To change the maximum number of concurrent NFM-P admin operator positions</td>
</tr>
<tr>
<td>3.38</td>
<td>To configure the number of allowed client sessions for a client delegate server</td>
</tr>
<tr>
<td>3.39</td>
<td>To enable secure access for remote LDAP users</td>
</tr>
<tr>
<td>3.40</td>
<td>To enable remote user authorization via RADIUS</td>
</tr>
<tr>
<td>3.41</td>
<td>To enable remote user authorization via TACACS+</td>
</tr>
<tr>
<td>3.42</td>
<td>To configure the NSP user-authentication timeout</td>
</tr>
<tr>
<td>3.43</td>
<td>To configure NFM-P remote user authentication</td>
</tr>
<tr>
<td>3.44</td>
<td>To change the NFM-P Task Manager settings</td>
</tr>
<tr>
<td>3.45</td>
<td>To export all workspaces and local tab preferences</td>
</tr>
<tr>
<td>3.46</td>
<td>To import workspaces and local tab preferences</td>
</tr>
</tbody>
</table>
3.2 Overview

3.2.1 User security mechanisms

This chapter describes the NFM-P user security mechanisms for providing and restricting access to various objects and functions. NFM-P user security includes the following:

- user group and account management, which involves the following elements:
  - "Scope of command roles" (p. 29) — contains the roles that define the level of user control in NFM-P functional areas such as the read, create, update, and delete access permissions
  - "Scope of command profiles" (p. 30) — contains the appropriate scope of command role for the types of tasks to be performed
  - 3.3.5 "Span of control" (p. 30) — list of objects to which a user has access
  - "Span of control profiles" (p. 31) — contains the required spans that allow group access to specific NFM-P objects
  - "Span rules" (p. 32) — directs the NFM-P to add new services to other spans in addition to the Default Service span

- global security parameters such as password expiry periods, the allowed number of login attempts, and any automated security E-mail notifications.

- managing user-group workspaces, which are customized configurations of NFM-P GUI elements; see the “NFM-P custom workspaces” chapter in the NSP NFM-P User Guide for comprehensive workspace information

- monitoring and managing active client sessions

- remote user access via LDAP, RADIUS, and TACACS+ authentication

- deleting NFM-P security elements that are no longer required, such as inactive user accounts or user groups.

- configuring task monitoring parameters and monitoring the progress of operational tasks:
  - GUI client write operations initiated by clicking Apply or OK
  - all write operations performed via the XML API
  - some read operations; for example, when you click Resync or Collect All

**Note:** See Appendix A, “Scope of command roles and permissions” for a list of the permissions, access levels, and descriptions of all predefined scope of command roles and profiles.
3.3 User account and group management

3.3.1 Overview

CAUTION

Service Disruption

Because the NFM-P cannot obtain an authentication secret value from an NE, it is recommended that you use only the NFM-P to configure a shared authentication secret on an NE.

If you configure a shared authentication secret on a managed NE using another interface, for example, a CLI, the NFM-P cannot synchronize the security policy with the NE.

You can create NFM-P user accounts and user groups to:

• provide GUI or XML API access to the NFM-P functional areas that match specific operator requirements
• restrict access to functions or objects based on operator expertise or authority

Users have view access, read-write access, or no access to NFM-P objects and functions based on:

• the user group to which they belong
• the scope of command profile assigned to the user group

The default NFM-P user account called admin is assigned the administrator scope of command role and a span of control profile that has Edit Access assigned to each default span.

Note: To restrict user access to top-level functions such as NFM-P and NE security management, the following guidelines are recommended:

• Assign the administrator scope of command role to a minimal number of NFM-P user accounts.
• Assign each NFM-P user to a user group that has the minimum privileges for performing the required tasks.

3.3.2 General NFM-P security management rules

The following general rules apply to NFM-P user and group security management:

• Only database space limits the number of accounts and groups that can be created.
• A user cannot belong to more than one user group.
• Only one session per user account can be open at the same time on a client station.
• A scope of command profile allows user-group access to one or more NFM-P functional areas.
• A span of control profile allows user-group access to one or more NFM-P managed objects.
• A user group is associated with only one scope of command profile that can contain multiple scope of command roles.
• A user group is associated with only one span of control profile that can contain multiple spans.
• The assigned user privileges determine the following for a GUI user:
- the available NFM-P menu options
- the parameters on object property forms that are configurable

• By default, a user group is assigned access to all NFM-P objects.
• A user acquires span of control access rights from the associated user group.
• When you modify a user group, and a user in the group has an open client session, client actions may fail for the user. To put the new user group permissions into effect, the user must close the current client session and open a new session.
• You can modify but not delete a span of control profile that is assigned to a group.

3.3.3 Password management
An NFM-P user password must observe the following constraints:
• It must be 8 to 100 characters.
• It must contain at least three of the following character types:
  − lowercase
  − uppercase
  − special ()?~!@#$&*_+
  − numeric
• It cannot be the user account name, in forward or reverse order.
• It cannot include more than three consecutive instances of the same character.
• It must change according to a configurable schedule, to prevent account lockout.
• It cannot be reused as a new password for the same user account.

3.3.4 Scope of command
A scope of command, which defines the actions that a user is allowed to perform, is a collection of configurable roles, which are sets of permissions. A scope of command profile contains one or more roles, and the profile is subsequently applied to a user group. Each user in the group acquires the access rights specified in the scope of command profile.

Scope of command roles
A scope of command role specifies the read, create, update, and delete access permissions for an NFM-P object type or functional area. You can create custom roles by assigning specific access permissions to different functional areas. The functional areas are organized in packages, methods, and classes. See Appendix A, “Scope of command roles and permissions” for a list of all access permissions that can be assigned to a scope of command role.

[i] Note: When you enable the Create permission, the Update permission is automatically enabled.

[i] Note: When you enable the Update permission, the Create permission is not automatically enabled.

You can create an original scope of command role, or copy an existing role and modify the role permissions to create a role. The NFM-P has several predefined scope of command roles. See
Appendix A, “Scope of command roles and permissions” for a list of the permissions, access levels, and descriptions of all pre-defined scope of command roles and profiles.

**Note:** When you create a scope of command role, you must enable create, update/execute, and delete access to allow the modification of a class or package.

**Scope of command profiles**

A scope of command profile contains one or more scope of command roles, and is assigned to a user group. Each user in the group acquires the permissions from the scope of command roles in the profile.

### 3.3.5 Span of control

The span of control for a user is a list of the objects over which the user has control, for example, a group of NEs or services. You can create an original span, or copy an existing span and modify the list of associated objects to create a new span. The objects that are in a span, or that can be added to a span, are called span objects.

The NFM-P has several predefined spans. Each new object, for example, a discovered NE, is added to the corresponding predefined span. **Table 3-1, “pre-defined spans of control” (p. 29)** lists the pre-defined spans and the type of span objects in each.

**Note:** You cannot modify or delete a pre-defined span.

**Table 3-1**  pre-defined spans of control

<table>
<thead>
<tr>
<th>Span</th>
<th>Included objects</th>
</tr>
</thead>
<tbody>
<tr>
<td>Default Topology Group Span</td>
<td>Topology groups</td>
</tr>
<tr>
<td>Default Router Span</td>
<td>Managed NEs</td>
</tr>
<tr>
<td>Default Script Span</td>
<td>CLI and XML API scripts, service templates, tunnel templates, and auto-provision profiles</td>
</tr>
<tr>
<td>Default Test Suite Span</td>
<td>Test suites</td>
</tr>
<tr>
<td>Default Group Span</td>
<td>Ring groups and VLAN groups</td>
</tr>
<tr>
<td>Default Bulk Operation Span</td>
<td>Bulk operations</td>
</tr>
<tr>
<td>Default Service Span</td>
<td>Services</td>
</tr>
<tr>
<td>Default Customer Span</td>
<td>Customers</td>
</tr>
</tbody>
</table>

Spans are specified in span of control profiles that are associated with user groups. A user can create an NFM-P object only when the pre-defined span for the object type is in the span of control profile. For example, if you do not have the Default Group Span in your span of control profile, you cannot create a ring group.

NEs are added automatically to a span when the parent topology group, ring group, or VLAN group is in a span. An object that is automatically added to a span cannot be removed from the span, but an explicitly added object can be removed.
Note: A user can view or configure a point-to-point connection only when each endpoint of the connection is in the user span of control. For example, when the endpoints of an LSP path are in different spans, you need view or configuration privileges in each span in order to view or configure the LSP path.

When you create a span, you can drag and drop NEs and topology groups into the span contents list.

Each user can control which objects the NFM-P displays in maps, lists, and navigation trees, based on the user span of control. The User Preferences form contains a parameter that globally specifies whether the Edit Access span objects of the user appear by default. Objects that are not in a View Access span of the user are not displayed, regardless of the user preference. See “To filter using span of control” in the NSP NFM-P User Guide for information about configuring the user span of control display preference.

In a list form, you can override the global display preference using the Span On parameter. The associated advanced filter form contains a selector for filtering the search results based on the span of control.

Span of control profiles

CAUTION

Service Disruption

It is recommended that you consider the effects of combining customer, service, and NE spans in a span of control profile.

For example, a user can modify a service only when the service, customer, and participating NEs are in one or more Edit Access spans of the user, and none of the objects is in a Blocked Edit or Blocked View span.

A span of control profile is a collection of one or more spans that is assigned to a user group. When you create a profile, each span in the profile is assigned one of the following access types:

• View Access—The user can view the span objects, unless the scope of command permissions deny read access.

• Edit Access—The user can modify the span objects, unless the scope of command permissions deny access.

• Blocked Edit—The user can view but not modify the span objects, regardless of the scope of command permissions.

• Blocked View—The user cannot view or modify the span objects, regardless of the scope of command permissions.

Blocked Edit and Blocked View spans restrict access to a subset of the objects in another span in the same profile. For example, when multiple span of control profiles each contain the Default Service Span, you can add a customer-specific Blocked View or Blocked Edit span to each profile so that the user group associated with a profile can view or configure only the services of specific customers.
A Blocked Edit or Blocked View span takes precedence over other spans. For example, when a user has an Edit Access span that contains all services and a Blocked View span that contains Customer A and Customer B, the user cannot view or configure the services that belong to Customer A and Customer B.

To ensure that span conflicts do not interfere with network troubleshooting, the NFM-P allows a user to execute tests on NEs and service sites that are not in an Edit Access span of the user. However, activities such as policy distribution, software upgrades, and statistics collection can be performed only by a user with Edit Access spans that contain the target objects.

**Span rules**

By default, the NFM-P automatically adds a new service to the Default Service span. Using an XML API or GUI client, you can create policies called span rules that add new services to other spans in addition to the Default Service span.

A span rule is associated with a format or range policy, and applies to the users and user groups that are specified in the format or range policy. You can associate multiple range policies with one user and service type, which enables the automatic addition of a new service to a specific span based on the service ID specified when the service is created.

When you create a span rule, you must specify one of the following to indicate which spans receive the services that the user creates:

- the Edit Access spans of each user associated with the format or range policy
- each span that is explicitly named in the rule

The span rules associated with a format or range policy take effect for new services only when the format or range policy is administratively enabled and has a valid configuration that includes at least one user or user group.

See **3.5 “Sample span rule configuration”** *(p. 35)* for a sample span rule configuration and implementation.

### 3.4 User activity logging

#### 3.4.1 Log records

The NFM-P logs each GUI and XML API user action, such as system access attempts and configuration changes in the main database. The following table lists the information in a user activity log record.

**Table 3-2 User activity log record information**

<table>
<thead>
<tr>
<th>Field name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Time</td>
<td>Time of activity</td>
</tr>
<tr>
<td>Session Type</td>
<td>Type of session, which is GUI, JMS, or XML API</td>
</tr>
<tr>
<td>Session ID</td>
<td>Client session identifier</td>
</tr>
<tr>
<td>Session IP Address</td>
<td>Client IP address</td>
</tr>
</tbody>
</table>
Table 3-2  User activity log record information  (continued)

<table>
<thead>
<tr>
<th>Field name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Session Time</td>
<td>Client session start time</td>
</tr>
<tr>
<td>Server IP Address</td>
<td>IP address of main server that reports the activity</td>
</tr>
<tr>
<td>Type</td>
<td>General activity type, which is Deployment, Operation, or Save</td>
</tr>
<tr>
<td>Sub Type</td>
<td>Specific activity type, which is Creation, Deletion, Modification, or name of the invoked method</td>
</tr>
<tr>
<td>Username</td>
<td>NFM-P username</td>
</tr>
<tr>
<td>Site Name</td>
<td>Name of affected NE, if applicable</td>
</tr>
<tr>
<td>Site ID</td>
<td>IP address of affected NE, if applicable</td>
</tr>
<tr>
<td>Object Name</td>
<td>Name of affected object</td>
</tr>
<tr>
<td>Object ID</td>
<td>Fully qualified name of affected object</td>
</tr>
<tr>
<td>Object Type</td>
<td>Type of affected object</td>
</tr>
<tr>
<td>State</td>
<td>Activity status, which is Failure, Success, or Timeout</td>
</tr>
<tr>
<td>Request ID</td>
<td>Identifier assigned to the request, which is unique to a session</td>
</tr>
<tr>
<td>Additional Info</td>
<td>Information such as old and new parameter values after a modification</td>
</tr>
<tr>
<td>XML</td>
<td>NFM-P object class descriptor, if applicable, and activity details in XML request format</td>
</tr>
</tbody>
</table>

To view general user activity log entries in the GUI, or retrieve the entries using the XML API, you require an NFM-P user account that has the Administrator or NFM-P Management and Operations scope of command role.

**Note:** Viewing or retrieving LI user activity entries requires the Lawful Intercept Management role, and is restricted to the entries of users in the same LI user group.

The logged activity types are the following:
- Operation—a request for the NFM-P
- Deployment—a change that is deployed to an NE
- Save—a change to an object in the NFM-P database

Each user activity creates an Operation log entry. If the activity results in an NE configuration change, a Deployment entry is logged. If the deployed information differs from the information in the NFM-P database, a Save entry is logged. If appropriate, a log entry contains the activity details in XML format.

The following table lists the user activity types and describes the associated sub types.
**Table 3-3  User activity types**

<table>
<thead>
<tr>
<th>Type</th>
<th>Sub Type</th>
<th>sub type description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Deployment</td>
<td>Creation</td>
<td>NE object creation</td>
</tr>
<tr>
<td></td>
<td>Deletion</td>
<td>NE object deletion</td>
</tr>
<tr>
<td></td>
<td>Modification</td>
<td>NE object modification</td>
</tr>
<tr>
<td>Operation</td>
<td>method</td>
<td>Name of invoked method</td>
</tr>
<tr>
<td>Save</td>
<td>Creation</td>
<td>Database object creation</td>
</tr>
<tr>
<td></td>
<td>Deletion</td>
<td>Database object deletion</td>
</tr>
<tr>
<td></td>
<td>Modification</td>
<td>Database object modification</td>
</tr>
</tbody>
</table>

The User Activity form displays a filterable list of the logged user activities, and a filterable list of the logged client and server session activities. Client session activities include connection, disconnection, and access violation. Server session activities include startup and shutdown. The properties form of a client connection log record lists the activities performed by the user during the client session.

The client GUI allows direct navigation between the following objects:
- activity record and the associated session record
- activity record and the activity target object
- object properties form and the associated user activity list form
- NFM-P Task Manager task and the associated user activity list form
- session record and the associated user activity list form

The User Activity form lists the recent user session and activity entries; older entries are purged according to configurable storage criteria. See 6.34 “To configure NFM-P system preferences” (p. 191) for information about configuring the user activity log retention criteria using the System Preferences form.

To archive user activity log entries before they are purged from the NFM-P database, an XML API client can use a time-based filter to retrieve entries from the sysact package using the find and findToFile methods. See Inventory retrieval methods in the *NSP NFM-P XML API Developer Guide* for information about using the find and findToFile methods.

User activity logging is a valuable troubleshooting function. For example, if a port unexpectedly fails, you can quickly determine whether misconfiguration is the cause by doing one of the following:
- opening the port properties form and clicking User Activity to view the recent user activity associated with the port
- opening the User Activity form, filtering the list by object type or name, and then verifying the associated user activities

**Note:** Script execution is logged, but the actions that a script performs are not. See “Troubleshooting using the NFM-P user activity log” in the *NSP NFM-P Troubleshooting Guide* for more information.

The following apply to user activity logging.
• A Deployment activity typically does not have an associated Save activity for the following reasons:
  − A Deployment activity takes place only after a successful Save activity, so a Deployment implies a Save.
  − A Save activity typically contains the same information as the associated Deployment activity.
• When a high-level object such as an NE is deleted, one aggregate activity record is created, rather than multiple NE child object activity records.
• The XML text in a log entry is limited to 4000 characters. If an activity generates more than 4000 characters of XML text, the text is truncated, and the truncation is indicated on the log entry form.

3.4.2 Client session control
Each GUI or XML API client request creates an NFM-P client session. You can view a list of the active client sessions on the Sessions tab of the NFM-P User Security - Security Management form. Using this form, an admin user, or a user with an assigned security scope of command role, can also terminate one or more client sessions. When a GUI client session is terminated in this manner, each client GUI displays a warning message and the connection is closed after a short delay. See 3.33 “To view and manage the active GUI client sessions” (p. 64) for more information.

Messaging connections
A list of active GUI connections and XML API JMS connections can be viewed on the Messaging Connections tab of the NFM-P User Security - Security Management form. Using this form, an admin user, or a user with an assigned security scope of command role, can terminate one or more connections. When an XML API client connection is terminated, a notification is sent to the client, but the admin user must also remove the JMS client connection so that the server stops storing JMS messages for the session. See 3.34 “To disconnect an XML API JMS client connection or remove a durable subscription” (p. 64) for more information.

Client delegate sessions
The threshold for the number of client sessions allowed on a client delegate server is configurable from the client GUI. When a user tries to open a client session that exceeds the threshold, the client delegate server opens the session, displays a warning message, and generates an alarm. The threshold-crossing function can help to balance the session load across multiple client delegate servers. You need the Update user permission on the Server package to configure the threshold. See 3.38 “To configure the number of allowed client sessions for a client delegate server” (p. 69) for more information.

3.5 Sample span rule configuration

3.5.1 Workflow
This section describes the configuration of a policy that instructs the NFM-P to automatically add each service created for a specific customer to an Edit Access span associated with the creator of the service. Only the service administrator for the customer can create or edit the specific customer services. In contrast, a typical service user can only view the specific customer services. The following table describes the tasks to configure a span rule.
Table 3-4 Sample span rule configuration

<table>
<thead>
<tr>
<th>Task</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Create a span that contains the existing customer services.</td>
<td>• Choose Administration→Security→NFM-P User Security from the NFM-P main menu.</td>
</tr>
<tr>
<td></td>
<td>• Choose Create→Span on the Span of Control tab.</td>
</tr>
<tr>
<td></td>
<td>• Specify a span name for the customer services.</td>
</tr>
<tr>
<td></td>
<td>• Use the Contents tab to specify the customer X services.</td>
</tr>
<tr>
<td>2. Create a span of control profile for the service administrator.</td>
<td>• Choose Administration→Security→NFM-P User Security from the NFM-P main menu.</td>
</tr>
<tr>
<td></td>
<td>• Choose Create→Profile on the Span of Control tab.</td>
</tr>
<tr>
<td></td>
<td>• Add the Default Service Span as a View Access span to the span of control profile, which allows the user to create a service.</td>
</tr>
<tr>
<td></td>
<td>• Add the customer services span as an Edit Access span to the span of control profile.</td>
</tr>
<tr>
<td>3. Create a range policy for each service type that the service administrator for the customer can create. In the sample, the services are IES and VPRN.</td>
<td>• Choose Administration→Format and Range from the NFM-P main menu.</td>
</tr>
<tr>
<td></td>
<td>• Choose Create→Range Policy.</td>
</tr>
<tr>
<td></td>
<td>• Specify IES Service as the Object Type.</td>
</tr>
<tr>
<td></td>
<td>• Specify Service ID as the Property Name.</td>
</tr>
<tr>
<td></td>
<td>• Configure a range.</td>
</tr>
<tr>
<td></td>
<td>• Click Add on the Users tab to assign the policy to the service administrator.</td>
</tr>
<tr>
<td></td>
<td>• Choose Create→Range Policy.</td>
</tr>
<tr>
<td></td>
<td>• Specify VPRN Service as the Object Type.</td>
</tr>
<tr>
<td></td>
<td>• Specify Service ID as the Property Name.</td>
</tr>
<tr>
<td></td>
<td>• Configure a range.</td>
</tr>
<tr>
<td></td>
<td>• Click Add on the Users tab to assign the policy to the service administrator.</td>
</tr>
<tr>
<td>4. Create a span rule that contains the customer span.</td>
<td>• Choose Administration→Span Rules from the NFM-P main menu.</td>
</tr>
<tr>
<td></td>
<td>• Specify a name for the customer span rule.</td>
</tr>
<tr>
<td></td>
<td>• Set the Created In parameter to All listed spans.</td>
</tr>
<tr>
<td></td>
<td>• Add the customer span on the Spans tab.</td>
</tr>
</tbody>
</table>

After the span rule is created, the service administrator creates a new VPRN service for the customer. The NFM-P uses the VPRN range policy to automatically configure the service ID, and applies the associated customer span rule when the service is saved. As a result, the service is added to the customer span and to the Default Service Span. The service administrator has Edit Access to the customer span, and, therefore, can modify the service, as required.

3.6 Remote NFM-P user access

3.6.1 Remote user access overview

In addition to local account management, NFM-P user authentication and authorization can be accomplished via remote servers. The NFM-P supports the following remote user access protocols:

- LDAPS
- RADIUS
TACACS+

Functional description

You can configure NFM-P access for users that log in through a third-party server in a corporate network. For example, a person who does not have an NFM-P user account can log in to the NFM-P using their corporate credentials. The NFM-P forwards the credentials to a remote authentication server, and grants or denies access to the user based on the remote server response.

If a remote authentication server is configured to authorize users, the remote server also sends the name of a user group in a successful authentication response. If the NFM-P has a user group with the same name, the user is assigned to the group and granted access based on the group properties. Otherwise, the user is assigned to a default external user group.

When a remote session terminates, the associated NFM-P user account remains, and the user application preferences, such as filters, apply to subsequent sessions.

Successful remote authentication for an XML API user requires that the remote server and the NFM-P use the same password format. The XML API users can log in using a clear-text or MD5-hashed password, if the remote server supports MD5 password hashing. See “Secure communication” in the NSP NFM-P XML API Developer Guide for more information.

Configuration

You use the NFM-P Remote Authentication Manager to configure the protocols and define the authentication order for users. For example, if you specify an order of RADIUS, LDAP, local, the NFM-P tries to authenticate each remote user via RADIUS; if the RADIUS servers are unavailable, the NFM-P tries LDAP, and upon failure tries to match the user credentials to a local NFM-P account.

3.43 “To configure NFM-P remote user authentication” (p. 76) describes how to configure the general remote access properties, such as the authentication types, the authentication order, and the remote servers.

Note: The combined timeouts of multiple NFM-P remote authentication servers may exceed the default NSP user-authentication timeout. To prevent remote login failures, you may need to increase the NSP timeout.

For example, two RADIUS servers are configured to retry user authentication five times each at ten-second intervals. If both servers are unavailable, the NFM-P attempts local authentication only after 100 seconds, which exceeds the default NFM-P user authentication timeout.

Consequently, although local NFM-P user authentication is enabled, remote login attempts fail, and the user receives notification that no authentication servers are available.

An operator then increases the user authentication timeout to 110 seconds. The remote servers remain unreachable, but because the timeout is not exceeded, local authentication proceeds, and the user is granted access.

See 3.42 “To configure the NSP user-authentication timeout” (p. 74) for information about increasing the timeout value.
3.6.2 Assigning remote users to NFM-P user groups

User authorization is the assignment of a user to a user group after successful user authentication. By default, the NFM-P assigns a remote user to a default user group, if one is specified. Optionally, you can configure the NFM-P to assign a group specified by a remote server. If no default group is specified, and remote group assignment is not configured, the authorization fails and the user is denied access.

After a remote server authenticates a user, if the name of the user group sent by the remote server matches an NFM-P user group name, the NFM-P creates a user account for the login session and grants the appropriate access rights. Otherwise, authorization fails and the NFM-P denies user access.

**RADIUS or TACACS+ user authorization**

In order for a remote RADIUS or TACACS+ server to assign an NFM-P user group, you must preconfigure the NFM-P and the remote server. See 3.40 “To enable remote user authorization via RADIUS” (p. 71) for information about enabling authorization for RADIUS users, and 3.41 “To enable remote user authorization via TACACS+” (p. 73) for information about enabling authorization for TACACS+ users.

**Note:** A RADIUS authentication success message that is sent to the NFM-P contains the user group name.

For TACACS+, authentication must succeed before an authorization message containing the user group name is sent to the NFM-P.

If an LDAP user password is MD5-hashed, only local user authorization is supported.

**LDAP user authorization**

For each LDAP server that you specify using the NFM-P Remote Authentication Manager, you can include LDAP group lookup criteria. The group name that the LDAP server returns in an authentication success message must match an existing NFM-P group name.

**Note:** If an LDAP user password is MD5-hashed, only local user authorization is supported.

3.6.3 One-time password use

For increased security, a GUI user can provide an authentication token to an LDAP, RADIUS or TACACS+ server that is validated only once. You can enable one-time password use during NFM-P remote authentication policy configuration, as described in 3.43 “To configure NFM-P remote user authentication” (p. 76).

**Note:** The one-time password function is not available to XML API clients.

To change the one-time password setting in a remote authentication policy, you require a scope of command that has Update/Execute access to the smmmtauth package.

After a communication failure between a GUI client and a main server when one-time password use is in effect, the GUI client is unable to obtain authentication using the cached credentials from the previous login attempt. When this occurs, the client prompts the user to log in to the remote authentication server again, but does not automatically close the GUI, in order to preserve the current view until the user is authenticated.
3.6.4 Combined local and remote authentication

An NFM-P operator can integrate an existing LDAP, RADIUS, or TACACS+ user account with an NFM-P user account by creating an NFM-P user account that has the same name as the remote account. An NFM-P user who authenticates remotely can then log in to the NFM-P using their remote credentials, if the password observes the NFM-P password constraints described in this chapter.

An NFM-P user name can be 1 to 80 characters long, which is sufficient for most combined authentication scenarios.

**Note:** If a RADIUS or TACACS+ server is configured to perform user authorization, the NFM-P requires a user group from the remote server, and the following conditions apply:

- The user group sent by the remote server must be defined in the NFM-P.
- If an NFM-P user account is associated with a local user group and configured to use remote authentication, the local user group is replaced by the specified remote user group.

For example, a user named jane has the following accounts:

- a remote RADIUS account called jane and the password accessforjane
- a local NFM-P account called jane and the password LetJane1In!

When jane is authenticated by RADIUS, she gains access to the NFM-P by typing in jane and accessforjane. If the RADIUS server is down, jane is authenticated locally by the NFM-P after typing jane and LetJane1In!.

3.7 Sample NFM-P user authentication configuration

3.7.1 Use case

*Figure 3-1, “Sample NFM-P user and user group authentication” (p. 40)* shows an example of how NFM-P performs user and user group authentication.

**Note:** RADIUS and TACACS+ authentication servers support multiple users. If the NFM-P cannot reach the first authentication server, the NFM-P sequentially attempts the user authentication using the remaining authentication servers.

If user authentication fails against the first authentication server in a sequence, for example, because of an incorrect password, there is no attempt to authenticate the user against the next authentication server in the sequence.

The NFM-P session log records unsuccessful user authentication attempts for known and unknown users. A user that is defined on an external AAA server but not in the NFM-P.
The following table lists the high-level tasks required to configure this sample.

### Table 3-5  Sample NFM-P user authentication configuration

<table>
<thead>
<tr>
<th>Task</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pre-configurations</td>
<td>Ensure correct RADIUS or TACACS+ server configuration, according to your company requirements. PAP authentication is supported for RADIUS and TACACS+. The NFM-P must be able to communicate with the authentication servers to validate users. All configuration tasks require admin user privileges. The NFM-P server IP address must be configured as the client of the RADIUS or TACACS+ server. The NFM-P and RADIUS or TACACS+ server secret keys must match.</td>
</tr>
</tbody>
</table>
### Table 3-5  Sample NFM-P user authentication configuration (continued)

<table>
<thead>
<tr>
<th>Task</th>
<th>Description</th>
</tr>
</thead>
</table>
| 1. Configure the remote authentication order for all users | Choose Administration→Security→NFM-P Remote User Authentication from the NFM-P main menu. Set the authentication order parameters to the following, and then specify the RADIUS and TACACS+ servers on the RADIUS and TACACS tabs.  
  - Authentication Order 1—radius  
  - Authentication Order 2—tacplus  
  - Authentication Order 3—local |
| 2. Create scope of command profiles | Choose Administration→Security→NFM-P User Security from the NFM-P main menu. Create a CLI scope of command profile and assign the default CLI management role to the profile. Create at least one scope of command profile that does not allow CLI access by assigning the default scope of command role, which has no access permissions to CLI management. |
| 3. Create and configure user groups | Choose Administration→Security→NFM-P User Security from the NFM-P main menu. Create a CLI user group and at least one user group that does not allow CLI access. Assign the scope of command profile with CLI management access to the CLI user group. Assign the scope of command profile without CLI management access to the user group without CLI access. Authorization is done using user groups, so each user must belong to a user group with a local account on the NFM-P. |
| 4. Create and configure user accounts | You can create local NFM-P user accounts by performing the following steps, or define remote users using RADIUS and TACACS+. The local accounts are available when RADIUS or TACACS+ authentication is not available.  
  Choose Administration→Security→NFM-P User Security from the NFM-P main menu.  
  Create users.  
  Assign the appropriate user group to restrict or allow CLI access to each user. |
| 5. Configure notification | Choose Administration→Security→NFM-P User Security from the NFM-P main menu. Configure the authentication failure action parameters, including the parameters that allow the E-mail account of the administrator to be notified after login failure. |

Consider the following:

- The NFM-P acts as a network access server. A network access server is considered a client of a remote access server.
- The sequence of activity between the NFM-P, which is the authentication client, and the remote server, which is the authentication server, is the following:
  - client requests authentication
  - server replies to authentication request
  - client requests logout and authentication stops
- When the remote authentication servers are down and local authentication is used, the user must log in using NFM-P credentials, as described in 3.6.4 "Combined local and remote authentication" (p. 39).
NFM-P user security procedures

3.8 Workflow to configure and manage NFM-P user security

3.8.1 Process

1. Assess the requirements for user access to the different NFM-P functional areas and develop a strategy for implementing user security. See 3.3 “User account and group management” (p. 28) for more information.

2. Reserve a client GUI session for the admin user to ensure that the admin user can always log in; see 3.9 “To reserve an admin account login” (p. 45).

3. Create scope of command roles or modify the default role to meet your operational requirements; see 3.10 “To create a scope of command role” (p. 45).

4. Create scope of command profiles that contain the appropriate scope of command roles for the types of tasks to be performed; see 3.11 “To create a scope of command profile” (p. 46).

5. Create spans or modify the default span to meet your operational requirements. Add managed objects to the spans; see 3.12 “To create a span of control” (p. 47).

6. Create span of control profiles that contain the required spans; see 3.13 “To create a span of control profile” (p. 48).

7. Create span rules, as required, to automatically assign new services to spans other than the Default Service Span; see 3.14 “To create a span rule” (p. 48).

8. Manage user group security requirements, as required.
   - Create or modify user groups and assign scope of command and span of control profiles to each group, as required; see 3.15 “To create an NFM-P user group” (p. 49).
   - Add workspaces to user groups; see 3.16 “To add or remove workspaces for a user group” (p. 51).
Create, modify, or copy user accounts for performing the tasks that are associated with each user group; see 3.17 “To create an NFM-P user account” (p. 52) and 3.18 “To copy an NFM-P user account” (p. 54).

Configure global user account parameters, as required.
- user-account expiry periods, password criteria, and a GUI inactivity timeout; see 3.19 “To configure global user account, password” (p. 54) and 3.20 “To configure the GUI client inactivity timeout” (p. 55).
- minimum username length; see 3.21 “To configure the minimum allowable user name length” (p. 56).
- allowed number of authentication attempts; see 3.22 “To configure authentication failure actions” (p. 56).
- suspended account actions; see 3.23 “To configure suspended account actions” (p. 57).
- automated E-mail notification; see 3.24 “To configure automated E-mail notification” (p. 57).

Configure global user activity logging, as required; see 6.34 “To configure NFM-P system preferences” (p. 191).

Enable and configure NFM-P access for remote users, if required.
1. If required, increase the NSP user-authentication timeout; see 3.42 “To configure the NSP user-authentication timeout” (p. 74).
2. Configure authorization for remote users in which either the NFM-P or the remote authentication server associates the user with a user group:
   - for LDAP: 3.39 “To enable secure access for remote LDAP users” (p. 70)
   - for RADIUS: 3.40 “To enable remote user authorization via RADIUS” (p. 71)
   - for TACACS+: 3.41 “To enable remote user authorization via TACACS+” (p. 73)
3. Configure the general remote-access parameters, and specify LDAP, RADIUS, and TACACS+ servers, as required; see 3.43 “To configure NFM-P remote user authentication” (p. 76).

Manage user accounts, as required.
- List inactive user accounts; see 3.25 “To list inactive user accounts” (p. 58).
- Suspend or reinstate user accounts; see 3.26 “To suspend or reinstate an NFM-P user account” (p. 58).
- Manage passwords.
  - As administrator, change the password of an NFM-P user account; see 3.27 “To administratively change the password of an NFM-P user” (p. 59).
  - Force a specified NFM-P user to change the account password during the next login.
attempt; see 3.28 “To disable an NFM-P user password” (p. 60).

- Change the account password of the current user; see 3.29 “To change the password of the current NFM-P user” (p. 61).

- Export user tab preferences; see 3.30 “To export the local tab preferences of one or more users” (p. 61).

- Assign user tab preferences; see 3.31 “To assign local tab preferences to users” (p. 62).

14

Monitor and manage the active client sessions, as required.

- Broadcast a message to one or more GUI operators; see 3.32 “To send a broadcast message to GUI clients” (p. 63).

- List and optionally close GUI client sessions; see 3.33 “To view and manage the active GUI client sessions” (p. 64).

- List and optionally close XML API client sessions; see 3.34 “To disconnect an XML API JMS client connection or remove a durable subscription” (p. 64).

- View the NFM-P user activity logs to monitor GUI and XML API user activity; see 3.35 “To view the user activity log” (p. 65) and 3.36 “To view the user activity associated with an object” (p. 67).

15

Configure or manage the following security functions, as required:

- Change the maximum number of concurrent NFM-P admin user sessions; see 3.37 “To change the maximum number of concurrent NFM-P admin operator positions” (p. 68).

- Limit the number of client sessions that the NFM-P accepts from one or more client delegate servers; see 3.38 “To configure the number of allowed client sessions for a client delegate server” (p. 69).

16

Change the default parameter setting for the Task Manager, as required; see 3.44 “To change the NFM-P Task Manager settings” (p. 78).

17

Export or import all workspaces and tab preferences, as required.

- Export all workspaces and tab preferences; see 3.45 “To export all workspaces and local tab preferences” (p. 79).

- Import all workspaces and tab preferences, import workspaces only, or import tabs only; see 3.46 “To import workspaces and local tab preferences” (p. 80).
3.9 To reserve an admin account login

3.9.1 Purpose
You can reserve one client GUI session from the maximum number of sessions allowed by the license key, for admin users only. This allows an administrator to manage the existing client GUI sessions. You must have an account with an assigned security scope of command role to perform this procedure.

3.9.2 Steps


2. Configure the Reserve Administrator Login parameter.

3. Save your changes and close the form.

4. Log in as required.

END OF STEPS

3.10 To create a scope of command role

3.10.1 Purpose
You can create a set of user permissions that define an operator role and apply one or more scope of command roles to a user group using a scope of command profile. You must have an account with an assigned security scope of command role to perform this procedure.

Note: You cannot delete a pre-defined scope of command role.
You cannot delete a scope of command role that is assigned to a scope of command profile when the scope of command profile is assigned to a user group that contains users.
Refer to Appendix A, “Scope of command roles and permissions” for a complete list of command profiles, roles, and permission information.

3.10.2 Steps

Click on the Scope of Command tab.

Click Create and choose Role. The Role (Create) form opens.

Configure the required parameters.

Configure the permissions for the scope of command role:
1. Click on the Permissions tab. A list of the NFM-P packages, classes, and methods is displayed.
2. Select the required access permissions, which are displayed in the list column headings, for each package, class, or method that you need to assign to the scope of command role.

Save your changes and close the form.

---

### 3.11 To create a scope of command profile

#### 3.11.1 Steps


2. Click on the Scope of Command tab.

3. Click Create and choose Profile. The Scope of Command Profile (Create) form opens.

4. Configure the required parameters.

5. Assign one or more scope of command roles to the profile:
   1. Click on the Roles tab and click Add. The Select Role - Role form opens.
2. Select one or more roles and click OK.
   
   **Note:** You cannot delete a scope of command profile that is assigned to a user group that contains users.

6. Save your changes and close the form.

**END OF STEPS**

### 3.12 To create a span of control

#### 3.12.1 Purpose

You can specify a set of NFM-P objects in a span of control and the type of user access available for the objects. You can apply one or more spans to a user group using a span of control profile. You must have an account with an assigned security scope of command role to perform this procedure.

**Note:** You cannot delete a span of control that is assigned to a user group that contains users.

#### 3.12.2 Steps


2. Click on the Span of Control tab.

3. Click Create and choose Span. The Span (Create) form opens.

4. Configure the required parameters.

5. Add one or more objects for user access:
   1. Click on the Contents tab.
   2. Click Add and choose an object type. The Select *(object_type)* form opens.
   3. Select one or more objects and click OK.
3.13 To create a span of control profile

3.13.1 Steps

1.
Using an account with an assigned security scope of command role, choose Administration→Security→NFM-P User Security from the NFM-P main menu. The NFM-P User Security - Security Management (Edit) form opens.

2.
Click on the Span of Control tab.

3.
Click Create and choose Profile. The Span of Control Profile (Create) form opens.

4.
Configure the required parameters.

5.
Assign one or more spans to the profile:
   1. Click on the Spans tab. The predefined spans are listed.
   2. Click Add and choose an access type. The Select access_type Spans form opens.
   3. Select one or more spans in the list and click OK.
   
      Note: You cannot delete a span of control profile that is assigned to a user group that contains users.

6.
Save your changes and close the form.

END OF STEPS

3.14 To create a span rule

3.14.1 Purpose

A span rule is a policy that specifies to which span of control profiles, in addition to the Default Service Span, a newly created service is automatically assigned. You must have an account with an assigned security scope of command role to perform this procedure.
See 3.5 “Sample span rule configuration” (p. 35) for a sample span rule configuration and implementation.

### 3.14.2 Steps

1. Using an account with an assigned security scope of command role, choose Administration→Span Rules from the NFM-P main menu. The Span Rules form opens.

2. Click Create. The Service Creation Span Rule (Create) form opens.

3. Configure the required parameters.

4. Associate one or more spans with the rule:
   1. Click on the Spans tab and click Add. The Select Span(s) form opens.
   2. Select one or more spans in the list and click OK.

5. Associate one or more format or range policies with the rule:
   1. Click on the Format and Range Policies tab and click Add. The Select Format or Range Policies form opens.
   2. Select one or more policies in the list and click OK.

6. Save your changes and close the form.

### 3.15 To create an NFM-P user group

#### 3.15.1 Steps


2. Click on the User Groups tab and click Create. The User Group (Create) form opens.
3 Configure the required general parameters.

4 Enable and configure the Maximum User Group Operator Positions Allowed parameter to specify the maximum number of operator positions for the user group, where one operator position allows for one NFM-P non-web client session and one web client session for the user group.

5 Configure the parameters in the Expiry Periods panel.

6 If the user group is for XML API users or remote GUI users, configure the required parameters in the Remote Users panel.

7 Select a scope of command profile in the Scope of Command panel.

8 Select a span of control profile in the Span of Control panel.

9 If you are modifying a user group, click on the Format and Range Policies tab. The Select Format or Range Policies form opens.

10 Select one or more policies and click OK.

**Note:** When you change the scope of command or span of control profiles of a group, the permissions of each user in the group are altered immediately when you click OK. You cannot delete a user group that contains users.

11 Save your changes and close the form.

12 If an active client GUI session is affected by the user group modification, restart the GUI client.

**End of steps**
3.16 To add or remove workspaces for a user group

3.16.1 Steps

Administrators can use this procedure to set conditions so that either users cannot change the list of workspaces on their User Preferences form or users can add additional workspaces to their workspace selector. To create or add new workspaces for a user group, see “NFM-P GUI custom workspace procedures” in the NSP NFM-P User Guide for more information.


2. Click on the User Groups tab.

3. Click Create or choose a user group and click Properties. The User Group (Create|Edit) form opens.

4. To configure the Allow Mandatory Workspaces Only parameter in the Mandatory Workspaces panel, choose one of the following:
   a. Select the Allow Mandatory Workspaces Only check box.

   **Note:** If you select the Allow Mandatory Workspaces Only check box, the Add button on the User Preferences→Workspaces form is dimmed and the user cannot change the list of workspaces on their User Preferences form. Any existing user-defined workspaces in the User Preferences form are deleted when the Allow Mandatory Workspaces Only check box is selected. The user can change the order that the workspaces appear in the workspace selector and set any workspace as the default workspace.

   b. Deselect the Allow Mandatory Workspaces Only check box.

   **Note:** The user can add additional workspaces to their workspace selector by clicking Add in the User Preferences form. See “NFM-P GUI custom workspace procedures” in the NSP NFM-P User Guide for more information. The user can change the order that the workspaces appear in the workspace selector and set any workspace as the default workspace.

5. Add mandatory workspaces to a specific user group:
   1. Click Add. The Add Workspace form opens.
   2. Choose a workspace from the list and click OK. The Add Workspace form closes.
Note: All mandatory workspaces that are added to the user group by the Administrator appear in the User Preferences→Workspaces form and in the workspace selector drop-down for each user in the user group and cannot be deleted.

6

To remove a workspace from the user group, choose a workspace in the Mandatory Workspaces panel and click Delete.

7

Click Move Up or Move Down to reorder the workspaces in the list. The workspace at the top of the list is the default workspace.

Note: You need a minimum of one workspace in the User Group. If the last user workspace is deleted, the user’s default workspace in the User Preferences form is replaced by the user group default workspace.

8

Save your changes and close the form.

END OF STEPS

3.17 To create an NFM-P user account

Note: If you want to delete an NFM-P user account, schedules associated with the user account are deleted only if the schedule is not associated with a scheduled task.

3.17.1 Steps

1

Using an account with an assigned security scope of command role, choose Administration→Security→NFM-P User Security from the NFM-P main menu. The NFM-P User Security - Security Management (Edit) form opens.

2

Click on the Users tab and click Create. The User (Create) form opens.

3

Configure the required general parameters.

4

Click Select and choose a user group.
5 If required, test the validity of the user E-mail address by clicking Test E-mail beside the E-mail Address parameter.

**Note:** Before you test the validity of the user E-mail address, ensure that the outgoing SMTP E-mail server and E-mail test message are configured. See 3.24 “To configure automated E-mail notification” (p. 57) for information about configuring the outgoing E-mail server and test message.

6 Configure the parameters in the Password panel.

7 In the UI Session panel, configure the Maximum User Operator Positions Allowed parameter to specify the maximum number of operator positions for the user, where one operator position allows for one NFM-P non-web client session and one web client session for the user.

The value for the Maximum User Operator Positions Allowed parameter cannot be greater than the Maximum User Group Operator Positions Allowed parameter value of the user group to which the user belongs.

**Note:** When two or more sessions of the same type are registered from a user ID, two or more operator positions are consumed.

8 Perform this step if the user requires XML API client access:
   1. Configure the required parameters in the OSS Session panel.
   2. To apply an alarm filter to control or limit the alarms that the NFM-P forwards to XML API clients over JMS, click Select in the OSS Session panel and choose an alarm filter. See 14.55 “To configure alarm filters for XML API clients using the NFM-P GUI” (p. 403) for more information.

9 Configure the required parameters in the Client IP Address panel.

10 Save your changes and close the form.

END OF STEPS
3.18 To copy an NFM-P user account

3.18.1 Steps


2. Click on the Users tab.

3. Choose a user and click Properties. The User type_of_user, Group user_group (Edit) form opens.

4. Click Copy. A User (Create) form opens for the second user.

5. Configure the required parameters. You must change the UserName parameter and configure the UserPassword and ConfirmPassword parameters.

6. Save your changes and close the form.

END OF STEPS

3.19 To configure global user account, password

3.19.1 Steps


2. Configure the Password Reuse Cycle and Password History Duration (days) parameters.

3. Configure the required parameters in the Expiry Periods panel.
**Note:** If you set any of the parameters to 0, the corresponding expiry period check is disabled.
You can specify how long an account can remain dormant before the account is locked using the Account Expiry (days) parameter.
When a user attempts to log in with an expired password, the user account is suspended.
When a user updates their password, the password expiry period is reset, and the new password again expires when the Password Expiry (days) parameter value is reached.

Save your changes and close the form.

**END OF STEPS**

### 3.20 To configure the GUI client inactivity timeout

#### 3.20.1 Steps


2. Change the GUI inactivity check for all GUI clients.
   1. Configure the Non-Web Client Timeout (minutes) parameter.
   2. Click Apply.

3. Change the GUI inactivity check for all users in a user group:
   1. Click on the User Groups tab. A list of user groups is displayed.
   2. Choose a user group from the list and click Properties. The User Group name (Edit) form opens.
   3. Enable the Non-Web Override Global Timeout parameter.
   4. Configure the Non-Web Client Timeout (minutes) parameter.

4. Save your changes and close the form.

**END OF STEPS**
3.21 To configure the minimum allowable user name length

3.21.1 Steps

The minimum number of characters for a user name length is one, and the maximum number of characters is 40.

1 Using an account with an assigned security scope of command role, choose Administration→Security→NFM-P User Security the NFM-P main menu. The NFM-P User Security - Security Management (Edit) form opens.

2 In the User Name panel, check the Enable box.

3 Configure the Minimum User Name Length Allowed parameter.

4 Save your changes and close the form.

END OF STEPS

3.22 To configure authentication failure actions

3.22.1 Purpose

You can specify an authentication message or a lockout for a user account that exceeds the configured number of login authentication attempts. Only non–admin accounts can be locked out. Admin accounts always have access.

3.22.2 Steps

1 Using an account with an assigned security scope of command role, choose Administration→Security→NFM-P User Security the NFM-P main menu. The NFM-P User Security - Security Management (Edit) form opens.

2 Click on the E-mail tab and configure the required parameters in the Authentication Failure Actions panel.

If you set the Attempts before lockout parameter to 0, the lockout function is disabled.
3.23 To configure suspended account actions

3.23.1 Steps


2. Click on the E-mail tab.

3. Configure the parameters in the Suspended Account Actions panel.

4. Save your changes and close the form.

END OF STEPS

3.24 To configure automated E-mail notification

3.24.1 Purpose

You can configure the NFM-P to automatically send E-mail messages to users and administrators; for example, when locking out a user account that exceeds the allowed number of authentication attempts.

3.24.2 Steps


2. Click on the E-mail tab.
3.25 To list inactive user accounts

3.25.1 Steps


2. Click on the Users tab.

3. Click Inactive User Search and perform one of the following:
   a. Choose ≥90 Days.
   b. Choose ≥180 Days.
   c. Specify another period:
      2. Configure the User inactive greater than or equal to parameter.

   User accounts that have been inactive for a number of days that are greater than or equal to the specified value are listed on the NFM-P User Security - Security Management (Edit) form.

4. Save your changes and close the form.

END OF STEPS

3.26 To suspend or reinstate an NFM-P user account

3.26.1 Steps

1.

2

Click on the Users tab.

3

Select a user account and click Properties. The User *type_of_user* (Edit) form opens.

4

Configure the User State parameter to suspend or reinstate the user account.

5

Save your changes and close the form.

END OF STEPS

3.27 To administratively change the password of an NFM-P user

3.27.1 Purpose

The system administrator uses the Security Management form to maintain user accounts. The user can change their password in a separate form. If a user forgets their password, the system administrator can change the password and inform the user of the new password.

When a user attempts to log in with an expired password, the user account is suspended. When a user updates their password, the password expiry period is reset, and the new password again expires when the Password Expiry (days) parameter value is reached.

3.27.2 Steps

1


2

Click on the Users tab.

3

Select a user and click Properties. The User *type_of_user* (Edit) form opens.

4

Configure the User Password parameter and the Confirm Password parameter.
3.28 To disable an NFM-P user password

3.28.1 Purpose
You can disable the password of a specific NFM-P user in order to block subsequent NSP Launchpad login attempts and force a password change.

**Note:** Disabling a user password may affect current user sessions. For example, if the user attempts to open the NFM-P client when the password is invalidated, the user may be directed back to the NSP Launchpad. The operation fails until a valid password is assigned to the user.

3.28.2 Steps

1. Open an NFM-P GUI client.


3. Click on the Users tab.

4. Select a user and click Properties. The User *username* (Edit) form opens.

5. Select the Invalidate User Password parameter.

6. Save your changes and close the form.

End of steps

The next login attempt by the user to the NSP Launchpad is blocked, and the following message is displayed to the operator:

*Your account password has expired and must be changed.*

The operator must request a password from an administrator.
3.29 To change the password of the current NFM-P user

3.29.1 Steps

1. Open an NFM-P GUI client.

2. Choose Administration→Security→Change Password from the main menu. The Password Change form opens.

3. Configure the parameters.

4. Save your changes and close the form.

3.30 To export the local tab preferences of one or more users

3.30.1 Purpose

You can export the local tab preferences of single or multiple users to a specified directory. You can reuse these saved tab preferences settings by importing them later.

The exported settings are the local tab preferences saved for the selected users, not the custom tab preferences saved in a workspace. See “To configure tab preferences” in the NSP NFM-P User Guide for information about saving tab preferences in a workspace.

3.30.2 Steps


2. Click on the Users tab.
Choose one or more users from the list.

Click Tab Preferences and choose Export to export the selected user’s local tab preferences to a specified directory. The Export Directory window opens.

Specify the export directory, or create a directory or folder, and click OK. The selected user’s local tab preferences are exported to the specified directory.

Close the form.

3.31 To assign local tab preferences to users

3.31.1 Steps

1 Choose Administration→Security→NFM-P User Security from the NFM-P main menu. The NFM-P User Security - Security Management (Edit) form opens.

2 Click on the Users tab.

3 Choose one or more users from the list.

4 Click Tab Preferences and choose Assign to assign the tab preferences from the specified directory to the selected users. The Import Directory window opens. To export local tab preferences to a specified directory, see 3.30 “To export the local tab preferences of one or more users” (p. 61).

5 Navigate to the directory from which you need to assign a tab preference.

Note: Only a single user’s tab preferences can be in the specified directory or an error message appears.
Click Open and click Yes. The assigned tab preferences overwrite the local tab preferences of the selected users.

All affected users who currently have a client session opened, other than the client session where the assign has been initiated, receive a system-generated message informing them that the local tab preferences have been changed and they must restart the client, or risk losing the changes. A client operator can use the Reply function to reply to the message.

Close the forms.

END OF STEPS

3.32 To send a broadcast message to GUI clients

3.32.1 Steps

1 Using an account with an assigned security scope of command role, choose Administration→Security→NFM-P User Security from the NFM-P main menu. The NFM-P User Security - Security Management (Edit) form opens.

2 Click on the Sessions tab.

3 Select the required client session and click Text Message. The Text Message form opens.

4 Enter a message in the Text Message form and click Send.

5 Close the form.

END OF STEPS
3.33 To view and manage the active GUI client sessions

3.33.1 Steps


2. Click on the Sessions tab.

3. Specify a filter to create a filtered list of GUI or XML API JMS client sessions and click Search. The active client sessions are listed.

4. Review the session information.

5. To close a GUI client session, select a session in the list and click Close Session.

   **Note:** Closing an XML API session has additional dependencies; see 3.34 “To disconnect an XML API JMS client connection or remove a durable subscription” (p. 63) for more information.

6. Close the form.

   **END OF STEPS**

3.34 To disconnect an XML API JMS client connection or remove a durable subscription

3.34.1 Steps


2. Click on the Messaging Connections tab.
3 Specify a filter and click Search. A list of active XML API client connections opens.

4 Select a connection in the list and perform one of the following:
   a. Click Close Connection to shut down the client connection.
   b. Click Remove Connection to shut down the client connection and remove the durable subscription.

5 Click Yes. The action is performed.
   If you choose Close Connection, the connection is terminated, but the NFM-P continues to store JMS messages for the session.
   If you choose Remove Connection, the NFM-P stops storing the JMS messages for the session.

   **Note:** When you remove a durable subscription, the XML API client can still attempt to connect to the XML API. You can prevent an XML API client from attempting to connect by suspending the XML API user account. See 3.26 “To suspend or reinstate an NFM-P user account” (p. 58) for more information.

6 Close the form.

**END OF STEPS**

### 3.35 To view the user activity log

#### 3.35.1 Purpose

You can view user activity log entries associated with the following:

- a user
- a client session

**Note:** Viewing user activity records other than LI activity records requires a user account with an assigned Administrator or NFM-P Management and Operations scope of command role. Viewing LI user activity records requires a user account with an assigned Lawful Interception Management scope of command role. The scope is restricted to the records of users in the same LI user group.
3.35.2 Steps

1. Choose Administration→Security→User Activity from the NFM-P main menu. The NFM-P User Activity form opens.

2. Perform one of the following:
   a. View the activities performed during a specific client session:
      1. Configure the filter criteria, if required, and click Search. A list of session entries is displayed.
      Note: Only client session entries with a State value of Connected contain activity entries.
      2. Select the required session entry and click Properties. The Session form opens.
      3. Click on the Activity tab.
      4. Configure the filter criteria, if required, and click Search. A list of activity entries is displayed.
   b. View the activities of a specific user.
      1. Click on the Activity tab.
      2. Specify the required username as the Username filter criterion and click Search. A list of user-specific entries is displayed.

3. Select an entry in the list and click Properties. The Activity form opens.

4. Review the general information, which matches the columnar information on the User Activity list form.

5. Depending on the activity Type and Sub Type, the Additional Info panel contains detailed activity information. If required, expand the panel to review the information. The following information is listed:
   - **Type Operation, all Sub Types**:
     - left pane—object hierarchy in tree form; each object is selectable
     - right pane—properties and values of selected object in left pane
     The Actions property, which is highlighted in yellow for an object creation or modification activity, has values that represent the actions associated with the activity, such as create and modify.
   - **Type Deployment or Save, Sub Type Modification**:
     - Property Name column—list of modified parameters
     - New Value column—the parameter value set during the activity
     - Old Value column—the previous parameter value
If required, expand the XML panel to display more information about the activity. The panel displays the following information:

- Full Class Name—the NFM-P class descriptor of the affected object type
- Additional Info—the activity details in the form of an XML request

**Note:** The displayed Additional Info text is limited to 4000 characters. If an activity generates more than 4000 characters of XML text, for example, access interface creation, the Additional Info panel of the log entry contains a “truncated” object, and the XML text contains a closing <truncated/> tag.

To navigate directly to the object of the activity, click View Object. The object properties form opens.

**Note:** The View Object button is dimmed when there is no object associated with the activity, for example, a user login or logout operation.

View the activity information and close the form.

**END OF STEPS**

### 3.36 To view the user activity associated with an object

#### 3.36.1 Steps

**Note:** Viewing user activity records other than LI activity records requires a user account with an assigned Administrator or NFM-P Management and Operations scope of command role. Viewing LI user activity records requires a user account with an assigned Lawful Interception Management scope of command role. The scope is restricted to the records of users in the same LI user group.

1. Open the required object properties form.

2. Click User Activity. The Activity form opens.

**Note:** The User Activity function is available only for objects that exist in the NFM-P database. For example, the function is not available on the User Preferences form, because the settings on the form are saved in the client or client delegate file system.
3.37 To change the maximum number of concurrent NFM-P admin operator positions

**CAUTION**

*Service Disruption*

Modifying the server configuration can have serious consequences including service disruption. Contact technical support before you attempt to modify the server configuration.

*i* **Note:** You must perform the procedure on each main server in the NFM-P system.

*i* **Note:** In a redundant system, you must perform the procedure on the standby main server station first.

3.37.1 Steps

1. Log in to the main server station as the nsp user.

2. Open a console window.

3. Navigate to the `/opt/nsp/nfmp/server/nms/config` directory.

4. Create a backup copy of the `nms-server.xml` file.

5. Open the `nms-server.xml` file using a plain-text editor such as vi.

6. Locate the section that begins with following XML tag:
   
   `<samsession`
Edit the following line in the section:
max5620SAMAdminSessions="value"
where value is the maximum number of concurrent admin operator positions

Save and close the nms-server.xml file.

On a standalone main server, or the primary main server in a redundant system, enter the following:
bash$ /opt/nsp/nfmp/server/nms/bin/nmsserver.bash read_config

The NFM-P puts the configuration change into effect.

Close the open console windows.

3.38 To configure the number of allowed client sessions for a client delegate server

3.38.1 Steps
The NFM-P continues to accept new client sessions from a client delegate server after the allowed number of sessions is reached. The maximum number of sessions is used as a guide for balancing the client session load among multiple client delegate servers.

Using an account with Update permission on the Server package, choose Administration→System Information from the NFM-P main menu. The System Information form opens.

Click on the Client Delegate Servers tab.

Select a client delegate server and click Properties. The Client Delegate Server (Edit) form opens.

Configure the Maximum UI Sessions parameter.
Save your changes and close the form.

---

## 3.39 To enable secure access for remote LDAP users

**CAUTION**

**Service Disruption**

Performing the procedure requires a restart of each main server in the NFM-P system, which is service-affecting.

You must perform the procedure only during a scheduled maintenance period.

**Note:** In a redundant system, you must perform the procedure on the standby main server station first.

**Note:** The remote LDAP server must be operational and accessible to the NFM-P when you perform the procedure.

### 3.39.1 Steps

1. Log in as the nsp user on the main server station.

2. Open a console window.

3. Navigate to the `/opt/nsp/nfmp/server/nms/bin` directory.

4. Enter the following to import the LDAP server SSL certificate to the NFM-P keystore:

   ```bash
   bash$ ./nmsserver.bash add_to_keystore IP_address port
   ```

   where
   
   | `IP_address` | is the remote LDAP server IP address |
   | `port`      | is the required LDAP server port |
   
   The script prompts you for the keystore alias.

5. Press Enter to accept the default.

   The script prompts you for the keystore password.
6

Enter the keystore password.
The certificate is imported to the keystore.

7

Restart the main server.

Note: When you restart the primary main server in a redundant system, a server activity switch occurs, and the standby main server assumes the primary role.

1. Enter the following:
   
   bash$ ./nmsserver.bash restart
   
   The main server restarts.
   
2. If you are restarting the standby main server in a redundant system, enter the following to display the server status:

   bash$ ./nmsserver.bash appserver_status

   The server status is displayed; the server is fully initialized if the status is the following:
   Application Server process is running. See nms_status for more detail.
   
   If the server is not fully initialized, wait five minutes and then repeat this step. Do not perform the next step until the server is fully initialized.

8

Close the console window.

END OF STEPS

3.40 To enable remote user authorization via RADIUS

3.40.1 Steps

Note: You must perform Step 1 to Step 8 on each main server in the NFM-P system.

Note: In a redundant system, you must perform Step 1 to Step 8 on the standby main server station first.

Enable NFM-P remote RADIUS authorization

1

Log in to the main server station as the nsp user.

2

Open a console window.
3. Navigate to the /opt/nsp/nfmp/server/nms/config directory.

4. Open the SamJaasLogin.config file using a plain-text editor such as vi.

5. Locate the RADIUSLogin section of the file and set the samvsa parameter to true, as shown in Figure 3-2, “SamJaasLogin.config file, RADIUS parameters” (p. 71):

```
RADIUSLogin
{
    com.timetra.nms.server.jaas.provider.radius.auth.RadiusJaasLoginModule REQUIRED
        debug=false
        samvsa=true
    ;
};
```

6. Save and close the file.

7. On a standalone main server, or the primary main server in a redundant system, enter the following:

```
bash$ /opt/nsp/nfmp/server/nms/bin/nmsserver.bash read_config
```

The NFM-P puts the configuration change into effect.

8. Close the console window.

**Configure remote RADIUS server**

9. Copy the RADIUS dictionary section in Code Figure 3-3, “NFM-P RADIUS dictionary entry” (p. 73) to the RADIUS dictionary file on the RADIUS server.

**Note:** The vendor ID must be 123.
3.41 To enable remote user authorization via TACACS+

3.41.1 Steps

Note: You must perform Step 1 to Step 8 on each main server in the NFM-P system.

Note: In a redundant system, you must perform Step 1 to Step 8 on the standby main server station first.

Enable NFM-P remote TACACS+ authorization

1 Log in to the main server station as the nsp user.

2 Open a console window.

3 Navigate to the /opt/nsp/nfmp/server/nms/config directory.

4 Open the SamJaasLogin.config file using a plain-text editor such as vi.

5 Locate the TACACSLogin section of the file and set the samvsaparameter to true, as shown in Code Figure 3-4, "SamJaasLogin.config file, TACACS+ parameters" (p. 74):
Figure 3-4  SamJaasLogin.config file, TACACS+ parameters

```
TACACSLogin
{
    com.timetra.nms.server.jaas.provider.tacacs.auth.TacacsPlus-JaasLoginModule REQUIRED
debug=false
samvsa=true
};
```

6  
Save and close the file.

7  
On a standalone main server, or the primary main server in a redundant system, enter the following:

```
bash$ /opt/nsp/nfmp/server/nms/bin/nmsserver.bash read_config
debag=0
```

The NFM-P puts the configuration change into effect.

8  
Close the console window.

Configure remote TACACS+ server

9  
As the TACACS+ server administrator, add the user group VSA to the TACACS+ user profile, as shown in the following:

```
service=sam-app{
    sam-security-group="user_group"
}
```

where user_group is the name of a valid NFM-P user group

END OF STEPS

3.42  To configure the NSP user-authentication timeout

3.42.1  Purpose

Perform this procedure if the following are true:

- You are currently using, or intend to enable, NFM-P remote user authentication.
- The combined timeout values of the remote authentication servers exceed the NSP default of 60 seconds.
Otherwise, remote user authentication may fail when the remote servers are unreachable.

**Note:** If the NSP system includes the NSD and NRC module, you perform the procedure on each NSD and NRC server station.

**Note:** If the NSP system includes only the NFM-P, you perform the procedure on each NFM-P main server station.

### 3.42.2 Steps

1. Log in to the station as the root user.

2. Open the following file with a plain-text editor such as vi:
   `/opt/nsp/os/tomcat/conf/cas/application.properties`

3. Locate the following line:
   
   ```
   nfmp.auth.readTimeout=value
   ```

4. Edit the line to read:
   
   ```
   nfmp.auth.readTimeout=new_value
   ```
   
   where *new_value* is the new timeout value, in ms; for example, 100000 represents 100 seconds

   **Note:** The recommended value is the combined timeouts of the remote authentication servers, plus 10 seconds.

5. Save and close the file.

6. Enter the following to put the new timeout into effect:
   
   ```
   # systemctl restart nspos-tomcat
   ```

7. Log out of the station.

**END OF STEPS**
3.43 To configure NFM-P remote user authentication

3.43.1 Steps

Assign default external user group

1
Using an account with an assigned security scope of command role, choose Administration→Security→NFM-P User Security from the NFM-P main menu. The NFM-P User Security - Security Management (Edit) form opens.

2
Select a user group in the Default External User Group panel.

Note: Do not select a user group that has the Apply Local Authentication Only parameter enabled, or remote login attempts fail.

3
Save your changes and close the form.

Configure remote servers

4
Using an account with an assigned security scope of command role, choose Administration→Security→NFM-P Remote User Authentication from the NFM-P main menu. The Remote Authentication Manager (Edit) form opens.

5
Configure the parameters.

6
Configure one or more RADIUS authentication servers, as required.
1. Click on the RADIUS tab and click Create. The SAM RADIUS Authentication Server (Create) form opens.
2. Configure the required parameters.
3. Save your changes.

7
Configure one or more TACACS+ authentication servers, as required.
1. Click on the TACACS tab and click Create. The SAM TACACS+ Authentication Server (Create) form opens.
2. Configure the required parameters.
3. Save your changes.
Configure one or more LDAP authentication servers, as required.

1. Click on the LDAP tab and click Create. The LDAP Authentication Server (Create) form opens.

2. Configure the general parameters.

   **Note:** The ID value that you specify defines the server priority. For example, if multiple servers are specified, the NFM-P attempts user authentication using the server that has the lowest ID value first. If the server is unavailable, the NFM-P attempts to connect to the other specified servers, in sequence, by ID.

3. Configure the parameters in the Lookup Credentials panel, if the LDAP server does not allow anonymous lookups.

   The Bind DN parameter specifies the LDAP attribute set that identifies a user who is authorized to perform LDAP lookups; the Bind DN password is the password of the user.

4. Configure the parameters in the User Lookup Settings panel.

   The Base DN parameter specifies the LDAP context for username and password lookup; for example, ou=People,dc=MyCompany,dc=org.

   The Base Filter parameter specifies a filter for the username query. The parameter format is the following:

   ```plaintext
   (attribute={USERNAME})
   ```

   where

   - **attribute** is the LDAP attribute that contains the username

   The NFM-P replaces {USERNAME} with the username provided during a login attempt; for example, (cn={USERNAME}) maps the "cn" LDAP attribute to the username.

5. If the LDAP server has user role information and is to provide the name of a user group, configure the parameters in the Group Lookup Settings panel.

   **Note:** The user group name that an LDAP server provides must match the name of a valid NFM-P user group; otherwise, an authenticated user is assigned to the default external user group.

   The Group DN parameter specifies the LDAP context for group lookup; for example: ou=Roles,dc=MyCompany,dc=org

   The Group Filter parameter format is one of the following:

   - **simple; the NFM-P replaces {1} with the DN of the user LDAP record**
     ```plaintext
     (attribute={1})
     ```

     where **attribute** is the LDAP attribute that contains the DN

   - **compound; the NFM-P replaces {USERNAME} with the username provided during a login attempt**
     ```plaintext
     (&(any_attribute=string)(user_attribute={USERNAME}))
     ```

     where

     - **any_attribute** is an LDAP attribute
     - **string** is the attribute value to match
     - **user_attribute** is the LDAP attribute that contains the username
The Attribute ID parameter specifies one of the following:
- the LDAP attribute name that maps to an NFM-P group name
- the DN of the query context, if the Attribute is DN? parameter is selected; the “name” attribute in the record maps to an NFM-P group name

6. Save your changes.


END OF STEPS

3.44 To change the NFM-P Task Manager settings

Note: The Task Manager is operational with the default values.

3.44.1 Steps

1. Log in to the primary or standalone main server station as the nsp user.

2. Open a console window.

3. Navigate to the /opt/nsp/nfmp/server/nms/config directory.

4. CAUTION

Service Disruption

Contact technical support before you attempt to modify the nms-server.xml file.

Modifying the nms-server.xml file can have serious consequences that can include service disruption.

Open the nms-server.xml file using a plain-text editor such as vi.

5. Find and configure the required parameters:
   - maxNumRetainedTasks
   - numTasksToPurgeWhenFull
   - successfulTasksPurgeInterval
   - failedTasksPurgeInterval
6. Save and close the nms-server.xml file.

7. Navigate to the /opt/nsp/nfmp/server/nms/bin directory.

8. Enter the following to restart the main server:
   
   ```bash
   bash$ ./nmsserver.bash force_restart
   ```

   The main server restarts, and the configuration change takes effect.

9. Modify the client configuration, if required.
   1. Log in to an NFM-P single-user client or client delegate server station.
      
      **Note:** If you log in to a RHEL client delegate server station, you must log in as the nsp user.
      
      **Note:** If you log in to a single-user client station, you must log in as the user who installed the client, or as a local administrator.
   2. Open a console window.
   3. Navigate to the client configuration directory, typically /opt/nsp/client/nms/config on RHEL, and C:\nsp\client\nms\config on Windows.
   4. Open the nms-client.xml file using a text editor.
   5. Configure the autoRefreshInterval parameter.
   7. Repeat **Step 7** and **Step 8** to restart the main server.

10. Close the console windows and form. See the *NSP NFM-P User Guide* for information about using the NFM-PTask Manager.

**END OF STEPS**

### 3.45 To export all workspaces and local tab preferences

#### 3.45.1 Steps


2. Click Settings and choose Export All. The Export Directory window opens.
Specify the export directory, or create a directory or folder, and click Save. All the workspaces and local tab preferences are exported to the specified directory. If the directory exists, a dialog box appears.

Click Yes to overwrite all the workspaces and local tab preferences saved in the existing directory.

Close the form.

END OF STEPS

3.46 To import workspaces and local tab preferences

3.46.1 Steps

1 Choose Administration→Security→NFM-P User Security from the NFM-P main menu. The NFM-P User Security - Security Management (Edit) form opens.

2 Click Settings and choose Import. The Import Directory window opens.

3 Click on the drop-down menu and choose one of the following:
   a. Import All (default)—to import all the workspaces and local tab preferences.
      If you choose this option, you can click on the Overwrite Existing Workspace(s) check box to allow overwriting of existing workspaces.
   b. Import Workspaces Only—to import only workspaces from the specified directory.
      If you choose this option, you can click on the Overwrite Existing Workspace(s) check box to allow overwriting of existing workspaces.
   c. Import Tabs Only—to import only local tab preferences from the specified directory.

4 Click Open. A confirmation dialog box displays the number of workspaces and local tab preferences that will be imported from the specified directory.

5 Click Yes.
All users whose local tab preferences change and currently have a client session open, other than the client session where the import has been initiated, receive a message to inform them of the local tab preference change and that they must restart the client, or risk losing the changes.

The user can use the Reply function to reply to the message.

For all users who have their current workspace changed and currently have a client session opened, the workspace selector displays Workspace Out of Sync. Select the current workspace from the workspace selector drop-down menu to apply the modified settings.

6. Close the form.

END OF STEPS
NFM-P user security
NFM-P user security procedures
To import workspaces and local tab preferences
4 NE user and device security

NE user and device security

4.1 Overview

4.1.1 Access management

**CAUTION**

Service Disruption

*The NFM-P cannot obtain a secret value from an NE during resynchronization. It is recommended that you use only the NFM-P to configure a shared authentication secret.*

*Do not configure a shared authentication secret directly on a managed NE using another interface, for example, a CLI, or the NFM-P cannot synchronize the security policy with the NE.*

You can use the NFM-P to configure security for managed-device access that includes the following:

* device user accounts, profiles, and passwords
* RADIUS, TACACS+, and LDAP authentication for NFM-P user accounts
* MAFs
* CPM filters
* DoS protection
* DDoS protection
* X.509 authentication

4.1.2 General rules

An NFM-P site user profile specifies which CLI commands or command groups are permitted or denied on a managed device. A profile can be associated with multiple NFM-P user accounts, and each user account can have up to eight associated profiles.

The following general rules apply to NFM-P security management for devices.

* The authentication settings on a device override any settings distributed by the NFM-P. For example, if you use the NFM-P to configure a user account with SHA authentication, and then distribute the account to a device that uses MD5 authentication, the account authentication type changes to MD5.
* MAFs and CPM filters must be manually distributed to a managed device.
* An operator can limit the type of managed device access per user, for example, allowing FTP access, but denying console, Telnet, and SNMP access.
* A user profile is independent of a user account, and is not in effect until associated with a user account.
4.2 RADIUS, TACACS+, and LDAP

4.2.1 Overview

RADIUS is an access server AAA protocol. The protocol provides a standardized method of exchanging information between a RADIUS client, which is located on a device and managed by the NFM-P, and a RADIUS server, which is located externally from the device and the NFM-P.

RADIUS provides an extra layer of login security. The RADIUS client relays user account information to the RADIUS server, which authenticates the user and returns user privilege information. The information defines the device access of the user. For example, a user may not be allowed to FTP information to or from the device.

You can create device user accounts as a backup to RADIUS, TACACS+, or LDAP authentication. In the event that a RADIUS, TACACS+, or LDAP function fails, the device user account provides device access.

TACACS+ and LDAP provide functions that are similar to RADIUS functions.

Note: The NFM-P checks for reachability to a TACACS+ server using UDP port 49 to prevent long timeout issues. However, all subsequent communication with the server uses TCP port 49.

See the appropriate RADIUS, TACACS+, or LDAP documentation for information about authentication server installation, configuration, and management.

For TACACS+ users, you can specify the following in a user template that is read by the global TACACS+ policy:

- the type of permitted device access, for example, console, FTP, or both
- a home directory
- a login script to execute

4.2.2 Combined local and remote authentication

An organization may have an established TACACS+ or RADIUS authentication configuration. You can add NFM-P client GUI user accounts to an existing TACACS+ or RADIUS user base for local NFM-P authentication.

Consider the following:

- You can create an NFM-P user account that matches a TACACS+, RADIUS, or LDAP user account. For example, if the RADIUS user account is Jane, you can create an NFM-P user Jane.
- An NFM-P user name can be 1 to 80 characters, which is flexible enough to match most remote authentication user accounts.
- An NFM-P user that is authenticated remotely can log in to the NFM-P using the RADIUS, TACACS+, or LDAP password.
- For local NFM-P user authentication, the account password must meet the NFM-P password requirements.

For example, for a user called Jane:

- The RADIUS user name is Jane, and the password is accessforjane.
• The NFM-P user name is Jane and password is !LetJane1In.

When Jane is authenticated by RADIUS, she can log in to the NFM-P client by typing in Jane and access for Jane. If the RADIUS server was down, and she could not be authenticated remotely, to be authenticated locally Jane must log in to the NFM-P client by typing jane and !LetJane1In.

4.3 CPM filters and traffic management

4.3.1 Overview

Device CPMs provide dedicated traffic management and queuing hardware to protect the control plane. You can use CPM filters to specify which types of traffic to accept or deny, and to allocate and rate-limit the shaping queues for traffic directed to the CPMs.

**Note:** The 7705 SAR does not support Queue filters or MAC CPM IP filters.

There is no partial distribution of CPM IP filter policies to a 7705 SAR. When you distribute a CPM IP Filter policy to a 7705 SAR, every entry, property, and value in the policy must be supported by the NE, or the policy distribution to the 7705 SAR is blocked.

4.3.2 Supported management functions

The NFM-P supports the following CPM traffic management functions:

• traffic classification using CPM filters
  - Packets going to the CPM are first classified by the IOM into forwarding classes before recognition by the CPM hardware. You can use CPM filters to further classify the packets using L3/L4 information, for example, destination IP, DSCP value, and TCP SYN/ACK.

• queue allocation
  - Queues 1 — 8 are the default queues. They cannot be modified or deleted. Unclassified traffic is directed to the default queues.
  - Queues 9 — 32 are reserved for future use.
  - Queues 33 — 2000 are available for allocation.
  - Queues 2001 — 8000 are used for per-peer queuing.

• queue configuration
  - PIR
  - CIR
  - CBS
  - MBS
4.4 DoS protection

4.4.1 Overview

The NFM-P supports the use of DoS protection on network and access interfaces. To protect NEs from the high incoming packet rates that characterize DoS attacks, you can use the NFM-P to configure DoS protection for the following scenarios:

- the arrival of unprovisioned link-layer protocol packets that are received from CE devices in the core network
- the arrival of excessive subscriber control-plane packets on L2 or L3 access interfaces in aggregation networks
- the arrival of excessive Ethernet CFM frames on L2 and L3 access interfaces, SAPs, and SDP bindings, based on a combination of CFM OpCode and MEG-level values

DoS protection limits the number of packets that are received each second, and optionally logs a violation notification if a policy limit is exceeded. You can use the NE System Security form to view the violations for a specific NE.

4.4.2 DoS protection in the core network

DoS protection in the core network limits the number of link-layer protocol packets that each network interface on an NE accepts for protocols that are not enabled on the interface. The interface drops the excessive packets before they are queued or processed by the CPU.

You can configure global DoS protection on an NE using the NE System Security form. DoS protection controls the following for unprovisioned link-layer protocols:

- the packet arrival rate per source on each network interface
- the overall packet arrival rate per source on the NE
- whether an NE sends a notification trap if a policy limit is exceeded

An NE that supports DoS protection automatically applies default DoS protection parameters to each network and access interface. These defaults limit only the overall packet arrival rate and apply to all of the interfaces on the NE.

4.4.3 DoS protection policies in aggregation networks

In a subscriber aggregation network, an NE typically receives few control-plane packets from a specific subscriber. If one or more subscribers generate excessive control-plane traffic, DoS protection policies can help to ensure that NEs do not become overburdened by these unwanted packets.

You can configure DoS protection policies to control the following on network interfaces, VPLS L2 access interfaces, and IES and VPRN L3 access interfaces:

- the control-plane packet arrival rate per subscriber host
- the overall control-plane packet arrival rate for the interface
- whether an NE sends a notification trap if a policy limit is exceeded
An NE that supports DoS protection automatically assigns a default DoS protection policy to each network and access interface. This default policy limits only the overall packet arrival rate for the interface, and cannot be deleted or modified.

See 4.10 “To configure an NE DoS protection policy” (p. 96) for information about creating or modifying a DoS protection policy and assigning the policy to one or more NEs. See the appropriate service chapter for information about applying DoS protection policies to interfaces.

### 4.5 DDoS protection

#### 4.5.1 Overview

DDoS protection extends DoS protection by controlling traffic destined for IOM or CPM CPUs on a per-SAP, per-protocol basis. A DDoS protection policy isolates protocols from each other and, at the same time, isolates subscribers so that attacks or misconfigurations affect only the source SAP or protocol.

Policers are used to enforce a traffic rate-limiting function. Rate limiting is configurable in packets per second or kb/s. Configurable burst tolerance allows extra full handshake attempts, as required by some protocols.

When a policer determines that a packet is non-conformant, it discards the packet or marks it as low-priority. Low-priority traffic is more likely to be discarded at a downstream queuing point if there is protocol congestion. Traffic marking is also useful for routing protocols, where an operator may need to offer all packets to the CPU, and only discard packets if the CPU cannot keep up. A policer can be mapped to one or more traffic protocols.

The following types of policer can be configured in a DDoS protection policy:

- static policers, which permanently instantiate enforcement policers on SAPs
- local monitoring policers, which dynamically instantiate enforcement policers on SAPs

A DDoS protection policy can be applied to a capture SAP or to an MSAP. A DDoS protection policy that is assigned to a capture SAP typically has higher traffic rate limiting values than a policy that is assigned to an MSAP.

A DDoS protection policy can be applied to the following objects:

- base router network interface other than a system or loopback interface
- VPRN network interface a loopback interface
- VPRN L3 access interface
- VPRN group interface SAP
- IES L3 access interface
- IES group interface SAP
- VPLS L2 access interface
- I-VPLS I-L2 access interface
- MVPLS L2 access interface
- I-MVPLS I-L2 access interface
- VLL E-Pipe L2 access interface
• VLL I-Pipe L2 access interface

4.5.2 DDoS alarm handling

The alarm messages generated by DDoS protection policies are presented in a unique manner. Instead of a new alarm message being generated in the Alarm Window every time a DDoS alarm event occurs for a given object, a single alarm message is generated and updated periodically as the object generates new DDoS alarm events. If an Alarm Information window is opened for an alarm message, the Additional Text field displays the updated alarm information.

The operator can view dynamically updated alarm information, and avoid the generation of excessive numbers of individual DDoS alarm messages. Figure 4-1, “Static policer alarm message sequence” (p. 87) shows the alarm message sequence for a static policer. Figure 4-2, “Local monitoring policer alarm message sequence” (p. 88) shows the alarm message sequence for local monitoring policer. Figure 4-3, “Dynamic policer alarm message sequence” (p. 89) shows the alarm sequence for a dynamic policer. In each sequence, the alarm clears when the policer returns to the Conform state.

Figure 4-1 Static policer alarm message sequence

![Static policer alarm message sequence diagram]

Figure 4-2 Local monitoring policer alarm message sequence

![Local monitoring policer alarm message sequence diagram]
4.6 IP security

4.6.1 Overview

The NFM-P supports the IPsec MDA, which provides IP security support including tunneling and encryption functions. See the device security documentation for more information about configuring IP security.
NE user and device security procedures

4.7 Workflow to manage NE user and device security

4.7.1 Process

1. Specify the type of authentication keys used on the device; for example, SHA or MD5, as part of the device discovery. See “To commission a device for NFM-P management” in the NSP NFM-P User Guide for more information.

2. As required, create and manage NFM-P user profiles and accounts. See Chapter 3, “NFM-P user security”.

3. Create a MAF for each device; see 4.8 “To configure a MAF” (p. 92).

4. Create filter policies for device CPM modules; see 4.9 “To configure a CPM filter” (p. 93).

5. Create NE DoS protection policies, as required to control the amount of subscriber-based control-plane traffic that the NE interfaces receive; see 4.10 “To configure an NE DoS protection policy” (p. 96).

6. View NE DoS protection violations, as required; see 4.11 “To view NE DoS protection violations” (p. 97).

7. Create NE DDoS protection policies, as required to isolate protocols from each other and isolate subscribers so that attacks or misconfigurations affect only the source SAP or protocol; see 4.12 “To configure an NE DDoS protection policy” (p. 98).

8. Configure NE TLS Authentication, as required; see 4.13 “To configure NE TLS authentication” (p. 100).

9. Create site user profiles based on job classifications and the access needed to the managed devices; see 4.14 “To configure a site user profile” (p. 101).
Create individual site user accounts based on the configured profiles; see 4.15 “To configure a user account on a managed device” (p. 102).

Specify password policies for access to managed devices and users; see 4.16 “To configure an NE password policy” (p. 104).

Create RADIUS, TACACS+, or LDAP access or security policies for user authentication on the managed device; see 4.17 “To configure an LDAP site authentication policy” (p. 105), 4.18 “To configure an NE RADIUS authentication policy” (p. 106), 4.19 “To configure an NE TACACS+ authentication policy” (p. 107), or 4.20 “To configure an OmniSwitch RADIUS, TACACS+, or LDAP security authentication policy” (p. 108).

View or configure the system security settings on managed NEs; see 4.21 “To configure device system security settings” (p. 109).

As required, configure X.509 authentication or a PKI certificate authority profile; see 4.22 “To configure and manage PKI site security on an NE” (p. 112) or 4.23 “To configure a PKI certificate authority profile” (p. 115).

Perform PKI CMPv2 actions, as required, to obtain or assign keys from a CA; see 4.25 “To perform CMPv2 actions” (p. 116).

Perform the following NE system security tasks, as required:

a. Delete security policies; see 4.26 “To delete a security policy” (p. 119).

b. Unlock user accounts that are locked due to failed login attempts; see 4.27 “To manually unlock a user account” (p. 120).

c. Clear the password history for a user on a managed object; see 4.28 “To clear the password history of a user on a managed device” (p. 121).

d. Perform CPMv2 certificate administration actions; see 4.25 “To perform CMPv2 actions” (p. 116).

e. Clear collected statistics information on a CPM filter; see 4.29 “To clear collected statistics on a CPM filter” (p. 122).

f. Clear OCSP cache entries on an NE; see 4.30 “To manage OCSP cache entries on an NE” (p. 123).
4.8 To configure a MAF

Note: To perform this procedure, you require an account with an assigned administrator scope of command role to the sitesec package, or a scope of command role with write access permission to the sitesec package.

4.8.1 Steps

1. Choose Administration→Security→NE Management Access Filters from the NFM-P main menu. The NE Management Access Filter form opens.

2. Click Create or choose a policy and click Properties. The Site Management Access Filter (Create|Edit) form opens.

3. Configure the general parameters.

4. Configure the required parameters in the IPv4, IPv6, and MAC panels.

5. CAUTION

Service Disruption

When you set the Action parameter to deny, you cannot distribute the MAF to an NE.

You must set the parameter to permit, manually distribute the MAF as required, and then set the parameter to deny in each local MAF instance.

To configure an IPv4 or IPv6 entry, perform the following steps.

1. Click on the IPv4 Entries or IPv6 Entries tab.

2. Click Create or choose an entry and click Properties. The Site MAF Match Entry (Create|Edit) form opens.

3. Configure the required parameters.

4. Save your changes and close the form.

6. Repeat Step 5 to configure an additional IPv4 or IPv6 entry, if required.

7. To configure a MAC entry, perform the following steps.
1. Click on the MAC Entries tab.
2. Click Create or choose an entry and click Properties. The Site MAC Match Entry (Create|Edit) form opens.
3. Configure the required parameters.
4. Click on the Filter Properties tab and configure the required parameters.
   - If you set the Frame Type parameter to e802dot2LLC, configure the parameters in the Match Criteria - DSAP SSAP panel.
   - If you set the Frame Type parameter to e802dot2SNAP, configure the parameters in the Match Criteria - SNAP panel.
   - If you set the Frame Type parameter to Ethernet II, configure the Ether Type parameter.
5. Save your changes and close the form.

8
Repeat  Step 7 to configure an additional MAC entry, if required.

9
Click Apply to save the changes.

10
Distribute the MAF to NEs, as required.

11
Close the open forms.

END OF STEPS

4.9 To configure a CPM filter

Note: To perform this procedure, you require an account with an assigned administrator scope of command role to the sitesec package, or a scope of command role with write access permission to the sitesec package.

The 7705 SAR does not support queue or MAC CPM filters.

4.9.1 Steps

1
Choose Administration→Security→NE CPM Filter from the NFM-P main menu. The NE CPM Filter form opens.

2
Click Create or choose a policy and click Properties. The CPM Filter (Create|Edit) form opens.

3
Configure the required parameters.

4

To configure an IPv4 filter entry, perform the following steps.
1. Click on the IPv4 Entries tab.
2. Click Create or choose an entry and click Properties. The CPM IP Filter Entry (Create|Edit) form opens.
3. Configure the required parameters.
4. Click Select to assign a Log ID to the CPM filter entry.
   See the NSP NFM-P User Guide for information on configuring a Filter Log policy that employs this Log ID.
5. Click on the Filter Properties tab.
6. Configure the required parameters.
7. Save your changes and close the form.

5

Repeat Step 4 to configure an additional IPv4 entry, if required.

6

To configure an IPv6 filter entry, perform the following steps.
1. Click on the IPv6 Entries tab.
2. Click Create or choose an entry and click Properties. The CPM IPv6 Filter Entry (Create|Edit) form opens.
3. Configure the required parameters.
4. Click Select to assign a Log ID to the CPM filter entry.
   See the NSP NFM-P User Guide for information on configuring a Filter Log policy that employs this Log ID.
5. Click on the Filter Properties tab.
6. Configure the required parameters.
7. Save your changes and close the form.

7

Repeat Step 6 to configure an additional IPv6 entry, if required.

8

To configure a MAC entry, perform the following steps.
1. Click Create or choose an entry and click Properties. The CPM MAC Filter Entry (Create|Edit) form opens.
2. Configure the required parameters.
3. Click Select to assign a Log ID to the CPM filter entry.
See the NFM-P User Guide for information on configuring a Filter Log policy that employs this Log ID.

4. Click on the Filter Properties tab and configure the required parameters.
   - If you set the Frame Type parameter to e802dot2LLC, configure the parameters in the Match Criteria - DSAP SSAP panel.
   - If you set the Frame Type parameter to e802dot2SNAP, configure the parameters in the Match Criteria - SNAP panel.
   - If you set the Frame Type parameter to Ethernet II, configure the Ether Type parameter.

5. Save your changes and close the form.

9 Repeat Step 8 to configure an additional MAC entry, if required.

10 To configure a queue entry, perform the following steps.
    1. Click on the Queues tab.
    2. Click Create or choose an entry and click Properties. The CPM Filter Queue Entry (Create|Edit) form opens.
    3. Configure the required parameters.
    4. Click on the CIR/PIR and Burst Size tab and configure the required parameters.
       Ensure that the Committed Burst Size (KB) parameter value is lower than the Maximum Burst Size (KB) parameter value.
    5. Save your changes and close the form.

11 Repeat Step 10 to configure an additional queue entry, if required.

12 Click Apply to save the changes.

13 Distribute the filter to NEs, as required.

14 Close the open forms.

END OF STEPS
4.10 To configure an NE DoS protection policy

Note: To perform this procedure, you require an account with an assigned administrator scope of command role to the sitesec package, or a scope of command role with write access permission to the sitesec package.

4.10.1 Steps


2. Click Create or choose a policy and click Properties. The NE DoS Protection (Create|Edit) form opens.

3. Configure the required parameters.

4. Perform the following steps to configure CFM frame-rate limiting, if required.
   1. Click on the CFM Rate Limiting tab.
   2. Click Create. The CfmRateLimiting (Create) form opens.
   3. Configure the required parameters:
      Note: You must specify at least one Op Code value.
   5. Choose one or more Op Codes in the list and click OK.
   6. Save your changes and close the form.

5. Click Apply to save the changes.

6. Distribute the policy to NEs, as required.

7. Close the open forms.

END OF STEPS
4.11 To view NE DoS protection violations

4.11.1 Steps

1. Choose Administration→Security→NE System Security from the NFM-P main menu. The Select Site form opens.

2. Choose a managed device in the list and click OK. The NE System Security (Edit) form opens.

3. Click on the NE DoS Protection tab.

4. Perform one of the following to view a specific violation type.
   a. Click on the Per MAC Source Violations tab to view a list of the violations associated with subscriber hosts according to MAC address.
   b. Click on the Per IP Source Violations tab to view a list of the violations associated with subscriber hosts according to IP address.
   c. Click on the Link Specific Port Violations tab to view a list of the violations at the port level. The following kinds of violations are listed:
      • violations that exceed the Link Rate Limit (pps) parameter value specified for the NE
      • violations that exceed the Port Overall Rate Limit (pps) parameter value specified for the NE.
   d. Click on the Network Interface Violations tab to view a list of the violations for network interfaces that exceed the Overall Rate Limit (pps) parameter value specified in an associated NE DoS protection policy.
   e. Click on the SAP Violations tab to view a list of the violations for SAPs that exceed the Overall Rate Limit (pps) parameter value specified in an associated NE DoS protection policy.
   f. Click on the Video Router Context Violations tab to view a list of violations for virtual routers exceeding the per source limit on the NE.
   g. Click on the Video Service Violations tab to view a list of violations for services exceeding the per source limit on the NE.

5. Repeat Step 4 as required to view another violation type.
4.12 To configure an NE DDoS protection policy

4.12.1 Steps


2. Click Create or choose a policy and click Properties. The DDoS Protection Policy (Create|Edit) form opens.

   Note: For SAPs and access/network interfaces, click Search to list the default NE DDoS protection policy types to apply Distributed CPU Protection (DCP). Select the appropriate access or network policy type and click Properties to modify the default policy if required.

3. Configure the required parameters.

4. To configure a static policer, perform the following steps.
   1. Click on the Static Policers tab.
   2. Click Create or choose an entry and click Properties. The Static Policer (Create|Edit) form opens.
   3. Configure the required parameters.
   4. If the Rate Type parameter is set to Kbps, configure the Rate Limit (Kb/s) and Buffer Space (Bytes) parameters in the Kbps panel. You can specify a default value for these parameters by selecting the Default check box.
   5. If the Rate Type parameter is set to Packets, configure the Rate Limit (packets), Time Limit (seconds), and Initial Delay (packets) parameters in the Packets panel. You can specify a default value for the Rate Limit (packets) parameter by selecting the Default check box.
   6. Configure the Exceed Action parameter. If you set this parameter to Discard or Low Priority, configure the Hold Down Duration (seconds) parameter.
   7. Click OK. The Static Policer form closes.

5. Repeat Step 4 to configure an additional static policer, if required.

Close the NE System Security (Edit) form.

END OF STEPS
To configure a local monitoring policer, perform the following steps.

1. Click on the Local Monitoring Policer tab.
2. Click Create or choose an entry and click Properties. The Local Monitoring Policer (Create|Edit) form opens.
3. Configure the required parameters.
4. If the Rate Type parameter is set to Kbps, configure the Rate Limit (Kb/s) and Buffer Space (Bytes) parameters in the Kbps panel. You can specify a default value for these parameters by selecting the Default check box.
5. If the Rate Type parameter is set to Packets, configure the Rate Limit (packets), Time Limit (seconds), and Initial Delay (packets) parameters in the Packets panel. You can specify a default value for the Rate Limit (packets) parameter by selecting the Default check box.
6. Configure the Exceed Action parameter.
7. Click OK. The Local Monitoring Policer form closes.

Repeat Step 6 to configure an additional local monitoring policer, if required.

To configure protocol mappings for static policers and local monitoring policers, perform the following steps.

1. Click on the Protocols tab.
2. Click Create or select an entry and click Properties. The Protocols (Create|Edit) form opens.
3. Configure the required parameters.
4. Select a policer in the Enforcement panel.
   
   **Note:** If the Type parameter is set to Static, you must choose a static policer. If the Type parameter is set to Dynamic, you must choose a local monitoring policer. However, if the Type parameter is set to Dynamic and the Local Monitoring Bypass parameter is enabled, you cannot specify a local monitoring policer.

5. If the Rate Type parameter is set to Kbps, configure the Rate Limit (Kb/s) and Buffer Space (Bytes) parameters in the Kbps panel. You can specify a default value for these parameters by selecting the Default check box.
6. If the Rate Type parameter is set to Packets, configure the Rate Limit (packets), Interval (seconds), and Initial Delay (packets) parameters in the Packets panel. You can specify a default value for the Rate Limit (packets) parameter by selecting the Default check box.
7. Configure the Exceed Action parameter. If you set this parameter to Discard or Low Priority, configure the Hold Down Duration (seconds) parameter.
8. Save your changes and close the form.

Repeat Step 8 to configure an additional protocol, if required.
To configure NE TLS authentication

4.13.1 Purpose

Use this procedure to administer TLS NE security for LDAP authentication. TLS authentication also enables PKI Certificate Authority Profiles for 7750 SR-c4 and 7950 XRS NEs. Other IPSec related features are not enabled on these NEs.

There are three parts to TLS support: the TLS Client Profile, Client Cipher List and TLS Trust Anchor Profile. The Trust Anchor, Cipher List and Client Profile are policies and behave like other policies in the NFM-P.

Before you can configure a Client Profile, a Client Cipher List and a Trust Anchor Profile must be configured. To configure a TLS Trust Anchor Profile, at least one PKI certificate authority profile must be configured; see 4.23 “To configure a PKI certificate authority profile” (p. 115).

4.13.2 Steps

1. Choose Administration→Security→NE TLS Authentication from the NFM-P main menu. The NE TLS Authentications form opens.

2. Perform the following to create a Client Cipher List:
   1. From the NE TLS Authentications form, choose Create→TLS Client Cipher List. The TLS Client Cipher List, Global Policy (Create) form opens.
   2. Enter a name for the Client Cipher List in the General tab.
   3. Choose the TLS Client Cipher List Param tab and configure the parameters to create up to eight entries in the cipher list.
   4. Click OK.
Perform the following to create a Trust Anchor:
1. From the NE TLS Authentications form, choose Create→TLS Trust Anchor Profile. The TLS Trust Anchor Profile, Global Policy (Create) form opens.
2. Enter a name for the TLS Trust Anchor Profile in the General tab.
3. Choose the TLS Trust Anchors tab and configure the parameters to add PKI certificate authority profiles to the list.
4. Click OK.

Perform the following to create a TLS Client Profile:
1. From the NE TLS Authentications form, choose Create→TLS Client Profile. The TLS Client Profile, Global Policy (Create) form opens.
2. Enter a name for the TLS Client Profile.
3. Choose the Cipher List and Trust Anchor Profile to use.
4. Configure the Administrative State parameter if needed.
5. Click OK.

END OF STEPS

4.14 To configure a site user profile

Note: To perform this procedure, you require an account with an assigned administrator scope of command role to the sitesec package, or a scope of command role with write access permission to the sitesec package.

4.14.1 Steps

1. Choose Administration→Security→NE User Profiles from the NFM-P main menu. The NE User Profiles form opens.

2. Click Create or choose a profile and click Properties. The Site User Profile (Create/Edit) form opens.

3. Configure the required parameters.

Note: You require LI user privileges to configure the LI Profile parameter.
Perform the following steps.
1. Click on the Entries tab.
2. Click Create or choose an entry and click Properties. The Site User Profile Match Entry (Create|Edit) form opens.
3. Configure the required parameters.
   The Match String parameter value is a CLI command prefix that defines the scope of the user profile. For example, when you set the match string to "config" and specify the deny action, the user profile cannot use any CLI commands that begin with the word "config".
4. Save your changes and close the form.

Repeat Step 4 to configure an additional match entry, if required.

Click Apply to save the changes.

Distribute the profile to NEs, as required.

Close the open forms.

4.15 To configure a user account on a managed device

Note: To perform this procedure, you require an account with an assigned administrator scope of command role to the sitesec package, or a scope of command role with write access permission to the sitesec package.

4.15.1 Steps

1. Choose Administration→Security→NE User Configuration from the NFM-P main menu. The NE User Configuration form opens.
2. Click Create or choose a user and click Properties. The NE User (Create|Edit) form opens.
3. Configure the required parameters.
Note: The SNMP option of the Access parameter is not valid for NEs that are managed using SNMPv2.

If the Console option of the Access parameter is selected, perform the following steps to specify one or more site user profiles for the user account.
1. Click on the Console Profiles tab.
2. Use the Select buttons to specify up to eight profiles

When an SNMPv3 user account and group exist on a managed device, you can configure the user authentication parameters. To configure the parameters, perform the following steps.

Note: If MD5 or SHA authentication and DES privacy is used, ensure that the keys are on the device and associated with the SNMPv3 user group.
1. Click on the SNMPv3 tab.
2. Configure the required parameters.

To specify an RSA key for use by SFTP on a 7750 SR MG, perform the following steps.

Note: Only the 7750 SR MG supports RSA key configuration.
1. Click on the RSA Key tab.
2. Click Create. The RSA Key (Create) form opens.
3. Configure the parameters.
4. Save your changes and close the form.

Click Apply to save the changes.

Distribute the account to NEs, as required.

Close the open forms.

END OF STEPS
4.16 To configure an NE password policy

4.16.1 When to use

Perform this procedure to configure NE password parameters such as length, special characters, maximum attempts, expiry conditions, lockout time, and other site password policy considerations.

Note: To perform this procedure, you require an account with an assigned administrator scope of command role to the sitesec package, or a scope of command role with write access permission to the sitesec package.

4.16.2 Steps

1. Choose Administration→Security→NE Password Policy from the NFM-P main menu. The NE Password Policy form opens.

2. Click Create or choose an entry and click Properties. The Site Password Policy (Create|Edit) form opens.

3. Configure the required parameters.

4. Specify the types and order of password authentication to be used to verify the user account password using the Authentication Order 1 through 3 parameters. Set the order from the most preferred authentication method to the least preferred.

5. Configure the password complexity rules using the parameters in the Complexity Rules panel.

6. Click Apply to save the changes.

7. Distribute the policy to NEs, as required.

8. Close the open forms.

END OF STEPS
4.17 To configure an LDAP site authentication policy

**Note:** Lightweight Directory Access Protocol (LDAP) is an authentication, authorization, and accounting (AAA) protocol. An LDAP AAA server stores and manages public keys. When a user needs to SSH to an NE SR-OS via a public key infrastructure, the SR NE obtains the key from the LDAP AAA server and authenticates the user with that key. An SR NE can only have one policy of this type.

### 4.17.1 Steps

1. Choose Administration→Security→NE LDAP Authentication from the NFM-P main menu. The NE LDAP Authentication form opens.

2. Click Create or choose an entry and click Properties. The Site LDAP Policy (Create|Edit) form opens.

3. Configure the required parameters.

4. Click on the Servers tab.

5. Perform the following steps to specify a LDAP server:
   1. Click Create or choose an entry and click Properties. The Site LDAP Server (Create | Edit) form opens.
   2. Configure the required parameters.

   **Note:**
   Refer to 4.13 “To configure NE TLS authentication” (p. 100) for information regarding creation of NE TLS profiles.

   3. Save your changes and close the form.

6. Click Apply to save the changes.

7. Distribute the policy to NEs, as required.
4.18 To configure an NE RADIUS authentication policy

**Note:** See the appropriate RADIUS documentation for information about configuring a RADIUS server.

4.18.1 Steps

1. Choose Administration→Security→NE RADIUS Authentication from the NFM-P main menu. The NE RADIUS Authentication form opens.

2. Click Create or choose an entry and click Properties. The Site RADIUS Policy (Create|Edit) form opens.

3. Configure the required parameters.

4. Click on the Servers tab.

5. Perform the following steps to specify a RADIUS server.
   1. Click Create or choose an entry and click Properties. The Site RADIUS Server (Create | Edit) form opens.
   2. Configure the required parameters.
   3. Save your changes and close the form.

6. Repeat Step 5 to specify an additional RADIUS server, if required.

**Note:** You can specify up to five RADIUS servers.

7. Click Apply to save the changes.

8. Distribute the policy to NEs, as required.

END OF STEPS
9 Close the open forms.

END OF STEPS

4.19 To configure an NE TACACS+ authentication policy

Note: See the appropriate TACACS+ documentation for more information about configuring TACACS+ servers.

4.19.1 Steps

1 Choose Administration→Security→NE TACACS+ Authentication from the NFM-P main menu. The NE TACACS+ Authentication form opens.

2 Click Create or choose an entry and click Properties. The Site TACACS+ Policy (Create|Edit) form opens.

3 Configure the required parameters. The Use Privilege Map parameter is configurable when the Enable Authorization parameter is set to true.

4 Click on the Privilege Level Map tab.

5 Click Create. The Privilege Level Map (Create) form opens.

6 Configure the Privilege Level parameter.

7 Choose a user profile.

8 Click on the Servers tab.

9 Perform the following steps to specify a TACACS+ server.
1. Click Create or choose an entry and click Properties. The Site TACACS+ Server (Create | Edit) form opens.
2. Configure the required parameters.
3. Save your changes and close the form.

10

Repeat Step 9 to specify an additional TACACS+ server, if required.

Note: You can specify up to five TACACS+ servers.

11

Click Apply to save the changes.

12

Distribute the policy to NEs, as required.

13

Close the open forms.

END OF STEPS

4.20 To configure an OmniSwitch RADIUS, TACACS+, or LDAP security authentication policy

4.20.1 Steps

1

Choose Administration→Security→NE AOS Security Authentication from the NFM-P main menu. The NE AOS Security Authentication form opens.

2

Click Create or choose an entry and click Properties. The Site AOS Security Policy (Create|Edit) form opens.

3

Configure the required parameters.

4

Click Apply to save the changes.

5

Distribute the policy to NEs, as required.
6

Close the open forms.

END OF STEPS

4.21 To configure device system security settings

4.21.1 Steps

1

Choose Administration→Security→NE System Security from the NFM-P main menu. The Select Site form opens.

2

Select a managed device and click OK. The NE System Security (Edit) form opens.

Note: Items that appear on the NE System Security (Edit) form are device-dependent. Not all configuration form tabs and parameters in this procedure apply to all devices.

3

To configure the FTP, Telnet, or SSH server parameters, click on the Servers Configuration tab.

Note: The 7705 SAR may become temporarily unreachable when enabling SSH and starting the SSH server on the device.

4

To configure allowed SSH ciphers, perform the following.
1. Click on the Servers Configuration tab, then on the SSH Cipher List tab.
2. Click Create in the Client tab. The SSH Client Cipher List (Create) form opens.
3. Configure the required parameters.
4. Save and close the form.
5. Click on the Server tab and click Create. The SSH Server Cipher List (Create) form opens.
6. Configure the required parameters.
7. Save and close the form.

5

To configure the CPM hardware queueing for BGP or T-LDP peers, click on the CPM Per-Peer-Queueing tab.

6

To configure user profiles, click on the System User Template tab. Otherwise, go to Step 19. The default System User radius_default and tacplus_default templates are listed.
7 Select the appropriate default template and click Properties. The System User Template (Edit) form opens.

8 Configure the required parameters.

9 If you intend to use the default Template Profile, go to Step 19.

10 Click Select in the Template Profile panel to choose a template profile.

11 If you choose the administrative template, go to Step 19.

12 Click Create. The Site User Profile (Create) form opens.

13 Configure the required parameters.

14 Click on the Entries tab.

15 Perform the following steps.

1. Click Create. The Site User Profile Match Entry (Create) form opens.

2. Configure the required parameters.

   The Match String parameter value is a CLI command prefix that defines the scope of the user profile. For example, when you set the match string to “config” and specify the deny action, the user profile cannot use any CLI commands that begin with the word “config”.

16 Repeat Step 15 to specify an additional match entry, if required.

17 Save your changes and close the form.

18 Close the System User Template (Edit) form.
To configure global DoS protection, click on the NE DoS Protection tab.

Configure the required parameters.

**Note:** PIM in an MVPN on the egress DR does not switch traffic from the (*,G) to the (S,G) tree if protocol protection is enabled, and if PIM is not enabled on the ingress network interface. Enable the Block PIM Tunneled parameter to enable extraction and processing of PIM packets that arrive from a tunnel, for example, an MPLS or GRE tunnel, on a network interface.

Click on the following child tabs, as required, to view the DoS violations.
- Per MAC Source Violations
- Per IP Source Violations
- Link Specific Port Violations
- Network Interface Violations
- SAP Violations
- SDP Violations
- Video Router Context Violations
- Video Service Violations

Click on the VPRN Network Exceptions tab to configure rate limits for VPRN network exceptions.

Configure the required parameters.

Save your changes and close the NE System Security (Edit) form.

Close the NE System Security form.

**END OF STEPS**
4.22 To configure and manage PKI site security on an NE

4.22.1 Purpose

Perform this procedure to create the required DSA or RSA keypair and CA request on an NE to enable PKI security between peers, and to manage keys, certificates, and CRLs.

PKI encryption is required for functions such as IPsec, which use X.509 certificate-based authentication. The following devices support PKI encryption:

- 7450 ESS
- 7705 SAR
- 7750 SR MG
- 7750 SR

Note: The displayed parameters vary depending on the NE type, release, and the settings of other parameters.

4.22.2 Steps

1. Choose Administration→Security→NE PKI Authentication→Site Public Key Infrastructure from the NFM-P main menu. The Select Site form opens.

2. Choose a managed NE and click OK. The Site Security Public Key Infrastructure (Edit) form opens.

3. Configure the required parameters.

4. Click Apply to save the changes.

5. Perform the following steps to generate a PKI keypair that is stored in a file on an NE compact flash drive.
   2. Configure the required parameters.
   3. Click Execute. The keypair is generated and stored.
   4. Close the form.
Perform the following steps to generate local PKCS#10 certificate request on a local compact flash drive.

2. Configure the required parameters.
3. Click Execute. The local request is generated.
4. Close the form.

If you want the certificate signed by a CA, FTP the request file to the CA and use the CA-signed certificate in the following steps.

Perform the following steps to convert the certificate file to the required format for the NE.

2. Configure the required parameters.
3. Click Execute. The file is imported.
4. Close the form.

To convert a certificate, keypair, or CRL file on the NE to another format, perform the following steps.

2. Configure the required parameters.
3. Click Execute. The file is exported.
4. Close the form.

To display the content of a certificate, keypair, or CRL file in plain text, perform the following steps.

2. Configure the required parameters.
   
   **Note:** If you are displaying key file content, only the Key Size and Key Type are displayed.
   
   **Note:** You must configure the Password parameter if the file uses PKCS#12 encryption.
3. Click Execute. The file content is displayed.
4. Close the form.
11
To reload a certificate or keypair file from a local compact flash drive, perform the following steps.
2. Configure the required parameters.
3. Click Execute. The file content is reloaded.
4. Close the form.

12
To clear the OCSP cache, perform the following steps.
2. Configure the required parameters.
3. Click Execute. The file content is reloaded.
4. Close the form.

13
To import a Secure ND RSA keypair, perform the following.
2. Configure the required parameters.
3. Click Execute. The keypair is imported.
4. Close the form.

14
To export the Secure ND RSA keypair, perform the following.
2. Click Execute. The keypair is exported.
3. Close the form.

15
To perform CMP2 actions, see 4.25 “To perform CMPv2 actions” (p. 116).

16
Close the Site Security Public Key Infrastructure (Edit) form.

End of steps
4.23  To configure a PKI certificate authority profile

4.23.1  Steps

**Note:** The displayed parameters vary depending on the NE type, release, and the settings of other parameters.

1. Choose Administration→Security→NE PKI Authentication→PKI Certificate Authority Profiles from the NFM-P main menu. The PKI Certificate Authority Profiles form opens.

2. Click Create. The Certificate Authority Profile (Create) form opens.

3. Configure the required parameters.

4. Click on the CMPv2 tab and configure the required parameters.

5. To create a CMP key, perform the following steps.

   **Note:** A key that is created locally on an NE, for example, using a CLI, is not sent to the NFM-P, and is displayed on the Certificate Authority Profile form as N/A. Any N/A keys on an NE must be deleted before the profile can be distributed to the NE.
   1. Click Create. The CMP Key List (Create) form opens.
   2. Configure the parameters.
   3. Save your changes and close the form.

6. To configure automatic CRL file download, perform the following.
   1. Click on the Auto CRL Update tab and click Create. The Auto CRL Update form opens.
   2. Configure the required parameters.
   3. To specify a URL for the CRL file, click on the Create button in the URL entries panel and configure the parameters in the CRL URL Entry form. See 4.24 “To create a file transmission profile” (p. 116) for information about creating a file transmission profile to use with the CRL URL entry.
   4. Save your changes and close the form.

7. Click Apply to save your changes.
8 Distribute the policy to NEs, as required.

9 Close the open forms.

4.24 To create a file transmission profile

4.24.1 Purpose
Follow this procedure to create a file transmission profile for use with a CRL URL entry when configuring a PKI certificate authority profile to use automatic CRL file download.

4.24.2 Steps

1 Choose Policies→ISA Policies→File Transmission Profile from the NFM-P main menu. The File Transmission Profile form opens.

2 Configure the required parameters.

3 Save your changes and close the form.

4.25 To perform CMPv2 actions

4.25.1 Purpose
CMP is a protocol that runs between a Certification Authority, or CA, and an end entity to provide certificate management functions over HTTP.

4.25.2 Steps

1 Choose Administration→Security→NE PKI Authentication→Site Public Key Infrastructure from the NFM-P main menu. The Select Site form opens.

2 Choose an NE in the list and click OK. The Site Security Public Key Infrastructure (Edit) form opens.

Perform one of the following to configure the CA Profile Name parameter.
- Select a CA profile.
- Enter the profile name.

**CMPv2 actions**

Select a CMPv2 action from the drop-down menu beside the Type parameter in the Action panel. The following table lists the available CMPv2 actions. You can view the status of the last CMPv2 action performed on this site in the Last Action Status panel.

<table>
<thead>
<tr>
<th>Action</th>
<th>See step</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;Initial Registration&quot; (p. 117)</td>
<td>Step 6</td>
</tr>
<tr>
<td>&quot;Certificate Request&quot; (p. 118)</td>
<td>Step 10</td>
</tr>
<tr>
<td>&quot;Key Update&quot; (p. 118)</td>
<td>Step 14</td>
</tr>
<tr>
<td>&quot;Poll&quot; (p. 118)</td>
<td>Step 18</td>
</tr>
<tr>
<td>&quot;Clear Request&quot; (p. 119)</td>
<td>Step 20</td>
</tr>
<tr>
<td>&quot;Abort Request&quot; (p. 119)</td>
<td>Step 22</td>
</tr>
<tr>
<td>&quot;Manually Update CRL files&quot; (p. 119)</td>
<td>Step 24</td>
</tr>
</tbody>
</table>

**Initial Registration**

Configure the required parameters in the Action panel.

Perform one of the following:
- To perform an initial registration using a password, configure the required parameters in the Protection Algorithm - using Password panel.
- To perform an initial registration using a certificate, configure the required parameters in the Protection Algorithm - using Certificate panel.

Click Apply to perform the action.
Certificate Request

10 Configure the required parameters in the Action panel.

11 Configure the required parameters in the Protection Algorithm - using Certificate panel.

12 Click Apply to perform the action.

Key Update

14 Configure the required parameters in the Action panel.

15 Configure the required parameters in the Protection Algorithm - using Certificate panel.

16 Click Apply to perform the action.

Poll

18 Click Apply to send the poll request.

19 Go to Step 26.
Clear Request

20 ____________________________________________________________________________
Click Apply to send the clear request.

21 ____________________________________________________________________________  
Go to  Step 26  .

Abort Request

22 ____________________________________________________________________________
Click Apply to send the abort request.

23 ____________________________________________________________________________  
Go to  Step 26  .

Manually Update CRL files

24 ____________________________________________________________________________
Configure the Certificate Authority Profile parameter.

25 ____________________________________________________________________________  
Click on the Execute button to send the update request.

26 ____________________________________________________________________________  
Close the open forms.

END OF STEPS

4.26 To delete a security policy

Note: When you delete site management access filter policies in which the Action parameter is set to deny, ensure that you modify the policy to set the parameter to permit before it is deleted, otherwise, the NFM-P may be isolated.

You cannot remove a site management access filter if the filter administrative state is up and the default action of the filter is set to deny or deny host unreachable.

If you attempt to delete an OmniSwitch RADIUS or TACACS+ security policy that is applied to an authentication service, the NFM-P generates a deployment error. You must use the OmniSwitch CLI to delete the policy from the authentication service before you can delete the policy from the NFM-P.
4.26.1 Steps

1 Choose the appropriate policy from one of the following.
   a. The Administration→Security↛option NFM-P main menu
   b. The Policies→AAA Policies↛option NFM-P main menu
   The appropriate form opens.

2 Set the filter criteria, if applicable.

3 Click Search. A policy list opens.

4 Choose a policy from the list.

5 Click Delete.

6 Click Yes. The policy is deleted.

END OF STEPS

4.27 To manually unlock a user account

4.27.1 Steps

1 From the NFM-P main menu, choose Administration→Security→NE User Configuration. The NE User Configuration form opens.

2 Click Search. A list of user accounts appears.

3 Perform one of the following:
   a. To unlock an NFM-P user, choose a user and click Unlock User. The user account is unlocked.
b. To unlock the local definition of a user on an NE, perform the following steps.

Use this method to unlock a user account that is still within the lockout time period. The lockout time is set in 4.16 “To configure an NE password policy” (p. 104).

1. Choose a user account and click Properties. The NE User form opens.
2. Click on the Local Definitions tab.
3. Click Search. A list of NEs with local definitions for the user appears.
4. Choose an NE and click Unlock User. The user account on the selected NE is unlocked.
5. Close the NE User form.

4.28 To clear the password history of a user on a managed device

4.28.1 Steps

1. Choose Administration→Security→NE User Configuration from the NFM-P main menu. The NE User Configuration form opens.

2. Configure the filters and click Search. A list of configured users appears.

3. Select a user and click Properties. The NE User (Edit) form opens.

4. Click on the Local Definitions tab. A list of sites with local definitions for the selected user appears.

5. Select one or more sites and click Clear Password History. A dialog box appears.

6. Click Yes to confirm the operation. The password history for the selected user at the specified sites is cleared.
Click OK. The NE User (Edit) form closes.

**END OF STEPS**

### 4.29 To clear collected statistics on a CPM filter

**4.29.1 Steps**

1. From the NFM-P main menu, choose Administration→Security→NE CPM Filter. The CPM Filter form appears.

2. Click Search. A list of CPM filters appears.

3. Choose a CPM filter and click Properties. The CPM Filter (Edit) form appears.

4. Click on the Local Definitions tab.

5. Configure the filters and click Search. A list of CPM filter local definitions appears.

6. Choose a local definition and click Properties. The CPM Filter Local Policy form appears.

7. Click on the IPv4 Entries, IPv6 Entries, MAC Entries or Queues tab, depending on the type of statistic you need to clear.

8. Configure the filters and click Search. A list of filter entries appears.

9. Perform one of the following:
   a. To clear specific entries, choose the entries you need to clear and click Clear Statistics on Entry.
   b. To clear all entries, choose an entry and click Clear Statistics on All Entries. This button is not available in the Queues tab.
To view the status of all clear requests, perform the following:
1. Click on the Clear Statistics Status tab.
2. Configure the filters, and click Search. A list of clear requests appears.
3. Choose a clear request and click Properties. The status of the clear request appears.

Close the CPM Filter Local Policy, CPM Filter (Edit) and CPM Filter forms.

**END OF STEPS**

### 4.30 To manage OCSP cache entries on an NE

#### 4.30.1 Steps

1. Choose Administration→Security→NE PKI Authentication→Site Public Key Infrastructure from the NFM-P main menu. The Select Site form opens.

2. Choose a managed device in the list and click OK. The Site Security Public Key Infrastructure (Edit) form opens.

3. Click on the OCSP Cache Entries tab.

4. Click Search. A list of OCSP cache entries for the site opens.

5. To clear cache entries, perform the following.
   2. Enter the Entry ID number of the cache entry you need to clear in the Entry ID parameter. To clear all entries, leave the parameter blank.
   3. Click Execute. The results of the clear operation appear in the results panel.

6. Click OK or Cancel. The Site Security Public Key Infrastructure (Edit) form closes.

**END OF STEPS**
To manage OCSP cache entries on an NE
5 TCP enhanced authentication

5.1 Overview

5.1.1 Purpose
This chapter describes TCP enhanced authentication keys

5.1.2 Contents

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>5.1 Overview</td>
<td>125</td>
</tr>
<tr>
<td>5.2 TCP enhanced authentication</td>
<td>125</td>
</tr>
<tr>
<td>5.3 Workflow to configure TCP enhanced authentication for NEs</td>
<td>127</td>
</tr>
<tr>
<td>5.4 To configure a global TCP key chain</td>
<td>127</td>
</tr>
<tr>
<td>5.5 To distribute global key chains to NEs</td>
<td>128</td>
</tr>
<tr>
<td>5.6 To verify the distribution of a global key chain to NEs</td>
<td>130</td>
</tr>
<tr>
<td>5.7 To identify differences between a global and local key chain policy or two local key chains</td>
<td>131</td>
</tr>
</tbody>
</table>

5.2 TCP enhanced authentication

5.2.1 Overview

CAUTION

Service Disruption

It is recommended that you use only the NFM-P to create keys and key chains. Do not create a key or key chain directly on a managed NE using another interface, for example, a CLI. The NFM-P cannot obtain a TCP key secret value from an NE during resynchronization, so it cannot specify the key for use on another NE.

If a local NE key chain and the associated global NFM-P key chain differ after a resynchronization, the NFM-P generates an alarm.

This chapter describes the NFM-P support of TCP enhanced authentication for NEs based on the MD5 encryption mechanism described in RFC2385. NFM-P TCP enhanced authentication allows the use of powerful algorithms for authenticating routing messages.

The NFM-P uses a TCP extension to enhance BGP and LDP security. TCP enhanced authentication is used for applications that require secure administrative access at both ends of a TCP connection. TCP peers update authentication keys during the lifetime of a connection.
An NFM-P operator with administrative privileges can create, delete, modify, and distribute TCP enhanced authentication components, and can perform an audit of a local key chain to compare it with the associated global key chain or other local key chains. The NFM-P TCP enhanced authentication components are called keys and key chains.

Global key chains are created in Draft mode. This allows operators to verify that the key chain is correctly configured before they distribute it to the network elements. When the key chain is approved for distribution, you can change the global key chain to Released mode, which also distributes the key chain to existing local definitions. The NFM-P saves the latest released version of the global key chain.

5.2.2 TCP keys and key chains

A key is a data structure that is used to authenticate TCP segments. One or more keys can be associated with a TCP connection. Each key contains an identifier, a shared secret, an algorithm identifier, and information that specifies when the key is valid for authenticating the inbound and outbound segments.

A key chain is a list of up to 64 keys that is associated with a TCP connection. Each key within a key chain contains an identifier that is unique within the key chain. You can use the NFM-P to distribute a global key chain to multiple NEs and assign a key to multiple BGP or LDP instances.

The NFM-P treats global and local key chain management as it does policy management; depending on the distribution mode configuration of a local key chain, when you modify a global key chain using the NFM-P, all local instances can be updated to ensure that all instances of the key chain in the network are synchronized. See “Policies overview” in the NSP NFM-P User Guide for information about global and local policy instances, policy distribution and distribution modes, and local policy audits.

When the NFM-P attempts to synchronize the keys in a global key chain with the keys on an NE, the NE does not return the secret key value. After a key chain is deployed to an NE, the shared secret and the encryption algorithm cannot be modified. You can delete a key chain or key only when it is not in use by a protocol.

You can specify whether an NE uses a TCP key for sending packets, receiving packets, or both. Using keys that are configured for both, or send-receive, is general good practice because communication between NEs cannot be affected by assigning the wrong key type.

There are two classes of TCP keys:
- Active
- Eligible

Active keys

A key set contains one active key. An active key is a key that TCP uses to generate authentication information for outbound segments. You cannot delete the active key in a keychain.

Eligible keys

Each set of keys, called a key chain, contains zero or more eligible keys. An eligible key is a key that TCP uses to authenticate inbound segments.
5.3 Workflow to configure TCP enhanced authentication for NEs

5.3.1 Process

1. Create a global key chain that contains at least one key; see 5.4 “To configure a global TCP key chain” (p. 126).

2. Distribute the key chain to the NEs; see 5.5 “To distribute global key chains to NEs” (p. 128).

3. Verify the distribution of a global key chain to the NEs; see 5.6 “To verify the distribution of a global key chain to NEs” (p. 130).

4. Assign the key chain to a routing protocol, such as BGP or LDP.

5. If required, identify the differences between a global and local policy or two local key chains; see 5.7 “To identify differences between a global and local key chain policy or two local key chains” (p. 131).

5.4 To configure a global TCP key chain

5.4.1 Steps

1. Choose Administration→Security→TCP KeyChains from the NFM-P main menu. The TCP KeyChains form opens.

2. Click Create or choose a key chain and click Properties. The KeyChain Create|Edit form opens.

3. Configure the required parameters.

4. Click on the KeyChain Key tab.

5. Click Create or choose a key chain key and click Properties. The KeyChain Key Create|Edit form opens.
6

CAUTION

Service Disruption

You must ensure bidirectional communication between NEs.

It is recommended that you choose the Send-receive option for the Key Direction parameter.

Configure the required parameters.

The End Time parameter is configurable only if the Key Direction parameter is set to Receive.

Note: The NFM-P generates a random default value for the Key parameter. For greater security, it is recommended that you accept this value rather than manually enter a value.

You cannot subsequently delete a TCP key chain or TCP key when the Admin State parameter for the key chain or key is set to In Service.

7

Save and close the forms.

END OF STEPS

5.5 To distribute global key chains to NEs

5.5.1 Purpose

Perform the following procedure to distribute one or more global TCP key chains to one or more NEs. When you distribute a global key chain, a local key chain using the Sync With Global distribution mode allows the NE to receive the key chain.

CAUTION

Service Disruption

Releasing, distributing, or deleting a TCP keychain or TCP key can be service-affecting.
Ensure that you understand the implications of these operations before you proceed.

5.5.2 Steps

1

Choose Administration→Security→TCP KeyChains from the NFM-P main menu. The TCP KeyChains form opens.

2

Verify that none of the key chains in the list that you want to distribute are in Draft configuration mode and go to Step 4. Otherwise go to Step 3.
WARNING

Equipment Damage

Verify the local definitions before releasing a global key chain.

When you release a global key chain, the key chain is distributed to existing local definitions.

When a key chain is in Draft configuration mode, the Distribute button is disabled and the key chain cannot be distributed to an NE. You must first release the key chain for distribution.

To release a key chain:
1. Select the key chain entry and click Properties. The Key Chain (Edit) form opens.
2. Click Switch Mode to acknowledge the Configuration Mode change. The Release form opens.
3. Select the required NEs for release by moving the appropriate row entries from the Available Objects panel to the Selected Objects panel.
   Refer to the Policies chapter in the NSP NFM-P User Guide for more information on policy distribution.
4. Click on the Distribute button to release the key chain locally to devices.
5. Click Close. The Release form closes and the configuration mode of the key chain is changed to Released.
6. Close the Key Chain (Edit) form.

To distribute a key chain:

Note: Local definitions of key chains that use the Local Edit Only distribution mode do not allow their NEs to receive the distribution of a global key chain. You must set the distribution mode of a local key chain to Sync With Global if you need the associated NE to receive the distribution of a global key chain.

1. Select one or more key chains and click Distribute. The Distribute - KeyChain form opens.
2. Select the required NEs by moving the appropriate row entries from the Available Objects panel to the Selected Objects panel.
3. Click Distribute. The NFM-P distributes the key chains to the NEs.

To configure the distribution mode of a local definition:
1. Click Switch Distribution Mode. The Switch Distribution Mode form opens.
2. Choose Sync With Global, Local Edit Only, or All from the drop-down menu. Only the sites that are configured with the selected distribution mode are listed.
3. Choose one or more entries in the Available Local Policies panel and click on the right arrow. The chosen entries move to the Selected Local Policies panel.

4. Depending on the current distribution mode of the chosen entries, perform one of the following:
   • Click Sync With Global.
   • Click Local Edit Only.
   The distribution mode of the selected entries changes accordingly.

5. Close the Distribution Mode form.

6. Close the TCP KeyChains form.

END OF STEPS

5.6 To verify the distribution of a global key chain to NEs

5.6.1 Steps

1. Choose Administration→Security→TCP KeyChains from the NFM-P main menu. The TCP KeyChains form opens.

2. Select a key chain and click Properties. The KeyChain (Edit) form opens.

3. Click on the Local Definitions tab. The NEs that have a local instance of the key chain are displayed in a list.

4. View the list of NEs to confirm that the key chain is distributed to the required NEs.

5. Close the forms.

END OF STEPS
5.7 To identify differences between a global and local key chain policy or two local key chains

5.7.1 Steps

1. Choose Administration→Security→TCP KeyChains from the NFM-P main menu. The TCP KeyChains form opens.

2. Choose Local from the Policy scope menu to select a local NE. The Select a Network Element form opens.

3. Select an NE and click OK. The NE IP address is displayed in the Local Node IP Address field.

4. Choose the local key chain that you need to compare with another key chain and click Properties. The KeyChain (Edit) form opens.

5. Click Local Audit On. The Local Audit form opens.

   Note: You can cancel the local audit at any time by clicking Local Audit Off on the KeyChain (Edit) form.

   The NFM-P does not identify differences between the Begin Time and End Time properties of key chains.

6. Perform one of the following from the Policy scope menu:
   a. Choose Global and go to Step 7.
   b. Choose Local to choose an NE. The Select a Network Element form opens.
      1. Select an NE and click OK. The NE IP address is displayed in the Local Node IP Address field.
      2. Go to Step 7.

7. Click OK. The Local Audit form closes and the appropriate global|local policy opens for comparison.

8. View the differences between the key chains by clicking on the tabs that are highlighted with an arrow icon to indicate that differences exist on the forms. An arrow icon beside a property
indicates that the property is modified. In lists, new entries are highlighted in pink and modified entries are highlighted in purple.

9

Close the forms.

END OF STEPS
Part III: NFM-P advanced configuration

Overview

Purpose

This part provides information about NFM-P components, database, and system redundancy.

Contents

| Chapter, NFM-P component configuration | 135 |
| Chapter 7, NFM-P database management  | 199 |
| Chapter 8, NFM-P system redundancy   | 227 |
6 NFM-P component configuration

6.1 Overview

6.1.1 Purpose
This chapter describes configuration and management procedures for NFM-P components.

6.1.2 Contents

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>6.1 Overview</td>
<td>135</td>
</tr>
<tr>
<td>NFM-P component configuration</td>
<td>137</td>
</tr>
<tr>
<td>6.2 Overview</td>
<td>137</td>
</tr>
<tr>
<td>6.3 Changing default text-field and ID ranges</td>
<td>137</td>
</tr>
<tr>
<td>6.4 NFM-P license management</td>
<td>142</td>
</tr>
<tr>
<td>6.5 Configuring Analytics functions</td>
<td>143</td>
</tr>
<tr>
<td>6.6 To create and manage custom auxiliary database table attributes</td>
<td>145</td>
</tr>
<tr>
<td>6.7 Workflow to configure NFM-P components</td>
<td>147</td>
</tr>
<tr>
<td>Software and license configuration procedures</td>
<td>150</td>
</tr>
<tr>
<td>6.8 To view the NFM-P license information</td>
<td>150</td>
</tr>
<tr>
<td>6.9 To export the NFM-P license information or create a license point inventory</td>
<td>151</td>
</tr>
<tr>
<td>6.10 To update the NFM-P license in a standalone deployment</td>
<td>151</td>
</tr>
<tr>
<td>6.11 To update the NFM-P license in a redundant deployment</td>
<td>152</td>
</tr>
<tr>
<td>6.12 To list the backed-up NFM-P license files</td>
<td>155</td>
</tr>
<tr>
<td>6.13 To change the default NFM-P license expiry notification date</td>
<td>156</td>
</tr>
<tr>
<td>System component configuration procedures</td>
<td>158</td>
</tr>
<tr>
<td>6.14 To modify the base configuration of all GUI clients</td>
<td>158</td>
</tr>
<tr>
<td>6.15 To configure the display of multiple NFM-P systems as client GUI login options</td>
<td>159</td>
</tr>
<tr>
<td>6.16 To change the default user file locations on a client delegate server</td>
<td>160</td>
</tr>
<tr>
<td>6.17 To change the IP address or hostname of an NFM-P system component</td>
<td>161</td>
</tr>
<tr>
<td>6.18 To enable main database backup file synchronization</td>
<td>162</td>
</tr>
</tbody>
</table>
6.19 To modify the default time period of statistics displayed by the Statistics Manager search filters

6.20 To modify the default time period of statistics displayed on object properties forms

6.21 To enable the preservation of the XML API statistics pool size

6.22 To configure auto-assigned service ID ranges and uniqueness checking

6.23 To create or configure a format policy

6.24 To create or configure a range policy

<table>
<thead>
<tr>
<th>Network management configuration procedures</th>
<th>174</th>
</tr>
</thead>
<tbody>
<tr>
<td>6.25 To configure automatic device configuration backup file removal</td>
<td>174</td>
</tr>
<tr>
<td>6.26 To enable alarm reporting to identify duplicate NE system IP addresses</td>
<td>175</td>
</tr>
<tr>
<td>6.27 To enable dynamic system IP address updates for 7705 SAR nodes</td>
<td>177</td>
</tr>
<tr>
<td>6.28 To enable LSP on-demand resynchronization</td>
<td>178</td>
</tr>
<tr>
<td>6.29 To enable debug configuration file reloading on an NE for mirror services</td>
<td>179</td>
</tr>
<tr>
<td>6.30 To configure throttle rates for subscriber trap events</td>
<td>181</td>
</tr>
<tr>
<td>6.31 To configure the windowing trap delay option for subscriber table resyncs</td>
<td>182</td>
</tr>
<tr>
<td>6.32 To create a default SNMPv2 OmniSwitch user</td>
<td>184</td>
</tr>
<tr>
<td>6.33 To enable telemetry reporting for a managed NE</td>
<td>185</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>System preferences configuration procedures</th>
<th>191</th>
</tr>
</thead>
<tbody>
<tr>
<td>6.34 To configure NFM-P system preferences</td>
<td>191</td>
</tr>
</tbody>
</table>
NFM-P component configuration

6.2 Overview

6.2.1 Post-installation system configuration

The NFM-P may require a configuration change to meet specific operational requirements. You can use the procedures in this chapter to configure system-wide NFM-P settings, functions, and preferences.

Note: You can use the NFM-P auto-client update function to reconfigure multiple GUI clients using one central configuration. See “Client deployment” in the NSP NFM-P Installation and Upgrade Guide for operational information about the function, and 6.14 “To modify the base configuration of all GUI clients” (p. 158) for information about using the function to update multiple clients.

6.3 Changing default text-field and ID ranges

6.3.1 Format and range policies overview

You can use NFM-P format policies and range policies to change the default number and format of characters used for text fields, and the ID ranges used for managed objects.

6.3.2 Format and range policies

Format policies manage how services, policies, LSPs, and L2 and L3 access interfaces are named and described. Range policies manage the ID values that are assigned to services, policies, LSPs, and L2 and L3 access interfaces. For example, you can configure the following:

- a range policy that specifies a range of 200 to 499 for service IDs
- a format policy that specifies a 15-character limit for service names

The object creation form indicates when a range or format policy is in effect for an object.

Format and range policies are not distributed to NEs. The format and range policies apply only to GUI creation of services, policies, LSPs, and L2 and L3 access interfaces. You cannot configure format and range policies when the services, LSPs, and L2 and L3 access interfaces are created using templates. However, the NFM-P allows an operator to use preconfigured examples of LSPs and services that have format and range policies applied to them. The examples can be used to create a template. For information about creating templates from a preconfigured example, see “Format and range policies configuration of services and LSPs using templates” in the NFM-P Scripts and Templates Developer Guide.

See 6.23 “To create or configure a format policy” (p. 170) for information about configuring a format policy.

See 6.24 “To create or configure a range policy” (p. 172) for information about configuring a range policy.

The following table lists the objects and associated parameters that can be managed using format and range policies.
### Table 6-1  Format and Range policy objects and associated parameters

<table>
<thead>
<tr>
<th>Object name</th>
<th>Format policy parameter</th>
<th>Range policy parameter</th>
</tr>
</thead>
<tbody>
<tr>
<td>B-VPLS Service Site</td>
<td>Description, Name</td>
<td>—</td>
</tr>
<tr>
<td>Bypass-only LSP</td>
<td>Description, Name</td>
<td>ID</td>
</tr>
<tr>
<td>Customer</td>
<td>—</td>
<td>ID</td>
</tr>
<tr>
<td>Dynamic LSP</td>
<td>Description, Name</td>
<td>ID</td>
</tr>
<tr>
<td>I-VPLS Service Site</td>
<td>Description, Name</td>
<td>—</td>
</tr>
<tr>
<td>IES Group Interface</td>
<td>Description, Name</td>
<td>Interface ID</td>
</tr>
<tr>
<td>IES L3 Access Interface</td>
<td>Description, Name</td>
<td>Interface ID, Outer Encapsulation Value</td>
</tr>
<tr>
<td>IES Service</td>
<td>Description, Service Name</td>
<td>Service ID</td>
</tr>
<tr>
<td>IES Service Access Point</td>
<td>Description, Name</td>
<td>Outer Encapsulation Value</td>
</tr>
<tr>
<td>IES Service Site</td>
<td>Description, Name</td>
<td>—</td>
</tr>
<tr>
<td>IES Subscriber Interface</td>
<td>Description, Name</td>
<td>Interface ID</td>
</tr>
<tr>
<td>IP Mirror Interface</td>
<td>—</td>
<td>Interface ID</td>
</tr>
<tr>
<td>MVPLS B-L2 Access Interface</td>
<td>Description</td>
<td>Outer Encapsulation Value</td>
</tr>
<tr>
<td>MVPLS I-L2 Access Interface</td>
<td>Description</td>
<td>Outer Encapsulation Value</td>
</tr>
<tr>
<td>MVPLS L2 Access Interface</td>
<td>Description</td>
<td>Outer Encapsulation Value</td>
</tr>
<tr>
<td>MVPLS Service</td>
<td>Description, Service Name</td>
<td>Service ID</td>
</tr>
<tr>
<td>Mirror L2 Access Interface</td>
<td>—</td>
<td>Outer Encapsulation Value</td>
</tr>
<tr>
<td>MVPLS Service B-Site</td>
<td>Description, Name</td>
<td>—</td>
</tr>
<tr>
<td>MVPLS Service I-Site</td>
<td>Description, Name</td>
<td>—</td>
</tr>
<tr>
<td>MVPLS Service Site</td>
<td>Description, Name</td>
<td>—</td>
</tr>
<tr>
<td>Mirror Service</td>
<td>Description, Service Name</td>
<td>Service ID</td>
</tr>
<tr>
<td>Mirror Service Site</td>
<td>Description, Name</td>
<td>—</td>
</tr>
<tr>
<td>Redundant Interface</td>
<td>—</td>
<td>Interface ID</td>
</tr>
<tr>
<td>Spoke SDP Binding</td>
<td>—</td>
<td>VC ID</td>
</tr>
<tr>
<td>Static LSP</td>
<td>Description, Name</td>
<td>ID</td>
</tr>
<tr>
<td>Tunnel</td>
<td>Description, Name</td>
<td>ID</td>
</tr>
<tr>
<td>VLAN L2 Access Interface</td>
<td>Description</td>
<td>—</td>
</tr>
<tr>
<td>VLAN Service</td>
<td>Description, Service Name</td>
<td>Service ID</td>
</tr>
<tr>
<td>VLAN Service Access Point</td>
<td>Description, Name</td>
<td>—</td>
</tr>
<tr>
<td>VLAN Service Site</td>
<td>Description, Name</td>
<td>—</td>
</tr>
<tr>
<td>VLL Apipe Service</td>
<td>Description, Service Name</td>
<td>Service ID</td>
</tr>
</tbody>
</table>
### Table 6-1  Format and Range policy objects and associated parameters  (continued)

<table>
<thead>
<tr>
<th>Object name</th>
<th>Format policy parameter</th>
<th>Range policy parameter</th>
</tr>
</thead>
<tbody>
<tr>
<td>VLL Apipe Service Site</td>
<td>Description, Name</td>
<td>—</td>
</tr>
<tr>
<td>VLL Cpipe Service</td>
<td>Description, Service Name</td>
<td>Service ID</td>
</tr>
<tr>
<td>VLL Cpipe Site</td>
<td>Description, Name</td>
<td>—</td>
</tr>
<tr>
<td>VLL Epipe Service</td>
<td>Description, Service Name</td>
<td>Service ID</td>
</tr>
<tr>
<td>VLL Epipe Service Site</td>
<td>Description, Name</td>
<td>—</td>
</tr>
<tr>
<td>VLL Fpipe Service</td>
<td>Description, Service Name</td>
<td>Service ID</td>
</tr>
<tr>
<td>VLL Fpipe Service Site</td>
<td>Description, Name</td>
<td>—</td>
</tr>
<tr>
<td>VLL Ippe L2 Access Interface</td>
<td>Description</td>
<td>Outer Encapsulation Value</td>
</tr>
<tr>
<td>VLL Ippe Service</td>
<td>Description</td>
<td>Service ID</td>
</tr>
<tr>
<td>VLL Ippe Site</td>
<td>Description, Name</td>
<td>—</td>
</tr>
<tr>
<td>VLL L2 Access Interface</td>
<td>Description</td>
<td>Outer Encapsulation Value</td>
</tr>
<tr>
<td>VPLS B-L2 Access Interface</td>
<td>Description</td>
<td>Outer Encapsulation Value</td>
</tr>
<tr>
<td>VPLS I-L2 Access Interface</td>
<td>Description</td>
<td>Outer Encapsulation Value</td>
</tr>
<tr>
<td>VPLS L2 Access Interface</td>
<td>Description</td>
<td>Outer Encapsulation Value</td>
</tr>
<tr>
<td>VPLS L2 Management Interface</td>
<td>—</td>
<td>Interface ID</td>
</tr>
<tr>
<td>VPLS Service</td>
<td>Description, Service Name</td>
<td>Service ID</td>
</tr>
<tr>
<td>VPLS Service Site</td>
<td>Description, Name</td>
<td>—</td>
</tr>
<tr>
<td>VPRN Group Interface</td>
<td>Description, Name</td>
<td>Interface ID</td>
</tr>
<tr>
<td>VPRN L3 Access Interface</td>
<td>Description, Name</td>
<td>Interface ID, Outer Encapsulation Value</td>
</tr>
<tr>
<td>VPRN Service</td>
<td>Description, Service Name</td>
<td>Service ID</td>
</tr>
<tr>
<td>VPRN Service Access Point</td>
<td>Description, Name</td>
<td>Outer Encapsulation Value</td>
</tr>
<tr>
<td>VPRN Service Site</td>
<td>Description, Name</td>
<td>—</td>
</tr>
<tr>
<td>VPRN Subscriber Interface</td>
<td>Description, Name</td>
<td>Interface ID</td>
</tr>
</tbody>
</table>

The following table lists the policies that support format and range policies.

### Table 6-2  Format and Range policy objects and associated parameters for policies

<table>
<thead>
<tr>
<th>Policy</th>
<th>Format policy</th>
<th>Range policy</th>
</tr>
</thead>
<tbody>
<tr>
<td>Access Ingress QoS</td>
<td>Description, Displayed Name</td>
<td>ID</td>
</tr>
<tr>
<td>Access Egress QoS</td>
<td>Description, Displayed Name</td>
<td>ID</td>
</tr>
<tr>
<td>ATM QoS policy</td>
<td>Description, Displayed Name</td>
<td>ID</td>
</tr>
<tr>
<td>Egress Queue Group template</td>
<td>Description, Displayed Name</td>
<td>—</td>
</tr>
<tr>
<td>Policy</td>
<td>Format policy</td>
<td>Range policy</td>
</tr>
<tr>
<td>--------------------------------</td>
<td>--------------------------------</td>
<td>--------------</td>
</tr>
<tr>
<td>7705 SAR Fabric Profile</td>
<td>Description, Displayed Name</td>
<td>ID</td>
</tr>
<tr>
<td>Policer Control policy</td>
<td>Description, Displayed Name</td>
<td>—</td>
</tr>
<tr>
<td>HSMDA Pool policy</td>
<td>Description, Displayed Name</td>
<td>—</td>
</tr>
<tr>
<td>HSMDA Scheduler policy</td>
<td>Description, Displayed Name</td>
<td>—</td>
</tr>
<tr>
<td>HSMDA WRED Slope policy</td>
<td>Description, Displayed Name</td>
<td>—</td>
</tr>
<tr>
<td>Ingress Queue Group template</td>
<td>Description, Displayed Name</td>
<td>—</td>
</tr>
<tr>
<td>MCFR Egress QoS Profile</td>
<td>Description, Displayed Name</td>
<td>Profile ID</td>
</tr>
<tr>
<td>MCFR Ingress QoS Profile</td>
<td>Description</td>
<td>Profile ID</td>
</tr>
<tr>
<td>MLPPP Egress QoS Profile</td>
<td>Description</td>
<td>Profile ID</td>
</tr>
<tr>
<td>MLPPP Ingress QoS Profile</td>
<td>Description</td>
<td>Profile ID</td>
</tr>
<tr>
<td>Named Buffer Pool policy</td>
<td>Description, Name</td>
<td>—</td>
</tr>
<tr>
<td>Network policy</td>
<td>Description, Displayed Name</td>
<td>ID</td>
</tr>
<tr>
<td>Network Queue</td>
<td>Description, Name</td>
<td>—</td>
</tr>
<tr>
<td>Port Scheduler policy</td>
<td>Description, Displayed Name</td>
<td>—</td>
</tr>
<tr>
<td>Sap Access Ingress for 7210</td>
<td>Description, Displayed Name</td>
<td>ID</td>
</tr>
<tr>
<td>Network Policy for 7210</td>
<td>Description, Displayed Name</td>
<td>NW Mgr ID, Policy Id</td>
</tr>
<tr>
<td>Network Queue for 7210</td>
<td>Description, Name</td>
<td>—</td>
</tr>
<tr>
<td>Port Access Egress for 7210</td>
<td>Description, Displayed Name</td>
<td>ID</td>
</tr>
<tr>
<td>Port Scheduler for 7210</td>
<td>Description, Displayed Name</td>
<td>—</td>
</tr>
<tr>
<td>Slope Policy for 7210</td>
<td>Description, Displayed Name</td>
<td>—</td>
</tr>
<tr>
<td>Scheduler policy</td>
<td>Description, Displayed Name</td>
<td>—</td>
</tr>
<tr>
<td>WRED Slope policy</td>
<td>Description, Displayed Name</td>
<td>—</td>
</tr>
<tr>
<td>ACL IP filter</td>
<td>Description, Displayed Name</td>
<td>Filter ID</td>
</tr>
<tr>
<td>ACL IPv6 filter</td>
<td>Description, Displayed Name</td>
<td>Filter ID</td>
</tr>
<tr>
<td>ACL MAC filter</td>
<td>Description, Displayed Name</td>
<td>Filter ID</td>
</tr>
<tr>
<td>ANCP policy</td>
<td>Displayed Name</td>
<td>—</td>
</tr>
<tr>
<td>Host Tracking policy</td>
<td>Description, Displayed Name</td>
<td>—</td>
</tr>
<tr>
<td>MSAP policy</td>
<td>Description, Displayed Name</td>
<td>—</td>
</tr>
<tr>
<td>PPPoE policy</td>
<td>Description, Displayed Name</td>
<td>—</td>
</tr>
<tr>
<td>SLA Profile</td>
<td>Description, Displayed Name</td>
<td>—</td>
</tr>
<tr>
<td>Subscriber Explicit Map Entry</td>
<td>Description, Displayed Name</td>
<td>—</td>
</tr>
</tbody>
</table>
Table 6-2  Format and Range policy objects and associated parameters for policies  (continued)

<table>
<thead>
<tr>
<th>Policy</th>
<th>Format policy</th>
<th>Range policy</th>
</tr>
</thead>
<tbody>
<tr>
<td>Subscriber Identification policy</td>
<td>Description, Displayed Name</td>
<td>—</td>
</tr>
<tr>
<td>Subscriber Profile</td>
<td>Description, Displayed Name</td>
<td>—</td>
</tr>
<tr>
<td>AA Application filter</td>
<td>—</td>
<td>Entry ID</td>
</tr>
<tr>
<td>Egress Multicast Group</td>
<td>Description, Displayed Name</td>
<td>—</td>
</tr>
<tr>
<td>Multicast Package</td>
<td>Description, Displayed Name</td>
<td>ID</td>
</tr>
<tr>
<td>Multicast CAC</td>
<td>Description, Name</td>
<td>—</td>
</tr>
<tr>
<td>Multicast PathMgmt BW policy</td>
<td>Description, Name</td>
<td>—</td>
</tr>
<tr>
<td>Multicast PathMgmt Info policy</td>
<td>Description, Name</td>
<td>—</td>
</tr>
<tr>
<td>AS Path</td>
<td>Description, AS Path Name</td>
<td>—</td>
</tr>
<tr>
<td>Community</td>
<td>Description, Community Name</td>
<td>—</td>
</tr>
<tr>
<td>Community Member</td>
<td>Community Member</td>
<td>—</td>
</tr>
<tr>
<td>Damping</td>
<td>Damping Name</td>
<td>—</td>
</tr>
<tr>
<td>Prefix List</td>
<td>Description, Prefix List Name</td>
<td>—</td>
</tr>
<tr>
<td>Statement</td>
<td>Description, Statement Name</td>
<td>—</td>
</tr>
<tr>
<td>Service L3 Routing</td>
<td>Export Target IP Address, Import</td>
<td>Export Target AS Value, Export Target AS Value (4Byte), Export Target</td>
</tr>
<tr>
<td></td>
<td>Target IP Address, Target IP Address</td>
<td>Community Value, Export Target Community Value, Export Target</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Extended Community Value, Export Target AS Value, Import Target AS Value</td>
</tr>
<tr>
<td></td>
<td></td>
<td>(4Byte), Import Target Community Value, Import Target</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Extended Community Value, Target AS Value, Target AS Value (4Byte),</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Target Community Value, Target Extended Community Value, Target</td>
</tr>
<tr>
<td></td>
<td></td>
<td>AS Value, Target AS Value (4Byte), Target Community Value, Target</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Extended Community Value, Target</td>
</tr>
<tr>
<td>MPLS Administrative Groups</td>
<td>Displayed Name</td>
<td>Value</td>
</tr>
<tr>
<td>Static Configuration for SRLGs</td>
<td>Displayed Name</td>
<td>—</td>
</tr>
<tr>
<td>Shared Risk Link Group Static Config</td>
<td>Displayed Name</td>
<td>Value</td>
</tr>
<tr>
<td>Accounting policy</td>
<td>Description, Displayed Name</td>
<td>ID</td>
</tr>
<tr>
<td>File policy</td>
<td>Description, Displayed Name</td>
<td>ID</td>
</tr>
<tr>
<td>Maintenance Domain</td>
<td>Description, Name</td>
<td>MD Mgr ID</td>
</tr>
<tr>
<td>Network Address Translation policy</td>
<td>Description, Displayed Name</td>
<td>—</td>
</tr>
<tr>
<td>PAE 802_1x policy</td>
<td>Description, Displayed Name</td>
<td>—</td>
</tr>
<tr>
<td>RADIUS Based Accounting</td>
<td>Description, Displayed Name</td>
<td>—</td>
</tr>
<tr>
<td>RMON</td>
<td>Description, Displayed Name</td>
<td>—</td>
</tr>
<tr>
<td>Time of Day Suite</td>
<td>Description, Name</td>
<td>—</td>
</tr>
</tbody>
</table>
Table 6-2  Format and Range policy objects and associated parameters for policies  (continued)

<table>
<thead>
<tr>
<th>Policy</th>
<th>Format policy</th>
<th>Range policy</th>
</tr>
</thead>
<tbody>
<tr>
<td>Time Range</td>
<td>Description, Name</td>
<td>—</td>
</tr>
<tr>
<td>VRRP policy</td>
<td>Description, Displayed Name</td>
<td>ID, Service ID</td>
</tr>
</tbody>
</table>

6.4  NFM-P license management

6.4.1  Overview

To enable the options or equipment capacity specified in a new license, you must import the license file on each NFM-P main server, as described in 6.10 “To update the NFM-P license in a standalone deployment” (p. 151) and 6.11 “To update the NFM-P license in a redundant deployment” (p. 152). If required, you can uncompress a license file and view the license information, which is in XML format.

You can view the NFM-P license information by choosing Help→License Information from the NFM-P main menu. The NSP Network Functions Manager - Packet License form lists information that includes the following, which you can export to a file, if required:

- NFM-P software release and license type
- main server associated with the license
- licensed NFM-P software options
- total consumed and remaining license points
- number of allowed operator positions
- extended NE software support information

License capacity management

Note: When the NFM-P license capacity is reached, the NFM-P does not discover new equipment.

From the NFM-P License form, you can generate a license inventory file that lists the NFM-P license points consumed per object per managed NE, and per subscriber type. The objects are ordered by NE site ID and by subscriber type; the information for each includes the following:

- object FDN, for equipment
- associated site ID, for equipment
- licensed product name
- number of license points that the object consumes

See 6.9 “To export the NFM-P license information or create a license point inventory” (p. 151) for information.

The license consumption information for a specific NE is viewable from the Inventory tab of the NE properties form. The tab lists the license information for cards, blades, chassis, and other equipment specific to the NE. See “Inventory Management Overview” in the NSP NFM-P User Guide for more information.
The Manage Equipment form displays license consumption information specific to a type of equipment, for example, a physical card.

6.5 Configuring Analytics functions

6.5.1 Custom auxiliary database table attributes

Some NSP Analytics reports require data that is not available to the NFM-P. Data such as location names, geographic co-ordinates, and maintenance windows must be imported to an auxiliary database in order to be included in reports. The NFM-P has a mechanism for the creation and management of auxiliary database tables and content.

An XML file that you create defines the table columns and data types to add to an auxiliary database. After you import a table definition to the NFM-P, an operator can add data records to the table using a CSV file whose record format matches the format defined in the XML file. An operator can also delete one or more tables, or the content of a table.

Note: A data-import operation appends the new records to the table, and does not affect the existing table contents or structure.

Custom auxiliary database table attributes are retained through system upgrades, and are included in auxiliary database backup and restore operations.

Table definition file format

Figure 6-1, “Custom table definition file format” (p. 142), shows a table definition XML file that contains the column definitions for two custom tables.

```
<customTablesConfig organization="OurCompany" name="CustomTableDefs"
  xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance"
  xsi:noNamespaceSchemaLocation="./schema/customtables.xsd">
  <customTables>
    <customTable
      name="table1"
      description="This is table 1"
      orderBy="column1"
    >
      <columns>
        <column name="column1" type="STRING" length="8" encoding="RLE" />
        <column name="column2" type="INTEGER" />
        <column name="column3" type="FLOAT" />
        <column name="column4" type="BOOLEAN" />
        <column name="column5" type="NUMERIC" precision="12" scale="4" />
      </columns>
    </customTable>
    <customTable
      name="table2"
      description="This is table 2"
      segmentedBy="column1,column2"
    >
  </customTables>
</customTablesConfig>
```
Table 6-3, “Custom attribute definition elements” (p. 143) lists and describes the configurable elements in a custom table definition.

**Table 6-3  Custom attribute definition elements**

<table>
<thead>
<tr>
<th>Element</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>description</td>
<td>Text that describes the table; optional</td>
</tr>
<tr>
<td>orderBy</td>
<td>Comma-separated list of column names that define how the table data is to be ordered; optional</td>
</tr>
<tr>
<td>segmentedBy</td>
<td>Comma-separated list of column names that define how the table is to be segmented; optional</td>
</tr>
<tr>
<td>column name</td>
<td>Table column name</td>
</tr>
<tr>
<td>type</td>
<td>One of the following:</td>
</tr>
<tr>
<td></td>
<td>• STRING—1 to 4096 characters</td>
</tr>
<tr>
<td></td>
<td>• INTEGER</td>
</tr>
<tr>
<td></td>
<td>• FLOAT</td>
</tr>
<tr>
<td></td>
<td>• BOOLEAN</td>
</tr>
<tr>
<td></td>
<td>• NUMERIC</td>
</tr>
<tr>
<td>precision</td>
<td>Maximum number of significant digits, represented by a positive integer less than or equal to 1024; required for NUMERIC data type</td>
</tr>
<tr>
<td>scale</td>
<td>Maximum number of digits to the right of the decimal point in a NUMERIC data type, represented by a positive integer less than or equal to the precision value; if omitted, defaults to 0</td>
</tr>
<tr>
<td></td>
<td>If the number of decimal digits in a data value exceeds the scale value, the data value is rounded to the number of digits specified by the scale value.</td>
</tr>
<tr>
<td>encoding</td>
<td>Text encoding type for STRING data type; optional, default is AUTO</td>
</tr>
<tr>
<td>length</td>
<td>Field length; required for STRING data type</td>
</tr>
</tbody>
</table>

**Functional description**

The management tool for custom tables is the customData.bash CLI script on a main server station. You can use the tool to do the following:

- create and delete tables
- import, export, and delete data
• list the currently defined custom tables
• export a table schema

**Note:** In order for the customData.bash script to function, the main server configuration must include an auxiliary database.

**Note:** If a string data value to be imported includes a comma, you must precede the comma with a backslash to prevent the comma from being interpreted as a CSV file delimiter.

The customData.bash script has the following operating characteristics:
• The script automatically assigns a prefix and suffix to the name of a custom table. References to the table in script operations after table creation must include the samdb prefix and _ct suffix; for example, customTable1 must be specified as samdb.customTable1_ct.
• Script operations that modify data, such as createTables, deleteTable, and importData, require the auxiliary database user password.
• During a createTable operation, a formatting error in an table definition causes all table creation during the operation to fail, and the script saves the table definition file as tmp/customtables.xml.template.
• The script logs each operation in the /opt/nsp/nfmp/server/nms/log/customdata.log; the maximum log size is five Mbytes.

### 6.6 To create and manage custom auxiliary database table attributes

**Note:** The password value that you specify in the following steps is the password of the samauxdb user.

#### 6.6.1 Steps

1. If you are creating a custom table, configure the elements in a table definition XML file using the format described in “Table definition file format” (p. 143).

2. If you are adding data to a custom table, create a CSV-formatted data file that has the same record format as the custom table.

3. Log in to the standalone or primary main server station as the nsup user.

4. Open a console window.

5. Navigate to the /opt/nsp/nfmp/server/nms/bin directory.
To create a custom table, enter the following:

```
bash$ ./customData.bash -password password -createTables definition_file
```

where `definition_file` is the table definition XML file created in **Step 1**
The specified tables are created.

To import data to a custom table, enter the following:

```
bash$ ./customData.bash -password password -importData data_file
```

where `data_file` is the CSV data file created in **Step 2**
The data is imported.

To list all custom tables, enter the following:

```
bash$ ./customData.bash -listTables
```
The tables are listed.

To delete all data in a custom table, enter the following:

```
bash$ ./customData.bash -password password -deleteData samdb.table_ct
```

where `table` is the name of the table from which to delete data
The table data is deleted.

To delete a custom table, enter the following:

```
bash$ ./customData.bash -password password -deleteTable samdb.table_ct
```

where `table` is the name of the table to delete
The table is deleted.

To export the data in a custom table to a file, enter the following:

```
bash$ ./customData.bash -exportData samdb.table_ct output_file
```

where
- `table` is the name of the table from which to export data
- `output_file` is the name of the file that is to contain the exported data
The table data are exported to the file.
12 To export a custom table schema to a file, enter the following:

```
bash$ ./customData.bash -tableSchema samdb.table_ct output_file
```

where

- `table` is the name of the table from which to export the schema
- `output_file` is the name of the file that is to contain the exported schema

The table schema is saved in the file.

13 Close the console window.

**END OF STEPS**

### 6.7 Workflow to configure NFM-P components

#### 6.7.1 Process

1 As required, manage the NFM-P software and license configuration.

   a. View the NFM-P license information, such as the equipment license capacity and the installed NFM-P options; see 6.8 “To view the NFM-P license information” (p. 150).

   b. Export the NFM-P license information to a file; see 6.9 “To export the NFM-P license information or create a license point inventory” (p. 151).

   c. Update the NFM-P license. For a standalone deployment, see 6.10 “To update the NFM-P license in a standalone deployment” (p. 151). For a redundant deployment, see 6.11 “To update the NFM-P license in a redundant deployment” (p. 152).

   d. View a list of the backup copies of NFM-P license files; see 6.12 “To list the backed-up NFM-P license files” (p. 155).

   e. Change the NFM-P license expiry notification date; see 6.13 “To change the default NFM-P license expiry notification date” (p. 156).

2 As required, configure NFM-P system components.

   a. Modify the base configuration of each GUI client that connects to the NFM-P; see 6.14 “To modify the base configuration of all GUI clients” (p. 158).

   b. Display multiple server login options on an NFM-P client GUI to allow you to connect to an alternate main server; see 6.15 “To configure the display of multiple NFM-P systems as client GUI login options” (p. 159).

   c. Customize the default file location of client delegate server files such as the user-defined GUI preference, script result, and client log files; see 6.16 “To change the default user file locations on a client delegate server” (p. 160).
d. Change the IP address or hostname of an NFM-P component, for example, a server or database; see 6.17 “To change the IP address or hostname of an NFM-P system component” (p. 161).

e. Enable main database backup file synchronization; see 6.18 “To enable main database backup file synchronization” (p. 162).

f. Modify the default time period of the statistics displayed by the NFM-P Statistics Manager search filters; see 6.19 “To modify the default time period of statistics displayed by the Statistics Manager search filters” (p. 164).

g. Modify the default time period of the statistics displayed on the Statistics tab on object properties forms; see 6.20 “To modify the default time period of statistics displayed on object properties forms” (p. 165).

h. Create format policies to manage how services, policies, LSPs, L2 and L3 access interfaces are named and described; see 6.23 “To create or configure a format policy” (p. 170).

i. Create range policies to manage the ID numbers that are assigned to services, policies, LSPs, L2 and L3 access interfaces; see 6.24 “To create or configure a range policy” (p. 172).

As required, configure NFM-P network management functions.

a. Configure the NFM-P to automatically remove the configuration backup files for a device when the device is unmanaged; see 6.25 “To configure automatic device configuration backup file removal” (p. 174).

b. Enable alarm reporting to identify duplicate NE system IP addresses; see 6.26 “To enable alarm reporting to identify duplicate NE system IP addresses” (p. 175).

c. Enable LSP on-demand resynchronization to disable scheduled resynchronization for some LSP objects; see 6.28 “To enable LSP on-demand resynchronization” (p. 178).

d. Reload the debug configuration file after an NE restarts to ensure mirror services in a managed network resume operation after a reboot or a CPM activity switch; see 6.29 “To enable debug configuration file reloading on an NE for mirror services” (p. 179).

e. Configure throttle rates for residential subscriber create and delete event traps on the 7750 SR; see 6.30 “To configure throttle rates for subscriber trap events” (p. 181).

f. Configure the windowing trap delay option to provide an enhanced method to resync the subscriber table in the event of a trap drop from an NE; see 6.31 “To configure the windowing trap delay option for subscriber table resyncs” (p. 182).

g. Create a default SNMPv2 OmniSwitch user in the NFM-P; see 6.32 “To create a default SNMPv2 OmniSwitch user” (p. 184).

As required, customize the global NFM-P alarm settings to meet specific operational requirements, for example:

• severity, clearing, and deletion criteria
• history logging

See “Alarm management” in the *NSP NFM-P User Guide* for detailed information about the global alarm settings that can be customized.

5

As required, customize or change the NFM-P system preferences to meet operational requirements; see 6.34 “To configure NFM-P system preferences” (p. 191).
6.8 To view the NFM-P license information

6.8.1 Steps

1. Choose Help→License Information from the NFM-P main menu. The NSP Network Functions Manager - Packet License (Edit) form opens.

2. View the license information in the following panels:
   - License Information—basic license and system information
   - Options—the optional NFM-P functions that are enabled
   - Licensed Limits—the number of consumed and remaining license points for capacity-based licensing objects such as equipment

3. A highlighted entry in the Licensed Limits panel is alarmed, and may indicate that the license capacity is approaching or has reached the license limit. To view the current alarms against an entry, double-click on the entry and click on the Faults tab of the form that opens.

4. Close the open forms, as required.

2

---

CAUTION

Service Disruption

An NFM-P license file is digitally signed. If you rename or modify the license XML file, the NFM-P rejects the license.

Do not rename or modify the XML file inside a compressed license file.

To verify the contents of an NFM-P license file, for example, if you are unsure which file contains a specific license option or number of license points:

Note: A license file does not include an object that has a licensed quantity of zero.

1. Uncompress the license zip file.
2. View the contents of the contained XML file.
3. Close the file.

**END OF STEPS**

### 6.9 To export the NFM-P license information or create a license point inventory

#### 6.9.1 Steps

1. Choose Help→License Information from the NFM-P main menu. The NSP Network Functions Manager - Packet License (Edit) form opens.

2. To export the information on the form to a file, perform the following steps.
   1. Click Export License information to file. A Save as form opens.
   2. Specify a name, location, and format for the file that is to contain the license information.
   3. Click Save. The license information is saved in the specified file.

3. To create a license point inventory, perform the following steps.

   **Note:** The license point inventory file is saved in XML format.
   1. Click License Points Inventory. A Save as form opens.
   2. Specify a name and location for the file that is to contain the license inventory.
   3. Click Save. The license point inventory is saved in the specified file.

4. Close the NFM-P License (Edit) form.

**END OF STEPS**

### 6.10 To update the NFM-P license in a standalone deployment

#### 6.10.1 Steps

1. Log in to the main server station as the nsp user.

2. Open a console window.
3 Navigate to the /opt/nsp/nfmp/server/nms/bin directory.

4 Enter the following:

```bash
bash$ ./nmsserver.bash import_license license_file
```

where `license_file` is the absolute file path of the NFM-P license zip file

The following prompt is displayed:

```
Detected an NFM-P license key. Do you want to proceed? (YES/no):
```

5 Enter the following:

```
YES
```

The main server reads the license file, copies the license file to a backup location, and displays the following status information:

```
Importing NFM-P license key...
```

Original license key file has been backed up to

```
/opt/nsp/nfmp/server/timestamp/SAMLicense.zip
```

Done.

where `timestamp` is a directory name in the following format: `yyyy.mm.dd-hh.mm.ss`

6 Close the console window.

**Verify new license information**

7 Perform **6.8 "To view the NFM-P license information" (p. 150)** to verify the imported license information.

8 If a license parameter is incorrect, contact technical support for assistance.

---

**6.11 To update the NFM-P license in a redundant deployment**

**Note:** The license files that you import to the primary and standby main servers must contain identical license quantity and option values.
Note: To reduce the risk of importing mismatched licenses, it is recommended that you obtain one license file that contains the system ID of each main server, and then import the same file on each main server.

Note: The primary and standby main server licenses must be synchronized to ensure correct NFM-P operation in the event of a server activity switch. The main servers compare license values after a system reconfiguration. If a difference is detected, the NFM-P raises an alarm that clears when the licenses are synchronized.

6.11.1 Steps

Update license on primary main server

1. Open a client GUI to monitor the NFM-P during the license update.

2. Log in to the primary main server station as the nsp user.

3. Open a console window.

4. Navigate to the /opt/nsp/nfmp/server/nms/bin directory.

5. Enter the following:
   
   ```bash
   bash$ ./nmsserver.bash import_license license_file
   ```
   
   where `license_file` is the absolute file path of the NFM-P license zip file

   The following prompt is displayed:
   
   Detected an NFM-P license key. Do you want to proceed? (YES/no):

6. Enter the following:
   
   `YES`

   The primary main server reads the license file, copies the license file to a backup location, and displays the following status information:

   Importing NFM-P license key...

   Original license key file has been backed up to
   /opt/nsp/nfmp/server/timestamp/SAMLicense.zip

   Done.

   where `timestamp` is a directory name in the following format: yyyy.mm.dd-hh.mm.ss
**Note:** Importing the new license on the primary main server creates a license mismatch with the standby main server. As a result, the NFM-P generates an alarm. The alarm clears automatically after you import the new license on the standby main server.

7 Close the console window.

Update license on standby main server

8 Log in to the standby main server station as the nsu user.

9 Open a console window.

10 Navigate to the `/opt/nsp/nfmp/server/nms/bin` directory.

11 Enter the following:

```
bash$ ./nmsserver.bash import_license license_file
```

where `license_file` is the absolute file path of the NFM-P license zip file

The following prompt is displayed:

Detected an NFM-P license key. Do you want to proceed? (YES/no):

12 Enter the following:

```
YES
```

The standby main server reads the license file, copies the license file to a backup location, and displays the following status information:

```
Importing NFM-P license key...
Original license key file has been backed up to
/opt/nsp/nfmp/server/timestamp/SAMLicense.zip
Done.
```

where `timestamp` is a directory name in the following format: `yyyy.mm.dd-hh.mm.ss`

13 Close the console window.
Ensure that the license mismatch alarm clears automatically. If it does not, contact technical support.

Verify new license information

Perform 6.8 “To view the NFM-P license information” (p. 150) to verify the imported license information.

If a license parameter is incorrect, contact technical support.

---

6.12 To list the backed-up NFM-P license files

6.12.1 Purpose

When you import an NFM-P license, the NFM-P creates a backup copy of the existing license file. The following steps describe how to list the NFM-P license files.

6.12.2 Steps

1. Log in to the main server station as the nsp user.

2. Open a console window.

3. Navigate to the /opt/nsp/nfmp/server/nms/bin directory.

4. Enter the following:

```bash
bash$ ./nmsserver.bash import_license
```

The command lists the files, as shown below:

The following backed up license key files have been detected on the system.

```
/opt/nsp/nfmp/server/timestamp1/SAMLicense.zip
/opt/nsp/nfmp/server/timestamp2/SAMLicense.zip
```

...
where timestamp1 and timestamp2 are directory names in the following format: yyyy.mm.dd-hh.mm.ss

5 Close the console window.

END OF STEPS

6.13 To change the default NFM-P license expiry notification date

6.13.1 Purpose

The NFM-P raises a daily warning alarm as the expiry date of the NFM-P license approaches. By default, the first alarm is raised seven days before the expiry date. Perform the procedure to change the default license expiry notification date.

CAUTION

Service Disruption

Modifying the nms-server.xml file can have serious consequences that can include service disruption.

Contact technical support before you attempt to modify the nms-server.xml file.

Note: You must perform the procedure on each main server in the NFM-P system.

Note: In a redundant system, you must perform the procedure on the standby main server station first.

6.13.2 Steps

1 Log in to the main server station as the nsp user.

2 Open a console window.

3 Navigate to the /opt/nsp/nfmp/server/nms/config directory.

4 Create a backup copy of the nms-server.xml file.
Open the nms-server.xml file using a plain-text editor such as vi.

Locate the following tag in the nms-server.xml file:
<license

Edit the following line in the section to read:
timedLicenseExpiryCount="value"
where value is the number of days to be notified before the license expiry

Save and close the nms-server.xml file.

On a standalone main server, or the primary main server in a redundant system, enter the following:
bash$ /opt/nsp/nfmp/server/nms/bin/nmsserver.bash read_config
The NFM-P puts the configuration change into effect.

Close the console window.
System component configuration procedures

6.14 To modify the base configuration of all GUI clients

Note: You can exclude a specific NFM-P client from a global configuration change by using a command line option when you open the client GUI.

6.14.1 Steps

1. Log in to the NFM-P main server station as the nsp user.

2. Modify the appropriate client configuration file in the /opt/nsp/nfmp/server/nms/config/clientDeploy directory. For example, update the nms-client.xml file with a new client log location.

3. Open a console window.

4. Enter the following to enable an update notification for clients that connect to the server and to prepare the client configuration files for download.
   
   bash$ /opt/nsp/nfmp/server/nms/bin/nmsdeploytool.bash deploy

5. Close the console window.

6. Perform one of the following on each single-user GUI client and client delegate server station.

Note: When you perform this step on a client delegate server station, you affect each GUI client that connects through the client delegate server.

a. Update the client configuration by restarting the client GUI. The client automatically backs up the current configuration and applies the configuration change.

Note: On a RHEL client delegate server station, you must start the client software as the root user, or the configuration update fails.

On RHEL, the client configuration backup is stored in the path/nms/configBackup directory, where path is the client installation location, typically /opt/nsp/client.

On Windows, the client configuration backup is stored in the path\nms\configBackup directory, where path is the client installation location, typically C:\nsp\client.

b. Retain the current client configuration when the client GUI starts by specifying the startup
option that disables the auto-client update function. See “Procedures for opening and closing the GUI” in the NSP NFM-P User Guide for information about GUI client startup options.

**Note:** Specifying a client startup option affects only the current GUI session. To ensure that the client configuration is not updated automatically during a subsequent session, you must open the session using the startup option that disables the auto-client update.

---

### 6.15 To configure the display of multiple NFM-P systems as client GUI login options

**Note:** You cannot configure a client delegate server to display multiple server options on the client login form. If you need client connections to multiple NFM-P main servers through a client delegate server, you must install one client delegate server software instance for each main server.

The NFM-P auto-client update function overrides the nms-client.xml configuration changes that are specified in the procedure. If the nms-client.xml file on a main server changes, it overwrites the local client copy the next time the client connects to the server, unless a client startup option is used to prevent it. For information about using client startup options, see “Procedures for opening and closing the GUI” in the NSP NFM-P User Guide.

It is recommended that you use the NFM-P auto-client update function described in Chapter 6, “NFM-P component configuration” to modify the NFM-P client configuration.

#### 6.15.1 Steps

1. Click on Application→Exit to close the NFM-P client GUI, if it is open. The client GUI closes.

2. Navigate to the client configuration directory, typically /opt/nsp/client/nms/config on RHEL, and C:\nsp\client\nms\config on Windows.

3. Open the nms-client.xml file using a text editor.

4. Find the lines starting with `<j2ee>` and `<systemMode>`. By default, the IP address and port information of the standalone or redundant servers, as configured during installation, are displayed.

5. For each standalone main server or redundant main server pair you need displayed on the client GUI login form, perform the following:
1. Copy the entire `<j2ee>` and `<systemMode>` sections of the file.
2. Paste the `<j2ee>` and `<systemMode>` sections after the previous section.
3. Modify the `ejbServer IP address` to the IP address or hostname of the server you need displayed during client GUI login.
4. Modify the `nameOne` (for standalone) or `nameOne` and `nameTwo` (for redundant) parameters to indicate the domain name and hostname of the server, for easier identification by operators. This name does not have to be the hostname of the server domain. In some cases, the name may be the same for the active and standby server in a redundant server domain. The name is not automatically derived from a host lookup.

   **Note:** Common hostname restrictions apply to the `nameOne` and `nameTwo` fields; you cannot include the following special characters:

   `! $ % & ( ) +`

5. Save the changes and close the file.

6. Log in to the client GUI. The Server drop-down menu displays the new server options.

**END OF STEPS**

### 6.16 To change the default user file locations on a client delegate server

#### 6.16.1 Purpose

Perform the procedure to configure the default location of one or more of the following on an NFM-P client delegate server:

- user preference files that contain the following information:
  - saved table layouts
  - preferences saved using `Application→User Preferences`
- script result files

#### 6.16.2 Steps

1. Close each GUI client that connects through the client delegate server by choosing `Application→Exit` from the NFM-P main menu.

2. Log in to the client delegate server station as the `nsp` user.

3. Open a console window.
4 Navigate to the client configuration directory, typically /opt/nsp/client/nms/config on RHEL, and C:\nsp\client\nms\config on Windows.

5 Open the nms-client.xml file using a plain-text editor.

6 To change the default GUI preferences and table layout file location, insert the following line directly above the </configuration> line at the end of the file:

```xml
<guiPreferences path="new_file_location" />
```

where `new_file_location` is the new default GUI table layout and GUI preferences location

ℹ️ **Note:** The specified location can be an absolute file path, or a file path relative to `install_dir/nms`, where `install_dir` is the client installation location.

7 To change the default script result file location, insert the following line directly above the </configuration> line at the end of the file:

```xml
<cache directoryName="new_file_location" />
```

where `new_file_location` is the new default script result file location

ℹ️ **Note:** The specified location can be an absolute file path, or a file path relative to `install_dir/nms`, where `install_dir` is the client installation location.

8 Save and close the nms-client.xml file. Subsequent client GUI sessions on the client delegate server use the new file location.

---

### 6.17 To change the IP address or hostname of an NFM-P system component

#### 6.17.1 Purpose

Changing the IP address or hostname of one or more NFM-P components in a standalone or redundant system may be required, for example, when the management network topology changes.

The requirements of such an operation depend on the management network topology and other considerations, so must be co-ordinated and performed only under the guidance of technical support.
CAUTION

Service Disruption

Changing an IP address or hostname in an NFM-P system is a complex operation that requires careful planning and organization, and depending on the type of change required, may involve a brief network management outage.

Do not attempt to modify the network configuration of an NFM-P component without assistance from technical support.

6.17.2 Steps

1 Collect the following information:
   • hostname of each main server, main database, auxiliary server, auxiliary database, NSP Flow Collector, and client delegate server station
   • current IP address of each interface that is used by the main servers, main databases, auxiliary servers, auxiliary databases, NSP Flow Collectors, and client delegate servers
   • configuration information for mechanisms in the management network that affect addressing, such as NAT
   • new IP addresses and hostnames of the components

2 Contact technical support to schedule a maintenance period for the network configuration change.

END OF STEPS

6.18 To enable main database backup file synchronization

6.18.1 Purpose

Perform the procedure to enable the main servers in a redundant NFM-P system to synchronize the main database backup file sets. After a database backup, if database backup file synchronization is enabled, the NFM-P automatically copies the database backup file set to the standby database station.

Note: The procedure applies only to a redundant NFM-P system.

Note: Before you perform the procedure, you must ensure that there is sufficient network bandwidth between the main database stations for a database copy operation. See the NSP NFM-P Planning Guide for information about the bandwidth requirements of database backup file synchronization.

Note: You must perform the procedure first on the standby main server station, and then on the primary main server station.
6.18.2 Steps

1. Log in to the main server station as the root user.

2. Open a console window.

3. Enter the following:
   
   # samconfig -m main
   
   The following is displayed:
   Start processing command line inputs...
   <main>

4. Enter the following:
   
   <main> configure redundancy database backup-sync
   
   The prompt changes to <main configure redundancy database>.

5. Enter the following:
   
   <main configure redundancy database> exit
   
   The prompt changes to <main>.

6. Enter the following:
   
   <main> apply
   
   The configuration change is applied.

7. Enter the following:
   
   <main> exit
   
   The samconfig utility closes.

8. Enter the following to switch to the nsp user:
   
   # su - nsp
9 Navigate to the /opt/nsp/nfmp/server/nms/bindirectory.

10 Enter the following:

```bash
bash$ /nmsserver.bash read_config
```

The main server puts the configuration change into effect. The NFM-P automatically copies subsequent main database backup file sets from the primary database station to the standby database station.

11 Close the console window.

**END OF STEPS**

### 6.19 To modify the default time period of statistics displayed by the Statistics Manager search filters

#### 6.19.1 Purpose

By default, the NFM-P Statistics Manager limits search results to statistics records collected during the past hour. Perform the procedure to modify the default time period of the statistics displayed by the NFM-P Statistics Manager search filters.

**CAUTION**

**Service Disruption**

*Consider possible service disruptions before modifying the statistics default time period.*

*Changing the default time period for the NFM-P Statistics Manager search filters can affect the performance of the NFM-P.*

#### 6.19.2 Steps

1 Choose Application→Exit to close the NFM-P client GUI, if it is open.

2 Navigate to the client configuration directory, typically /opt/nsp/client/nms/config on RHEL, and C:\nsp\client\nms\config on Windows.

3 Open the nms-client.xml file using a text editor.
4 Locate the section that begins with the following XML tag:
   <statistics

5 Edit the following line to read:
   browserDefaultHour="value"
   where value is the default number of hours for the Past <number_of_hours> filter

6 Save the changes and close the file.

7 Log in to an NFM-P GUI client to verify that the new value is displayed on the Statistics Manager form.

END OF STEPS

6.20 To modify the default time period of statistics displayed on object properties forms

6.20.1 Purpose

By default, the NFM-P displays the statistics records collected during the past hour on the Statistics tab on object properties forms. Perform the procedure to modify the default time period of the statistics displayed on the Statistics tab of an object properties form.

CAUTION

Service Disruption

Consider possible service disruptions before modifying the statistics default time period.

Changing the default time period for the NFM-P Statistics Manager search filters can affect the performance of the NFM-P.

6.20.2 Steps

1 Choose Application→Exit to close the NFM-P client GUI, if it is open. The NFM-P client GUI closes.

2 Navigate to the client configuration directory, typically /opt/nsp/client/nms/config on RHEL, and C:\nsp\client\nms\config on Windows.
3. Open the nms-client.xml file using a text editor.

4. Locate the section that begins with the following XML tag:
   `<statistics`

5. Edit the following line to read:
   `tabDefaultHour="value"
   where value is the default number of hours for the Past <number_of_hours> filter`

6. Save the changes and close the nms-client.xml file.

7. Log in to an NFM-P GUI client to verify that the new value is displayed on the Statistics tab of an object properties form.

---

### 6.21 To enable the preservation of the XML API statistics pool size

#### 6.21.1 Purpose

**CAUTION**

Service Disruption

*Modifying the server configuration can have serious consequences including service disruption. Contact technical support before you attempt to modify the server configuration.*

Perform this procedure to ensure that the pool size for XML API statistics operations is not reset by a system upgrade or main server configuration update.

**Note:** You must perform the procedure on each main server in the NFM-P system.

#### 6.21.2 Steps

1. Log in to the main server station as the nsp user.

2. Open a console window.
3  Navigate to the /opt/nsp/nfmp/server/nms/config directory.

4  Create a backup copy of the nms-server.xml file.

5  Open the nms-server.xml file using a plain-text editor such as vi.

6  Locate the following line:
   <deploymentWorker statsPoolSize="nn"

7  Add the following to the end of the line:
   preserveAttributes="true"
   The line now reads:
   <deploymentWorker statsPoolSize="nn" preserveAttributes="true"

8  Save and close the file.

9  Navigate to the /opt/nsp/nfmp/server/nms/bin directory.

10  Enter the following:
    bash$ ./nmsserver.bash read_config
    The main server configuration is updated.

11  Close the console window.

END OF STEPS
6.22 To configure auto-assigned service ID ranges and uniqueness checking

6.22.1 Purpose

**CAUTION**

**Service Disruption**

*Modifying the NFM-P system configuration can have serious consequences that include service disruption.*

Contact technical support before you attempt to modify the server configuration.

**CAUTION**

**Misconfiguration risk**

You must configure each main server in the NFM-P system using the same values, as described in the procedure; otherwise, a potentially service-affecting configuration mismatch exists.

*If you perform the procedure, ensure that you perform the procedure on each main server station.*

By default, the NFM-P performs uniqueness checking to verify that a service ID that is to be auto-assigned is not currently associated with a service in the NFM-P managed network. Service creation using auto-assigned service IDs can take considerable time, and consume system resources unnecessarily, if the NFM-P manages a large number of services.

To avoid such a scenario, you can configure a range of service IDs for auto-assignment, and disable the uniqueness checking for the specified range.

Perform this procedure to:

- configure the system-wide default minimum and maximum values for auto-assigned service IDs
- disable or enable the uniqueness checking of service IDs during service creation

**Note:** When uniqueness checking is disabled for a range, a value in the range cannot be used as a service ID for the following, or an error is logged and the service creation fails:

- manually created service
- service created using a range policy, if the ranges in the range policy and server configuration overlap to any extent

**Note:** The order in which you configure the main servers is unimportant, but you must perform the procedure on each main server before you attempt automatic service creation using the specified service ID range.

6.22.2 Steps

1. Log in to the main server station as the nsp user.
2. Open a console window.

3. Navigate to the /opt/nsp/nfmp/server/nms/config directory.

4. Create a backup copy of the nms-server.xml file.

5. Open the nms-server.xml file using a plain-text editor such as vi.

6. Locate the section that begins with the following line:
   `<idManager>
   The section describes the ID ranges for which you can configure the minimum and maximum values.

7. Add a serviceId range entry with uniqueness checking disabled to the `<idManager>` section, for example:
   ```xml
   <range
       name="serviceId"
       min="minimum_value"
       max="maximum_value"
       skipIdCheck="true" />
   ```

   **Note:** The skipIdCheck parameter can have one of the following values:
   - `true`—disables the uniqueness check
   - `false`—enables the uniqueness check

   **Note:** Before you set skipIdCheck to `true` for a service ID range, you must ensure that no existing service in the NFM-P managed network has a service ID in the range.

8. Save and close the file.

9. On a standalone main server, or the primary main server in a redundant system, enter the following:
   ```bash
   bash$ /opt/nsp/nfmp/server/nms/bin/nmsserver.bash read_config
   ```
The NFM-P puts the configuration change into effect.

10

Close the console window.

End of steps

6.23 To create or configure a format policy

6.23.1 Steps

1

Choose Administration→Format and Range Policies from the NFM-P main menu. The Format and Range Polices form opens.

2

Expand Format/Range (Property Rules) and choose Format Policy (Property Rules) from the Select Object Type drop-down menu.

3

Click Create or choose a format policy and click Properties. The Format Policy (Create | Edit) form opens.

4

Configure the required parameters.

5

Select an object and property for which you need to apply the name format policy in the Property panel.

6

Click on the Users tab.

Note: Only users and user groups that are assigned to this policy are affected by the policy. You can apply one or more format policies to a user or user group. See Chapter 3, “NFM-P user security” for more information about creating users and user groups.

7

Click Add. The Select User form opens with a list of users.

8

Select one or more users in the list and click OK. The Format Policy form is refreshed with the selected users.
Click on the User Groups tab.

Click Add. The Select Group form opens with a list of user groups.

Choose one or more user groups in the list and click OK. The Format Policy (Create | Edit) form is refreshed with the selected user groups.

Click on the Text Block Formats tab to further define the format of the text. For example, an operator can classify a group of services with a similar name. The operator can also create a tool tip text to describe the purpose of the parameter.

Click Move Up or Move Down to change the sequence of the text blocks in the text string.

Click Create and perform one of the following:
  a. Choose Auto-Filled Parameter. The Auto-Filled Parameter (Create) form opens.
  b. Choose Masked Text Parameter. The Formatted Text (Create) form opens.
  c. Choose Number Range Parameter. The Number Range (Create) form opens.
  d. Choose Text Parameter. The Text (Create) form opens.

Configure the required parameters.
The Min. Length and Max. Length parameters are not configurable when the Read Only parameter is enabled.

Save your changes and close the forms.

Note: After a format policy is applied to a service, a drop-down menu is displayed beside the object field during object creation, to indicate that a format policy is in effect. When there is only one matching policy, the drop-down menu is dimmed. When there are multiple matching policies, the drop-down menu is used to choose a policy. The sequence of the policies in the drop-down menu is based on the value of the Priority parameter.

END OF STEPS
6.24 To create or configure a range policy

6.24.1 Steps


2. Expand Format/Range (Property Rules) and choose Range Policy (Property Rules) from the Select Object Type drop-down menu.

3. Click Create or choose a range policy and click Properties. The Range Policy (Create | Edit) form opens.

4. Configure the required parameters.

5. Select an object and property for which you need to apply the range policy in the Property panel.

6. Configure the parameters in the Range panel.

7. Configure the parameters in the Auto Assignment panel.

8. Click on the Users tab.

   Note: Only users and user groups that are assigned to this policy are affected by the policy. You can apply one or more range policies to a user or user group. See Chapter 3, “NFM-P user security” for more information about creating users and user groups.

9. Click Add. The Select User form opens with a list of users.

10. Choose one or more users in the list and click OK. The Range Policy form is refreshed with the users.
11 Click on the User Groups tab.

12 Click Add. The Select Group form opens with a list of user groups.

13 Choose one or more user groups in the list and click OK. The Range Policy form is refreshed with the user groups.

14 Click OK and close the forms.

**Note:** After a range policy is applied to a service, a drop-down menu is displayed beside the object field during object creation, to indicate that a range policy is in effect. When there is only one matching policy, the drop-down menu is dimmed. When there are multiple matching policies, the drop-down menu is used to choose a policy. The sequence of the policies in the drop-down menu is based on the value of the Priority parameter.

**End of steps**
Network management configuration procedures

6.25 To configure automatic device configuration backup file removal

6.25.1 Purpose
Configure the NFM-P to automatically remove the configuration backup files for a device when the device is unmanaged.

CAUTION

Service Disruption

The procedure requires a restart of each main server, which is service-affecting.
Ensure that you perform the procedure only during a scheduled maintenance window.

CAUTION

Service Disruption

Modifying the server configuration can have serious consequences including service disruption.
Contact technical support before you attempt to modify the server configuration.

Note: You must perform the procedure on each main server in the NFM-P system.

Note: In a redundant system, you must perform the procedure on the standby main server station first.

6.25.2 Steps

1. Log in to the main server station as the nsu user.

2. Open a console window.

3. Navigate to the /opt/nsu/nfmp/server/nms/config directory.

4. Create a backup copy of the nms-server.xml file.

5. Open the nms-server.xml file using a plain-text editor.
6.26 To enable alarm reporting to identify duplicate NE system IP addresses

6.26.1 Purpose

Enable the NFM-P to verify the uniqueness of NE system IP addresses.

When the verification is enabled, the NFM-P generates an alarm when an NE reports a system IP address that is in use by another NE.

CAUTION

Service Disruption

Modifying the server configuration can have serious consequences including service disruption.

Contact technical support before you attempt to modify the server configuration.

Note: You must perform the procedure on each main server in the NFM-P system.

Note: In a redundant system, you must perform the procedure on the standby main server first.
6.26.2 Steps

1. Log in to the main server station as the nsps user.

2. Open a console window.


4. Open the nms-server.xml file using a plain-text editor.

5. Create a backup copy of the nms-server.xml file.

6. Locate the section that begins with the following XML tag:

   &lt;snmp

7. Insert the following before the section end, which is marked by a /&gt; tag:

   verifyNodeIdentity="1"

   **Note:** If the inserted text and end tag are on the same line, you must include a space between the text and the end tag.

8. Save and close the nms-server.xml file.

9. On a standalone main server, or the primary main server in a redundant system, enter the following:

   
   bash$ /opt/nsps/nfmp/server/nms/bin/nmsserver.bash read_config
d

   The NFM-P puts the configuration change into effect.

10. Close the console window.

END OF STEPS
To enable dynamic system IP address updates for 7705 SAR nodes

Purpose

Allow the NFM-P to react automatically when the IP address of a 7705 SAR node changes, for example, after acquiring a new address via DHCP. 7705 SAR NEs are uniquely identified in the network by the System ID parameter. Before you attempt to enable dynamic system IP address updates, please consider the following:

• The system ID of each 7705 SAR must be unique, or the NFM-P may update SDPs to point to an incorrect NE. You can configure the system ID parameter through CLI.

• All 7705 SAR NEs in the network must be unmanaged before you attempt to perform the procedure.

CAUTION

Service Disruption

Modifying the server configuration can have serious consequences including service disruption. Contact technical support before you attempt to modify the server configuration.

Note: You must perform the procedure on each main server in the NFM-P system.

Note: In a redundant system, you must perform the procedure on the standby main server station first.

Steps

1. Log in to the main server station as the nsp user.

2. Open a console window.

3. Navigate to the /opt/nsp/nfmp/server/nms/config directory.

4. Open the nms-server.xml file using a plain-text editor.

5. Locate the following section:

   <SARSysIPAddrChange
   enabled="false"
To enable LSP on-demand resynchronization

6.28.1 Purpose

By default, LSP on-demand resynchronization is disabled. When you enable LSP on-demand resynchronization, the NFM-P scheduled resynchronization is then disabled for some LSP objects. See “LSP on-demand resynchronization” in the NSP NFM-P User Guide for information about which LSP objects do not support on-demand resynchronization.

**CAUTION**

*Service Disruption*

*Modifying the server configuration can have serious consequences including service disruption.*
*Contact technical support before you attempt to modify the server configuration.*

**Note:** You must perform the procedure on each main server in the NFM-P system.

**Note:** In a redundant system, you must perform the procedure on the standby main server station first.

6.28.2 Steps

1. Log in to the main server station as the nsp user.
2 Open a console window.

3 Navigate to the /opt/nsp/nfmp/server/nms/config directory.

4 Create a backup copy of the nms-server.xml file.

5 Open the nms-server.xml file using a plain-text editor.

6 Locate the following line:
   lspOnDemand overrideEnabled="false" />

7 Change "false" to "true".

8 Save and close the nms-server.xml file.

9 On a standalone main server, or the primary main server in a redundant system, enter the following:
   bash$ /opt/nsp/nfmp/server/nms/bin/nmsserver.bash read_config
   The NFM-P puts the configuration change into effect.

10 Close the console window.

END OF STEPS

6.29 To enable debug configuration file reloading on an NE for mirror services

6.29.1 Purpose

Ensure that the managed NEs reload the debug configuration file after an NE restart. This ensures that the mirror services in the managed network resume operation after a reboot or a CPM activity switch on the NE that hosts the mirror service. By default, debug configuration file reloading is disabled.
6.29.2 Steps

1. Log in to the main server station as the nsp user.

2. Open a console window.

3. Navigate to the /opt/nsp/nfmp/server/nms/config directory.

4. Open the nms-server.xml file using a plain-text editor.

5. Locate the section that begins with the following XML tag:
   <serviceMirror

6. Specify the NE location of the debug configuration file. For example:
   <serviceMirror
   debugFilename="filename"
   reloadDelay="delay"
   />

CAUTION

Service Disruption

The procedure requires a restart of each main server, which is service-affecting. Ensure that you perform the procedure only during a scheduled maintenance window.

CAUTION

Service Disruption

Modifying the server configuration can have serious consequences including service disruption. Contact technical support before you attempt to modify the server configuration.

Note: You must perform the procedure on each main server in the NFM-P system.

Note: In a redundant system, you must perform the procedure on the standby main server station first.
where

filename is the absolute file path of the debug log on the NE, for example, cf3:/ServiceMirror.
dbg
delay is the time, in seconds, to wait before a reload request is sent

7

Save and close the nms-server.xml file.

8

Navigate to the /opt/nsp/nfmp/server/nms/bin directory.

9

Enter the following to restart the main server:

bash$ ./nmsserver.bash force_restart

The main server restarts.

10

Close the console window.

END OF STEPS

6.30 To configure throttle rates for subscriber trap events

6.30.1 Purpose

Configure throttle rates for residential subscriber create and delete event traps on a 7750 SR. The throttle rate specifies the number of events that are received in a specified period before the NE stops sending individual traps.

6.30.2 Steps

1

On the equipment tree, right-click on the NE for which you want to configure trap event throttle rates and choose Properties. The Network Element (Edit) form opens.

2

Click Event Throttling. The ESM Trap Throttle form opens.

3

Disable the Default check box and configure the required parameters.
4 Click Execute. The Detailed Status/Error message field displays status information about the throttle rate change.

5 Close the Network Element (Edit) form.

END OF STEPS

6.31 To configure the windowing trap delayer option for subscriber table resyncs

6.31.1 Purpose

Configure the windowing trap delayer option to provide an enhanced method to resynchronize the subscriber table in the event that an NE drops a trap.

Configurable hold-off options prevent subscriber table resyncs for a minimum specified duration after a trap drop is received from an NE, and until a specified period has elapsed with no additional trap drops. Additionally, a maximum hold-off time is specified to prevent excessive periods during which the NFM-P is not synchronized with the NE. The windowing trap delayer configuration reduces the number of subscriber table resync events while attempting to maintain synchronization with the NE.

Note: The windowing trap delayer option affects only tmnxTrapDropped traps associated with tmnxSubscriberCreated, tmnxSubscriberDeleted or tmnxSubscriberRenamed traps. When the windowing trap delayer option is disabled, tmnxTrapDropped traps are delayed using the default trap delay function.

CAUTION

Service Disruption

Modifying the server configuration can have serious consequences including service disruption.
Contact technical support before you attempt to modify the server configuration.

Note: You must perform the procedure on each main server in the NFM-P system.

Note: In a redundant system, you must perform the procedure on the standby main server station first.

6.31.2 Steps

1 Log in to the main server station as the nsp user.
Open a console window.

Navigate to the /opt/nsp/nfmp/server/nms/config directory.

Create a backup copy of the nms-server.xml file.

Open the nms-server.xml file using a plain-text editor.

Locate the section that begins with the following XML tag:
<snmp

Add the following to the section:

```
<i> Note: </i> The checkInterval value must be less than the windowLength value, which must be less than the maxHoldOff value.

<windowingTrapDelayer
  enabled="true"
  checkInterval="interval"
  windowLength="duration"
  maxHoldOff="wait" />

where

interval is the minimum time, in seconds, during which subscriber table resynchronization is prevented; the range is 5 to 30, and the default is 10

duration is the time, in seconds, during which no additional trap drops can be received before subscriber table resyncs are allowed; the range is 5 to 60, and the default is 30

wait is the maximum hold-off time, in seconds, after which subscriber table resynchronization is allowed; the range is 5 to 1800; the default is 60
```

Save and close the nms-server.xml file.

On a standalone main server, or the primary main server in a redundant system, enter the following:

```
bash$ /opt/nsp/nfmp/server/nms/bin/nmsserver.bash read_config
```
The NFM-P puts the configuration change into effect.

10

Close the console window.

END OF STEPS

6.32 To create a default SNMPv2 OmniSwitch user

CAUTION

Service Disruption

Modifying the server configuration can have serious consequences including service disruption.

Contact technical support before you attempt to modify the server configuration.

Note: You must perform the procedure on each main server in the NFM-P system.

Note: In a redundant system, you must perform the procedure on the standby main server station first.

6.32.1 Steps

1

Log in to the main server station as the nsp user.

2

Open a console window.

3

Navigate to the /opt/nsp/nfmp/server/nms/config directory.

4

Create a backup copy of the nms-server.xml file.

5

Open the nms-server.xml file using a plain-text editor.

6

Locate the section that begins with following XML tag:

<snmp
Insert the following before the section end, which is marked by a /> tag:

```xml
snmpV2UserName="username"
```

where `username` is a user name that is configured on the OmniSwitch

**Note:** If the inserted text and end tag are on the same line, you must include a space between the text and the end tag.

The section now reads as follows:

```xml
<snmp
  ip="IPv4_address"
  port="nnnnn"
  ipv6="IPv6_address"
  msgMaxSize="nnnn"
  natEnabled="value"
  trapLogId="nn"
  snmpV2UserName="username" />
```

Save and close the nms-server.xml file.

On a standalone main server, or the primary main server in a redundant system, enter the following:

```bash
bash$ /opt/nsp/nfmp/server/nms/bin/nmsserver.bash read_config
```

The NFM-P puts the configuration change into effect.

Close the console window.

---

**6.33 To enable telemetry reporting for a managed NE**

**6.33.1 Purpose**

Perform this procedure to enable the collection of gRPC telemetry data from one or more NEs by an NSP server. The data is used as statistical input for reporting by the NSP Telemetry application.

The telemetry data from an NE is forwarded over a channel secured using TLS. Establishing the channel requires the distribution of security artifacts to the NE. For information about configuring and managing TLS on an NE, see the device-specific System Management Guide.
Note: Telemetry reporting is sensitive to NE and NSP clock synchronization. To ensure that the Telemetry data from multiple NEs is assigned to the correct reporting period, it is strongly recommended that you engage NTP or a similar mechanism to ensure that the NE and NSP system clocks are synchronized.

### 6.33.2 Steps

#### Prepare security artifacts

1. Obtain the required TLS artifacts. You can use a publicly available utility such as OpenSSL to generate and manage the artifacts, which are the following:
   - public certificate
   - private server certificate

   **Note:** Security certificates signed by a recognized certification authority, or CA, are strongly recommended for a live NFM-P deployment. A self-signed certificate is typically for use only in a lab or trial deployment.

   **Note:** As a certificate renewal reminder, it is important to record the expiry date of each certificate.
   1. Generate an RSA encryption key for the public certificate.
   2. Create a Certificate Signing Request, or CSR, for the public certificate.
   3. Have the CSR signed by a CA.
   4. Generate an RSA encryption key for the private server certificate.
   5. Create a Certificate Signing Request, or CSR, for the private server certificate.
   6. Have the CSR signed by a CA.

   **Note:** The Subject Alternative Name, or SAN, of the private server certificate, must include the IP address of each NE interface that is to establish a gRPC session using the certificate.

2. Log in to the appropriate station as the nsps user.
   - if the NSP system includes the NSD and NRC—primary NSP server
   - if the NSP system includes only the NFM-P—standalone or primary main server

   **Note:** In subsequent steps, the station is called the NSP server station.

3. Open a console window.
Enter the following to create a directory for the security certificate files:

```
bash$ mkdir -p /opt/nsp/os/ssl/certs/telemetry/cert_dir
```

where `cert_dir` is the new directory name

**Note:** Using a name that clearly identifies the certificate set simplifies subsequent certificate management.

Transfer the certificate files to the new directory.

**Enable security on NE**

Log in to the NE as the admin user.

Transfer the certificate files from the NSP server station to the cf3: drive on the NE.

Enter the following to import the public certificate:

```
/admin certificate import type cert input cf3:/CA_cert_file output public_cert_file format pem
```

where

- `CA_cert_file` is the name of the transferred public certificate file
- `public_cert_file` is the public certificate file to create on the NE

Enter the following to import the private server certificate to a file:

```
/admin certificate import type key input cf3:/server_cert_file output private_cert_file format pem
```

where

- `server_cert_file` is the name of the transferred private server certificate file
- `private_cert_file` is the private server certificate file to create on the NE

Create the TLS cipher list.

1. Enter the following:

```
/configure system security tls server-cipher-list "grpc_cipher_list" create
```

2. Enter the following:
Create the certificate profile.
1. Enter the following:
   /configure system security tls cert-profile grpc_cert_profile create
2. Enter the following, in sequence:
   entry 1 create
cert "public_cert_file"
key "private_cert_file"
exit
no shutdown
where
public_cert_file is the file created in Step 8
private_cert_file is the file created in Step 9

Create the server profile.
1. Enter the following:
   /configure system security tls server-tls-profile grpc_tls_profile create
2. Enter the following, in sequence:
cert-profile "grpc_cert_profile"
cipher-list "grpc_cipher_list"
no shutdown

Configure and enable gRPC on NE
1. Enter the following:
   /configure system grpc tls-server-profile grpc_tls_profile
2. Enter the following, in sequence:
   /configure system security user admin access grpc
   /configure system grpc no shutdown

Log out of the NE.

**Add NE to telemetry collector configuration**

15

Log in to the NSP server station as the nsp user.

16

Open the following file using a plain-text editor such as vi:

```
/opt/nsp/os/tomcat/webapps/telemetry-collector/WEB-INF/classes/telemetry_connections.conf
```

**Note:** You can add multiple NEs to the file during one editing session, rather than opening the file repeatedly.

17

Copy an example NE parameter block such as the following:
```
// "NE_system_ID" { //
//   host = NE_interface_IP_address //
//   port = port //
//   trustCertCollectionFile = file //
//   username = user //
//   password = "open-ssl-encoded_password" //
// },
```

18

Paste the section after the last line in the comment section, which reads:
```
// }
```

19

Remove the leading // from each line in the pasted section.

20

To clearly associate the parameters with the NE, replace `NE_system_ID` with an NE identifier such as the system name.
21 Edit the parameters, as required:
• host—IP address of source NE interface
• port—source NE TCP port
• trustCertCollectionFile—absolute file path of public certificate file on NSP server station
• username—name of NE user with gRPC access, for example, admin
• password—OpenSSL-encrypted password of NE user specified by username parameter

**Note:** See the comment section at the head of the file for additional configuration information.

22 Repeat Step 17 to Step 21 to add another NE, if required.

23 If the pasted NE parameter block is the last one in the file, ensure that no comma follows the pasted entry, and that the last line of the entry reads:

```
}
```

**Note:** Each NE parameter block except the last requires a closing comma.

24 Save and close the file. The NSP server configuration is updated.

25 Close the console window.

**END OF STEPS**
System preferences configuration procedures

6.34 To configure NFM-P system preferences

CAUTION
Service Disruption

A system preference setting typically applies globally to an NFM-P system; changing a system preference setting may adversely affect NFM-P operation.

Contact technical support before you attempt to change a System Preferences setting.

Note: Changing a system preference requires a scope of command role with administrator privileges.

6.34.1 Steps

1

Choose Administration→System preferences from the NFM-P main menu. The System Preferences form opens.

The following table lists and describes, by tab, the functions on the System Preferences form, and where to find additional information, if applicable. The table lists the tabs in sequential order as they appear on the form.

Note: The descriptions in the table are general, and not an exhaustive list of the available settings. Specific System Preferences requirements and settings are described in NFM-P procedures, as required.

<table>
<thead>
<tr>
<th>Tab and available settings</th>
<th>See</th>
</tr>
</thead>
<tbody>
<tr>
<td>General</td>
<td></td>
</tr>
</tbody>
</table>
### Table 6-4  NFM-P system preferences  (continued)

<table>
<thead>
<tr>
<th>Tab and available settings</th>
<th>See</th>
</tr>
</thead>
<tbody>
<tr>
<td>GUI form display — tabs shown or hidden by default, whether to allow customization</td>
<td>NSP NFM-P User Guide</td>
</tr>
<tr>
<td>CSV encoding for file export operations</td>
<td></td>
</tr>
<tr>
<td>NE display threshold for equipment groups in navigation tree — maximum NEs displayed in expanded equipment group</td>
<td></td>
</tr>
<tr>
<td>Equipment groups can contain up to 2000 NEs. The GUI navigation tree display a maximum of 500 NEs per group.</td>
<td></td>
</tr>
<tr>
<td>You can set the NE display threshold for Equipment Group parameter to accomplish any of the following:</td>
<td></td>
</tr>
<tr>
<td>• To display all the NEs in equipment groups that contain no more than 500 NEs, set the parameter to 500.</td>
<td></td>
</tr>
<tr>
<td>• To display a small number of NEs per equipment group, set the parameter to a low value. The minimum setting is 2. You can use the NE list form to access and manage the NEs in the group, and you can show additional NEs in the tree if required. See “To manage NEs in equipment groups on the navigation tree” in the NSP NFM-P User Guide.</td>
<td></td>
</tr>
<tr>
<td>• To allow the display of enough NEs to meet your typical requirements while also allowing additional NEs to show in the tree if necessary, set the parameter to a value in the middle of the range. This is useful if you have more than 500 NEs in a group. For example, if the parameter is set to 300, then 300 of the NEs in the group are displayed in the tree. You can select and display up to 200 additional NEs in that group before the limit of 500 is reached. Select the additional NEs to show in the tree from the NE list form for the group; see “To manage NEs in equipment groups on the navigation tree” in the NSP NFM-P User Guide.</td>
<td></td>
</tr>
</tbody>
</table>

You must close and re-open the NFM-P client for changes to the NE display threshold for Equipment Group parameter to take effect. The change is propagated to all GUI clients during the next client startup.

### Services

NFM-P component configuration

System preferences configuration procedures

To configure NFM-P system preferences
Table 6-4  NFM-P system preferences  (continued)

<table>
<thead>
<tr>
<th>Tab and available settings</th>
<th>See</th>
</tr>
</thead>
<tbody>
<tr>
<td>Default behavior for the following service functions:</td>
<td>NSP NFM-P User Guide</td>
</tr>
<tr>
<td>• Composite services:</td>
<td></td>
</tr>
<tr>
<td>- Allow or suppress the auto discovery of Spoke, CCAG, SCP, or RVPLS connectors.</td>
<td></td>
</tr>
<tr>
<td>- Enable or disable the use of VRF Route Target connections.</td>
<td></td>
</tr>
<tr>
<td>- Specify whether service alarms are aggregated in composite services.</td>
<td></td>
</tr>
<tr>
<td>• Service bandwidth management:</td>
<td></td>
</tr>
<tr>
<td>- Allow or suppress multi-segment tunnel selection.</td>
<td></td>
</tr>
<tr>
<td>- Enable or disable Service Bandwidth Management (CAC).</td>
<td></td>
</tr>
<tr>
<td>• Specify the maximum of sites that can be moved from one service to another when reducing the overall size of a particular service; the default is 25.</td>
<td></td>
</tr>
<tr>
<td>• Specify the default priority of a service when creating a service; the default is set to Low.</td>
<td></td>
</tr>
<tr>
<td>• Allow or suppress VPRN SNMP Community string warnings and alarms.</td>
<td></td>
</tr>
<tr>
<td>• Allow or suppress the automatic removal of an empty service.</td>
<td></td>
</tr>
<tr>
<td>• Enable or disable the use of multi-segment tunnel selection functionality.</td>
<td></td>
</tr>
<tr>
<td>• Specify if a site name and description are to be added when a service is created.</td>
<td></td>
</tr>
<tr>
<td>• Allow or suppress Route Target Reservation alarms.</td>
<td></td>
</tr>
<tr>
<td>• Enable or disable if a service or service site can be deleted if the service or service site has any child objects such as SAPs, SDP bindings, policies, or any other objects related to the service CLI hierarchy. When enabled, you must first delete all child objects before the service or service site can be deleted. This preference only applies to services or service site associated with SROS-based devices.</td>
<td></td>
</tr>
<tr>
<td>• Specify if a Service Name is to be added to the Site Name when sites are added to a service.</td>
<td></td>
</tr>
<tr>
<td>TCA</td>
<td>NSP NFM-P User Guide</td>
</tr>
<tr>
<td>Allows you to configure the default behavior associated with configuring TCA policies such as specifying the maximum TCA limit, the TCA reset synchronization time or reset interval, and the default TCA severity.</td>
<td></td>
</tr>
<tr>
<td>Statistics</td>
<td>NSP NFM-P Statistics Management Guide</td>
</tr>
<tr>
<td>Allows you to configure the default behavior associated when exporting statistics files, such as specifying the log file retention and rollover times.</td>
<td></td>
</tr>
<tr>
<td>Allows you to enable or disable the database storage of statistics; when database storage is disabled for a statistics type, the statistics data is retained only temporarily on a main or auxiliary server, and must be retrieved using the registerLogToFile XML API method</td>
<td></td>
</tr>
<tr>
<td>The Accumulate time over suspect intervals parameter specifies how to manage the Periodic Time of the first valid statistics record after a suspect collection of the record. When the parameter is enabled, the Periodic Time of a record increases by the collection interval length after each consecutive suspect collection. Consequently, the periodic data values in the first valid record are averaged over a greater time span to yield a more realistic value.</td>
<td></td>
</tr>
<tr>
<td>Allows you to configure the number of JMS client connection checks that are performed when exporting statistics files before a registerLogToFile request is automatically de-registered.</td>
<td></td>
</tr>
</tbody>
</table>

NSP NFM-P component configuration
System preferences configuration procedures
To configure NFM-P system preferences
### Table 6-4 NFM-P system preferences (continued)

<table>
<thead>
<tr>
<th>Tab and available settings</th>
<th>See</th>
</tr>
</thead>
<tbody>
<tr>
<td>Allows you to specify whether the accounting policy ID is included in each accounting statistics record. The function enables OSS applications to use XML API filters based on the policy ID, if required.</td>
<td>NSP NFM-P Statistics Management Guide NSP NFM-P XML API Developer Guide</td>
</tr>
<tr>
<td><strong>Bin Alarm</strong></td>
<td></td>
</tr>
<tr>
<td>Allows you to configure the maximum Bin Alarm limit, reset synchronization time, reset interval, and alarm severity.</td>
<td>NSP NFM-P User Guide</td>
</tr>
<tr>
<td><strong>Analytics</strong></td>
<td></td>
</tr>
<tr>
<td>Allows you to configure and enable a regular purge of scheduled NSP Analytics reports, and purge outdated reports on demand.</td>
<td>Chapter 7, “NFM-P database management”</td>
</tr>
<tr>
<td><strong>Test Manager</strong></td>
<td></td>
</tr>
<tr>
<td>Allows you to configure the default retention time for dB test results and target test results and log files performed with the Service Test Manager and which test results are stored.</td>
<td>NSP NFM-P User Guide</td>
</tr>
<tr>
<td><strong>User Activity</strong></td>
<td></td>
</tr>
<tr>
<td>Allows you to configure how much user activity log information the NFM-P stores before purging information, and how long to retain the information.</td>
<td>3.4 “User activity logging” (p. 32)</td>
</tr>
<tr>
<td><strong>OLC</strong></td>
<td></td>
</tr>
<tr>
<td>Allows you to configure the default behavior associated with OLC state of an object that is undergoing commissioning or maintenance. You can configure the following:</td>
<td>14.66 “To schedule an OLC state change” (p. 415)</td>
</tr>
<tr>
<td>• In the Automatic OLC State Change panel, enable or disable the Enable Automatic OLC State change parameter to indicate whether the OLC state is automatically set to maintenance when the following actions occur:</td>
<td></td>
</tr>
<tr>
<td>- When the Administrative state is down.</td>
<td></td>
</tr>
<tr>
<td>- If the status of the parent object is set to administratively down.</td>
<td></td>
</tr>
<tr>
<td>- If the affecting object administrative state is down.</td>
<td></td>
</tr>
<tr>
<td>If the Enable Automatic OLC State change parameter is enabled, a Shut Down action sets the object OLC state to Maintenance and a Turn Up action sets the object OLC state to In Service. This state change is also applied to any child objects, unless the child object OLC state is locked in maintenance mode.</td>
<td></td>
</tr>
<tr>
<td>• In the OLC Scheduling panel, for scheduled objects that are set to maintenance mode, enable the Create Info Alarm Prior to OLC Revert, if an info alarm is to be raised prior to an OLC revert and the lead time of the alarm notification before reverting.</td>
<td></td>
</tr>
<tr>
<td>• In the OLC Scheduling panel, you can customize the three revert times that appear for the Revert OLC State parameter in the in the OLC panel on service and network object properties forms.</td>
<td></td>
</tr>
<tr>
<td><strong>Policies</strong></td>
<td></td>
</tr>
</tbody>
</table>
### Table 6-4  NFM-P system preferences (continued)

<table>
<thead>
<tr>
<th>Tab and available settings</th>
<th>See</th>
</tr>
</thead>
<tbody>
<tr>
<td>Allows you to display or hide the policy names on policy configuration forms for the following:</td>
<td></td>
</tr>
<tr>
<td>• Access ingress and access egress policies</td>
<td>NSP NFM-P User Guide</td>
</tr>
<tr>
<td>• ACL IP, ACL IPv6, and ACL MAC policy filters</td>
<td></td>
</tr>
<tr>
<td>• QoS network policies</td>
<td></td>
</tr>
<tr>
<td>Allow you to set a restriction in the distribution mode for certain types of local policies that will permit local editing only. Additionally, the following applies to this system preference configuration:</td>
<td></td>
</tr>
<tr>
<td>• Policy types supported by this system preference include Access Ingress, Access Egress, Network QoS, ACL MAC, ACL IPv4, and ACL IPv6.</td>
<td></td>
</tr>
<tr>
<td>• When creating any of these policies, if you set the Scope parameter to exclusive, the NFM-P will set the distribution mode to local edit.</td>
<td></td>
</tr>
<tr>
<td>• The NFM-P will not allow policies with the Scope parameter set to exclusive to be assigned or used more than once.</td>
<td></td>
</tr>
<tr>
<td>• If you attempt to set the Policy Distribution Mode to Sync With Global while the Scope attribute is configured as exclusive, an error message will result.</td>
<td></td>
</tr>
<tr>
<td>Allow you to specify that for policy changes made using CLI, to switch the distribution mode for certain types of local policies to Local Edit Only, as opposed to the default Sync with Global mode.</td>
<td></td>
</tr>
<tr>
<td>Allows you to configure the automatic distribution of a global policy to applicable NEs once the policy is released.</td>
<td></td>
</tr>
<tr>
<td>Allows you to configure the maximum number of scheduled audit results stored for a local policy.</td>
<td></td>
</tr>
<tr>
<td>Allows you to enable or disable if all zones are re-synchronized from the node as local edit only. If you disable the Discover Security Zone in Local Edit Only parameter, all zones re-synchronized from the node are set to Sync With Global.</td>
<td></td>
</tr>
<tr>
<td>• The Discover Security Zone in Local Edit Only parameter is only supported on the 7705 SAR-8 with CSMv2, 7705 SAR-8v2 with CSMv2, 7705 SAR-18, 7705 SAR-H, 7705 SAR-Hc, and 7705 SAR-Wx variants, Release 6.1 R1 or later.</td>
<td></td>
</tr>
<tr>
<td><strong>Custom NE Properties</strong></td>
<td></td>
</tr>
<tr>
<td>Allows you to configure if custom property labels and values are used to identify an NE, for example, the location and site name that differs from the actual NE site name. These properties cannot be configured on the NE. Additionally, the following applies to this system preference configuration:</td>
<td></td>
</tr>
<tr>
<td>• If custom property labels are not configured, the default labels are used.</td>
<td></td>
</tr>
<tr>
<td>• NE custom properties support the extended character set including multi-byte characters.</td>
<td></td>
</tr>
<tr>
<td>• Custom property labels and values are displayed in the following locations:</td>
<td></td>
</tr>
<tr>
<td>- NE Properties form</td>
<td></td>
</tr>
<tr>
<td>- NE List form</td>
<td></td>
</tr>
<tr>
<td>ESM</td>
<td></td>
</tr>
</tbody>
</table>
Table 6-4  NFM-P system preferences  (continued)

<table>
<thead>
<tr>
<th>Tab and available settings</th>
<th>See</th>
</tr>
</thead>
<tbody>
<tr>
<td>Allows you to configure the default behavior associated with the on-demand retrieval of residential subscriber-related information from NEs such as: • The tracked subscriber retrieval timeout interval • The subscriber host retrieval timeout interval • The maximum number of residential subscriber instances returned via XML API • If managed route information is to be collected • If QoS override information is to be collected • If SLAAC host addresses are to be collected • If access loop encapsulations are to be collected • If BGP peer information is to be collected</td>
<td>NSP NFM-P User Guide</td>
</tr>
<tr>
<td>WMM</td>
<td>Allows you to configure the default behavior for the following NFM-P LTE EPC functions: • Enable or disable the automatic creation of physical links by the NFM-P between SRS and MME 9471 WMMs. • The time-to-live time interval for PM statistics on WMM nodes. • Enable or disable automatic PM file retrieval on discovery or manage to automatically collect any PM files that were missed during an out-of-service software upgrade. • Set the timeout value for on-demand EPS peers queries.</td>
</tr>
<tr>
<td>Multi Vendor</td>
<td>Allows you to configure the Enforce SysObjectId Validation on Driver Module parameter. The parameter specifies whether a driver replacement will be blocked if the SysObjectIds do not match.</td>
</tr>
<tr>
<td>MPR</td>
<td>Allows or denies user-access to configure Wavence devices using a Local Craft Terminal (LCT). This prevents multi-write access sessions on Wavence devices. You can also enable or disable if the NFM-P receives LAC alarms from the nodes.</td>
</tr>
<tr>
<td>Application Assurance</td>
<td>Allows you to configure the default behavior for the following NFM-P AA functions: • The database persisted transit IP address retrieval time interval • The database persisted transit prefix address retrieval time interval • The maximum number of database transit subscribers returned via XML API</td>
</tr>
<tr>
<td>NFV</td>
<td>Allows you to configure automatic healing and automatic scale-out for the VMM and VMG. You can enable the functions and configure timers to limit the frequency at which automatic scale-out or healing is attempted.</td>
</tr>
<tr>
<td>PCMD</td>
<td></td>
</tr>
</tbody>
</table>
Table 6-4  NFM-P system preferences  (continued)

<table>
<thead>
<tr>
<th>Tab and available settings</th>
<th>See</th>
</tr>
</thead>
<tbody>
<tr>
<td>Allows you to configure the global 7750 SR MG PCMD collection settings, which include the following:</td>
<td>NFM-P User Guide</td>
</tr>
<tr>
<td>• PCMD auxiliary server UDP port to which the PCMD records are sent by NEs</td>
<td></td>
</tr>
<tr>
<td>• CSV file retention and rollover periods</td>
<td></td>
</tr>
<tr>
<td>• criteria for raising disk usage alarms</td>
<td></td>
</tr>
<tr>
<td>• CSV file parameters</td>
<td></td>
</tr>
<tr>
<td>Network Group Encryption</td>
<td></td>
</tr>
<tr>
<td>Allows you to set the NGE version</td>
<td>NFM-P User Guide</td>
</tr>
</tbody>
</table>

2 Configure the required parameters. Information about system preferences parameters is available in the NFM-P User Guide appendix, and in the online help Parameter Search Tool.

3 As required, click on the appropriate tab to configure another system preference.

4 Click OK to save your changes and close the form.

END OF STEPS
NFM-P component configuration
System preferences configuration procedures
To configure NFM-P system preferences
7 NFM-P database management

7.1 Overview

7.1.1 Purpose
This chapter describes the NFM-P databases and how to manage the associated data integrity and security functions.

7.1.2 Contents

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>7.1 Overview</td>
<td>199</td>
</tr>
<tr>
<td>NFM-P database management</td>
<td>201</td>
</tr>
<tr>
<td>7.2 Overview</td>
<td>201</td>
</tr>
<tr>
<td>7.3 Main database</td>
<td>201</td>
</tr>
<tr>
<td>7.4 Auxiliary database</td>
<td>202</td>
</tr>
<tr>
<td>NFM-P database management procedures</td>
<td>203</td>
</tr>
<tr>
<td>7.5 Workflow for NFM-P database management</td>
<td>203</td>
</tr>
<tr>
<td>7.6 To view the main database properties</td>
<td>205</td>
</tr>
<tr>
<td>7.7 To view the auxiliary database status using the client GUI</td>
<td>206</td>
</tr>
<tr>
<td>7.8 To view the auxiliary database status using a CLI</td>
<td>207</td>
</tr>
<tr>
<td>7.9 To configure the allowed number of Oracle database login attempts</td>
<td>208</td>
</tr>
<tr>
<td>7.10 To unlock the Oracle database user account</td>
<td>210</td>
</tr>
<tr>
<td>7.11 To configure Oracle database error monitoring</td>
<td>211</td>
</tr>
<tr>
<td>7.12 To configure a size constraint policy</td>
<td>212</td>
</tr>
<tr>
<td>7.13 To configure an ageout constraint policy</td>
<td>213</td>
</tr>
<tr>
<td>7.14 To create a database file policy to manage database log or core dump files</td>
<td>215</td>
</tr>
<tr>
<td>7.15 To configure the purging of scheduled NSP Analytics reports</td>
<td>216</td>
</tr>
<tr>
<td>7.16 To configure the statistics data retention period for the main database</td>
<td>217</td>
</tr>
<tr>
<td>7.17 To back up the main database from the client GUI</td>
<td>217</td>
</tr>
<tr>
<td>7.18 To back up the main database from a CLI</td>
<td>220</td>
</tr>
<tr>
<td>7.19 To back up an auxiliary database</td>
<td>222</td>
</tr>
<tr>
<td>7.20 To schedule main database backups</td>
<td>223</td>
</tr>
<tr>
<td>7.21 To schedule auxiliary database backups</td>
<td>224</td>
</tr>
</tbody>
</table>
NFM-P database management

7.2 Overview

7.2.1 References
The NFM-P uses the following databases to store network data such as object configurations, device backups, and statistics:
- main database
- auxiliary database
See the following for more information:
- NSP NFM-P Planning Guide—platform and network requirements
- NSP NFM-P Installation and Upgrade Guide—deployment information
- NSP NFM-P Troubleshooting Guide—troubleshooting information
- NSP NFM-P Alarm Search Tool—alarm descriptions, raising and clearing conditions, and remedial actions

7.3 Main database

7.3.1 Description
An NFM-P system requires a central database for persistent storage. The database can be on the same station as the main server, or on a separate station. A redundant NFM-P system has two main databases that are synchronized in a primary-standby configuration to limit data loss in the event of a failure.
You can manage the following database functions and parameters:

- security
- statistics data retention
- data synchronization
- backups and restores
- historical record retention
- object ageout
- log storage
- error monitoring
- alarm handling

7.3.2 Main database safeguards
In addition to the protection of system redundancy, the NFM-P has mechanisms that raise alarms for the following:
- database disk and tablespace capacity issues
- redundancy events, misconfiguration, and failures
- database backup misconfiguration and failures
- archive log management actions and failures
- internal errors that may represent a security risk
- size constraint and ageout constraint policy violations
Note: The password for the main database user, which is named samuser by default at installation, expires after 180 days.

7.4 Auxiliary database

7.4.1 Description
An auxiliary database provides additional statistics data storage, and is required for functions such as NSP Analytics. The database is deployed on one or more stations, depending on the scale requirements.

From the NFM-P client GUI, you can do the following.
• View the status of each auxiliary database station.
• Perform manual and scheduled database backups.

7.4.2 Auxiliary database safeguards
The following safeguards provide auxiliary database fault tolerance:
• hardware redundancy in a multi-station auxiliary database
• data replication among the stations in a multi-station auxiliary database
• manual and scheduled database backups

Backups and restores
An auxiliary database backup operation backs up all data on each auxiliary database station. Scheduled backups are typically not required in a multi-station auxiliary database deployment, because the database data is replicated among multiple stations.

A single-station auxiliary database, however, has no hardware redundancy, so requires regular backups to ensure that data loss is minimal after a failure.

See 7.21 “To schedule auxiliary database backups” (p. 224) for information about enabling scheduled backups, and 7.19 “To back up an auxiliary database” (p. 222) for information about performing an on-demand auxiliary database backup.

Note: Scheduled auxiliary database backups are disabled by default.

Although an auxiliary database may be distributed among multiple stations, a database restore operation is initiated on one station, and automatically replicates the restored data among the other stations, as required.

See 14.23 “To restore an auxiliary database” (p. 339) for information about restoring an auxiliary database.

Fault detection
To detect a database failure or a connectivity loss, the NFM-P monitors each auxiliary database station, and raises an alarm for the following:
• station unavailability
• database unavailability
NFM-P database management procedures

7.5 Workflow for NFM-P database management

7.5.1 Process

Viewing database properties and status

1. Display the main database properties; see 7.6 “To view the main database properties” (p. 205).

2. Display the auxiliary database properties; see 7.7 “To view the auxiliary database status using the client GUI” (p. 206) and 7.8 “To view the auxiliary database status using a CLI” (p. 207).

Configuring database operation and security

3. As a security precaution, configure the number of failed Oracle database user login attempts that the NFM-P allows before a user is locked out; see 7.9 “To configure the allowed number of Oracle database login attempts” (p. 208).

4. Configure how the NFM-P responds to Oracle database errors; see 7.11 “To configure Oracle database error monitoring” (p. 211).

5. Configure size constraint policies to regulate the number of records retained in the main database; see 7.12 “To configure a size constraint policy” (p. 212).

6. Configure ageout constraint policies to define a configurable ageout time for a specific object type in the main database; see 7.13 “To configure an ageout constraint policy” (p. 213).

7. Manage main database disk usage by configuring policies to manage the file size and number of archive log and core dump files; see 7.14 “To create a database file policy to manage database log or core dump files” (p. 215).

8. Configure the statistics data retention period for the main database; see 7.16 “To configure the statistics data retention period for the main database” (p. 217).
If the NFM-P system includes one or more analytics servers, configure the NFM-P to regularly purge the outdated scheduled analytics reports from the main database; see 7.15 “To configure the purging of scheduled NSP Analytics reports” (p. 216).

Backup, restore, and general maintenance

10 Perform an immediate full or partial main database backup; see 7.17 “To back up the main database from the client GUI” (p. 217) or 7.18 “To back up the main database from a CLI” (p. 220).

11 Schedule a regular main database backup; see 7.20 “To schedule main database backups” (p. 223).

12 Back up an auxiliary database; see 7.19 “To back up an auxiliary database” (p. 222).

13 Schedule regular auxiliary database backups; see 7.21 “To schedule auxiliary database backups” (p. 224).

14 Restore the main database in a standalone system; see 14.30 “To restore a standalone main database” (p. 353).

15 Restore the main database in a redundant system; see 14.31 “To restore the primary main database in a redundant system” (p. 362).

16 Restore an auxiliary database; see 14.23 “To restore an auxiliary database” (p. 339)

17 Test the main database restore function to ensure that main database backups are viable in the event of a failure; see 12.6 “To test a main database restore” (p. 284).

18 Verify the synchronization of NE and main database information; see 11.6 “To verify main database information” (p. 277).
**Incidental tasks**

19

As required, unlock the Oracle database user account due to multiple login failures; see 7.10 “To unlock the Oracle database user account” (p. 210).

20

Manage main database redundancy in a redundant system:

- Perform a main database switchover; see 8.10 “To configure main database switchover behavior” (p. 251), 8.11 “To perform a main database switchover using the NFM-P client GUI” (p. 252), or 8.12 “To perform a main database switchover using a CLI script” (p. 253).
- Enable or disable automatic database realignment on a main server; see 8.13 “To enable or disable automatic database realignment” (p. 254).
- Re-establish redundancy after a database activity switch or similar maintenance activity; see 14.32 “To reinstantiate the main database from the client GUI” (p. 373) and 14.33 “To reinstantiate the main database from a CLI” (p. 374).

21

Troubleshoot main database problems such as corruption, failure, disk space shortage, or performance degradation. See the NFM-P Troubleshooting Guide.

**7.6 To view the main database properties**

**7.6.1 Steps**

1

Choose Administration→Database from the NFM-P main menu. The Database Manager (Edit) form opens and displays information that includes the following:

- Database Name
- Instance Name
- Listener Port—the port on the main server for database communication
- DBID—the Oracle database ID, sometimes called the SID
- Creation Time—the database creation time
- Version—the Oracle version identifier
- IP Address—the database IP address that the main and auxiliary servers use
- Host Name—the database station hostname
- Open Mode—specifies the type of database access
- Archive Log Mode—specifies whether to archive the database log files; configured during database installation
- Protection Mode—the database protection mode, which cannot be changed
To view the auxiliary database status using the client GUI

7.7.1 Purpose

Perform this procedure to display information about an auxiliary database in the NFM-P client GUI.

7.7.2 Steps

1. Choose Administration→Database from the NFM-P main menu. The Database Manager form opens.

2. Click on the Auxiliary Database Cluster tab. The auxiliary database station clusters are listed.

3. Select a cluster and click Properties. The Auxiliary Database Cluster (View) form opens.

4. Click on the Auxiliary Databases tab. The auxiliary database stations in the cluster are listed.

5. Select an auxiliary database station and click Properties. The Auxiliary Database (View) form opens.

6. View the State and Connectivity State indicators. During normal operation, the indicators display:
   • State—Up
   • Connectivity State—Online

   If the indicators display different values, contact technical support for assistance.
7.8 To view the auxiliary database status using a CLI

7.8.1 Purpose

Perform this procedure to display auxiliary database status information using a CLI on a main server or an auxiliary database station.

7.8.2 Steps

1. To display the status on a main server station:
   1. Log in to a main server station as the nsp user.
   2. Open a console window.
   3. Enter the following:

```
bash$ /opt/nsp/nfmp/server/nms/bin/nmsserver.bash -s nms_status
```

The main server status output includes the following auxiliary database information:

```
-- Auxiliary Database Information
   -- Auxiliary Database Enabled: Yes

-- Auxiliary Database Servers Information
   -- Auxiliary Database Server: internal_IP_1
      Auxiliary Database Server Status: Up
      Auxiliary Database Server Connectivity Status: ONLINE
   -- Auxiliary Database Server: internal_IP_2
      Auxiliary Database Server Status: Up
      Auxiliary Database Server Connectivity Status: ONLINE
   .
   .
   .

   -- Auxiliary Database Server: internal_IP_n
      Auxiliary Database Server Status: Up
      Auxiliary Database Server Connectivity Status: ONLINE
```

4. View the information.
5. If any Auxiliary Database Server Status is not Up, or any Server Connectivity Status is not ONLINE, contact technical support for assistance.
6. Close the console window.
To display the status on an auxiliary database station:

1. Log in to an auxiliary database station as the root user.
2. Open a console window.
3. Enter the following:
   
   ```
   # /opt/nsp/nfmp/auxdb/install/bin/auxdbAdmin.sh status
   
   The script displays the following:
   
   Copyright 20XX Nokia.
   
   Database status
   
   Node | Host | State | Version | DB
   --------+-------+-------+---------+-------
   host_IP_1 | internal_IP_1 | STATE | version | name
   host_IP_2 | internal_IP_2 | STATE | version | name
   host_IP_n | internal_IP_n | STATE | version | name
   
   Output captured in log_file
   
   4. View each STATE value.
   5. If any STATE is not UP, contact technical support for assistance.

Close the console window.

7.9 To configure the allowed number of Oracle database login attempts

7.9.1 Purpose

As a security precaution, you can configure the allowed number of Oracle database user login attempts before the user account is locked because of failed attempts. See 7.10 “To unlock the Oracle database user account” (p. 210) for information about how to reset the Oracle database user account.

Note: In a redundant deployment, you must perform this procedure on the primary database station. After you perform the procedure, the primary database automatically copies the configuration change to the standby database. The configuration changes that you make in this procedure are not affected by subsequent database upgrades.
### 7.9.2 Steps

1. **Log in to the main database station as the Oracle management user.**

2. **Open a console window.**

3. **Enter the following:**
   
   ```bash
   bash$ /opt/nsp/nfmp/db/install/config/samdb/SAMDb_security.sh
   ```

   The following prompt is displayed:

   Please select one of the following options:

   1) Setting failed login attempts
   2) Unlock database user
   0) Exit

   Please enter (1,2 or 0): 

4. **Enter 1.**

   The following prompt is displayed:

   Please select one of the following options:

   1) Setting the number of failed login attempts
   2) Remove the number of failed login attempts setting (no checking)
   0) Exit

   Please enter (1,2 or 0):

5. **To specify the allowed number of login failures, perform the following steps.**

   1. **Enter 1.**

      The following prompt is displayed:

      This value will be used for setting the number of failed login attempts before locking the database user account.

      Please enter value for number of failed login attempts (20 to 1000) (30):

   2. **Specify a value between 20 and 1000 and press .**

      The following messages are displayed:

      About to change the Oracle database user settings
      Completed changing the Oracle database user settings
3. Go to Step 7.

6. To disable checking for failed login attempts, enter 2 ↵.
   The following messages are displayed, and the NFM-P no longer locks the Oracle database user account after multiple login failures.
   About to change the Oracle database user settings
   Completed changing the Oracle database user settings

7. Close the console window.

END OF STEPS

7.10 To unlock the Oracle database user account

7.10.1 Purpose
   Perform this procedure to unlock the Oracle database user account after the user account is locked out because of multiple login failures. See 7.9 “To configure the allowed number of Oracle database login attempts” (p. 208) for information about how to configure the allowed number of Oracle database user login attempts.

7.10.2 Steps

1. Log in to the main database station as the Oracle management user.

2. Open a console window.

3. Enter the following:
   bash$ /opt/nsp/nfmp/db/install/config/samdb/SAMDb_security.sh ↵
   The following prompt is displayed:
   Enter the password for the "sys" user (terminal echo is off):

4. Enter the Oracle SYS user password and press ↵.
   The following prompt is displayed:
   Please select one of the following options:
     1) Setting failed login attempts
2) Unlock database user
0) Exit
Please enter (1, 2 or 0):

5

Enter 2 ↵.
The following messages are displayed, and the Oracle database user account is unlocked.
About to unlock the database user username
Completed unlocking the database user username

6

Close the console window.

END OF STEPS

7.11 To configure Oracle database error monitoring

7.11.1 Purpose
You can configure how the NFM-P handles Oracle database errors to provide monitoring information that may help with troubleshooting or the detection of security violations such as SQL injection attacks. When database error monitoring is enabled, the NFM-P raises an alarm when the Oracle software reports an error, for example, an invalid SQL statement.

7.11.2 Steps

1

Choose Administration→Database from the NFM-P main menu. The Database Manager (Edit) form opens.

2

To enable database error monitoring, select the Enable Database Error Monitoring parameter.

3

To disable database error monitoring, deselect the Enable Database Error Monitoring parameter.

4

Save your changes and close the form.

END OF STEPS
7.12 To configure a size constraint policy

7.12.1 Purpose

Size constraint policies regulate the number of historical records that the main database retains before they are purged. The scheduling of tasks through the NFM-P can generate a large volume of archived result information if left unchecked. Size constraint policies control the volume of information stored by defining thresholds for various record classes. When the number of records for a specific class or group of classes reaches a threshold specified in the policy, the NFM-P deletes a specified number of the oldest objects that are associated with the class or group of classes.

7.12.2 Steps


2. Click Create or choose a policy and click Properties. The Size Constraint Policy (Create | Edit) form opens.

   Note: The NFM-P is preconfigured with the following default size constraint policies for various record classes:
   - Script Management Results
   - Clear Requests
   - CPAM Protocol Data
   - Work Order Import Logs
   - LTE User Stats Query Output Snapshots

3. Configure the general policy parameters.

4. Click on the Constrained Packages tab.

5. Right-click on the Size Constraint Policy icon and choose Select Packages.

6. Choose a size constraint package and click OK. The package appears in the navigation tree under the Size Constraint policy. Go to Step 7 if the package selected supports a sub-class package, for example, the dhcp package supports three sub-class packages. Otherwise, go to Step 9.
7. Right-click on the package icon and choose Select Classes. The Select Size Constrained Classes form opens.

8. Choose a sub-class package and click OK to Save your changes and close the form.

9. Close the Size Constraint Policy (Create|Edit) form.

END OF STEPS

7.13 To configure an ageout constraint policy

7.13.1 Purpose

An ageout constraint policy defines the database ageout period for a specific object type. When the age of an object reaches the ageout value, the NFM-P deletes the object from the database.

The NFM-P supports ageout constraint policies to define the period of time the database retains persisted virtual network objects. These policies are the dcrt policies listed below. See the NFM-P VSAP User Guide for more information about virtual network object persistence in data center networks.

Note: The NFM-P has a number of preconfigured ageout constraint policies.

7.13.2 Steps


3. Review the Object Count information in the Status panel. The information refers to the most recent object deletion, and can help you define the appropriate ageout time and deletion interval values for the policy.

4. Configure the parameters.

Note: The default Qualified Ageout Time for non-DC object types is:

• 24 hours, if the NSP Analytics application is not enabled
• 1464 hours, if the NSP Analytics application is enabled
  The default value does not change when the Analytics application is enabled using a
different method, in which case the value must be changed manually to enable
optimum NFM-P and NSP Analytics interoperation.
The Qualified Ageout Time defaults are guidelines. Consider the following when setting
the Qualified Ageout Time:
• A small value can prevent excessive database table growth.
• The value must be great enough to allow sufficient time to upload the database records
to a third-party application.

5
Save your changes and close the form.

6

CAUTION

Service Disruption

Modifying the server configuration can have serious consequences including service disruption.
Contact technical support before you attempt to modify the server configuration.
If required, edit the ageout constraint policy configuration file to modify the following parameters
in the Deletion Interval panel:
• Synchronization Time—shown as ageoutSyncTime in the configuration file
• Interval (hours)—shown as ageoutInterval in the configuration file

Note: You must perform the following steps on each main server in the NFM-P system.
1. Log in to the main server station as the nsp user.
2. Open a console window.
3. Navigate to the /opt/nsp/nfmp/server/nms/config directory.
4. Open the AgeoutConstraints.xml file using a plain-text editor.
5. Locate the following XML tag:
   <ageout>
6. Locate the object class section that you need to modify; the following code shows the
   residential subscriber instance object class as an example:
   <class name="ressubscr.ResidentialSubscriberInstance"
   ageoutSyncTime="00:00"
   ageoutInterval="1">
   /class>
7. Modify the ageoutSyncTime and ageoutInterval values, as required.
8. Save and close the AgeoutConstraints.xml file.
9. On a standalone main server, or the primary main server in a redundant system, enter the following:

```
bash$ /opt/nsp/nfmp/server/nms/bin/nmsserver.bash read_config
```

The NFM-P puts the configuration change into effect.

10. Close the console window.

---

7.14 To create a database file policy to manage database log or core dump files

7.14.1 Purpose

You can create database file policies to manage the file size and number of archives for stored alert, listener, trace, audit, and core dump files. When the size and number of files are left unbounded, excessive database disk capacity is consumed.

Database trace, alert, and audit log files are compressed and stored in the alert log directory. Database listener log files are stored in the listener log directory.

**Note:** For historical or troubleshooting purposes, recommends that you archive the main database log files on a regular basis.

7.14.2 Steps

1. Choose Administration→Database from the NFM-P main menu. The Database Manager (Edit) form opens.

2. Click on the File Policies tab.

3. Click Database File Policies or choose a default policy and click Properties. The Database File Policies Create | Edit) form opens. If you selected a default policy, go to Step 5.

4. Click Create.

5. Configure the required general file policy parameters and Purge Details panel parameters.

6. Click OK to save your changes and close the form.
7.15 To configure the purging of scheduled NSP Analytics reports

7.15.1 Purpose

Scheduled NSP Analytics reports are stored in the main database. Outdated reports consume
database capacity unnecessarily. Perform this procedure to configure the automatic daily deletion of
outdated reports, or to delete the outdated reports on demand.

7.15.2 Steps

1. Choose Administration→System Preferences from the NFM-P main menu. The System
Preferences form opens.

2. Click on the Analytics tab.

3. Configure the Analytics Report Results Retention parameter to specify the number of days to
keep the reports.

   Note: The daily purge operation removes reports that predate the retention value. For
   example, a value of 3 specifies a purge of reports that are four or more days old.

4. Select the Enable Analytics Report Results Scheduled Purge parameter.

   Note: The time at which the daily purge occurs is the time of day at which you enable the
   purge by clicking OK or Apply on the form.

   Note: In the event of a main server restart, the purge start time changes to the server
   initialization time.

5. If required, use the Purge Results Now button to delete the reports that predate the specified
retention period. The NFM-P deletes the outdated reports.
6 Click OK to save your changes and close the System Preferences form. The daily report purge is enabled.

END OF STEPS

7.16 To configure the statistics data retention period for the main database

7.16.1 Steps

1 Choose Administration→Database from the NFM-P main menu. The Database Manager (Edit) form opens.

2 CAUTION

Service Disruption

Configuring the parameter can seriously affect NFM-P system performance.
Consult technical support before you configure the parameter.

Configure the Accounting Statistic Data Retention Period (Days) parameter.

3 Save your changes and close the Database Manager (Edit) form.

END OF STEPS

7.17 To back up the main database from the client GUI

7.17.1 Purpose

Perform this procedure to initiate an on-demand main database backup using the client GUI. You can perform a full backup, which includes the entire database, or a partial backup, which excludes accounting statistics data.
CAUTION

Service Disruption

The disk partition that is to contain the database backup must have sufficient space for the database backup file set.

Ensure that the backup directory is at least five times as large as the expected database backup size. For more information, contact technical support or see the NFM-P Planning Guide.

Note: The NFM-P backs up the Oracle encryption wallet during a database backup, and restores the wallet during a database restore. In a redundant deployment, the NFM-P automatically replicates the encryption wallet from the primary to the standby database after the standby database reinstatation.

Note: In an NSP system that does not include the NSD and NRC, a main database backup performed using the NFM-P client GUI also backs up the local Neo4j and PostgreSQL databases; a backup performed from a CLI does not. The Neo4j and PostgreSQL backup files are stored on the standalone or primary main server in the /opt/nsp/os/backup directory.

Note: During a database backup, the performance of GUI or XML API operations may be affected. It is recommended that you perform a database backup only during a period of low NFM-P activity.

7.17.2 Steps

1
Choose Administration→Database from the NFM-P main menu. The Database Manager form opens.

2
Click on the Backup tab.

3

CAUTION

Data Loss

Before the NFM-P performs a database backup, it deletes the contents of the specified backup directory.

Ensure that the backup directory that you specify does not contain files that you need to retain.
CAUTION

Data Loss

The Manual Backup Directory path must not include the main database installation directory, or data loss may occur.

Ensure that the directory path does not include /opt/nsp/nfmp/db.

Note: The Oracle management user requires read and write permissions on the backup directory.

Configure the following parameters:
• Manual Backup Directory
• Enable Backup File Compression

Perform one of the following.
a. Click Partial Backup.
b. Click Full Backup.

Click Yes. The full or partial backup operation begins, and the Backup State indicator reads In Progress.
Depending on the database size, a backup may take considerable time.

If required, monitor the Backup Status information, which includes the following:
• Scheduled Backup—whether scheduled backup is configured
• Backup State—state of current backup operation; dynamically updated
• Next Scheduled Backup Time—time of next scheduled backup
• Last Successful Backup Time—completion time of latest successful backup
• Last Successful Backup Type—type of latest successful backup
• Last Attempted Backup Time—when latest attempted backup began
• Last Attempted Backup Type—type of latest attempted backup
• Directory of the Last Successful Backup—location of latest successful backup
• Host Name of the Last Successful Backup—hostname of station that performed latest successful backup

Close the Database Manager (Edit) form.

END OF STEPS
7.18 **To back up the main database from a CLI**

### 7.18.1 Purpose

Perform this procedure to initiate an on-demand main database backup using CLI. You can perform only a full database backup from a CLI. To perform a partial backup, see 7.17 “To back up the main database from the client GUI” (p. 217).

**CAUTION**

**Service Disruption**

*The disk partition that is to contain the database backup must have sufficient space for the database backup file set, or system performance may be compromised.*

Ensure that the backup directory is at least five times as large as the expected database backup size. For more information, contact technical support or see the NFM-P Planning Guide.

**Note:** The NFM-P backs up the Oracle encryption wallet during a database backup, and restores the wallet during a database restore. In a redundant deployment, the NFM-P automatically replicates the encryption wallet from the primary to the standby database after the standby database reinstatiation.

**Note:** In an NSP system that does not include the NSD and NRC, a main database backup performed using the NFM-P client GUI also backs up the local Neo4j and PostgreSQL databases; a backup performed from a CLI does not.

**Note:** During a database backup, the performance of GUI or XML API operations may be affected. It is recommended that you perform a database backup only during a period of low NFM-P activity.

### 7.18.2 Steps

1. Log in as the root user on the main database station.

   **Note:** In a redundant NFM-P system, you must log in to the primary database station.

2. Open a console window.
CAUTION
Data Loss

Before the NFM-P performs a database backup, it deletes the contents of the specified backup directory.

Ensure that the backup directory that you specify in this step does not contain files that you need to retain.

CAUTION
Data Loss

The backup directory path must not include the main database installation directory, or data loss may occur.

Ensure that the directory path does not include /opt/nsp/nfmp/db.

Note: The Oracle management user requires read and write permissions on the backup directory.

Perform one of the following.

a. Enter the following to back up the database without using file compression:

```bash
# sambackupDb backup_directory
```

where `backup_directory` is the absolute path of the directory that is to contain the database backup file set.

b. Enter the following to back up the database using file compression:

```bash
# sambackupDb backup_directory compress
```

where `backup_directory` is the absolute path of the directory that is to contain the database backup file set.

Note: Depending on the database size, a backup may take considerable time.

The database backup begins, and messages like the following are displayed as the backup progresses:

```
Backup log is /opt/nsp/nfmp/db/install/NFM-P_Main_Database.backup. yyyy.mm.dd-hh.mm.ss.stdout.txt
<date time> working..
<date time> Performing Step 1 of 4 - Initializing ..
<date time> Performing Step 2 of 4 - Backup archive logs ..
<date time> Performing Step 3 of 4 - Backup the database ............
<date time> Performing Step 4 of 4 - Finalizing ..... 
```

The following is displayed when the backup is complete:
When the backup is complete, close the console window.

END OF STEPS

7.19 To back up an auxiliary database

7.19.1 Steps

1 Choose Administration→Database from the NFM-P main menu. The Database Manager form opens.

2 Click on the Auxiliary Database Backups tab.

3 **CAUTION**

Data Loss

*If you specify a Backup Location on the database data partition, data loss or corruption may occur.*

*To avoid data loss or corruption, specify an absolute path on a partition other than the database data partition.*

**Note:** The backup location requires 20% more space than the database data consumes.

**Note:** If the backup location is remote, a 10 Gb/s link to the location is required.

Configure the Backup Location parameter.

4 Click Backup All Databases. A confirmation form opens.

5 Click OK. The backup process begins, and the Latest Backup State indicator displays In Progress; the backup is complete when the indicator displays Success.
When the backup is complete, close the Database Manager form.

7.20 To schedule main database backups

CAUTION

Service Disruption

The disk partition that is to contain the database backup must have sufficient space for the
database backup file set, or system performance may be compromised.

Ensure that the backup directory is at least five times as large as the expected database backup
size. For more information, contact technical support or see the NFM-P Planning Guide.

CAUTION

Service Disruption

A main database backup consumes considerable system resources.

Ensure that you specify a backup schedule of reasonable frequency, for example, daily.

Note: The NFM-P backs up the Oracle encryption wallet during a database backup, and
restores the wallet during a database restore. In a redundant deployment, the NFM-P
automatically replicates the encryption wallet from the primary to the standby database after
the standby database reinstatement.

Note: During a database backup, the performance of GUI or XML API operations may be
affected. It is recommended that you schedule the database backup to occur during a period
of low NFM-P activity.

7.20.1 Steps

1 Choose Administration→Database from the NFM-P menu. The Database Manager form (Edit)
opens.

2 Click on the Backup tab.

3 Configure the required parameters in the Backup Schedule panel.

Note: You must select the Schedule Enabled parameter.
CAUTION

Data Loss

Before the NFM-P performs a database backup, it deletes the contents of the specified backup directory.

Ensure that the backup directory that you specify in this step does not contain files that you need to retain.

Configure the Scheduled Backup Directory parameter in the Backup Setting panel. The value that you specify is the database station directory in which to save the backup file sets. Each file set is stored in a subdirectory named backupset\(n\), where \(n\) is a sequential number; the highest possible value is the Number to Keep parameter value.

Note: The Oracle management user requires read and write permissions on the Scheduled Backup Directory.

Note: The Scheduled Backup Directory must be a directory on the local file system.

Close the Database Manager form.

After each scheduled database backup completes, move the database backup file set to another station for safekeeping.

To schedule auxiliary database backups

Steps

1. Choose Administration→Database from the NFM-P menu. The Database Manager form (Edit) opens.

2. Click on the Auxiliary Database Backups tab.

3. Select the Run Scheduled Backups parameter.
4

**CAUTION**

**Service Disruption**

*Consider the directory path when you configure the Backup Location parameter.*

You must specify the absolute path of a directory in a partition other than the partition that contains the database data.

Configure the remaining parameters.

5

Click OK to save your changes and close the form.

END OF STEPS
To schedule auxiliary database backups
8 NFM-P system redundancy

8.1 Overview

8.1.1 Purpose
This chapter describes the workflow to set up system redundancy.

8.1.2 Contents

| 8.1 Overview | 227 |
| NFM-P system redundancy | 228 |
| 8.2 Overview | 228 |
| 8.3 NFM-P system redundancy models | 228 |
| 8.4 Redundancy functions | 233 |
| 8.5 Redundancy failure scenarios | 240 |
| NFM-P system redundancy procedures | 245 |
| 8.6 Workflow to perform NFM-P system redundancy functions | 245 |
| 8.7 To view the NFM-P system redundancy status | 246 |
| 8.8 To view the NFM-P auxiliary server status | 249 |
| 8.9 To perform a server activity switch | 250 |
| 8.10 To configure main database switchover behavior | 251 |
| 8.11 To perform a main database switchover using the NFM-P client GUI | 252 |
| 8.12 To perform a main database switchover using a CLI script | 253 |
| 8.13 To enable or disable automatic database realignment | 254 |
| 8.14 To configure the IPDR file transfer policy | 257 |
NFM-P system redundancy

8.2 Overview

8.2.1 Redundancy functions

NFM-P system redundancy is initially configured during system deployment. You use the NFM-P GUI, or scripts on a main server station, to perform the following redundancy functions:

• Check the main server and database redundancy status.
• Manually switch the primary and standby main server roles.
• Enable or disable automatic database realignment.
• Reinstantiate the former primary database as the standby database.

You can configure the following redundancy parameters to specify how an NFM-P system manages a loss of connection to the managed NEs; contact technical support for more information:

• the number of elapsed seconds that constitute a loss of connectivity
• how often a main server refreshes the list of managed NEs
• the minimum number of NEs that must respond to a connectivity check

8.3 NFM-P system redundancy models

8.3.1 Overview

CAUTION

Service Disruption

It is recommended that you deploy the primary server and database in the same geographical location and LAN.

This results in increased NFM-P system performance and fault tolerance.

A redundant NFM-P system provides greater fault tolerance by ensuring that there is no single point of software failure in the NFM-P management network. A redundant system consists of the following components:

• primary and standby main servers
• primary and standby main databases

The current state of a component defines the primary or standby role of the component. The primary main server actively manages the network and the primary database is open in read/write mode. When a standby component detects a primary component failure, it automatically changes roles from standby to primary. You can also change the role of a component using the NFM-P client GUI or a CLI script.

The NFM-P supports collocated and distributed system redundancy. A collocated system requires two stations that each host a main server and database. A distributed system requires four stations
that each host a main server or database. Each main server and database is logically independent, regardless of the deployment type.

The primary and standby main servers communicate with the redundant databases and periodically verify server redundancy. If the standby server fails to reach the primary server within 60s, the standby server becomes a primary server. See 8.5 “Redundancy failure scenarios” (p. 240) for information about various NFM-P redundancy failure scenarios.

A main database uses the Oracle DataGuard function to maintain redundancy. During a redundant NFM-P installation or upgrade, the Oracle DataGuard synchronization level is set to real-time apply, which ensures that the primary and standby databases are synchronized.

Figure 8-1 Collocated redundant NFM-P deployment

Figure 8-2 Distributed redundant NFM-P deployment
A main server role change is called a server activity switch. An automatic database role change is called a failover; a manual database role change is called a switchover.

A typical redundant NFM-P system has a primary server and database in a geographically separate facility from the standby server and database facility. To ensure that the primary components are in the same LAN after an activity switch or failover, you can configure automatic database realignment during a main server installation or upgrade. See 8.4.6 “Automatic database realignment” (p. 237) for more information.

The NFM-P GUI, application, and XML API clients must always communicate with the current primary main server. After a server activity switch or switchover:

• The GUI clients automatically connect to the new primary main server, which is the former standby.
• The XML API and application clients do not automatically connect to the new primary main server; you must redirect each application and XML API client to the new primary main server.

The following general conditions apply to NFM-P system redundancy:

• The main servers and databases must each be redundant. For example, you cannot have redundant servers and a standalone database.

• The network that contains a redundant NFM-P system must meet the latency and bandwidth requirements described in the NSP NFM-P Planning Guide.

  Note: To provide hardware fault tolerance in addition to software redundancy, it is recommended that you use redundant physical links between the primary and standby servers and databases to ensure there is no single point of network or hardware failure.

• The server and database stations require the same OS version and patch level.
• The server stations require identical disk layouts and partitioning.
• The database stations require identical disk layouts and partitioning.
• Only the nsp user on a main server station can perform a server activity switch.
• The following users can perform a database switchover:
  – the nsp user on a main server station
  – a GUI client user with update or execute permissions on the following classes:
    db.DatabaseManager.switchover
    db.DatabaseManager.reinstantiateStandby
  – a GUI client user with the admin scope of command role

8.3.2 Auxiliary server redundancy

NFM-P auxiliary servers are optional servers that extend the network management processing engine by distributing server functions among multiple stations. An NFM-P main server controls task scheduling and sends task requests to auxiliary servers. Each auxiliary server is installed on a separate station, and responds to processing requests only from the current primary main server in a redundant system.

When an auxiliary server cannot connect to the primary main server or database, it re-initializes and continues trying to connect until it succeeds or, in the case of a database failover, until the main server directs it to the peer database.
After startup, an auxiliary server waits for initialization information from a main server. An auxiliary server restarts if it does not receive all required initialization information within five minutes.

**Note:** NFM-P system performance may degrade when a main server loses contact with a number of auxiliary servers that exceeds the number of Preferred auxiliary servers.

When an auxiliary server fails to respond to a primary main server, the main server tries repeatedly to establish communication before it generates an alarm. The alarm clears when the communication is re-established.

**Auxiliary server types**

The auxiliary servers in an NFM-P system are specified in each main server configuration, which includes the address of each auxiliary server in the system, and the auxiliary server type, which is one of the following:

- Preferred—processes requests under normal conditions
- Reserved—processes requests when a Preferred auxiliary server is unavailable
- Remote Standby—unused by the main server; processes requests only from the peer main server, and only when the peer main server is operating as the primary main server

If a Preferred auxiliary server is unresponsive, the main server directs the requests to another Preferred auxiliary server, if available, or to a Reserved auxiliary server. When the unresponsive Preferred auxiliary server returns to service, the main server reverts to the Preferred auxiliary server and stops sending requests to any Reserved auxiliary server that had assumed the Preferred workload.

An auxiliary server that is specified as a Remote Standby auxiliary server is a Preferred or Reserved auxiliary server of the peer main server. The Remote Standby designation of an auxiliary server in a main server configuration ensures that the main server does not use the auxiliary server under any circumstances. Such a configuration may be required when the network latency between the primary and standby main servers is high, for example, when the NFM-P system is geographically dispersed.

Alternatively, if all main and auxiliary servers are in the same physical facility and the network latency between components is not a concern, no Remote Standby designation is required, and you can apply the Preferred and Reserved designations based on your requirements. For example, you may choose to configure a Preferred auxiliary server of one main server as the Reserved auxiliary server of the peer main server, and a Reserved auxiliary server as the Preferred of the peer main server.

### 8.3.3 IPDR file transfer redundancy

The NFM-P can forward collected AA accounting and AA Cflowd statistics in IPDR format to redundant target servers for retrieval by OSS applications. For additional redundancy, you can configure multiple NSP Flow Collectors to forward AA Cflowd statistics data to the target servers. Such a configuration provides a high degree of fault tolerance in the event of an NFM-P component failure.
AA accounting statistics collection

An NFM-P main or auxiliary server forwards AA accounting statistics files to the target servers specified in an IPDR file transfer policy. An IPDR file transfer policy also specifies the file transfer type and user credentials, and the destination directory on the target server. See 8.14 “To configure the IPDR file transfer policy” (p. 257) for configuration information.

Each IPDR file is transferred as it is closed. A file that cannot be transferred is retained and an error is logged. Corrupt files, and files that cannot be created, are stored in a directory named “bad” below the specified destination directory on the server.

**Note:** An main or auxiliary server does not retain successfully transferred IPDR files; each successfully transferred file is deleted after the transfer.

After you configure the IPDR file transfer policy, the main or auxiliary server that collects AA accounting statistics forwards the statistics files to the primary transfer target named in the policy. If the server is unable to perform a file transfer, for example, because of an unreachable target, invalid user credentials, or a disk-capacity issue, the main or auxiliary server attempts to transfer the files to the alternate target, if one is specified in the policy. Statistics data is sent to only one target; no statistics data is duplicated on the target servers.

AA Cflowd statistics collection

In an NFM-P system that includes NSP Flow Collectors, each collector transfers AA Cflowd statistics files to a target server for OSS retrieval. The target server is specified during NSP Flow Collector installation using the flow collector web UI.

You can specify the same or a different target for each NSP Flow Collector. For example, to ensure minimal data loss in the event of a collector or target failure, you can configure two collectors to:

- retrieve the same AA Cflowd statistics from one group of NEs
- send the statistics files to different targets

If files are absent from a target, or the target is unreachable, the third-party system can retrieve the files from the other target.

**Note:** An NSP Flow Collector does not retain successfully transferred statistics files; each successfully transferred file is deleted after the transfer.

To facilitate the deployment of redundant NSP Flow Collectors, you can copy the collection configuration of one collector to another.

See “Flow statistics collection” in the *NSP NFM-P Statistics Management Guide* for information about NSP Flow Collector configuration using the web UI.

8.3.4 Analytics servers and system redundancy

You can deploy multiple analytics servers in an active/active configuration that eliminates the single point of failure in the event that a server fails. The use of multiple analytics servers also allows load balancing of client requests among the servers.

A main server that provides web client access to the NSP Analytics application monitors the reachability of each analytics server, and assigns requests to the available servers in accordance with the specified load-balancing scheme, which is one of the following:
• none—no load balancing
• round-robin—each new client connection is directed to the next analytics server named in the main server configuration
• round-robin with stickiness—browser cookies bind one browser to the same analytics server for each subsequent client connection

The redundancy function is active when the main server configuration includes multiple analytics servers, regardless of whether load balancing is enabled. If load balancing is disabled, the default analytics server is chosen based on the server IP address order in the main server configuration. In the event that the default server fails, the main server directs client requests to the next server listed in the configuration.

During analytics server deployment, you can specify the IP addresses of multiple auxiliary database stations. If an auxiliary database IP address becomes unreachable, the analytics server sequentially attempts to reach the auxiliary database using each IP address until communication is re-established.

### 8.4 Redundancy functions

#### 8.4.1 Overview

Figure 8-3  NFM-P redundancy role-change functions

8.4.2 Server activity switches

The standby server initiates an automatic server activity switch when it cannot communicate with the primary server. An NFM-P system administrator can perform a manual server activity switch, which is typically a planned server maintenance or test operation.
Note: For security reasons, you cannot use an NFM-P GUI or XML API client to perform a server activity switch.

Figure 8-4 Server and database roles before server activity switch

![Diagram showing server and database roles before server activity switch]

The NFM-P raises alarms when a server activity switch is initiated. During the activity switch, the main servers do not process SNMP traps, attempt to synchronize NEs, or collect statistics. Auxiliary servers process outstanding requests, but do not communicate with a main server.

Figure 8-5 Server and database roles after server activity switch

![Diagram showing server and database roles after server activity switch]

After a server activity switch:
- If automatic database realignment is enabled, the new primary main server performs a database switchover.
- All application and XML API clients require redirection to the new primary main server.
- The new primary server establishes communication and synchronizes information with the auxiliary servers.
- The auxiliary servers exchange information with the new primary server; no auxiliary servers exchange information with the former primary server.
• The Preferred or Reserved state of each auxiliary server changes, depending on the configuration of the new primary server.
• The new primary server attempts to redeploy the client requests that the former primary server did not complete before the activity switch.

### 8.4.3 Database switchovers

An NFM-P administrator directs a main server to initiate a database switchover.

*Figure 8-6  Server and database roles before database switchover*

The following occurs after a successful database switchover:
• The primary server connects to the new primary database.
• Archive logging begins on the new primary database.
• The primary server directs each auxiliary server to use the new primary database.
When a database switchover fails, the primary and standby database roles do not change. No automatic database realignment occurs as a result of a switchover.

### 8.4.4 Database failovers

The main database failover function is enabled by default. A failover occurs when a main server cannot communicate with the primary database, but can communicate with the standby database and the managed NEs. When this happens, the main server directs the standby database to become the primary database.

A database failover occurs only if the following conditions are true.

- The standby database is configured, operational, and reachable.
- The main server can communicate with the managed NEs.

**Figure 8-8** Server and database roles before database failover

**Figure 8-9** Server and database roles after database failover
When a database failover fails, the primary server tries again to communicate with the primary database. If the primary database remains unavailable, the primary server tries again to initiate a failover.

**Note:** During a database failover, a network management outage occurs; the GUI clients can monitor the failover, but cannot perform configuration activities.

**Note:** After a successful failover, database redundancy is not available until the new primary database is reinstantiated as the standby database on the former primary database station. See 8.4.5 “Re-establishing database redundancy” (p. 236) for more information.

### 8.4.5 Re-establishing database redundancy

After a failover, the former primary database is no longer part of the redundant configuration. To re-establish database redundancy, you must reinstantiate the former primary database as the new standby database. You can do this only when the failed database station is restored to full operation and has a functional proxy port. See 14.32 “To reinstantiate the main database from the client GUI” (p. 373) and 14.33 “To reinstantiate the main database from a CLI” (p. 374) for information about how to reinstantiate a database.

**Figure 8-10**  Server and database roles after database reinstatement

![Server and database roles after database reinstatement](image)

### Automatic database reinstatiation

You can configure the NFM-P to automatically reinstantiate the former primary database as the new standby database. Automatic database reinstatiation occurs only in the event of a database failover. When the function is enabled, the NFM-P attempts an automatic reinstatiation every 60 minutes by default. You can enable automatic database reinstatiation during a main server installation or upgrade. See the *NSP NFM-P Installation and Upgrade Guide* for information about enabling and configuring automatic database reinstatiation.

### 8.4.6 Automatic database realignment

In a redundant NFM-P system that is geographically dispersed, the primary main server and database may be in separate LANs or WANs after an activity switch or failover. The network latency...
that this introduces can affect NFM-P system performance. Automatic database realignment is an
optional mechanism that attempts to ensure that each main server uses the local database.

The database with which a main server tries to align itself is called the preferred database of the
main server. An operator enables automatic database realignment and specifies the preferred
database during NFM-P server installation, or during server configuration after installation.

**Note:** For automatic database alignment to work, you must enable it and specify a preferred
database on each main server in a redundant NFM-P system.

When a primary server starts, it verifies that the primary database is the preferred database. If the
primary database is not the preferred database, the server performs a database switchover to
reverse the primary and standby database roles. If the switchover is successful, the main servers
and databases in the NFM-P system are aligned. If the switchover fails, each database reverts to
the former role, and the main server generates an alarm about the failed switchover.

When you perform a database switchover and automatic database realignment is enabled, the
primary server does not attempt database realignment. A switchover is a manual operation that is
considered to be a purposeful act.

Performing a server activity switch when automatic database realignment is enabled triggers a
database switchover.

### 8.4.7 Redundancy function summary

**Table 8-1** Redundancy functions, main server

<table>
<thead>
<tr>
<th>Function</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Automatic server activity switch</strong></td>
<td>During an activity switch, each application client and XML API client loses connectivity with the primary main server. During an activity switch, a main server does not process SNMP traps from the network, and no NE re-synchronizations occur. The auxiliary servers continue to process outstanding requests, and synchronize the request information with the new primary server after the activity switch. When the communication failure is resolved, you must re-open each application client from the NSP Launchpad, and redirect each XML API client to the new primary main server.</td>
</tr>
<tr>
<td>An automatic activity switch occurs when the primary server cannot communicate with the standby server, and involves the following sequence of events.</td>
<td></td>
</tr>
<tr>
<td>• The standby server cannot communicate with the primary server within 60 seconds, or the primary server cannot communicate with the managed network.</td>
<td></td>
</tr>
<tr>
<td>• The standby server performs an activity switch to become the new primary server. The activity switch occurs only if the standby server can communicate with the managed network.</td>
<td></td>
</tr>
<tr>
<td>• If automatic database realignment is enabled, the new primary server attempts a database switchover.</td>
<td></td>
</tr>
<tr>
<td>• The new primary server connects to the primary database and manages the network.</td>
<td></td>
</tr>
<tr>
<td>• The new primary server and the auxiliary servers synchronize the request information.</td>
<td></td>
</tr>
<tr>
<td><strong>Manual server activity switch</strong></td>
<td></td>
</tr>
<tr>
<td>A manual activity switch is typically performed for maintenance or testing during a scheduled period of low activity, and involves the following sequence of events.</td>
<td></td>
</tr>
<tr>
<td>• An NFM-P administrator initiates the activity switch on the primary server.</td>
<td></td>
</tr>
<tr>
<td>• The standby server performs an activity switch to become the new primary server.</td>
<td></td>
</tr>
<tr>
<td>• The new primary server connects to the primary database and manages the network.</td>
<td></td>
</tr>
<tr>
<td>• The new primary server and the auxiliary servers synchronize the request information.</td>
<td></td>
</tr>
<tr>
<td>• If automatic database realignment is enabled, the new primary server attempts a database switchover.</td>
<td></td>
</tr>
</tbody>
</table>
### Table 8-2  Redundancy functions, main database

<table>
<thead>
<tr>
<th>Function</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Database switchover</strong></td>
<td>A database switchover is a manual operation that reverses the primary and standby database roles, for example, for primary database maintenance, or to realign database roles with database stations after a server activity switch. A switchover can occur only when the primary and standby databases are functioning correctly and can communicate with each other. A database switchover involves the following sequence of events.</td>
</tr>
<tr>
<td></td>
<td>• An NFM-P administrator initiates the switchover on a primary or standby server.</td>
</tr>
<tr>
<td></td>
<td>• The main server asks each auxiliary server to release all database connections. The switchover fails if all database connections are not released within 15 minutes.</td>
</tr>
<tr>
<td></td>
<td>• The main server directs the standby database to become the primary database.</td>
</tr>
<tr>
<td></td>
<td>• The main server fully synchronizes information with the new primary database.</td>
</tr>
<tr>
<td></td>
<td>See 8.11 “To perform a main databaseswitchover using the NFM-P client GUI” (p. 252) for information about performing a database switchover.</td>
</tr>
<tr>
<td><strong>Database failover</strong></td>
<td>A database failover is an automatic operation that changes the standby database into a primary database when the original primary database is unreachable, for example, because of a power disruption on the primary database station. A database failover involves the following sequence of events.</td>
</tr>
<tr>
<td></td>
<td>• No main server can communicate with the primary database within a period that is 2 min by default.</td>
</tr>
<tr>
<td></td>
<td>• The primary main server directs the standby database to become the primary database.</td>
</tr>
<tr>
<td></td>
<td>• If automatic database realignment is enabled and the primary server and database are not aligned, the primary server performs an activity switch.</td>
</tr>
<tr>
<td></td>
<td>• The primary server directs each auxiliary server to connect to the new primary database.</td>
</tr>
<tr>
<td></td>
<td>• The main server restarts after a failover.</td>
</tr>
<tr>
<td><strong>Re-establishing database redundancy</strong></td>
<td>Re-establishing database redundancy after a database failure requires database reinstatiation to replicate the current primary database as the standby database. After a failover, the former primary database is not available for redundancy until an operator or the automatic database reinstatiation function reinstantiates it as the new standby database.</td>
</tr>
<tr>
<td></td>
<td>See 14.32 “To reinstantiate the main database from the client GUI” (p. 373) and 14.33 “To reinstantiate the main database from a CLI” (p. 374) for information about re-establishing database redundancy after a failover.</td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
</tbody>
</table>
8.5 Redundancy failure scenarios

8.5.1 Overview

The following describe the NFM-P actions in response to various types of redundancy failures.

- **Primary server loses contact with primary database**
  If the standby server can communicate with the primary database and the managed NEs, the primary server performs a server activity switch. No database failover occurs.
  If automatic database realignment is enabled, the new primary server performs a database switchover.

- **Primary server loses contact with managed NEs**
  If the standby server can communicate with the primary database and the managed NEs, the primary server performs a server activity switch.
  If automatic database realignment is enabled, the new primary server performs a database switchover.

- **Primary server loses contact with primary database and managed NEs**
  If the standby server can communicate with the primary database and the managed NEs, the primary server performs a server activity switch. No database failover occurs.
  If automatic database realignment is enabled, the new primary server performs a database switchover.

- **Primary server loses contact with primary database, managed NEs, and standby server**
  The standby server activates to become the new primary server, and if automatic database realignment is enabled, initiates a database switchover.

- **Both servers lose contact with primary database**
  The primary server initiates a database failover, and if automatic database realignment is enabled, also initiates a server activity switch.

- **Both servers lose contact, primary server and database can communicate**
  The primary server and database remain the primary server and database. The NFM-P raises an alarm about the server communication failure.

- **Both servers lose contact with managed NEs**
  If the primary and standby servers can each communicate with the preferred database, no server activity switch or database failover occurs. The NFM-P raises a reachability alarm against each NE in the network.

- **Both servers lose contact with primary database and managed NEs**
  If the primary and standby servers can communicate with each other, no server activity switch or database failover occurs. However, the NFM-P system is unavailable; manual intervention such as a database failover is required.

- **Both servers fail, primary database isolated, standby database operational**
  When both servers return to operation, the servers cannot connect to the primary database. Because the state of the standby database is unknown, no database failover occurs; manual intervention such as a database switchover is required.
8.5.2 Collocated system, primary station unreachable

Figure 8-11 Primary server and database station down, collocated system

- Rebuild as standby main server and database
- Activity switch
- Failover

The following occur when the primary station becomes unresponsive:
- The standby server and database become the primary server and database.
- Redundancy is restored when the former primary station returns to service as the standby station.

8.5.3 Distributed system, primary server unreachable

Figure 8-12 Primary server unreachable, distributed system

- Station down
- Connectivity loss
- Activity switch
- Failover

The following occur when the primary station becomes unresponsive:
- The standby server detects the connectivity loss and becomes the primary server.
- The new primary main server raises alarms about the unavailability of the former standby, and about the activity switch.
• If automatic database realignment is enabled, the new primary server initiates a database switchover.
• When connectivity is restored, the former primary server assumes the standby server role.

8.5.4 Distributed system, standby server unreachable

Figure 8-13  Standby server unreachable, distributed system

The following occur when the standby station becomes unresponsive:
• The standby server interprets the primary server unresponsiveness as a primary server failure, so attempts to assume the primary server role.
• The primary server generates an alarm to indicate that the standby server is down.
• When the reachability is restored, the standby server resumes the standby role and the alarm clears.
### 8.5.5 Distributed system, managed network unreachable by primary side

The following occur after the connectivity loss is detected:

- The initial primary server continues to operate as a primary server.
- The initial primary server generates an alarm about the standby server unavailability, and a reachability alarm against each NE in the network.
- Each GUI client displays the standby server status as Down.
- The standby server becomes a primary server.

**Note:** You can eliminate a single point of hardware or network failure by using redundant interfaces and redundant physical network paths. See the *NSP NFM-P Planning Guide* for more information.

### 8.5.6 Split complex

A split complex is a scenario in which both servers in a collocated or distributed system lose contact, but each server can communicate with the preferred database, as shown in the following figure.
The following occur after the connectivity loss is detected:

- The initial primary server and database roles do not change; the initial primary server continues to manage the network. The client sessions are not interrupted.
- The primary server raises an alarm about the communication failure.
- The standby server and database switch roles to become a second primary server and database.
- New clients connect to the initial primary server; however, if a client explicitly tries to connect to the second primary server, a session is established.
- When the servers regain contact:
  - If the network disruption also isolates one server from the managed NEs, the other server and database remain the primary.
  - Otherwise, the server that has currently held the primary role for longer remains the primary, and the other server and database assume the standby role.
NFM-P system redundancy procedures

8.6 Workflow to perform NFM-P system redundancy functions

8.6.1 Process

1

Configure redundancy during NFM-P component installation. See the NSP NFM-P Installation and Upgrade Guide.

2

As required, perform server activity switches and database switchovers.

   a. For main servers:
      1. View the status of the primary and secondary servers to verify the redundancy status is Up; see 8.7 “To view the NFM-P system redundancy status” (p. 246).
      2. If required, verify the redundancy status of the NFM-P auxiliary server; see 8.8 “To view the NFM-P auxiliary server status” (p. 249).
      3. Perform a manual activity switch to reverse the primary and standby roles; see 8.9 “To perform a server activity switch” (p. 250).
      4. Validate the updated redundancy status; see 8.7 “To view the NFM-P system redundancy status” (p. 246).

   b. For main databases:
      1. View the redundancy status of the primary and secondary database to verify the redundancy status is Up; see 8.7 “To view the NFM-P system redundancy status” (p. 246).
      2. As required, specify the behavior of how database switchovers are executed; see 8.10 “To configure main database switchover behavior” (p. 251).
      3. As required, perform a database switchover; see 8.11 “To perform a main database switchover using the NFM-P client GUI” (p. 252) or 8.12 “To perform a main database switchover using a CLI script” (p. 253).
      4. As required, enable or disable automatic database realignment; see 8.13 “To enable or disable automatic database realignment” (p. 254).
      5. Validate the updated redundancy status; see 8.7 “To view the NFM-P system redundancy status” (p. 246).

3

After a failover, re-establish redundancy between the standby and primary databases; see 14.32 “To reinstantiate the main database from the client GUI” (p. 373) and 14.33 “To reinstantiate the main database from a CLI” (p. 374).
8.7 To view the NFM-P system redundancy status

8.7.1 Steps

1 View the Standby Server, Primary DB and Standby DB status indicators in the NFM-P client GUI task bar. Each indicator must display Up.

2 Choose Administration→System Information. The System Information form opens.

3 View the general redundancy information:
   • Domain Name—the NFM-P domain name specified at installation
   • Redundancy Enabled—selected if redundancy is enabled
   • Realignment Enabled—selected if automatic database realignment is enabled; displayed only if the NFM-P system is redundant
   • Auto Standby Re-instantiation Enabled
   • Realignment Status—Aligned or Not Aligned

4 View the following information in the Primary Server panel:
   • Host Name—the host name of the primary or standalone main server
   • Preferred DB—the preferred database of the main server
   • Status—Unknown, Down, or Up

5 View the following information in the Primary Database Server panel:
   • Instance Name—the name of the primary database instance, also called a SID
   • IP Address—the IP address that each main or auxiliary server uses to reach the primary database
   • Host Name—the host name of the primary or standalone main database

6 If the NFM-P system is redundant, view the following information in the Standby Server panel:
   • Host Name—the host name of the standby main server
   • Status—Unknown, Down, or Up

7 If the NFM-P system is redundant, view the following information in the Standby Database Server panel:
• Instance Name—the name of the standby database instance, also called a SID
• IP Address—the IP address that each main or auxiliary server uses to reach the standby database
• Host Name—the host name of the standby database

Click Properties to display additional information about the primary or standby main server. The Main Server (Edit) properties form opens.

View the following general main-server information:
• Host Name—the host name of the primary main server
• Server Type—Main
• Resource Managed—selected if the main server is included in NFM-P resource management

View the following information in the Client Communication panel:
• Private IP Address—the IP address that the main server uses as the source address for communication with the NFM-P GUI, application, and XML API clients through a NAT router
• Public IP Address—the IP address that the NFM-P GUI, application, and XML API clients use to reach the main server through a NAT router

Note: The Private IP Address and Public IP Address display 0.0.0.0 when the NFM-P clients and the main server use host names, rather than IP addresses, for communication. The Private IP Address and Public IP Address display the same IP address when NAT is not used between the main server and clients.

View the following information in the Redundant Server Communication panel:
• Private IP Address—the IP address that the main server uses as the source address for communication with the standby main server through a NAT router
• Public IP Address—the IP address that the standby main server uses to reach the primary main server through a NAT router
• Peer Public IP Address—the IP address that the standby main server uses to reach the main server

Note: The Private IP Address and Public IP Address display the same IP address when NAT is not used between the primary and standby main servers.

View the following information in the Redundancy Database State panel:
• Switchover State—whether switchover in progress, and operational state
• Last Attempted Switchover Time—time of previous switchover attempt
To view the NFM-P system redundancy status

- Failover State—whether failover in progress, and operational state
- Last Attempted Failover Time—time of previous failover attempt
- Standby Re-instantiation State—whether re-instantiation is in progress, and operational state
- Last Attempted Standby Re-instantiation Time—time of previous standby re-instantiation attempt
- Number of Archive Logs To be Applied—number of archive logs that remain to be applied on standby database
- Estimated Time to Apply Archive Logs (seconds)—system time estimate for application of archive logs on standby database

13

View the following information in the Auxiliary Server Communication panel:
- Private IP Address—the IP address that the main server uses as the source address for communication with the auxiliary servers through a NAT router
- Public IP Address—the IP address that the auxiliary servers use to reach the primary main server

**Note:** The Private IP Address and Public IP Address display the same IP address when NAT is not used between the main server and the auxiliary servers.

14

View the following information in the Main Server Communication panel:
- Server Public IP Address—the IP address that the auxiliary server uses to communicate with the main server

15

Close the Main Server properties form.

16

Click Database to view detailed database information, if required. See Chapter 7, “NFM-P database management” for information about the main database.

17

Click on the Faults tab to view alarm information, if required.

18

Close the form.

END OF STEPS
8.8 To view the NFM-P auxiliary server status

8.8.1 Steps

1. Choose Administration→System Information. The System Information form opens.

2. Click on the Auxiliary Servers tab.

3. Review the list of auxiliary servers.

4. Select an auxiliary server in the list and click Properties. The properties form for the auxiliary server opens.

5. Review the auxiliary server information, which includes the following:
   - Host Name—the hostname of the auxiliary server
   - Port Number—identifies the port that the auxiliary server uses to communicate with each main server and database
   - Auxiliary Server Type—Reserved or Preferred
   - Server Status—Unknown, Down, Up or Unused
   - Resource Managed—selected if the auxiliary server is included in NFM-P resource management
   - Public IP address—the IP address that the main servers use to reach the auxiliary server

6. Perform one of the following:
   a. View the following main server information for a redundant system:
      - Server 1 Public IP address—the IP address that the auxiliary server uses to communicate with the primary or standby main server
      - Server 2 Public IP address—the IP address that the auxiliary server uses to communicate with the primary or standby main server
   b. View the following main server information for a standalone system:
      - Server Public IP address—the IP address that the auxiliary server uses to communicate with the main server

7. Click on the Auxiliary Services tab.
Review the list of auxiliary services.

Review the information for each auxiliary service, which includes the following:
- Service Name—the type of service, for example, statistics collection
- Selected—indicates whether this auxiliary server is currently used by a main server to process requests
- IP Address—the IPv4 address that the managed NEs use to reach the auxiliary server
- IPv6 Address—the IPv6 address that the managed Wavence NEs use to reach the auxiliary server
- Host Name—the host name of this auxiliary server
- Auxiliary Server Type—Reserved or Preferred

Close the Auxiliary Services form.

Click on the Faults tab to view alarm information, if required.

Close the form.

END OF STEPS

8.9 To perform a server activity switch

8.9.1 Purpose

Perform this procedure to reverse the primary and standby roles of the main servers in a redundant system. Consider the following before you perform a server activity switch.

- A server activity switch stops and starts the primary main server. Server redundancy is unavailable until the main server is fully initialized as the new standby main server.
- During a server activity switch:
  - The NFM-P raises an alarm about the activity switch; the alarm is not self-clearing.
  - A main server does not process SNMP traps, attempt to synchronize NEs, or collect statistics.
  - All GUI, application, and clients lose connectivity to the NFM-P.
  - Auxiliary servers process outstanding requests, but do not communicate with a main server.
- After a server activity switch:
  - The new primary main server deploys outstanding configuration changes to NEs, establishes communication with the auxiliary servers, and synchronizes information with the auxiliary servers.
  - The GUI clients automatically connect to the new primary main server.
8.9.2 Steps

1. Log in to the primary main server station as the nsp user.

2. Open a console window.

3. Enter the following:
   
   bash$ /opt/nsp/nfmp/server/nms/bin/nmsserver.bash force_restart

   The server activity switch begins. The primary main server restarts as the standby main server, and the standby main server restarts as the primary.

4. When the activity switch is complete, close the console window.

5. Reconnect each application client to the NFM-P.
   1. Close the application.
   2. Open the application.

   Note: After an activity switch, depending on the state of the former primary main server station, the NFM-P automatically redirects NSP Launchpad requests to the new primary main server. If the redirection fails to occur, you must open the Launchpad using the address of the new primary main server.

6. Redirect each XML API client to the new primary main server.

7. Manually clear the activity switch alarms, as required.

END OF STEPS

8.10 To configure main database switchover behavior

8.10.1 Purpose

Perform this procedure on a redundant system to specify how database switchovers are executed. A database switchover occurs immediately upon request unless a database query is in progress, in which case the NFM-P does the following:
• if session interruption is enabled, waits a specified period before forcing the switchover
• if session interruption is disabled, the switchover does not occur and the Switchover State is Failed

8.10.2 Steps

1 Choose Administration→Database from the NFM-P main menu. The Database Manager (Edit) form opens.

2 Configure the required parameters:
   • DB Session wait time (minutes)
   • Interrupt Read sessions after time out
   • Interrupt Write sessions after time out

3 Save your changes and close the form.

END OF STEPS

8.11 To perform a main database switchover using the NFM-P client GUI

8.11.1 Purpose
Perform this procedure to use the NFM-P client GUI to switch the primary and standby database roles. Before you perform the procedure, ensure that you understand the following implications of a switchover.

• The primary and standby database roles are reversed.
• The primary main server connects to the new primary database.
• Archive logging begins on the new primary database.
• The primary main server directs each auxiliary server to connect to the new primary database.

CAUTION

Service Disruption

The execution of a database switchover depends on how the database switchover behavior is configured.

It is recommended that you review 8.10 “To configure main database switchover behavior” (p. 251) before you attempt to perform this procedure to verify the current database switchover configuration.
8.11.2 Steps

1 Log in to the client GUI as a user with the admin scope of command role.

2 Choose Administration→System Information from the NFM-P main menu. The System Information form opens.

3 Click Switchover and respond to the dialog box prompt.

   Note: The Switchover option is disabled when the correct switchover conditions are not in place, for example, when a switchover or failover is in progress.

4 Click Yes. The NFM-P server performs the database switchover.

5 Close the form.

END OF STEPS

8.12 To perform a main database switchover using a CLI script

8.12.1 Purpose

Perform this procedure to use a CLI script to switch the primary and standby database roles. Before you perform the procedure, ensure that you understand the following implications of a switchover.

- The primary and standby database roles are reversed.
- The primary main server connects to the new primary database.
- Archive logging begins on the new primary database.
- The primary main server directs each auxiliary server to connect to the new primary database.

CAUTION

Service Disruption

The execution of a database switchover depends on how the database switchover behavior is configured.

It is recommended that you review 8.10 “To configure main database switchover behavior” (p. 251) before you attempt to perform this procedure to verify the current database switchover configuration.
8.12.2 Steps

1. Log in to the primary main server station as the nsp user.

2. Open a console window.

3. Enter the following at the CLI prompt:
   
   ```bash
   bash$ /opt/ns/nfmp/server/nms/bin/switchoverdb.bash username password
   ```
   
   where `username` and `password` are the login credentials of an NFM-P user with the required privilege level and scope of command.
   
   The script displays the following confirmation message:
   
   The standby database will become the new primary database, and the old primary will become the new standby.
   
   Do you want to proceed? (YES/no) :

4. Enter the following to initiate the switchover:
   
   ```bash
   YES
   ```
   
   The NFM-P server initiates a database switchover. Progress is indicated by a rolling display of dots in the console window. The database switchover is complete when the CLI prompt reappears.

5. Close the console window when the database switchover is complete.

---

8.13 To enable or disable automatic database realignment

**CAUTION**

**Service Disruption**

*This procedure requires a primary main server restart, which is service-affecting.*

*Ensure that you perform this procedure only during a scheduled maintenance period.*

**Note:** This procedure applies only to redundant systems.
8.13.1 Steps

1. Perform Step 4 to Step 14 on the standby main server station.

2. Perform Step 4 to Step 14 on the primary main server station.

   **Note:** When you stop the primary main server, a switchover to the standby main server occurs.

3. Go to Step 15.

4. Log in to the main server as the nsu user.

5. Stop the main server.
   1. Enter the following:
      
      ```bash
      cd /opt/ns/nfmp/server/nms/bin
      ```
   2. Enter the following:
      
      ```bash
      ./nmsserver.bash stop
      ```
   3. Enter the following:
      
      ```bash
      ./nmsserver.bash appserver_status
      ```
      The server status is displayed; the server is fully stopped if the status is the following:
      Application Server is stopped
      If the server is not fully stopped, wait five minutes and then repeat this step. Do not perform the next step until the server is fully stopped.

6. Enter the following to switch to the root user:

   ```bash
   su -
   ```

7. Enter the following:

   ```bash
   # samconfig -m main
   ```
   The following is displayed:
   Start processing command line inputs...
   <main>
Perform one of the following:

a. Enable database alignment; perform the following steps.
   1. Enter the following:
      
      ```
      <main> configure redundancy database alignment
      Database alignment is enabled, and the prompt changes to <main configure redundancy database>.
      ```
   2. Enter the following:
      
      ```
      <main configure redundancy database> prefer-instance instance
      where instance is the database instance with which the main server is to align, typically the database instance on the same side of the management LAN
      ```

b. Disable database alignment; perform the following steps.
   1. Enter the following:
      
      ```
      <main configure redundancy database> no alignment
      Database alignment is disabled, and the prompt changes to <main configure redundancy database>.
      ```

Enter the following:

```
<main configure redundancy database> exit
The prompt changes to <main>.
```

Enter the following:

```
<main> apply
The configuration change is applied.
```

Enter the following:

```
<main> exit
The samconfig utility closes.
```

Enter the following to switch back to the nsp user:

```
# exit
```}

Start the main server.

1. Enter the following:
bash$ cd /opt/nsp/nfmp/server/nms/bin

2. Enter the following:
bash$ ./nmsserver.bash start

3. Enter the following:
bash$ ./nmsserver.bash appserver_status

The server status is displayed; the server is fully initialized if the status is the following:
Application Server process is running. See nms_status for more detail.
If the server is not fully initialized, wait five minutes and then repeat this step. Do not perform the next step until the server is fully initialized.

14

Log out of the main server station.

15

If required, perform 8.9 “To perform a server activity switch” (p. 250) to perform a server activity switch to revert the primary and standby main servers to their initial roles.

END OF STEPS

8.14 To configure the IPDR file transfer policy

8.14.1 Purpose

Perform this procedure to specify the target servers to which the NFM-P main or auxiliary servers forward IPDR-formatted AA accounting statistics.

Note: An main or auxiliary server does not retain any IPDR files that are successfully transferred to a target server; each successfully transferred file is deleted after the transfer.

8.14.2 Steps

1

Choose Tools→Statistics→IPDR File Transfer Policies from the NFM-P main menu. The IPDR File Transfer Policies form opens.

2

Select the default policy and click Properties. The IPDR File Transfer Policy form (Edit) opens.

3

Select the Enabled parameter.
4 Configure the File Transfer Protocol parameter.

5 Configure the parameters in the Transfer Target panel to specify the target IP address or hostname, port, file-transfer user credentials, and the directory on the target server in which to store the transferred statistics files.

    Note: The directory that you specify must be the absolute path of an existing directory on the target server.

    Note: The specified user requires read and write access to the directory that you specify.

6 Configure the parameters in the Alternate Transfer Target panel to specify a redundant transfer target, if required.

    Note: The directory that you specify must be the absolute path of an existing directory on the target server.

    Note: The specified user requires read and write access to the directory that you specify.

7 Click OK to save your changes and close the form.

END OF STEPS
Part IV: NFM-P routine maintenance

Overview

Purpose

This part provides information about NFM-P maintenance.

Contents

<table>
<thead>
<tr>
<th>Chapter</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Chapter 9, NFM-P routine maintenance overview</td>
<td>261</td>
</tr>
<tr>
<td>Chapter 10, NFM-P maintenance base measures</td>
<td>265</td>
</tr>
<tr>
<td>Chapter 11, Daily maintenance</td>
<td>273</td>
</tr>
<tr>
<td>Chapter 12, Weekly maintenance</td>
<td>281</td>
</tr>
<tr>
<td>Chapter 13, Monthly maintenance</td>
<td>293</td>
</tr>
<tr>
<td>Chapter 14, As required maintenance</td>
<td>303</td>
</tr>
</tbody>
</table>
9 NFM-P routine maintenance overview

9.1 Routine maintenance overview

9.1.1 General information

The NFM-P maintenance tasks and procedures are intended for NOC operations or other engineering operational staff that are responsible for developing and implementing maintenance procedures in NFM-P-managed IP/MPLS networks.

The NFM-P maintenance tasks and procedures are categorized by the frequency they are performed or on an as required basis. The implementation of a regular maintenance schedule is recommended in order to:

- prevent downtime caused by software, platform, or network failure
- enable maximum system performance

The appropriate maintenance frequency depends on the network conditions of the individual service provider or operation. Tailor the suggested maintenance actions and frequency to the unique needs of your network.

Table 9-1 Maintenance information

<table>
<thead>
<tr>
<th>For information about</th>
<th>See chapter</th>
</tr>
</thead>
<tbody>
<tr>
<td>Performance maintenance baselines</td>
<td>Chapter 10, “NFM-P maintenance base measures”</td>
</tr>
<tr>
<td>Daily maintenance tasks</td>
<td>Chapter 11, “Daily maintenance”</td>
</tr>
<tr>
<td>Weekly maintenance tasks</td>
<td>Chapter 12, “Weekly maintenance”</td>
</tr>
<tr>
<td>Monthly maintenance tasks</td>
<td>Chapter 13, “Monthly maintenance”</td>
</tr>
<tr>
<td>As required maintenance tasks</td>
<td>Chapter 14, “As required maintenance”</td>
</tr>
</tbody>
</table>

9.2 Routine maintenance guidelines

9.2.1 General information

Use these guidelines as a basis for developing new or enhancing existing maintenance procedures and workflows that are used in the NOC. These guidelines do not provide a complete list of the features and functionality of the NFM-P. The guide includes a high-level view of maintenance actions based on frequency, suggests baseline measures to ensure performance tracking, and describes how to use NFM-P and OS utilities to check the performance.

See the other documentation, as described in 2.3 “NFM-P system administrator tasks and information map” (p. 20), to supplement the development of individualized maintenance procedures for your network.
9.3 Obtaining technical assistance

9.3.1 General information

Collect the information listed in Table 9-2, “Required technical-support Information” (p. 261) before you contact technical support. The list of support contacts is available at the following URL:

Technical support

<table>
<thead>
<tr>
<th>Table 9-2</th>
<th>Required technical-support Information</th>
</tr>
</thead>
<tbody>
<tr>
<td>Information type</td>
<td>Description</td>
</tr>
</tbody>
</table>
| Issue description | • recent GUI or XML API operations  
| | • screen captures or text versions of error or information messages  
| | • actions performed in response to the issue |
| Platform and software specifications | • NFM-P software release ID  
| | • OS release and patch level  
| | • hardware information such as the following:  
| | - CPU type  
| | - number of CPUs  
| | - disk sizes, partition layouts, and RAID configuration  
| | - amount of RAM |
| OS and NFM-P system logs | You can run the following script to collect the log files required by technical support:  
| | • On a main server station:  
| | /opt/nsp/nfmp/server/nms/bin/getDebugFiles.bash  
| | • On an auxiliary server station:  
| | /opt/nsp/nfmp/auxserver/nms/bin/getDebugFiles.bash  
| | See the NSP NFM-P Troubleshooting Guide for information about using the script. |

9.4 Routine maintenance checklist

9.4.1 Preventive maintenance tasks

<table>
<thead>
<tr>
<th>Table 9-3</th>
<th>Recommended NFM-P preventive maintenance tasks</th>
</tr>
</thead>
<tbody>
<tr>
<td>✓</td>
<td>Maintenance task</td>
</tr>
<tr>
<td>Daily maintenance tasks</td>
<td></td>
</tr>
<tr>
<td></td>
<td>“Daily maintenance information” (p. 274)</td>
</tr>
<tr>
<td></td>
<td>11.3 “Backing up the main database” (p. 274)</td>
</tr>
<tr>
<td></td>
<td>11.4 “Collecting and storing NFM-P log and configuration files” (p. 275)</td>
</tr>
<tr>
<td></td>
<td>11.3 “Backing up the main database” (p. 274)</td>
</tr>
</tbody>
</table>
### Table 9-3  Recommended NFM-P preventive maintenance tasks  (continued)

<table>
<thead>
<tr>
<th>✓</th>
<th>Maintenance task</th>
<th>Purpose</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td><strong>Weekly maintenance tasks</strong></td>
<td></td>
</tr>
<tr>
<td></td>
<td>12.4 “To check for performance monitoring statistics collection” (p. 282)</td>
<td>Ensure that there is sufficient capacity to process and store network statistics.</td>
</tr>
<tr>
<td></td>
<td>12.5 “To gather port inventory data for a specific managed device” (p. 283)</td>
<td>Collect inventory information for future baseline checks and post processing of equipment trends and use.</td>
</tr>
<tr>
<td></td>
<td>12.6 “To test a main database restore” (p. 284)</td>
<td>Ensure that main database backups are viable in the event that a restore is required.</td>
</tr>
<tr>
<td></td>
<td>12.7 “To check scheduled device backup status” (p. 289)</td>
<td>Ensure that managed device configuration backups are stored and collected correctly if a restore is required.</td>
</tr>
<tr>
<td></td>
<td>12.8 “To reduce the number of Oracle audit logs” (p. 290)</td>
<td>Ensure that the logs do not use excessive disk space.</td>
</tr>
<tr>
<td></td>
<td><strong>Monthly maintenance tasks</strong></td>
<td></td>
</tr>
<tr>
<td></td>
<td>13.1 “Performing main server and database redundancy switches” (p. 293)</td>
<td>Perform regular main server activity switches to ensure that system redundancy functions correctly and responsively.</td>
</tr>
<tr>
<td></td>
<td>13.2 “Checking the NFM-P platform performance” (p. 293)</td>
<td>Compare RHEL platform performance over time to check for degradation.</td>
</tr>
<tr>
<td></td>
<td>13.3 “Checking Windows client platform performance” (p. 293)</td>
<td>Compare Windows platform performance over time to check for degradation.</td>
</tr>
<tr>
<td></td>
<td>13.4 “Checking LAN TCP/IP connections between network-management domain elements” (p. 294)</td>
<td>Test connectivity between NFM-P components.</td>
</tr>
<tr>
<td></td>
<td>13.5 “Generating and storing a user account list” (p. 294)</td>
<td>Keep up-to-date records of staff and their assigned user accounts.</td>
</tr>
<tr>
<td></td>
<td>13.6 “Verifying documentation and support contact list updates” (p. 294)</td>
<td>Check for product updates and new load information.</td>
</tr>
<tr>
<td></td>
<td>13.7 “Setting the time and date” (p. 294)</td>
<td>Keep network devices and the NMS domain on the same clock.</td>
</tr>
<tr>
<td></td>
<td><strong>As required maintenance tasks</strong></td>
<td></td>
</tr>
<tr>
<td></td>
<td>“NFM-P platform modification and replacement” (p. 303)</td>
<td>Modify or replace the platform of an NFM-P component.</td>
</tr>
<tr>
<td></td>
<td>“Changing NFM-P system passwords” (p. 321)</td>
<td>Change NFM-P system passwords.</td>
</tr>
<tr>
<td></td>
<td>“Auxiliary server administration” (p. 332)</td>
<td>Control auxiliary component operation, for example, start or stop the component.</td>
</tr>
<tr>
<td></td>
<td>“NSP Flow Collector administration” (p. 334)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>“Analytics server administration” (p. 336)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>“Auxiliary database administration” (p. 338)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>“Backing up and restoring NE configuration files” (p. 350)</td>
<td>Back up or restore NE configuration backup files.</td>
</tr>
<tr>
<td></td>
<td>“Restoring and reinstatiating the main database” (p. 352)</td>
<td>Restore or reinstantiate a main database using a previously created database backup.</td>
</tr>
<tr>
<td>✓</td>
<td>Maintenance task</td>
<td>Purpose</td>
</tr>
<tr>
<td>---</td>
<td>------------------</td>
<td>---------</td>
</tr>
<tr>
<td>✓</td>
<td>“Clearing inactive residential subscriber instances” (p. 385)</td>
<td>Clear the accumulation of inactive subscriber instance records from the main database.</td>
</tr>
<tr>
<td>✓</td>
<td>“Listing customer service information” (p. 388)</td>
<td>Generate and export a list of services or service objects for analysis.</td>
</tr>
<tr>
<td>✓</td>
<td>“Checking for duplicate service or resource names” (p. 390)</td>
<td>Check for duplicate names to ensure that naming conventions are followed.</td>
</tr>
<tr>
<td>✓</td>
<td>“Configuring OLC states” (p. 410)</td>
<td>Use OLC states to limit the numbers of NFM-P alarms raised during an equipment or service maintenance period.</td>
</tr>
</tbody>
</table>
10 NFM-P maintenance base measures

10.1 Overview

10.1.1 Purpose

This chapter describes the maintenance base measures used to evaluate the activity and performance of network components.

10.1.2 Contents

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>10.1 Overview</td>
<td>265</td>
</tr>
<tr>
<td>Maintenance base measures</td>
<td>266</td>
</tr>
<tr>
<td>10.2 Base measures overview</td>
<td>266</td>
</tr>
<tr>
<td>10.3 Base measures guidelines</td>
<td>266</td>
</tr>
<tr>
<td>10.4 Platform base measures</td>
<td>267</td>
</tr>
<tr>
<td>10.5 Inventory base measures</td>
<td>268</td>
</tr>
<tr>
<td>10.6 Performance and scalability base measures</td>
<td>269</td>
</tr>
<tr>
<td>10.7 Reachability base measures</td>
<td>271</td>
</tr>
</tbody>
</table>
Maintenance base measures

10.2 Base measures overview

10.2.1 General information

Maintenance base measures can be used by NOC operations or engineering staff that are responsible for maintenance issues to evaluate the activity and performance of network components, for example, client GUI response times when listing equipment.

The data from a series of base measures can be used, over time, to track performance trends. For example, if there are reports that client GUI response times for listing equipment degrades over time, you can use the base measures to determine how much performance has degraded. The procedures in this guide can help narrow the search for the cause of performance degradation.

It is recommended to do the following:

• Determine the types of base measures required for your network.
• Record base-measure data.
• Regularly collect system information and compare the information with the base measure data.

This chapter provides base measure information for:

• platform—to ensure system sizes are tracked
• performance and scalability—to categorize system limitations as a baseline against NMS response times
• inventory counts—to generate inventory lists for storage and post-processing
• reachability—to ensure that customer services are available

10.3 Base measures guidelines

10.3.1 Overview

Base measures can be affected by issues that are beyond the scope of this guide, including:

• network topology design
• NOC or operations area LAN design

The NFM-P service test manager (STM) provides the ability to group OAM diagnostic tests into test suites that you can run as scheduled tasks. You can customize a test suite to your network topology and execute the test suite to establish baseline performance information. You can retain the test suite, modify it to accommodate network topology changes, and execute the test suite to establish new base measures as required. Scheduled execution of the test suite and regular review of the results may reveal deviations from the baseline. See the NSP NFM-P User Guide for information about using the STM and creating scheduled tasks.
10.4 Platform base measures

10.4.1 Overview

You can use platform base measures to:
• record the details of the platform configuration
• track network-specific growth to provide a delta for performance measures, for example, how long it takes to list 1000 ports on the current station compared to 10 000 ports on the same station, or on a smaller or larger station

Table 10-1 Platform base data

<table>
<thead>
<tr>
<th>Component</th>
<th>Platform information</th>
</tr>
</thead>
<tbody>
<tr>
<td>Main server 1</td>
<td>RAM:</td>
</tr>
<tr>
<td></td>
<td>CPU (quantity, type, speed):</td>
</tr>
<tr>
<td></td>
<td>OS version and patch level:</td>
</tr>
<tr>
<td>Main database 1</td>
<td>RAM:</td>
</tr>
<tr>
<td></td>
<td>CPU (quantity, type, speed):</td>
</tr>
<tr>
<td></td>
<td>OS version and patch level:</td>
</tr>
<tr>
<td>Main server 2</td>
<td>RAM:</td>
</tr>
<tr>
<td></td>
<td>CPU (quantity, type, speed):</td>
</tr>
<tr>
<td></td>
<td>OS version and patch level:</td>
</tr>
<tr>
<td></td>
<td>Swap space:</td>
</tr>
<tr>
<td></td>
<td>Disk slices:</td>
</tr>
<tr>
<td>Main database 2</td>
<td>RAM:</td>
</tr>
<tr>
<td></td>
<td>CPU (quantity, type, speed):</td>
</tr>
<tr>
<td></td>
<td>OS version and patch level:</td>
</tr>
<tr>
<td></td>
<td>Swap space:</td>
</tr>
<tr>
<td></td>
<td>Database disk file systems:</td>
</tr>
<tr>
<td></td>
<td>Disk slice sizes:</td>
</tr>
<tr>
<td>Auxiliary server 1</td>
<td>RAM:</td>
</tr>
<tr>
<td></td>
<td>CPU (quantity, type, speed):</td>
</tr>
<tr>
<td></td>
<td>OS version and patch level:</td>
</tr>
<tr>
<td></td>
<td>Swap space:</td>
</tr>
<tr>
<td></td>
<td>Disk slice sizes:</td>
</tr>
<tr>
<td>Auxiliary server 2</td>
<td>RAM:</td>
</tr>
<tr>
<td></td>
<td>CPU (quantity, type, speed):</td>
</tr>
<tr>
<td></td>
<td>OS version and patch level:</td>
</tr>
<tr>
<td></td>
<td>Swap space:</td>
</tr>
<tr>
<td></td>
<td>Disk slice sizes:</td>
</tr>
<tr>
<td>Auxiliary server 1</td>
<td>RAM:</td>
</tr>
<tr>
<td></td>
<td>CPU (quantity, type, speed):</td>
</tr>
<tr>
<td></td>
<td>OS version and patch level:</td>
</tr>
<tr>
<td></td>
<td>Swap space:</td>
</tr>
<tr>
<td></td>
<td>Disk slice sizes:</td>
</tr>
</tbody>
</table>
Table 10-1 Platform base data (continued)

<table>
<thead>
<tr>
<th>Component</th>
<th>Platform information</th>
</tr>
</thead>
<tbody>
<tr>
<td>Auxiliary server 2</td>
<td>RAM:</td>
</tr>
<tr>
<td></td>
<td>CPU (quantity, type, speed):</td>
</tr>
<tr>
<td></td>
<td>OS version and patch level:</td>
</tr>
<tr>
<td></td>
<td>Swap space:</td>
</tr>
<tr>
<td></td>
<td>Disk slice sizes:</td>
</tr>
<tr>
<td>Client delegate server</td>
<td>OS type, version, patch level:</td>
</tr>
<tr>
<td></td>
<td>RAM:</td>
</tr>
<tr>
<td></td>
<td>CPU:</td>
</tr>
<tr>
<td></td>
<td>Disk space:</td>
</tr>
<tr>
<td></td>
<td>Monitor:</td>
</tr>
<tr>
<td></td>
<td>Graphics card:</td>
</tr>
<tr>
<td>Single-user GUI client</td>
<td>OS type, version, patch level:</td>
</tr>
<tr>
<td></td>
<td>RAM:</td>
</tr>
<tr>
<td></td>
<td>CPU:</td>
</tr>
<tr>
<td></td>
<td>Disk space:</td>
</tr>
<tr>
<td></td>
<td>Monitor:</td>
</tr>
<tr>
<td></td>
<td>Graphics card:</td>
</tr>
<tr>
<td>Single-user GUI client</td>
<td>RAM:</td>
</tr>
<tr>
<td></td>
<td>CPU:</td>
</tr>
<tr>
<td></td>
<td>OS type, version, patch level:</td>
</tr>
<tr>
<td></td>
<td>Disk space:</td>
</tr>
<tr>
<td></td>
<td>Monitor:</td>
</tr>
<tr>
<td></td>
<td>Graphics card:</td>
</tr>
</tbody>
</table>

10.5 Inventory base measures

10.5.1 Overview

You can use inventory base measures to:
- create lists of network objects for future processing
- track network-specific growth to provide a delta for any performance measures, for example, how long it takes 5 versus 15 client GUIs to list 1000 ports

Use the following sequence to create inventory base measures, for example, for access ports. You can modify the sequence to create additional inventory base measures for other objects.

1. Determine the type of object data for which you need to create inventory records, for example, access ports.
2. List the ports of all managed network devices using the client GUI manage equipment window or create an XML API request to generate the list.
3. Format the inventory for future processing, based on your inventory processing applications.
4. Generate the inventory data, using the same listing and filtering criteria, on a weekly or monthly basis, as necessary to track changes to the network.
When new devices are added to the network on a regular basis, increase the inventory frequency.

5. Use the generated list to record the current inventory of network objects and as a baseline measure of performance.

For example, baseline the time required to generate a client GUI list of 1000 access ports. When an access port list is later generated, record the time required to generate the list using 2000 ports. Ideally, it takes twice as long to list twice as many ports; if the ratio of listing time to number of ports is highly nonlinear, there may be scalability issues that require investigation.

10.6 Performance and scalability base measures

10.6.1 Overview

You can use the following performance and scalability base measures to:

• record the system limit numbers and compare to the measurement data collected in your network
• track network-specific growth to provide a delta for any performance measures on similarly-sized platforms, for example, how long it takes to discover 10 new devices versus 20 new devices
• quantify user perceptions of performance
Table 10-2  Scalability base measures

<table>
<thead>
<tr>
<th>Type of base measure</th>
<th>System limits</th>
<th>Expected response time</th>
<th>Network base measure response time</th>
<th>Additional information</th>
</tr>
</thead>
<tbody>
<tr>
<td>Total devices managed</td>
<td>See the appropriate NSP NFM-P Release Description and NSP NFM-P Planning Guide for information about release-specific system limits.</td>
<td>The client GUI is operational XX seconds after launching.</td>
<td></td>
<td>The time to open icons in the Equipment navigation tree increases depending on the number of configured MDAs.</td>
</tr>
</tbody>
</table>
| Total services       | - XML API configuration of 300 VLL services in X min  
- XML API configuration of 100 VPLS services with 3 sites and one SAP in 5 min | | The complexity of the service configuration affects response time. For example, adding additional SAPs to a VPLS increases provisioning time. |
| Outstanding alarms   | The client GUI is able to retrieve and display XX 000 alarms in the dynamic alarm list during startup. | | |
| Client GUIs for each server | | | Open a configuration form using the client GUI in X amount of time. Measure X against a constant platform size over time |
| Device discovery     | Discover one additional device with an IP address in the X.X.X.1 to 255 range in less than 1 min. | | |

10.6.2  Performance base measures

For networks, commonly available tools such as ping, which measures round trip time using ICMP, can be used to determine quantities such as packet loss and round trip delay. See the ping command information in this guide, and the NSP NFM-P Troubleshooting Guide, for more information about performing the commands.

- Packet loss is defined as the fraction of packets sent from a measurement agent to a test point for which the measurement agent does not receive an acknowledgement from the test point. Acknowledgements that do not arrive within a pre-defined round trip delay at the measurement agent are considered lost.
- Round trip delay is defined as the interval between the time a measurement agent application sends a packet to a test point and the time it receives acknowledgement that the packet was received by the test point.

You can baseline the packet loss results and round trip delay times for specific NMS LAN and network scenarios. Record those results for future baselines against regularly run packet loss and round trip delay tests.
10.7 Reachability base measures

10.7.1 Overview
System reachability is important in business-critical applications. Service reachability components are:

- Can the customer reach the service? (reachability)
- If so, is the service available for customer use? (service availability)
- If not, how frequently and how long do service outages last? (service outage duration)

The types of measures and baselines necessary to ensure reachability and availability are network-dependent, and vary depending on the topology of the network, the networking technologies used to move data, and the types of equipment used.

10.7.2 Reachability
A test point is reachable from a testing measurement agent when the agent can send packets to the test point and receive a response from the test point that the packet was received. The ping test and the OAM diagnostics using the NFM-P or device CLI can test reachability. Record the test results to create a measurement baseline.

These tests can be performed when you troubleshoot a customer service, or when you perform SLA tests before you enable a customer service.

10.7.3 Service availability
The network between a measurement agent and a test point is considered available at a given time when the measured packet loss rate and the round trip delays are both below pre-defined thresholds. The threshold values are dependent on network topology. The ping test and the OAM diagnostics using the NFM-P or CLI to a device can test service availability. Record the test results to create a measurement baseline.

10.7.4 Service outage duration
The duration of an outage is defined as the difference between the time a service becomes unavailable and the time it is restored. Time between outages is defined as the difference between the start times of two consecutive outages. Troubleshooters that resolve customer problems, or the data generated to resolve SLAs, can provide the baseline metrics to measure outages, and the time between outages. Record the information to create a measurement baseline.
11 Daily maintenance

11.1 Overview

11.1.1 Purpose
This chapter describes daily maintenance information and procedures for monitoring alarms, backing up the main database, and collecting and storing log and configuration files.

11.1.2 Contents

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>11.1 Overview</td>
<td>273</td>
</tr>
<tr>
<td>Daily maintenance information</td>
<td>274</td>
</tr>
<tr>
<td>11.2 Viewing and filtering alarms</td>
<td>274</td>
</tr>
<tr>
<td>11.3 Backing up the main database</td>
<td>274</td>
</tr>
<tr>
<td>11.4 Collecting and storing NFM-P log and configuration files</td>
<td>275</td>
</tr>
<tr>
<td>Daily maintenance procedures</td>
<td>276</td>
</tr>
<tr>
<td>11.5 To monitor incoming alarms</td>
<td>276</td>
</tr>
<tr>
<td>11.6 To verify main database information</td>
<td>277</td>
</tr>
<tr>
<td>11.7 To back up the NFM-P log and configuration files</td>
<td>278</td>
</tr>
</tbody>
</table>

Daily maintenance
Overview
Release 18.3
March 2018
Issue 1
NFM-P
Daily maintenance information

11.2 Viewing and filtering alarms

11.2.1 Overview

In large networks where the NFM-P is constantly interacting with a busy network, many alarms are raised. Review alarms on a daily basis to check the type and characteristics of the alarms, and to resolve the network problems caused by the alarms. You must immediately correct physical equipment failure alarms or network device alarms.

You can create search filters to identify alarms for a specific site or service, and view up to six filtered alarm lists to monitor network wide issues.

You can also analyze the alarm history log on an as required basis to determine whether there are any chronic or prolonged failures, or trends. See “To review historical alarm records” in the NSP NFM-P User Guide for more information.

Note: If your NOC is organized to feed alarm streams from multiple vendor equipment to a third-party system, you must verify that all alarms are correctly logged by the system and then remove the alarms from the NFM-P GUI.

Performing maintenance operations on NEs can cause the NFM-P to raise a considerable number of alarms. The OLC state of an object indicates whether the object is in service or in maintenance mode. Using the OLC state as a criterion, you can create an alarm filter to suppress the display of alarms raised as the result of a maintenance operation. See “Configuring OLC states” (p. 410).

11.3 Backing up the main database

11.3.1 Overview

It is strongly recommended that you frequently back up the main database to prevent network data loss in the event of a failure. Other reasons for performing a database backup include the following:

• To move a database from one station to another
• To set aside a clean copy of the database before performing a system upgrade
• As a preventive measure before making a major change to the network

You can use the NFM-P client GUI or a CLI script to perform an immediate backup, and can use the GUI to schedule regular backups. See Chapter 7, “NFM-P database management” for information about configuring and performing database backups.

It is recommended that you perform a daily backup of the file system on each NFM-P station to enable the component restoration in the event of a catastrophic failure.
11.4 Collecting and storing NFM-P log and configuration files

11.4.1 Overview

When an NFM-P system runs for long periods with significant activity, the number of generated log files can consume a large amount of disk space. You must ensure that the contents of the NFM-P log directories are backed up on a regular basis to maintain a system activity record and to save disk space. It is also recommended that you back up the NFM-P configuration files.

**Note:** You must contact technical support to modify the NFM-P log storage parameters.
Daily maintenance procedures

11.5 To monitor incoming alarms

11.5.1 Process

The dynamic alarm list allows you to monitor all incoming network and network management domain alarms.

11.5.2 Steps

1. If required, choose Application→Alarm Window to enable the display of correlated alarms in the alarm window.

2. Ensure that the Alarm Table tab in the Alarm Window at the bottom of the NFM-P client GUI is selected.

3. If required, configure the filter criteria to limit the range of alarms displayed or to identify alarms for a specific site or service.

4. Right-click on an alarm entry row.
   The contextual alarm menu appears.

5. **CAUTION**

   **Service Disruption**

   *Handle the alarms according to your company alarm policies*

   *You cannot recover a deleted alarm unless you store alarms in the alarm history log.*

   For example, to acknowledge an alarm and then delete the alarm:
   1. Choose Acknowledge Alarm(s).
      The Alarm Acknowledgment form appears.
   2. Modify the Severity and Urgency parameters, as required.
   3. In the Acknowledgment Text parameter, enter data about the alarm, according to your company alarm policies.
   4. Click OK.
   5. Confirm the action.
The Ack column in the alarm row indicates that the alarm is acknowledged.

6. Right-click on the alarm entry row.
   The contextual alarm menu appears.

7. Choose Delete Alarm(s) from the contextual menu to delete the alarm.
   **Note:** It is recommended that you save all deleted alarms to the alarm history log. You can specify when alarms are logged using the Alarm History DB Behavior panel in the Alarm Setting window. See 14.52 “To configure alarm history database management behavior” (p. 401) for more information.

8. Confirm the action. The alarm is deleted.

**END OF STEPS**

### 11.6 To verify main database information

#### 11.6.1 Steps

Monitor device synchronization to confirm that the main database information is maintaining synchronization with the NE configuration information.

1. Check for deployment failures. Deployment failures indicate that communication with a managed NE is failing.
   1. Choose Administration→NE Maintenance→Deployment from the NFM-P main menu. The Deployment form opens.
   2. Click Search to display the latest information.
      When no failed deployments are listed, deployment problems are not causing a synchronization issue.
   3. If deployments are listed, view the state of a deployment in the State column. The possible deployment states include:
      • Canceled
      • Deployed
      • Failed (Configuration). Failure occurred because the configuration could not be applied to the specified objects.
      • Failed (Internal Error). Failure occurred due to general error conditions. The state is intended for all other possible errors.
      • Failed (Partial). Failure occurred at deployment and some of the configuration may have been sent to the network.
      • Failed (Resource Unavailable). Failure occurred because one of the resources required to apply the configuration is not in the main database.
      • Not Deployed
      • Pending
      • Postponed
   4. Identify the source of the deployment problem. For example, for a Failed configuration state, ensure the configuration was performed correctly on the client GUI.
2 If you determine that there is a deployment problem and the problem is unrelated to the NFM-P or device configuration, use your company IT policies to check the LAN for connectivity and transmission problems, such as collisions and CRC errors.

END OF STEPS

11.7 To back up the NFM-P log and configuration files

11.7.1 Process

Perform this procedure to save a copy of the NFM-P installation log and configuration files for later analysis in the event of a failure.

Note: During a system restart, NFM-P log files are backed up to directories that are named using a timestamp. A component that runs for a long time can generate multiple log files. Before you restart an NFM-P component, ensure that there is sufficient disk space to store the backed-up log files.

11.7.2 Steps

1 Copy the following files from the /tmp directory on a RHEL station, or from the installation_directory\client directory on a Windows client station:
   • NFM-P_component_stderr.txt
   • NFM-P_component_stdout.txt.
   where component is the NFM-P component type, for example, Main_Server, Main_Database, or Client

2 Copy the following file from each GUI client station; rename each file to indicate the client station from which it is copied:
   • installation_directory/nms/config/nms-client.xml

3 Copy the following file from each main database station:
   • /opt/nsp/nfmp/samdb/install/config/dbconfig.properties

4 Copy the following files from each main server station.
   • /opt/nsp/nfmp/server/nms/config/nms-server.xml
   • all log files in the /opt/nsp/nfmp/server/nms/log/server directory
   • all log files in the /opt/nsp/nfmp/server/nms/log/jmsserver directory

When an NFM-P log file reaches a predetermined size, the NFM-P closes, compresses, and
renames the file by including a sequence number and a timestamp. The following is an example of the filename format:

EmsServer.#.timestamp.log

where

# is a sequence number; the sequence begins at 0
timestamp is the log closure time, in the following format: YYYY-MM-DD_HH-mm-ss

5

Copy the following file from each auxiliary server station:

• /opt/nsp/nfmp/auxserver/nms/config/nms-auxserver.xml

6

Transfer the files to a secure location that is not in the network management domain.

END OF STEPS
Daily maintenance

Daily maintenance procedures

To back up the NFM-P log and configuration files
12 Weekly maintenance

12.1 Collecting device hardware inventory data

12.1.1 Overview
You can collect device hardware inventory data to:
• create a list of managed device objects, for example, access ports that are available as SAPs
• save for future processing and inventory tracking
• compare the current and historical lists to identify trends and capacity changes
• record the time required to gather inventory data as a base measure
See the inventory chapter in the NSP NFM-P User Guide for more information about generating specific types of inventory reports.

12.2 Checking scheduled device backups

12.2.1 Overview
When the NFM-P performs a device configuration backup, the NFM-P FTPs the following files from the NE:
• bof.cfg
• primary-config file specified in bof.cfg
• index file, which is the primary-config file with an .ndx extension
Before you schedule a backup, you must:
• have an NFM-P user account with an assigned admin scope of command role or a scope of command role with write access to the mediation package.
• have a user account with FTP access on the managed device.
• ensure the BOF persist parameter is set by typing the command: <show bof>. The parameter must be set to <persist on>.

12.3 Managing main database audit logs

12.3.1 Overview
As part of the main database security, audit log files are automatically created to track database session creation activities. The NFM-P does not automatically remove the files. You must monitor the directory that contains the audit log files to ensure that the files do not consume excessive disk space.
12.4 To check for performance monitoring statistics collection

12.4.1 Process

Use the performance monitoring statistic log records to determine whether performance statistics are collected within the scheduled interval using the client GUI.

1 Choose Tools→Statistics→Statistics Manager from the NFM-P main menu. The Statistics Manager form opens.

2 Set the Statistics Type parameter to Statistics Record to retrieve a list of historical data for the type of logged statistics.

3 Choose a type of statistics to collect. For example, to check interface statistics for managed devices, choose Interface Additional Stats (Physical Equipment).

4 Perform one of the following:
   a. To collect statistics for the past hour, click Search. Go to Step 6.
   b. To collect statistics based on a set of user-defined criteria, choose No Filter.

5 Configure the filter criteria and click Search.

   Note: You must specify a filter to limit the number of log records to less than 15 000; otherwise, a problem encountered form appears.

6 Review the data for the selected statistic.
   1. Click on the Monitored Object or Monitored Object Name headings to sort the historical statistics records by type of object.
   2. Review the Time Captured heading for one or more objects.
      Verify that the time captured intervals match the intervals set for the object or the statistic logging class.
      If the time captured intervals are not sufficient, there will be gaps in the historical record.

7 If there are gaps in the historical record, check the mediation policy to ensure that:
   • polling is enabled and administratively up
• the polling interval for a specific MIB or MIB entry is sufficient for collecting the required statistics

Note: Each row that represents a log record shows the Suspect column. When a check mark is present for an interval, there may have been a problem with collection during that interval.

Record the data for the selected device and type of statistics. Use this data as a base measurement to verify that statistics data was collected correctly over the scheduled interval.

END OF STEPS

12.5 To gather port inventory data for a specific managed device

12.5.1 Process
For most inventory lists you can:
• generate an inventory of the listed data
• reorganize the information from most important to least important
• remove columns of data
• sort rows in ascending or descending order

12.5.2 Steps

1
Choose Manage→Equipment→Equipment from the NFM-P main menu. The Manage Equipment form opens.

2
Choose a Network Element (Network) and click Search. The list form displays the results of the inventory search.

3
Choose an NE from the list and click Properties. The Network Element (Edit) form opens.

4
Click on the Inventory tab and choose Port (Physical Equipment). The list form displays the results of the inventory search for the selected device.

5
Generate a list based on the inventory collection or comparison that you plan to make. For example, to compare weekly lists of access ports, generate a filter to list only access ports.
Record the amount of time required to generate the inventory list for future base measure comparisons.

To show or hide columns of access port information:
1. Right-click on a column heading and choose Column Display.
2. Select Administrative State in the Displayed on Table column and click the left arrow to move the Administrative State to the Available for Table column.
3. Click Apply. The Administrative State column of data is removed from the access port list.

To save the list of access ports:
1. Right-click on a column heading and choose Save To File. The Save form opens.
2. Enter a filename; for example, access_device123_dateoflistgeneration.
3. Click Files of Type to specify the file type.
4. Browse to choose a location in which to save the file.
5. Click Save. The file is saved to the specified location with the appropriate file extension.

To save the table preferences for future use:
1. Right-click on a column heading and choose Save Table Preferences.
2. Click OK to confirm.
   The table preferences for the list form and user are saved. For example, when you choose another device, and click on the Ports tab and the Physical Ports tab, the Administrative State heading is not displayed. However, when you click on the SONET Channels tab, the Administrative State heading appears.

Move the file to another station, as required, for inventory analysis or post-processing.

END OF STEPS

12.6 To test a main database restore

CAUTION

**Service Disruption**

Restoring a main database on a station that has connectivity to the managed network or other NFM-P components may cause a service disruption.

Ensure that you perform the procedure only on an isolated station.
Note: Before you can test a database restore on a station, you must ensure that no NFM-P software is installed on the station.

12.6.1 Steps

It is strongly recommended that you regularly test a recent database backup to ensure that you can use the backup file to restore the main database in the event of a failure.

1 Generate comparison points for the main database, for example, the number of managed devices and cards, by creating an inventory of information, as described in the NSP NFM-P User Guide. This information is used to compare against the restored database information in a test environment to check the validity of the database backup.

2 Ensure that the station on which you plan to restore the database, called the test station, has the same system configuration as the actual database station, for example, partitioning, OS version, and OS patch level.

3 Identify a recent main database backup.

4 Log in to the test station as the root user.

5 Copy the database backup file set to the test station.

   Note: The path to the backup file set on the test station must be the same as the path of the backup file set on the database station.

6 Transfer the following NFM-P installation files for the existing release to an empty directory on the test station:
   • nsp-nfmp-jre-R.r.p-rel.v.rpm
   • nsp-nfmp-config-R.r.p-rel.v.rpm
   • nsp-nfmp-oracle-R.r.p-rel.v.rpm
   • nsp-nfmp-main-db-R.r.p-rel.v.rpm
   • OracleSw_PreInstall.sh
   where
   R.r.p is the NSP release identifier, in the form MAJOR.minor.patch
   v is a version identifier

7
Open a console window.

8 Navigate to the directory that contains the NFM-P installation files.

9 Enter the following:
   
   # chmod +x *

10 Enter the following:
   
   # ./OracleSw_PreInstall.sh

   **Note:** A default value is displayed in brackets []. To accept the default, press ↓.

   The following prompt is displayed:
   
   This script will prepare the system for a new install/restore of an NFM-P Version R.r Rn database.
   
   Do you want to continue? [Yes/No]:

11 Enter Yes. The following prompt is displayed:

   Enter the Oracle dba group name [group]:

12 Enter the group name from the existing database deployment.

   The following messages and prompt are displayed:
   
   Creating group group if it does not exist ... done
   
   Enter the Oracle user name [user]:

13 Enter the username from the existing database deployment.

   The following messages and prompt are displayed:
   
   Oracle user [user] new home directory will be [/opt/nsp/nfmp/oracle12r1].
   
   Checking or Creating the Oracle user home directory /opt/nsp/nfmp/oracle12r1...
   
   Checking user user...
   
   Adding user...
   
   Changing ownership of the directory /opt/nsp/nfmp/oracle12r1 to user:group.
   
   About to unlock the UNIX user [user]
Unlocking password for user user.
passwd: Success
Unlocking the UNIX user [user] completed
Please assign a password to the UNIX user user..
New Password:

14

Enter the password from the existing database deployment.
The following prompt is displayed:
Re-enter new Password:

15

Re-enter the password. The following message is displayed if the password change is successful:
pwd: password successfully changed for user
The following message and prompt are displayed:
Specify whether an NFM-P server will be installed on this workstation.
The database memory requirements will be adjusted to account for the additional load.
Will the database co-exist with an NFM-P server on this workstation [Yes/No]:

16

Enter Yes or No, as required, based on the existing NFM-P deployment.
Messages like the following are displayed as the script execution completes:
INFO: About to set kernel parameters in /etc/sysctl.conf...
INFO: Completed setting kernel parameters in /etc/sysctl.conf...
INFO: About to change the current values of the kernel parameters
INFO: Completed changing the current values of the kernel parameters
INFO: About to set ulimit parameters in /etc/security/limits.conf...
INFO: Completed setting ulimit parameters in /etc/security/limits.conf...
INFO: Completed running Oracle Pre-Install Tasks

17

Enter the following:
# yum install *.rpm
The yum utility resolves any package dependencies, and displays the following prompt:
Total size: nn G
Installed size: nn G
Is this ok [y/N]:

18

Enter y. The following and the installation status are displayed as each package is installed:

- Downloading packages:
- Running transaction check
- Running transaction test
- Transaction test succeeded
- Running transaction

The package installation is complete when the following is displayed:

Complete!

19

Enter the following:

```
# samrestoreDb path
```

where path is the absolute path of the database backup file set

The database restore begins, and messages like the following are displayed as the restore progresses.

- Restore log is /opt/nsp/nfmp/db/install/NFM-P_Main_Database.restore. yyyy.mm.dd–hh.mm.ss.stdout.txt
- <date time> working..
- <date time> Performing Step 1 of 7 - Initializing ..
- <date time> Executing StartupDB.sql ...
- <date time> Performing Step 2 of 7 - Extracting backup files ..... 
- <date time> Performing Step 3 of 7 - Restoring archive log files ..
- <date time> Performing Step 4 of 7 - Executing restore.rcv .......... 
- <date time> Performing Step 5 of 7 - Restoring Accounting tablespaces .......

- <date time> Performing Step 6 of 7 - Opening database ..... 
- <date time> working....
- <date time> Executing ConfigRestoreDB.sql ....................... 
- <date time> working.............
- <date time> Performing Step 7 of 7 - Configuring SAM Server settings ...

The following is displayed when the restore is complete:

- <date time> Database restore was successful
- DONE
Review the comparison points of the restored database with the actual database, as generated in Step 1. If the databases are the same, the backup is valid and the restore operation is successful.

---

**12.7 To check scheduled device backup status**

**12.7.1 Steps**

1. Choose Administration→NE Maintenance→Backup/Restore from the NFM-P main menu. The Backup/Restore form opens.

2. Click on the Backup/Restore Status tab. The managed devices are listed and backup and restore status information is displayed.


4. View the information in the Backup Status panel. A Backup State other than Successful may indicate a communication problem or a backup policy configuration error.

5. Ensure that the device configuration file and the associated index file are saved on the device and available for backup. Click on the Configuration Saves tab, and ensure that the Config Save State indicator reads Success.
   
   See the appropriate device operating-system documentation for more information.

6. Click on the Backups tab to view a list of backup operations that are currently in progress. A backup operation disappears from the list after it completes.

7. Click on the Faults tab to view additional troubleshooting information.

8. Close the NE Backup/Restore Status form.
9. Use the information obtained from the NE Backup/Restore Status form to check the backup policy configuration, if required. Click on the Backup/Restore Policy tab.

10. Select the backup policy for the device and click Properties. The Backup Policy (Edit) form opens.

11. Ensure that the policy is assigned to the device.
   2. Configure the policy filter criteria and click OK. The Backup Policy - Filter form closes.
   3. Move the device to the Assigned Sites list if it is not there by selecting the site from the Unassigned Sites list and clicking on the right-arrow.
   4. Save your changes and close the form.

12. Click on the General tab on the Backup Policy (Edit) form.

13. Select the Enable Backup check box.

14. Modify the other parameters, if required.

15. Save your changes and close the form.

END OF STEPS

12.8 To reduce the number of Oracle audit logs

12.8.1 Steps

1. Log in to the main database station as the Oracle management user.

2. Navigate to the /opt/nsp/nfmp/oracle12r1/rdbms/audit directory.
Archive and delete the files, as required. If the number of audit files increases quickly, you may need to perform this procedure more frequently.

END OF STEPS
Weekly maintenance
To reduce the number of Oracle audit logs
13 Monthly maintenance

13.1 Performing main server and database redundancy switches

13.1.1 Overview

In a redundant NFM-P system, performing regular main server and database redundancy tests is important for the following reasons:

• to ensure that main server and database redundancy functions correctly and responsively
• to identify conditions that may interfere with an NFM-P upgrade

**Note:** It is strongly recommended that you perform a main server activity switch and a database switchover monthly, or at least quarterly, if a monthly test is not possible. See Chapter 8, "NFM-P system redundancy" for information about performing a server activity switch or database switchover. Contact technical support for further assistance.

13.2 Checking the NFM-P platform performance

13.2.1 Overview

Use the following procedure to test the NFM-P platform performance and to record base measures. You can compare performance monthly to:

• collect base measure information related to platform performance
• ensure that there is no degradation in performance

If the performance degrades, collect the necessary logs and performance data and contact technical support. See the NSP NFM-P Troubleshooting Guide for information about NFM-P log collection.

13.3 Checking Windows client platform performance

13.3.1 Overview

You can compare Windows client station performance monthly to:

• collect base measure information related to platform performance
• ensure that there is no degradation in performance
13.4 Checking LAN TCP/IP connections between network-management domain elements

13.4.1 Overview
Use the ping and traceroute functions each month to check LAN TCP/IP connectivity between NFM-P components. Contact your IT department if there seems to be a communication problem between components.

13.5 Generating and storing a user account list

13.5.1 Overview
System administrators must keep a record of NFM-P users to:
- associate staff names with user accounts
- provide account information to TAC or Support staff as required for support to log in
- review user account privileges

13.6 Verifying documentation and support contact list updates

13.6.1 Overview
Use the Customer Documentation Welcome Page website as the source for NFM-P technical information and updates to:
- check for changes to TAC, Support, and Call Centre information
- find additional product updates, updated user documentation, and documentation generated for specific situations, such as Network Application Notes, Technical Notes, Product Change Notifications, and Field Notices

You must also regularly check your NFM-P platform vendor websites for information about OS patches, updates, and other software and hardware issues.

13.7 Setting the time and date

13.7.1 Overview
You can use a variety of time synchronization and network time protocol tools, depending on network design needs, including:
- ntpd, xntpd, or rdate, for network management domain devices
- the clock function on a Windows station
- SNTP, for devices in the managed network

It is strongly recommended that you maintain time synchronization between network devices. See the appropriate OS documentation for more information about using time and date synchronization protocols.

Note: Timing between the NFM-P main servers and GUI clients must be synchronized.
13.8 To measure NFM-P platform performance

13.8.1 Steps

1. Log into a main server, auxiliary server, or main database station as the root user.

2. Open a console window.

3. Enter the following to list the processes that have the highest CPU usage:
   
   ```
   # top
   ```
   
   Depending on your system configuration, approximately the top 20 processes are displayed. The top NFM-P process, by CPU usage, is typically the Java process.

4. Review the output; see the top man page for a description of the output fields.

5. Record the data for future performance comparison. Look for data that indicates excessive or continuously increasing CPU usage by the Java process.

6. Press CTRL+C to stop the command.

7. Enter the following to list CPU resource usage information:
   
   ```
   # mpstat nn
   ```
   
   where `nn` is the time, in seconds, between CPU polls; a value between 10 and 60 is recommended

8. Review the command output; see the mpstat man page for a description of the output fields.

9. Record the data for future performance comparison. Look for a difference in the output for a similar load on each station; a difference may indicate CPU performance degradation.

10. Press CTRL+C to stop the command.
Enter the following to list disk performance information:

```
# iostat -x n
```

where \( nn \) is the time, in seconds, during which you want to collect data; a starting value of 2 is recommended.

Review the output; see the iostat man page for a description of the output fields.

Record the data for future performance comparison. Look for a difference in the output for a similar load on each station that may indicate disk performance degradation on a station.

Press CTRL+C to stop the command.

Enter the following to list network interface performance information:

```
# netstat -i n
```

where \( n \) is the time, in seconds, over which you want to collect data; a starting value of 5 is recommended.

Review the output; see the netstat man page for a description of the output fields.

Record the data for future performance comparison. Look for a difference in the output for a similar load on each station that may indicate network performance degradation.

Press CTRL+C to stop the command.

Close the console window.

END OF STEPS
13.9  To check Windows client station performance

13.9.1  Steps

1
Open a command window on the client station.

2
Enter the following at the command prompt:

```
ping station_name
```
where `station_name` is the IP address or hostname, if DNS is used, of the main server to which you need to test connectivity.

3
Review the ping output for round-trip delays or lost packets. Resolve any connectivity issues that cause delays or dropped packets. Store ping round-trip delay or lost-packet data as a performance base measure for the station. You can use the data for future performance comparisons.

4
Open Windows Task Manager.

5
Check performance using the appropriate Task Manager tab.
   a. Click on the Processes tab. A list of processes appears. Sort the processes by CPU usage. The name of each NFM-P process begins with javaw. The CPU usage percentage for each NFM-P process must fall within your IT specifications or the established performance base measures.
   b. Click on the Performance tab. The CPU and page file usage charts appear. The memory and page-file usage percentages must fall within your IT specifications or the established performance base measures.
   c. Click on the Networking tab. The Local Area Connection chart appears. Network utilization greater than 10 or 20 percent may indicate collisions or other LAN problems that could affect performance in the network management domain.

6
Choose File→Exit Task Manager to close the form.

7
Open a console window.
Type:
tracert station_name
where station_name is the IP address or hostname of the main server to which you need to test connectivity
The tracert command provides details about network connectivity.

Review the tracert data, including:
• number of hops required to reach the main server
• average time between hops
Record the data for future base measure comparison. For example, when the number of hops between a client GUI and main server increases over time, traffic takes longer to travel between them, which can degrade performance.

Check regularly for advisories related to the OS. If updates or patches are required, contact technical support for information about potential effects on the NFM-P.

### 13.10 To check network management connections

#### 13.10.1 Steps

1. Open a console window on the station.

2. Ping the hostname of another station in the network management domain by entering the following:
   ping station_name
   where station_name is the IP address or hostname of the other station

3. Review the output. The following is an example of ping output:
   PING station_name: 56 data bytes
   64 bytes from hostname (IP_address): icmp_seq=0, time=nnn ms
   64 bytes from hostname (IP_address): icmp_seq=1, time=nnn ms
   64 bytes from hostname (IP_address): icmp_seq=2, time=nnn ms
   ----station_name PING Statistics----
3 packets transmitted, 3 packets received, 0% packet loss
round-trip (ms) min/avg/max = 0/0/1
LAN congestion may be a problem if packets are received out of order, are dropped, or take too long to complete the round trip.

4

Store the output for future base measure comparison.
Compare the output over time to ensure that changes in the data are not caused by deteriorating LAN conditions.

5

Check the routing information.
1. Open a console window on the station.
2. Enter one of the following traceroute commands to determine the path taken to a destination by an ICMP echo request message:
   • traceroute on a RHEL station
   • tracert on a Windows station
   The list of near-side interfaces in the path between a source host and a destination device is displayed. The near-side interfaces are the interfaces closest to the source host.

6

Store the output as a record for future base measure comparisons. Compare routes over time to ensure that there is optimal connectivity.

7

To check the routing tables for the platform:
1. Open a console window on the station.
2. To view the active routes for the platform, type:
   ```
   netstat -rn
   ```
   The following information is displayed:
   • network destination and gateway IP addresses
   • gateway used to reach the network destination
   • IP address of the interface on which communication occurs
   • metric value of the route

8

Store the output as a record for future base measure comparison. Compare routes over time to ensure that there is optimal connectivity.
13.11 To generate and store user account data

13.11.1 Steps

1. As the admin user, choose Administration→Security→NFM-P User Security from the NFM-P main menu. The NFM-P User Security -- Security Management (Edit) form opens.

2. Click on the Users tab.

3. Click Search without setting any filtering. The complete list of user accounts appears.

4. Organize the list of users. For example, to organize the list by the type of group that the user belongs to, click on the User Group column heading. The user accounts are listed alphabetically by user group.

5. Save the list of user accounts.
   1. Right-click on the user name list heading and choose Save To File. The Save form opens.
   2. Enter a name for the user account list, for example, NOCabc_useraccounts_yearmonthday.
   3. Click on the Files of Type pull-down menu to specify the file type.
   4. Browse to choose a location in which to save the file.
   5. Click Save. The file is saved to the selected location in the specified format with the appropriate extension.

6. Move the account list to a secure location. Store the latest version of the list and keep existing versions of the list for historical purposes.

END OF STEPS

13.12 To check for documentation and support updates

Note: You must register to view the product support pages. Contact your account representative for more information.

13.12.1 Steps

1. Log in to the Nokia product support center.
2 Enter your login user name and password when prompted.

3 Choose Network Services Platform (NSP) as the product. You can set it as a favorite on the site.

4 On the Product Information page, you can link to documentation or alerts, and can subscribe to e-mail notifications for either.

END OF STEPS
Monthly maintenance
To check for documentation and support updates
14 As required maintenance

NFM-P platform modification and replacement

14.1 Overview

14.1.1 Description

CAUTION

Service Disruption

To avoid a network management outage, it is strongly recommended that you contact technical support before you attempt to modify an NFM-P component platform.

An NFM-P component may require reconfiguration or another type of action in response to a change in the available platform resources.

When you modify the platform of an NFM-P component, you must also perform specific actions before or after the modification, depending on the component type; see 14.1.2 “Platform modification” (p. 303).

When you replace the platform of an NFM-P component, for example, after a catastrophic failure, you must ensure that the newly installed component on the replacement station retains all functions and customized properties of the original component. See 14.1.3 “Platform replacement” (p. 304).

14.1.2 Platform modification

Table 14-1, “NFM-P platform modification requirements” (p. 303), lists the required actions associated with specific platform changes. Some are to be performed before the platform modification, and some afterward.

Table 14-1  NFM-P platform modification requirements

<table>
<thead>
<tr>
<th>Modification type</th>
<th>Component and required action</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Main server</td>
</tr>
<tr>
<td>Number of CPUs</td>
<td>14.2 &quot;To reconfigure a main server after a platform modification&quot; (p. 304)</td>
</tr>
<tr>
<td>Amount of RAM</td>
<td>14.3 &quot;To reconfigure a main database after a platform modification&quot; (p. 305)</td>
</tr>
<tr>
<td>NIC type</td>
<td>14.4 &quot;To reconfigure an auxiliary server after a platform modification&quot; (p. 306)</td>
</tr>
<tr>
<td>LVM disk space</td>
<td>14.5 &quot;To reconfigure an NSP Flow Collector&quot; (p. 307)</td>
</tr>
<tr>
<td>OS patch or upgrade</td>
<td></td>
</tr>
<tr>
<td></td>
<td>14.6 &quot;To test NFM-P disk performance&quot; (p. 308), before increasing disk space</td>
</tr>
<tr>
<td></td>
<td>14.7 &quot;To relink the Oracle executable files&quot; (p. 311)</td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Release 18.3
March 2018
Issue 1

3HE-14090-AAAA-TQZZA 303
14.1.3 Platform replacement

In the event that an NFM-P component station fails and cannot be recovered, you must re-install the component on a replacement station that has the same platform specifications as the original station. If you want to use a station with different specifications, you must contact technical support to develop an approved hardware migration strategy.

Some components, such as main servers, may have custom settings in configuration files. In order to restore the original server functions, you must restore the custom settings. Each NFM-P procedure that describes modifying parameters in configuration files includes a step to back up the current configuration to a secure location. After a replacement component is installed, and before the component initializes, you must use the backup files to replace the newly installed files. Contact technical support for more information.

Multi-vendor driver restoration

MV driver files are installed on a main server after the main server installation. If your NFM-P system manages devices using MV drivers, and the main server fails, you must re-install the drivers on the replacement main server.

Note: Until the MV drivers are installed on the new main server, any devices managed using the drivers are in the Suspended state, and the driver status indicates that the driver file is absent from the main server file system.

See the NSP NFM-P User Guide for driver installation information.

14.2 To reconfigure a main server after a platform modification

14.2.1 Purpose

Perform this procedure to update the main server configuration after a change in the available platform resources.

CAUTION

Service Disruption

This procedure requires a main server restart, which is service-affecting.

Ensure that you perform the procedure only during a scheduled maintenance period.

Note: You require root and nsps user privileges on the main server station.

14.2.2 Steps

1. Log in to the main server station as the nsps user.

2. Open a console window.
3

Stop the main server:
1. Enter the following:
   bash$ cd /opt/nsp/nfmp/server/nms/bin
   bash$ ./nmsserver.bash stop
2. Enter the following:
   bash$ ./nmsserver.bash appserver_status
   The server status is displayed; the server is fully stopped if the status is the following:
   Application Server is stopped
   If the server is not fully stopped, wait five minutes and then repeat this step. Do not perform
   the next step until the server is fully stopped.

4

Enter the following to switch to the root user:
bash$ su -

5

Enter the following to reboot the station:
# systemctl reboot
The station reboots, and the platform change takes effect.

6

Close the console window.

END OF STOPS

14.3 To reconfigure a main database after a platform modification

14.3.1 Purpose
Perform this procedure to update the main database configuration after a change in the available
platform resources.

CAUTION

Service Disruption
This procedure requires a main database restart, which is service-affecting.
Ensure that you perform the procedure only during a scheduled maintenance period.

Note: You require root user privileges on the main database station.
14.3.2 Steps

1. Log in as the root user on the main database station.

2. Open a console window.

3. Enter the following to reboot the database station:

   `systemctl reboot`

   The station reboots, and the platform change takes effect.

END OF STEPS

14.4 To reconfigure an auxiliary server after a platform modification

14.4.1 Purpose

Perform this procedure to update the auxiliary server configuration after a change in the available platform resources.

CAUTION

Service Disruption

This procedure requires a restart of the auxiliary server, which is service-affecting.

Ensure that you perform the procedure only during a scheduled maintenance period.

Note: You require root and nsp user privileges on the auxiliary server station.

14.4.2 Steps

1. Log in as the nsp user on the auxiliary server station.

2. Open a console window.

3. Stop the auxiliary server:
   1. Enter the following:

      `bash$ cd /opt/nsp/nfmp/auxserver/nms/bin`

As required maintenance
NFM-P platform modification and replacement
To reconfigure an auxiliary server after a platform modification
2. Enter the following:
   
   ```bash
   ./auxnmsserver.bash auxstop
   ```

3. Enter the following to display the auxiliary server status:
   
   ```bash
   ./auxnmsserver.bash auxappserver_status
   ```
   
   The server status is displayed; the server is fully stopped if the status is the following:
   
   Auxiliary Server is stopped
   
   If the server is not fully stopped, wait five minutes and then repeat this step. Do not perform
   the next step until the server is fully stopped.

4. Enter the following command to switch to the root user:
   
   ```bash
   su -
   ```

5. Enter the following:
   
   ```bash
   # systemctl reboot
   ```
   
   The station reboots, and the platform change takes effect.

END OF STEPS

14.5 To reconfigure an NSP Flow Collector

14.5.1 Purpose

Perform this procedure to update the NSP Flow Collector configuration after a change in the
available platform resources.

**CAUTION**

**Service Disruption**

*This procedure requires a restart of the NSP Flow Collector, which is service-affecting.*

*You must perform the procedure only during a scheduled maintenance period.*

**Note:** You require root user privileges on the NSP Flow Collector station.

14.5.2 Steps

1. Log in to the NSP Flow Collector station as the root user.

2. Open a console window.
3

Enter the following to stop the NSP Flow Collector:

```
# systemctl stop nsp-flow-collector.service
```

The following messages are displayed as the NSP Flow Collector stops.

```
Stopping NSP Flow Collector...
NSP Flow Collector is stopped successfully
```

4

Enter the following:

```
# cd /opt/nsp/nfmp/dcp/bin
```

5

Enter the following:

```
# ./dcpctl.sh reconfig
```

The script lists the configuration files that are updated.

6

Enter the following to start the NSP Flow Collector:

```
# systemctl start nsp-flow-collector.service
```

The following and status messages are displayed as the NSP Flow Collector starts:

```
Starting NSP Flow Collector...
Data Category: category
The NSP Flow Collector is started when the following is displayed:
NSP Flow Collector is started successfully
```

7

Close the console window.

**END OF STEPS**

14.6 To test NFM-P disk performance

14.6.1 Purpose

Before you add disk capacity to a component that uses the RHEL LVM function, you must ensure that the disk throughput and latency values of a new volume are within tolerance, which is defined as being within 10% of the values for the current volume.

Perform this procedure to check the performance of an NFM-P disk partition.
**CAUTION**

**Service Disruption**

*Performing this procedure requires stopping one or more NFM-P components, which may be service-affecting.*

*You must perform this procedure only during a scheduled maintenance period.*

### 14.6.2 Steps

1. **Perform one of the following, depending on the type of component for which you need to check performance:**

   **a. Shut down a main server.**
   1. Log in to the main server station as the nsp user.
   2. Open a console window.
   3. Navigate to the `/opt/nsp/nfmp/server/nms/bin` directory.
   4. Enter the following:
      
      ```bash
      bash$ ./nmsserver.bash stop
      ```
   5. Enter the following to display the server status:
      
      ```bash
      bash$ ./nmsserver.bash appserver_status
      ```
      
      The server status is displayed; the server is fully stopped if the status is the following:
      
      **Application Server is stopped**
      
      If the server is not fully stopped, wait five minutes and then repeat this step. Do not perform the next step until the server is fully stopped.

   **b. Shut down an auxiliary server.**
   1. Log in to the auxiliary server station as the nsp user.
   2. Open a console window.
   3. Navigate to the `/opt/nsp/nfmp/auxserver/nms/bin` directory.
   4. Enter the following:
      
      ```bash
      bash$ ./auxnmsserver.bash auxstop
      ```
   5. Enter the following to display the auxiliary server status:
      
      ```bash
      bash$ ./auxnmsserver.bash auxappserver_status
      ```
      
      The command returns a status message.
      
      **Auxiliary Server is stopped**
      
      If the server is not fully stopped, wait five minutes and then repeat this step. Do not perform the next step until the server is stopped.

   **c. Shut down a main database.**
1. Log in to the main database station as the root user.
2. Open a console window.
3. Enter the following to stop the Oracle proxy:
   ```bash
   # systemctl stop nfmp-oracle-proxy.service
   ```
4. Enter the following to stop the main database:
   ```bash
   # systemctl stop nfmp-main-db.service
   ```

   If you are performing the test on a main or auxiliary server station, enter the following to switch to the root user:
   ```bash
   bash$ su -
   ```

3. Perform one of the following to run the disk performance utility.
   a. On a main server station, enter the following:
      ```bash
      # /opt/nsp/nfmp/server/nms/bin/unsupported/IOTest/NSP_IOTest.pl -d target
      ```
   b. On an auxiliary server station, enter the following:
      ```bash
      # /opt/nsp/nfmp/auxserver/nms/bin/unsupported/IOTest/NSP_IOTest.pl -d target
      ```
   c. On a main database station, enter the following:
      ```bash
      # /opt/nsp/nfmp/db/install/tools/unsupported/IOTest/NSP_IOTest.pl -d target
      ```

   where `target` is the disk partition to test

4. Record the utility output.

5. Increase the disk space of the target disk partition, as required.

6. Repeat Step 3 to Step 5, as required.

7. Compare the two Read, Write, and Latency values for the partition. If the values differ by more than 10%, contact the NFM-P Platform Team through your account representative.
8  Close the console window.

END OF STEPS

14.7 To relink the Oracle executable files

14.7.1 Purpose
Perform this procedure to relink the Oracle executable files on a main database station after you apply an OS patch, or after an OS upgrade.

CAUTION

Service Disruption

This procedure requires a restart of the main database, which is service-affecting.
You must perform the procedure only during a scheduled maintenance period.

Note: You require Oracle management user privileges on the main database station.

14.7.2 Steps

1  Log in to the main database station as the Oracle management user.

2  Open a console window.

3  Enter the following:
   
   bash$ /opt/nsp/nfmp/db/install/config/samdb/relinkOracle.sh
   
   where instance is the name of the main database instance, for example, maindb1
   
   The script relinks the Oracle executable files.

4  When the script execution is complete, enter the following to reboot the database station:
   
   # systemctl reboot
   
   The station reboots, and the main database initializes.

END OF STEPS
14.8 To update the supported NFM-P TLS versions and ciphers

14.8.1 Purpose

CAUTION

Service Disruption

This procedure involves a complete shutdown and restart of the NFM-P system.

It is strongly recommended that you perform this procedure only during a scheduled maintenance period.

CAUTION

Potential Service Outage

Using this procedure to disable the TLSv1 protocol may prevent NFM-P system access for GUI and OSS clients that use Java 7; Java 8 and later clients are unaffected.

If you use the procedure to disable TLSv1, the following conditions apply to Java 7 clients:

• A client that uses Java 7, update 94 or earlier, cannot connect to the NFM-P.

• A client that uses Java 7, update 95 or later, can connect to the NFM-P only if you enable TLSv1.1 or TLSv1.2, as required, on the client station.

To enable TLSv1.1 or TLSv1.2 for a client, you must add the protocol to the list of supported protocols defined by the jdk.tls.client.protocols Java system property on the client station, for example:

jdk.tls.client.protocols=TLSv1.2

Outdated TLS versions or ciphers may present a security risk. Perform this procedure to update the lists of supported TLS versions and ciphers in an NFM-P system.

Note: You require the following user privileges:

• on each main, auxiliary, and analytics server station — root, nsp

• on each NSP Flow Collector station — root

• on each main database station — root, Oracle management

Note: The following RHEL CLI prompts in command lines denote the active user, and are not to be included in typed commands:

• # —root user

• bash$ —nsp, Oracle management users
14.8.2 Steps

Prepare new cipher and TLS files

1 Log in to the standalone or primary NFM-P main server station as the nsp user.

2 Enter the following:
   
   \[
   \text{bash}\$ \ cd \ /opt/ns/nfmp/server/nms/bin/security_management/ssl \ \\
   \]

3 Enter the following to create the default cipher list file:
   
   \[
   \text{bash}\$ \ ./ciphers_and_tls_update.bash create -cdc default-ciphers-file \ \\
   \]

4 Enter the following to create the default TLS list file:
   
   \[
   \text{bash}\$ \ ./ciphers_and_tls_update.bash create -cdt default-TLS-file \ \\
   \]

5 Enter the following to copy the default ciphers file to a new file:
   
   \[
   \text{bash}\$ \ cp \ default-ciphers-file \ new_ciphers_file \ \\
   \text{where } new_ciphers_file \text{ is the name to assign to the new ciphers file} \ \\
   \]

6 Open new_ciphers_file using a plain-text editor such as vi.

7 Remove the ciphers that are not to be supported.

8 Save and close the file.

9 Enter the following to copy the default TLS file to a new file:
   
   \[
   \text{bash}\$ \ cp \ default-TLS-file \ new_TLS_file \ \\
   \text{where } new_TLS_file \text{ is the name to assign to the new TLS file} \ \\
   \]

10 Open new_TLS_file using a plain-text editor such as vi.
11

Remove the TLS versions that are not to be supported.

Note: TLSv1.2 is mandatory and must not be removed.

12

Save and close the file.

Distribute files to system components

13

If the NFM-P system is redundant, distribute the required files to the standby main server.

1. Log in to the standby main server station as the root user.
2. Enter the following:
   
   ```
   # cd /opt/nsp/nfmp/server/nms/bin/security_management/ssl
   ```
3. Copy the following files from the primary main server station to the current directory:
   - /opt/nsp/nfmp/server/nms/bin/security_management/ssl/new_ciphers_file
   - /opt/nsp/nfmp/server/nms/bin/security_management/ssl/new_TLS_file

14

If the system includes one or more auxiliary servers, distribute the required files to each auxiliary server.

1. Log in to the auxiliary server station as the root user.
2. Enter the following:
   
   ```
   # cd /opt/nsp/nfmp/auxserver/nms/bin/security_management/ssl
   ```
3. Copy the following files from the standalone or primary main server station to the current directory:
   - /opt/nsp/nfmp/server/nms/bin/security_management/ssl/new_ciphers_file
   - /opt/nsp/nfmp/server/nms/bin/security_management/ssl/new_TLS_file
4. Enter the following:
   
   ```
   # chown nsp:nsp new_ciphers_file
   ```
5. Enter the following:
   
   ```
   # chown nsp:nsp new_TLS_file
   ```

15

If the system includes one or more analytics servers, distribute the required files to each analytics server.

1. Log in to the analytics server station as the nsp user.
2. Enter the following:
   
   ```
   bash$: mkdir /opt/nsp/cipher_update
   ```
3. Enter the following to switch to the root user::
4. Copy the following files from the standalone or primary main server station to the /opt/nsp/cipher_update directory:
   - /opt/nsp/nfmp/server/nms/bin/security_management/ssl/ciphers_and_tls_update.bash
   - /opt/nsp/nfmp/server/nms/bin/security_management/ssl/new_ciphers_file
   - /opt/nsp/nfmp/server/nms/bin/security_management/ssl/new_TLS_file

5. Enter the following:
   ```
   # chmod a+x /opt/nsp/cipher_update/ciphers_and_tls_update.bash
   ```

Distribute the required files to each main database.

1. Log in to the main database station as the Oracle management user.
2. Enter the following:
   ```
   bash$ mkdir ~user/cipher_update
   ```
   where `user` is the name of the Oracle management user; the installation default is oracle

3. Enter the following to switch to the root user:
   ```
   # su
   ```

4. Copy the following files from the standalone or primary main server station to the ~user/cipher_update directory, where `user` is the name of the Oracle management user:
   - /opt/nsp/nfmp/server/nms/bin/security_management/ssl/ciphers_and_tls_update.bash
   - /opt/nsp/nfmp/server/nms/bin/security_management/ssl/new_ciphers_file
   - /opt/nsp/nfmp/server/nms/bin/security_management/ssl/new_TLS_file

5. Enter the following:
   ```
   # chown -R user:group ~user/cipher_update/
   ```
   where `user` is the Oracle management user name
   `group` is the Oracle management user group; the installation default is dba

6. Enter the following:
   ```
   # chmod a+x ~user/cipher_update/ciphers_and_tls_update.bash
   ```
   where `user` is the Oracle management user name

**Stop NFM-P system**

17

Close the open client sessions.

1. Open an NFM-P GUI client using an account with security management privileges, such as admin.
3. Click on the Sessions tab.
4. Click Search. The form lists the open GUI and XML API client sessions.
5. Identify the GUI session that you are using based on the value in the Client IP column.
6. Select all sessions except for the session that you are using.
7. Click Close Session.
8. Click Yes.
9. Click Search to refresh the list and verify that only the current session is open.
11. Close the GUI.

If the NFM-P system is redundant, stop the standby main server.
1. Log in to the standby main server station as the nsp user.
2. Open a console window.
3. Enter the following:
   ```
   bash$ /opt/nsp/nfmp/server/nms/bin/nmsserver.bash stop
   ```
   The main server stops.

If the system includes one or more auxiliary servers, stop each auxiliary server.
1. Log in to the auxiliary server station as the nsp user.
2. Open a console window.
3. Enter the following:
   ```
   bash$ /opt/nsp/nfmp/auxserver/nms/bin/auxnmsserver.bash auxstop
   ```
   The auxiliary server stops.

If the system includes one or more analytics servers, stop each analytics server.
1. Log in to the analytics server station as the nsp user.
2. Open a console window.
3. Enter the following:
   ```
   bash$ /opt/nsp/nfmp/analytics/bin/AnalyticsAdmin.sh stop
   ```
   The analytics server stops.

If the system includes one or more NSP Flow Collectors, stop each NSP Flow Collector.
1. Log in to the NSP Flow Collector station as the root user.
2. Open a console window.
3. Enter the following:
   ```
   # /opt/nsp/flow/dcp/bin/dcpctl.sh stop
   ```
The NSP Flow Collector stops.

22

Stop the standalone or primary main server.
1. Log in to the main server station as the nsps user.
2. Open a console window.
3. Enter the following:
   ```bash
   bash$ /opt/nsp/nfmp/server/nms/bin/nmsserver.bash stop
   ```
   The main server stops.

23

If the NFM-P system is redundant, stop the standby database proxy.
1. Log in to the standby database station as the root user.
2. Open a console window.
3. Enter the following:
   ```bash
   # systemctl stop nfmp-oracle-proxy.service
   ```
   The database proxy stops.

24

Stop the standalone or primary database proxy.
1. Log in to the database station as the root user.
2. Open a console window.
3. Enter the following:
   ```bash
   # systemctl stop nfmp-oracle-proxy.service
   ```
   The database proxy stops.

Apply new cipher and TLS lists

25

Perform the following steps on each main database station to apply the new TLS configuration.
1. Log in as the Oracle management user.
2. Enter the following:
   ```bash
   bash$ cd ~/cipher_update
   ```
3. Enter the following:
   ```bash
   bash$ ./ciphers_and_tls_update.bash apply -c new_ciphers_file -t new_TLS_file -fo
   ```
   where

Note: The -fo parameter is optional, and sets the cipher priority according to the order in the specified file. If the parameter is not included, the cipher priority is set to the default order.

Release 18.3
March 2018
Issue 1

3HE-14090-AAAA-TQZZA 317
Perform the following steps on each main server station to apply the new TLS configuration.

1. Log in as the nsp user.
2. Enter the following:
   `bash$ cd /opt/nsp/nfmp/server/nms/bin/security_management/ssl`
3. Enter the following:
   **Note:** The `-f0` parameter is optional, and sets the cipher priority according to the order in the specified file. If the parameter is not included, the cipher priority is set to the default order.
   ```bash
   bash$ ./ciphers_and_tls_update.bash apply -c new_ciphers_file -t new_TLS_file -f0
   ```
   where
   - `new_ciphers_file` is the updated ciphers file
   - `new_TLS_file` is the updated TLS file
   The script applies the new configuration, and backs up the previous configuration in the following file:
   `ciphers_and_tls_backup.timestamp.tar.gz`

If the system includes one or more auxiliary servers, perform the following steps on each auxiliary server station to apply the new TLS configuration.

1. Log in as the nsp user.
2. Enter the following:
   `bash$ cd /opt/nsp/nfmp/auxserver/nms/bin/security_management/ssl`
3. Enter the following:
   **Note:** The `-f0` parameter is optional, and sets the cipher priority according to the order in the specified file. If the parameter is not included, the cipher priority is set to the default order.
   ```bash
   bash$ ./ciphers_and_tls_update.bash apply -c new_ciphers_file -t new_TLS_file -f0
   ```
   where
   - `new_ciphers_file` is the updated ciphers file
   - `new_TLS_file` is the updated TLS file
The script applies the new configuration, and backs up the previous configuration in the following file:
ciphers_and_tls_backup.timestamp.tar.gz

If the system includes one or more analytics servers, perform the following steps on each analytics server station to apply the new TLS configuration.
1. Log in as the nsp user.
2. Enter the following:
   ```bash
   cd /opt/nsp/cipher_update
   ```
3. Enter the following:
   ```bash
   ./ciphers_and_tls_update.bash apply -c new_ciphers_file -t new_TLS_file -fo
   ```
   where
   - `new_ciphers_file` is the updated ciphers file
   - `new_TLS_file` is the updated TLS file

   The script applies the new configuration, and backs up the previous configuration in the following file:
ciphers_and_tls_backup.timestamp.tar.gz

### Start NFM-P system

29

Start the standalone or primary database proxy.
As the root user on the database station, enter the following:

```bash
# systemctl start nfmp-oracle-proxy.service
```

The database proxy starts.

30

If the NFM-P system is redundant, start the standby database proxy.
As the root user on the standby database station, enter the following:

```bash
# systemctl start nfmp-oracle-proxy.service
```

The database proxy starts.

31

Start the standalone or primary main server.
As the nsp user on the main server station, enter the following:
bash$ /opt/nsfmp/server/nms/bin/nmsserver.bash start
The main server starts.

32

If the NFM-P system is redundant, start the standby main server.
As the nsp user on the standby main server station, enter the following:
bash$ /opt/nsfmp/server/nms/bin/nmsserver.bash start
The main server starts.

33

If the system includes one or more auxiliary servers, start each auxiliary server.
As the nsp user on the auxiliary server station, enter the following:
bash$ /opt/nsfmp/auxserver/nms/bin/auxnmsserver.bash auxstart
The auxiliary server starts.

34

If the system includes one or more analytics servers, start each analytics server.
As the nsp user on the analytics server station, enter the following:
bash$ /opt/nsfmp/analytics/bin/AnalyticsAdmin.sh start
The analytics server starts.

35

If the system includes one or more NSP Flow Collectors, start each NSP Flow Collector.
As the root user on the NSP Flow Collector station, enter the following:
bash$ # /opt/nsf/flow/dcp/bin/dcpctl.sh start
The NSP Flow Collector starts.

36

Close the open console windows.

END OF STEPS
Changing NFM-P system passwords

14.9 Overview

14.9.1 Description

For increased security, it is recommended that you regularly change the passwords of the administrative user accounts on NFM-P components, as described in the following procedures:

• 14.10 “To change the nsp user password” (p. 321)
• 14.11 “To change a database user password in a standalone NFM-P system” (p. 322)
• 14.12 “To change a database user password in a redundant NFM-P system” (p. 325)

14.10 To change the nsp user password

14.10.1 Purpose

Perform this procedure to change the password of the nsp user in a standalone or redundant NFM-P system.

CAUTION

Service Disruption

If you perform this procedure, you must update the nsp password in each backup/restore and software upgrade policy that requires the password, or the associated operation fails.

Changing the nsp user password affects the following policy-based operations, if the associated policy includes the nsp user credentials:

• eNodeB backups, restores, and software upgrades

You must change the nsp password on each of the following stations, and must set each password to the same value:

• main server
• auxiliary server
• client delegate server

14.10.2 Steps

1. Log in to the component station as the root user.

2. Open a console window.
3 Enter the following:
   \# passwd nsp

The following prompt is displayed:
   New Password:

4 Enter the new password and press \.

The following prompt is displayed:
   Confirm New Password:

5 Enter the new password again and press \.
   The password is changed.

6 Record the new password and store it in a secure location.

7 Close the console window.

8 Log out of the component station.

END OF STEPS

14.11 To change a database user password in a standalone NFM-P system

14.11.1 Purpose

Perform this procedure to change the password of a user associated with the main database or the auxiliary database in a standalone NFM-P system.

CAUTION

Service Disruption

The procedure requires a restart of the NFM-P main server, which is service-affecting.

It is strongly recommended that you perform this procedure only during a scheduled maintenance period.

Note: Before you perform the procedure, you must ensure that each main server, auxiliary server, and main database is running and operational.
You can use the procedure to change only one user password at a time. To change multiple user passwords, you must perform the procedure multiple times. When you change a password on one station, the NFM-P automatically updates the password on all other NFM-P stations.

**Note:** The NFM-P synchronizes the samauxdb password of an auxiliary database with the SYS password of the main database. When you change the SYS password, the samauxdb password is set to the same value.

**Note:** The NFM-P synchronizes the samuser password of an auxiliary database with the samuser password of the main database. When you change the samuser password of the main database, the samuser password of the auxiliary database is set to the same value.

**Note:** The samuser password expires after 180 days.

### 14.11.2 Steps

1. Log in to the main server station as the nsp user.

2. Open a console window.

3. Navigate to the `/opt/nsp/nfmp/server/nms/bin` directory.

4. Enter the following:
   
   ```bash
   bash$ ./nmsserver.bash passwd
   
   The script prompts you for the current SYS user password.
   ```

5. Enter the password. The script validates the password, and then displays a list of user names like the following:

   **SAM Database Users:**
   - sys
   - database_user (installation default is samuser)

   **Other Database Users:**
   - sq1txplain
   - appqossys
   - outln
   - dip
To change a database user password in a standalone NFM-P system

- system
- exit

6

Enter a user name. The script prompts you for a password.

7

Enter the new password, which must:
- Be between 4 and 30 characters long
- Contain at least three of the following:
  - lower-case alphabetic character
  - upper-case alphabetic character
  - numeric character
  - special character, which is one of the following:
    # $ _
- Not contain four or more of the same character type in sequence
- Not be the same as the user name or the reverse user name
- Not contain a space character
- Differ by at least four characters from the current password

If the password is valid, the script prompts you to retype the password.

8

Enter the new password again. The following prompt is displayed:

WARNING: Changing passwords may cause instability to the NFM-P server as well as the Oracle proxy on the database server.
Do you want to proceed (yes/no)?:

9

Enter yes ✓. The script displays status messages and then exits. If the status indicates a password change failure, contact technical support.

10

Record the password in a secure location.

11

Perform the following steps.
1. Log in to the main database station as the root user.
2. Open a console window.
3. Enter the following to stop the Oracle proxy:
   # systemctl stop nfmp-oracle-proxy.service ✓
4. Enter the following to stop the main database:
   
   ```bash
   # systemctl stop nfmp-main-db.service
   ```

5. Close the console window.

6. Log out of the database station.

12

Perform the following steps.

1. Navigate to the `/opt/nsp/nfmp/server/nms/bin` directory on the main server station.

2. Enter the following to restart the main server:
   
   ```bash
   bash$ ./nmsserver.bash restart
   ```

3. Enter the following to display the server status:
   
   ```bash
   bash$ ./nmsserver.bash appserver_status
   ```

   The server status is displayed; the server is fully initialized if the status is the following:

   Application Server process is running. See nms_status for more detail.

   If the server is not fully initialized, wait five minutes and then repeat this step. Do not perform the next step until the server is fully initialized.

13

Close the console windows.

14

Log out of the main server station.

END OF STEPS

14.12 To change a database user password in a redundant NFM-P system

14.12.1 Purpose

Perform this procedure to change the password of a user associated with the main database or the auxiliary database in a redundant NFM-P system.

CAUTION

Service Disruption

The procedure requires a restart of each main server, which is service-affecting.

Perform the procedure only during a scheduled maintenance period.

Note: Before you perform the procedure, you must ensure that each main server, auxiliary server, and database is running and operational.
You can use the procedure to change only one user password at a time. To change multiple user passwords, you must perform the procedure multiple times.

When you change a password on one station, the NFM-P automatically updates the password on all other NFM-P stations.

**Note:** The NFM-P synchronizes the samauxdb password of an auxiliary database with the SYS password of the main database. When you change the SYS password, the samauxdb password is set to the same value.

**Note:** The NFM-P synchronizes the samuser password of an auxiliary database with the samuser password of the main database. When you change the samuser password of the main database, the samuser password of the auxiliary database is set to the same value.

**Note:** The samuser password expires after 180 days.

### 14.12.2 Steps

1. Log in to the primary main server station as the nsp user.

2. Open a console window.

3. **CAUTION**

   **Service Disruption**

   Contact technical support before you attempt to modify the nms-server.xml file.

   Modifying the nms-server.xml file can have serious consequences that can include service disruption.

   If you are changing the SYS user or main database user password, disable the automatic database failover function.

   1. Navigate to the /opt/nsp/nfmp/server/nms/config directory.
   2. Open the nms-server.xml file using a plain-text editor such as vi.
   3. Locate the following parameter entry:

      ```
      dbAutoFailOver=value
      ```

   4. Record the parameter value.
   5. Edit the entry to read:

      ```
      dbAutoFailOver="no"
      ```

   6. Save and close the nms-server.xml file.
8. Enter the following:
   
   `bash$ ./nmsserver.bash read_config`  
   
   The configuration change is applied, and automatic database failovers are disabled.

   **Note:** For convenience, leave the console window open; it is required later in the procedure.

4. Navigate to the /opt/nsp/nfmp/server/nms/bin directory.

5. Enter the following:
   
   `bash$ ./nmsserver.bash passwd`  
   
   The script prompts you for the current SYS user password.

6. Enter the password. The script validates the password, and then displays a list of user names like the following:
   
   SAM Database Users:
   - sys
   - database_user (installation default is samuser)
   
   Other Database Users:
   - sqltxplain
   - appqossys
   - outln
   - dip
   - system
   - exit

7. Enter a user name. The script prompts you for a password.

8. Enter the new password, which must:
   
   - Be between 4 and 30 characters long
   - Contain at least three of the following:
     - lower-case alphabetic character
     - upper-case alphabetic character
     - numeric character
     - special character, which is one of the following:
# $ _

- Not contain four or more of the same character type in sequence
- Not be the same as the user name or the reverse user name
- Not contain a space character
- Differ by at least four characters from the current password

If the password is valid, the script prompts you to retype the password.

9

Enter the new password again. The following prompt is displayed:

WARNING: Changing passwords may cause instability to the NFM-P server as well as the Oracle proxy on the database server.

Do you want to proceed (yes/no)?:

10

Enter yes ↵. The script displays status messages and then exits. If the status indicates a password change failure, contact technical support.

11

Record the password in a secure location.

12

If you are changing a password other than the SYS or database user password, go to Step 18.

13

Stop each main database; stop the standby first, and then the primary.

1. Log in to the database station as the root user.
2. Open a console window.
3. Enter the following:
   
   `# systemctl stop nfmp-oracle-proxy.service` ↵
4. Enter the following:
   
   `# systemctl stop nfmp-main-db.service` ↵

   **Note:** For convenience, leave the console window open; it is required later in the procedure.

14

Stop the standby main server.

1. Log in to the standby main server station as the nsp user.
2. Open a console window.
3. Navigate to the /opt/nsp/nfmp/server/nms/bin directory.
4. Enter the following:

```
bash$ ./nmsserver.bash stop
```

5. Enter the following:

```
bash$ ./nmsserver.bash appserver_status
```

The server status is displayed; the server is fully stopped if the status is the following:

**Application Server is stopped**

If the server is not fully stopped, wait five minutes and then repeat this step. Do not perform the next step until the server is fully stopped.

**Note:** For convenience, leave the console window open; it is required later in the procedure.

15

Start each main database; start the primary first, and then the standby.

1. Return to the open console window on the database station.

2. Enter the following:

```
# systemctl start nfmp-main-db.service
```

3. Enter the following:

```
# systemctl start nfmp-oracle-proxy.service
```

4. Close the console window.

16

Restart the primary main server.

1. Return to the open console window on the primary main server station.

2. Enter the following:

```
bash$ ./nmsserver.bash restart
```

The primary main server restarts.

3. Enter the following:

```
bash$ ./nmsserver.bash appserver_status
```

The server status is displayed; the server is fully initialized if the status is the following:

**Application Server process is running. See nms_status for more detail.**

If the server is not fully initialized, wait five minutes and then repeat this step. Do not perform the next step until the server is fully initialized.

**Note:** For convenience, leave the console window open; it may be required later in the procedure.

17

Start the standby main server.
1. Return to the open console window on the standby main server station.
2. Enter the following:
   ```bash
   bash$ ./nmsserver.bash start
   ```
3. Enter the following:
   ```bash
   bash$ ./nmsserver.bash appserver_status
   ```
   The server status is displayed; the server is fully initialized if the status is the following:
   Application Server process is running. See `nms_status` for more detail.
   If the server is not fully initialized, wait five minutes and then repeat this step. Do not perform the next step until the server is fully initialized.
4. Close the console window.
5. Log out of the standby main server station.

---

**CAUTION**

Service Disruption

*Modifying the nms-server.xml file can have serious consequences that can include service disruption.*

*Contact technical support before you attempt to modify the file.*

If the `dbAutoFailOver` value recorded in Step 3 is yes, re-enable the automatic database failover function.

1. Navigate to the `/opt/nsp/nfmp/server/nms/config` directory on the primary main server station.
2. Open the nms-server.xml file using a plain-text editor such as vi.
3. Locate the following parameter entry:
   ```xml
   dbAutoFailOver="no"
   ```
4. Edit the entry to read:
   ```xml
   dbAutoFailOver="yes"
   ```
5. Save and close the nms-server.xml file.
7. Enter the following:
   ```bash
   bash$ ./nmsserver.bash read_config
   ```
   The configuration change is applied, and automatic database failovers are enabled.

---

Close the open console windows.
Log out of the primary main server station.
Auxiliary server administration

14.13 To start an auxiliary server

14.13.1 Steps

1. Choose Administration→System Information from the NFM-P main menu. The System Information form opens.

2. Click on the Auxiliary Servers tab.

3. Select the auxiliary server and click Properties. The Auxiliary Server (Edit) form opens.

4. Set the Operation Mode parameter to In Service.

5. Click OK to commit the change and close the form.

6. Close the System Information form.

7. Log in to the auxiliary server station as the nsp user.

8. Open a console window.

9. Enter the following:
   
   `bash$ /opt/nsp/nfmp/auxserver/nms/bin/auxnmsserver.bash auxstart`

   The auxiliary server starts.

10. Close the console window.

END OF STEPS
14.14 To stop an auxiliary server

CAUTION

Service Disruption

Performing this procedure may be service-affecting.

Ensure that you perform this procedure only during a scheduled maintenance period.

14.14.1 Steps

1. Choose Administration→System Information from the NFM-P main menu. The System Information form opens.

2. Click on the Auxiliary Servers tab.

3. Select the auxiliary server and click Properties. The Auxiliary Server (Edit) form opens.

4. Set the Operation Mode parameter to In Maintenance Mode.

5. Click OK to commit the change and close the form.
   The auxiliary server stops.

6. Close the System Information form.

END OF STEPS
**NSP Flow Collector administration**

14.15 **To start an NSP Flow Collector**

14.15.1 **Steps**

1. Log in to the NSP Flow Collector station as the root user.

2. Open a console window.

3. Enter the following:
   
   ```
   # systemctl start nsp-flow-collector.service
   
   Starting NSP Flow Collector...  
   Data Category: category
   
   The NSP Flow Collector is started when the following is displayed:
   
   NSP Flow Collector is started successfully
   ```

4. Close the console window.

**END OF STEPS**

14.16 **To stop an NSP Flow Collector**

14.16.1 **Steps**

1. Log in to the NSP Flow Collector station as the root user.

2. Open a console window.

3. Enter the following:
   
   ```
   # systemctl stop nsp-flow-collector.service
   
   Stopping NSP Flow Collector...
   ```
NSP Flow Collector is stopped successfully

4

Close the console window.

END OF STEPS

14.17 To display the NSP Flow Collector status

14.17.1 Steps

1

Log in to the NSP Flow Collector station as the root user.

2

Open a console window.

3

Enter the following:

```
# systemctl status nsp-flow-collector.service
```

The following and system version messages are displayed:

```
################################################
Status report at date  time
Checking NSP Flow Collector status...
The following is displayed if the server is functioning normally:
NSP Flow Collector is started successfully
JBoss Status: UP
NSP Flow Collector Operational Status: UP
NSP Flow Collector Admin Status: ENABLED
Data Category: category
################################################
```

4

Close the console window.

END OF STEPS
Analytics server administration

14.18 To start an analytics server

14.18.1 Purpose
Perform this procedure to start the analytics server software.

1
Log in to the analytics server station as the nsp user.

2
Open a console window.

3
Enter the following:
bash$ /opt/nsp/nfmp/analytics/bin/AnalyticsAdmin.sh start

The following message is displayed:
Starting Analytics Server

When the analytics server is started, the following message is displayed.
Analytics Server successfully started!

4
Close the console window.

END OF STEPS

14.19 To stop an analytics server

14.19.1 Purpose
Perform this procedure to stop the analytics server software.

1
Log in to the analytics server station as the nsp user.

2
Open a console window.

3
Enter the following:
bash$ /opt/nsp/nfmp/analytics/bin/AnalyticsAdmin.sh stop
As required maintenance
Analytics server administration
To stop an analytics server

The following message is displayed:

Stopping Analytics Server

When the analytics server is stopped, the following message is displayed:

Analytics Server is not running

4

Close the console window.

END OF STEPS
Auxiliary database administration

14.20 To start an auxiliary database

14.20.1 Purpose
Perform this procedure to start the auxiliary database software, for example, if the auxiliary
database fails to start after a power disruption.

1 Log in to an auxiliary database station as the root user.

2 Enter the following:
# /opt/ns/nfmp/auxdb/install/bin/auxdbAdmin.sh start 
You are prompted for the database user password.

3 Enter the password. The auxiliary database starts.

END OF STEPS

14.21 To stop an auxiliary database

14.21.1 Purpose
Perform this procedure to stop the auxiliary database software, for example, for maintenance
purposes.

1 Log in to an auxiliary database station as the root user.

2 Enter the following:
# /opt/ns/nfmp/auxdb/install/bin/auxdbAdmin.sh stop 
You are prompted for the database user password.

3 Enter the password. The auxiliary database stops.

END OF STEPS
14.22 To change an auxiliary database user password

14.22.1 Purpose

Note: The NFM-P automatically synchronizes an auxiliary database password with the password of the corresponding main database user. To change an auxiliary database password, you must change the corresponding main database password.

1

To change the sam$dbpassword in a standalone NFM-P system, perform 14.11 “To change a database user password in a standalone NFM-P system” (p. 322) and specify the SYS password.

2

To change the sam$dbpassword in a redundant NFM-P system, perform 14.12 “To change a database user password in a redundant NFM-P system” (p. 325) and specify the SYS password.

3

To change the sam$userpassword in a standalone NFM-P system, perform 14.11 “To change a database user password in a standalone NFM-P system” (p. 322) and specify the sam$user password.

4

To change the sam$userpassword in a redundant NFM-P system, perform 14.12 “To change a database user password in a redundant NFM-P system” (p. 325) and specify the sam$user password.

END OF STEPS

14.23 To restore an auxiliary database

14.23.1 Purpose

Perform this procedure to restore an auxiliary database in an NFM-P system using an auxiliary database backup file set.

CAUTION

Service disruption

Restoring an auxiliary database requires a shutdown of the NFM-P system and causes a network management outage.

Ensure that you perform this procedure only during a scheduled maintenance period.
14.23.2 Steps

Stop NFM-P main and auxiliary servers

1

If the NFM-P system is redundant, stop the standby main server and the associated auxiliary servers.

1. Perform 14.14 “To stop an auxiliary server” (p. 333) to stop each Preferred and Reserved auxiliary server of the standby main server.
2. Log in to the standby main server as the nsp user.
3. Open a console window.
4. Enter the following:
   
   bash$ cd /opt/nsp/nfmp/server/nms/bin
   
   5. Enter the following to stop the main server:
   
   bash$ ./nmsserver.bash stop
   
   6. Enter the following to display the main server status:
   
   bash$ ./nmsserver.bash appserver_status
   
   The server status is displayed; the server is fully stopped if the status is the following:
   
   Application Server is stopped
   
   If the server is not fully stopped, wait five minutes and then repeat this step. Do not perform the next step until the server is fully stopped.

2

Stop the standalone or primary main server and the associated auxiliary servers.

1. Perform 14.14 “To stop an auxiliary server” (p. 333) to stop each Preferred and Reserved auxiliary server of the primary or standalone main server.
2. Log in to the main server station as the nsp user.
3. Open a console window.
4. Enter the following:
   
   bash$ cd /opt/nsp/nfmp/server/nms/bin
   
   5. Enter the following to stop the main server:
   
   bash$ ./nmsserver.bash stop
   
   6. Enter the following to display the main server status:
   
   bash$ ./nmsserver.bash appserver_status
   
   The server status is displayed; the server is fully stopped if the status is the following:
   
   Application Server is stopped
   
   If the server is not fully stopped, wait five minutes and then repeat this step. Do not perform the next step until the server is fully stopped.
Prepare auxiliary database stations

3

Stop the auxiliary database; perform 14.21 “To stop an auxiliary database” (p. 338).

4

If the backup files to restore are not in the original backup location on each auxiliary database station, copy the files to the original backup location on each station.

1. If you know the original backup location, go to substep 6.
2. Open the following text file in for viewing:
   
   path/AuxDbBackUp/samAuxDbBackup_restore.conf
   
   where path is the current location of the backup file set
3. Locate the [Mapping] section, which contains one line like the following for each auxiliary server station:
   
   v_name_node0001 = IP_address:path/AuxDbBackUp
   
   The path is the original backup location.
4. Record the original backup location.
5. Close the samAuxDbBackup_restore.conf file.
6. Copy the AuxDbBackUp directory contents from the current backup location to the AuxDbBackUp directory in the original backup location on each auxiliary database station.
7. As the root user, enter the following commands on each auxiliary database station:
   
   # chown -R samauxdb path
   
   # chmod -R 777 path
   
   where path is the absolute path of the original backup location

Perform auxiliary database restore operation

5

Enter the following on one auxiliary database station:

   # su - samauxdb

6

Perform one of the following:

a. Restore the latest backup; enter the following:
   
   bash$ vbr.py --task restore --config-file
   
   path/AuxDbBackUp/samAuxDbBackup_restore.conf
   
   where path is the original backup directory
b. Restore a backup other than the latest; perform the following steps.
   
   1. Enter the following:
bash$ ls /path/AuxDbBackUp/.auxdb_backup_history

where *path* is the original backup directory

The directory contents are listed; the following files are present for each previous backup:

- AuxDbBackUpID_datestamp_timestamp_samAuxDbBackup_info.txt
- AuxDbBackUpID_datestamp_timestamp_samAuxDbBackup_restore.txt

where

- *datestamp* is the backup date, in the form *YYYYMMDD*
- *timestamp* is the backup time, in the form *hhmmss*
- *ID* is a unique numerical identifier

2. Based on the date and time of the backup that you want to restore, identify and record the *ID*, *datestamp*, and *timestamp* values.

3. Enter the following:

bash$ vbr.py --task restore --config-file /path/AuxDbBackUp/.auxdb_backup_history/AuxDbBackUpID_datestamp_timestamp_samAuxDbBackup_restore.conf --archive= datestamp_timestamp

where

- *path* is the original backup directory
- *ID* is the recorded *ID* value
- *datestamp* is the recorded *datestamp* value
- *timestamp* is the recorded *timestamp* value

The restore operation begins. The following messages and progress indicators are displayed:

Starting full restore of database *db_name*.
Participating nodes: *node_1, node_2, ... node_n*.
Restoring from restore point: AuxDbBackUpID_datestamp_timestamp
Determining what data to restore from backup.

[==============================================] 100%
Approximate bytes to copy: nnnnnnnnn of nnnnnnnnn total.
Syncing data from backup to cluster nodes.

When the restore is complete, the second progress indicator reaches 100%, and the following message is displayed:

[==============================================] 100%
Restoring catalog. Restore complete!

**Start NFM-P components**

Enter the following to switch back to the root user:

bash$ exit
Enter the following to start the auxiliary database:

```bash
# /opt/nsp/nfmp/auxdb/install/bin/auxdbAdmin.sh start
```

Start the standalone or primary main server and associated auxiliary servers.

1. Log in to the main server station as the nsp user.
2. Open a console window.
3. Enter the following:
   ```bash
   cd /opt/nsp/nfmp/server/nms/bin
   ```
4. Enter the following to start the main server:
   ```bash
   ./nmsserver.bash start
   ```
5. Enter the following:
   ```bash
   ./nmsserver.bash appserver_status
   ```
   The server status is displayed; the server is fully initialized if the status is the following:
   Application Server process is running. See nms_status for more detail.
   If the server is not fully initialized, wait five minutes and then repeat this step. Do not perform the next step until the server is fully initialized.
6. Perform 14.13 “To start an auxiliary server” (p. 332) to start each Preferred and Reserved auxiliary server of the primary or standalone main server.

If the NFM-P system is redundant, start the standby main server and associated auxiliary servers.

1. Log in to the standby main server as the nsp user.
2. Open a console window.
3. Enter the following:
   ```bash
   cd /opt/nsp/nfmp/server/nms/bin
   ```
4. Enter the following to start the main server:
   ```bash
   ./nmsserver.bash start
   ```
5. Enter the following to display the main server status:
   ```bash
   ./nmsserver.bash appserver_status
   ```
   The server status is displayed; the server is fully initialized if the status is the following:
   Application Server process is running. See nms_status for more detail.
   If the server is not fully initialized, wait five minutes and then repeat this step. Do not perform the next step until the server is fully initialized.
6. Perform 14.13 “To start an auxiliary server” (p. 332) to start each Preferred and Reserved auxiliary server of the standby main server.

11

Close the open console windows.

END OF STEPS

14.24 To replace an auxiliary database station

14.24.1 Purpose

Perform this procedure to replace an auxiliary database station with a station that has the same IP address, for example, after a hardware failure.

1

Log in to the replacement auxiliary database station as the root user.

2

Transfer the following NFM-P installation files for the existing release to an empty directory on the auxiliary database station:

- nsp-nfmp-jre-R.r.p-rel.v.rpm
- vertica-V.w.x-y.rpm
- nsp-nfmp-aux-db-R.r.p-rel.v.rpm
- VerticaSw_PreInstall.sh

where

R.r.p is the NSP release identifier, in the form MAJOR.minor.patch
V.w.x-y is a version number
v is a version identifier

3

Open a console window.

4

Navigate to the directory that contains the auxiliary database software.

5

Enter the following:

```bash
# chmod +x *
```

6

Enter the following:
# ./VerticaSw_PreInstall.sh
d
The script displays output like the following:

INFO: About to set kernel parameters in /etc/sysctl.conf...
INFO: Completed setting kernel parameters in /etc/sysctl.conf...
INFO: Completed setting kernel parameters in /etc/sysctl.conf...
INFO: About to change the current values of the kernel parameters...
INFO: Completed changing the current values of the kernel parameters...
INFO: About to set ulimit parameters in /etc/security/limits.conf...
INFO: Completed setting ulimit parameters in /etc/security/limits.conf...
Checking Vertica DBA group samauxdb...
Adding Vertica DBA group samauxdb...
Checking Vertica user samauxdb...
Adding Vertica user samauxdb...
Changing ownership of the directory /opt/nsp/nfmp/auxdb to samauxdb:samauxdb.
Adding samauxdb to sudoers file.
Changing ownership of /opt/nsp/nfmp/auxdb files.
INFO: About to add setting to /etc/rc.d/rc.local...
INFO: Completed adding setting to /etc/rc.d/rc.local...

7

If the script instructs you to perform a restart, perform the following steps.
1. Enter the following:

   # systemctl reboot
d
   The station restarts.
2. Log in to the station as the root user.
3. Open a console window.
4. Navigate to the directory that contains the auxiliary database software.

8

Enter the following:

# yum install *.rpm
d
The yum utility resolves any dependencies, and displays the following prompt:

Total size:  nn G
Installed size:  nn G
Is this ok [y/N]:

As required maintenance
Auxiliary database administration
To replace an auxiliary database station
Enter y. The following and the installation status are displayed as each package is installed:

```
Downloading packages:
Running transaction check
Running transaction test
Transaction test succeeded
Running transaction
```

The package installation is complete when the following is displayed:

```
Complete!
```

Perform the following steps on each auxiliary database station.

1. Log in to the station as the root user.
2. Open a console window.
3. Enter the following:
   ```
   # rm -f ~root/.ssh/known_hosts
   ```
4. Enter the following:
   ```
   # rm -f ~samauxdb/.ssh/known_hosts
   ```

Log in to an existing auxiliary database station as the root user.

Open a console window.

Enter the following:
```
# /opt/nsp/nfmp/auxdb/install/bin/auxdbAdmin.sh recoverNode internal_IP
```

where `internal_IP` is the IP address that the station uses to communicate with the other auxiliary database stations

When you are prompted for the database user password, enter the password.

When you are prompted for the samauxdb password, enter the password.

Log in to the replacement station as the root user.
Open a console window.

Enter the following:

```
# systemctl start nfmp-auxdbproxy.service
```

Messages like the following are displayed:

```
hh:mm:ss Day mm/dd/yy : Starting NFM-P Auxiliary DB Proxy ...
hh:mm:ss Day mm/dd/yy : Refer to log_file for startup status.
```

The replacement station initializes, and the data is rebalanced among the auxiliary database stations.

END OF STEPS

---

14.25 To remove an auxiliary database station

14.25.1 Purpose

Perform this procedure to remove a station from an auxiliary database.

⚠️ CAUTION

Service Disruption

This procedure requires a restart of each main server, which is service-affecting.

Perform this procedure only during a scheduled maintenance period.

14.25.2 Steps

1. Log in to the auxiliary database station as the root user.

2. Open a console window.

3. Enter the following:

```
# /opt/nsp/nfmp/auxdb/install/bin/auxdbAdmin.sh removeNode internal_IP
```

where `internal_IP` is the IP address that the station uses to communicate with the other auxiliary database stations.

The station is removed from the auxiliary database.
If a cluster rebalance is required, you are prompted for the database user password. Perform the following steps.

**Note:** A cluster rebalance operation may take considerable time, depending on the volume of data in the auxiliary database.

1. Enter the password.
   
The rebalance operation begins. When the operation is complete, the following is displayed:
   
   Cluster rebalance completed. Press a key to continue...
   
2. Press a key to continue.

Perform the following steps on each main server station.

**Note:** In a redundant system, you must perform the steps on the standby main server station first.

1. Log in to the main server station as the nsp user.
2. Open a console window.
3. Enter the following:
   
   bash$ cd /opt/nsp/nfmp/server/nms/bin
   
4. Enter the following:
   
   bash$ ./nmsserver.bash stop
   
5. Enter the following:
   
   bash$ ./nmsserver.bash appserver_status
   
   The server status is displayed; the server is fully stopped if the status is the following:
   
   Application Server is stopped
   
   If the server is not fully stopped, wait five minutes and then repeat this step. Do not perform the next step until the server is fully stopped.

6. Enter the following to switch to the root user:
   
   bash$ su -
   
7. Enter the following:
   
   # samconfig -m main
   
8. Enter the following:
   
   <main> configure auxdb ip-list address1,address2...addressN exit
   
   where address1,address2...addressN are the IP addresses of the remaining auxiliary database stations

9. Enter the following:
   
   <main> apply
   
   The configuration is applied.
10. Enter the following:
   <main> exit \n
   The samconfig utility closes.

11. Enter the following to switch back to the nsp user:
    # exit \n
6

On the standalone or primary main server station, enter the following to start the main server:
bash$ ./nmsserver.bash start \n
The main server starts, and the station is removed from the auxiliary database.

7

If the NFM-P system is redundant, enter the following on the standby main server station to start the main server:
bash$ ./nmsserver.bash start \n
The main server starts.

8

Log in to one of the remaining auxiliary database stations as the root user.

9

Open the /opt/nsp/nfmp/auxdb/config/install.config file using a plain-text editor such as vi.

10

Locate the following line and delete the IP address of the station that is being removed:
hosts=internal_IP1,internal_IP2...internal_IPn

11

Locate the following line and delete the IP address entries of the station that is being removed:
export_hosts=internal_IP1[export_IP1],internal_IP2[export_IP2]...internal_IPn[export_IPn]

12

Save and close the file.

13

Enter the following:
# /opt/nsp/nfmp/auxdb/install/bin/auxdbAdmin.sh distributeConfig \n
The updated configuration is distributed to the other auxiliary database stations.

END OF STEPS
Backing up and restoring NE configuration files

14.26  Overview

14.26.1  Description

The NFM-P stores NE configuration files on a main server file system. The following procedures describe how to create a backup archive of all NE configuration files on a main server, and how to restore an NE backup archive, for example, after a main server disk failure.

14.27  To back up the NE configuration files

Note: Depending on the size and number of NE configuration files, a backup operation may take considerable time.

14.27.1  Steps

1

Log in to the standalone main server station, or the primary main server station in a redundant deployment, as the nspl user.

2

Open a console window.

3

Enter the following:

bash$ mkdir /opt/nspl/nfmp/nebackup/backup

4

Enter the following:

Note: If you intend to copy and paste the command from this step into the console window, ensure that you remove the line breaks from the command text before you paste the text.

bash$ tarcf --exclude='backup' /opt/nspl/nspl/nebackup/ | gzip -c >
/opt/nspl/nspl/nebackup/backup/nebackup_`date +"%Y-%m-%d-%H-%M"`.tgz

A compressed archive file named YYYY-MM-DD-hh-mm.tgz is created in the /opt/ssp/nspl/nebackup/backup directory, where YYYY-MM-DD-hh-mm is the file creation time.

5

When the backup operation is complete, copy the file to a secure station that is not part of the NFM-P system. If you lack access to such a station, and the NFM-P system is redundant, copy the file to the standby main server station.
6 Close the console window.

END OF STEPS

14.28 To restore the NE configuration files

Note: Depending on the size and number of NE configuration files, a restore operation may take considerable time.

14.28.1 Steps

1 Log in to the standalone or primary main server station as the nsp user.

2 Open a console window.

3 Copy the appropriate NE configuration archive file to the /opt/nsp/nfmp/nebackup/backup directory.

Note: An NE configuration archive file is named using the file creation time, and has the following format:
YYYY-MM-DD-hh-mm.tgz

4 Enter the following:

Note: If you intend to copy and paste the command from this step into the console window, ensure that you remove the line break from the command text before you paste the text.

bash$ gzip -cd /opt/nsp/nfmp/nebackup/backup/nebackup_
YYYY-MM-DD-hh-mm.tgz | tar xf - -C /

where YYYY-MM-DD-hh-mm.tgz is the name of the backup file

The NE configuration files are extracted to the /opt/nsp/nfmp/nebackup directory.

5 When the restore operation is complete, close the console window.

END OF STEPS
14.29 Overview

14.29.1 Description

CAUTION

Service Disruption

A main database restore requires a shutdown of each main database and main server in the NFM-P system, which causes a network management outage.

You must perform a database restore only during a scheduled maintenance period, and contact technical support before you attempt to restore a main database.

You can restore a main database using a backup copy.

In a redundant system, you must perform one or both of the following to regain main database function and redundancy, depending on the failure type.

- Restore the primary main database.
- Reinstantiate the standby main database.

Both operations are required after a primary database failure. After a standby database failure, no restore operation is required, but you must reinstantiate the primary database on the standby database station to restore redundancy. You can use the NFM-P client GUI or a CLI script to reinstantiate a database.

Note: In a redundant system, you can restore a main database backup only on a primary database station. To restore a database backup on a station other than the primary station, you must do the following on the station before you attempt the restore:

- Uninstall the main database, if it is installed.
- Install a primary database on the station.

In a redundant system, you can reinstantiate a database only on a standby database station. To reinstantiate a database on a station other than the standby station, you must do the following on the station before you attempt the reinstatement:

- Uninstall the main database, if it is installed.
- Install a standby database on the station.

See 14.30 “To restore a standalone main database” (p. 353) for information about restoring a standalone main database. See 14.31 “To restore the primary main database in a redundant system” (p. 362) for information about restoring a redundant main database. See 14.32 “To reinstantiate the main database from the client GUI” (p. 373) and 14.33 “To reinstantiate the main database from a CLI” (p. 374) for information about reinstantiating a primary main database on a standby database station.
14.30 To restore a standalone main database

14.30.1 Purpose

The following steps describe how to restore a standalone main database using a backup file set. You require the following:
• a database backup file set from the same NFM-P release
• the original file path of the database backup
• root user privileges on the main server and database stations
• nsd user privileges on the main server station
• Oracle management user privileges on the main server and database stations

Note: In an NSP system that does not include the NSD and NRC, a main database backup performed using the NFM-P client GUI also backs up the local Neo4j and PostgreSQL databases; a backup performed from a CLI does not.

In such a deployment, when you restore a main database using a backup created from the GUI, you must also restore the local Neo4j and PostgreSQL databases, as described in the procedure.

14.30.2 Steps

1. If the database backup file set is on the database station, copy the file set to a different station for safekeeping.

2. Perform the following steps to stop the main server.
   1. Log in to the main server station as the nsd user.
   2. Open a console window.
   3. Enter the following:
      ```bash
      cd /opt/nsd/nsmp/server/nms/bin
      ```
   4. Enter the following to stop the main server:
      ```bash
      ./nmsserver.bash stop
      ```
   5. Enter the following to display the NFM-P server status:
      ```bash
      ./nmsserver.bash appserver_status
      ```
      The server status is displayed; the server is fully stopped if the status is the following:
      Application Server is stopped
      If the server is not fully stopped, wait five minutes and then repeat this step. Do not perform the next step until the server is fully stopped.

3. Enter the following to switch to the root user:
Enter the following to disable the automatic main server startup.

```
# systemctl disable nfmp-main.service
```

If you are restoring the database on a new station, for example, if the current database station is unusable, go to Step 10.

Log in to the database station as the root user.

Enter the following to uninstall the database:

```
# yum remove nsp-nfmp-main-db
```

The yum utility displays the following prompt:

```
Installed size: nn G
Is this ok [y/N]:
```

Enter y. The following is displayed:

Downloading packages:
Running transaction check
Running transaction test
Transaction test succeeded
Running transaction
Uninstalling the NFM-P Database...

When the uninstallation is complete, the following is displayed:

```
Complete!
```

When the uninstallation is complete, enter the following to reboot the database station:

```
# systemctl reboot
```

The station reboots.

Log in as the root user on the database station.
11
Open a console window.

12
Remove any files in the /opt/nsp/nfmp/db/tablespace and /opt/nsp/nfmp/db/archivelog directories.

13
Copy the database backup file set to the station.

⚠️ Note: The path to the backup file set must be the same as the path to the file set at creation time.

14
Perform one of the following.

a. If you are restoring the database on the same station, download or copy the following NFM-P installation files for the existing release to an empty directory on the database station:
   - nsp-nfmp-main-db-R.r.p-rel.v.rpm
   - OracleSw_PreInstall.sh

b. If you are restoring the database on a new station, for example, if the current database station is unusable, download or copy the following NFM-P installation files for the existing release to an empty directory on the database station:
   - nsp-nfmp-jre-R.r.p-rel.v.rpm
   - nsp-nfmp-config-R.r.p-rel.v.rpm
   - nsp-nfmp-oracle-R.r.p-rel.v.rpm
   - nsp-nfmp-main-db-R.r.p-rel.v.rpm
   - OracleSw_PreInstall.sh

   where

   R.r.p is the NSP release identifier, in the form MAJOR.minor.patch
   v is a version identifier

15
Navigate to the directory that contains the NFM-P installation files.

⚠️ Note: Ensure that the directory contains only the installation files.

16
Enter the following:

```bash
# chmod +x *
```
Enter the following:

```
# ./OracleSw_PreInstall.sh
```

**Note:** The default values displayed by the script are shown as `[default]`. To accept a default value, press `<CR>`. The following prompt is displayed:

This script will prepare the system for a new install/restore of an NFM-P Version R.r Rn database.

Do you want to continue? [Yes/No]:

Enter Yes. The following prompt is displayed:

Enter the Oracle dba group name [group]:

Enter a group name and press `<CR>`. The following message is displayed:

**Note:** To reduce the complexity of subsequent software upgrades and technical support activities, it is recommended that you accept the default.

The following message is displayed:

Creating group group if it does not exist...

If you specify a new group, the following message is displayed:

done

If you specify an existing group, the following prompt is displayed:

WARNING: Group group already exists locally.

Do you want to use the existing group? [Yes/No]:

Perform one of the following.

a. Enter Yes `<CR>`.

b. Enter No `<CR>`. Go to Step 19.

If the default user exists in the specified group, the following prompt is displayed:

The user [username] for the group [group] already exists locally.

Do you want to use the existing user? [Yes/No]:

Perform one of the following.

a. Enter Yes `<CR>`; the following messages are displayed:
Checking or Creating the Oracle user home directory 
/opt/nsp/nfmp/oracle12r1...
Checking user username...
WARNING: Oracle user with the specified name already exists locally.
Redefining the primary group and home directory of user username ...
usermod: no changes
Changing ownership of the directory /opt/nsp/nfmp/oracle12r1 to 
username:group.
About to unlock the UNIX user [username]
Unlocking password for user username
passwd: Success Unlocking the UNIX user [username] completed

b. Enter No ↵. The following prompt is displayed:
Enter the Oracle user name:
   Type a username and press ↵.
The following messages and prompt are displayed:
   Oracle user [username] new home directory will be 
   [/opt/nsp/nfmp/oracle12r1].
   Checking or Creating the Oracle user home directory 
   /opt/nsp/nfmp/oracle12r1..
   Checking user username...
   Adding username...
   Changing ownership of the directory /opt/nsp/nfmp/oracle12r1 to 
   username:group.
   About to unlock the UNIX user [username]
   Unlocking password for user username.
passwd: Success
   Unlocking the UNIX user [username] completed
   Please assign a password to the UNIX user username ..
   New Password:

Perform one of the following.
a. If you specify a new user in Step 22, the following prompt is displayed:
   Please assign a password to the UNIX user username ..
   New Password:
   Perform the following steps.
   1. Type a password and press ↵. The following prompt is displayed:
      Re-enter new Password:
2. Retype the password and press ↵. The following message is displayed if the password update is successful:

    passwd: password successfully changed for username

b. If you specify an existing user in Step 22, the following prompt is displayed:

    Do you want to change the password for the UNIX user username? [Yes/No]:
    Type No ↵.

24

The following prompt is displayed:

Specify whether an NFM-P server will be installed on this workstation. The database memory requirements will be adjusted to account for the additional load.
Will the database co-exist with an NFM-P server on this workstation [Yes/No]:
Enter Yes or No, as required, and press ↵.

Messages like the following are displayed as the script execution completes:
INFO: About to set kernel parameters in /etc/sysctl.conf...
INFO: Completed setting kernel parameters in /etc/sysctl.conf...
INFO: About to change the current values of the kernel parameters
INFO: Completed changing the current values of the kernel parameters
INFO: About to set ulimit parameters in /etc/security/limits.conf...
INFO: Completed setting ulimit parameters in /etc/security/limits.conf...
INFO: Completed running Oracle Pre-Install Tasks

25

When the script execution is complete, enter the following to reboot the database station:

    # systemctl reboot ↵

The station reboots.

26

When the reboot is complete, log in as the root user on the database station.

27

Navigate to the directory that contains the NFM-P installation files.

28

Perform one of the following:

a. If you are restoring the database on the same station, enter the following:
As required maintenance
Restoring and reinstating the main database
To restore a standalone main database

b. If you are restoring the database on a new station, enter the following:

```bash
# yum install *.rpm
```

The `yum` utility resolves any package dependencies, and displays the following prompt:

```
Total size: nn G
Installed size: nn G
Is this ok [y/N]:
```

Enter `y`. The following and the installation status are displayed as each package is installed:

- Downloading packages:
- Running transaction check
- Running transaction test
- Transaction test succeeded
- Running transaction

The package installation is complete when the following is displayed:

```
Complete!
```

Enter the following:

```bash
# samrestoreDb path
```

where `path` is the absolute path of the database backup file set

The database restore begins, and messages like the following are displayed as the restore progresses.

```
Restore log is /opt/nsp/nfmp/db/install/NFM-P_Main_Database.restore/yyyy.mm.dd-hh.mm.ss.stdout.txt
<date time> working..
<date time> Performing Step 1 of 7 - Initializing ..
<date time> Executing StartupDB.sql ...
<date time> Performing Step 2 of 7 - Extracting backup files ..... 
<date time> Performing Step 3 of 7 - Restoring archive log files ..
<date time> Performing Step 4 of 7 - Executing restore.rcv ............
<date time> Performing Step 5 of 7 - Restoring Accounting tablespaces .......
<date time> Performing Step 6 of 7 - Opening database ..... 
<date time> working....
<date time> Executing ConfigRestoreDB.sql ..................
<date time> working............... 
```
31 Log in to the main server station as the root user.

32 If the NSP system includes the NSD and NRC, go to Step 35.

33 In an NSP system that does not include the NSD and NRC, a main database backup performed using the NFM-P client GUI also backs up the local Neo4j database on the main server; a backup performed from a CLI does not. When you restore a main database in such a system using a GUI-created backup, you must also restore the local Neo4j database.

If the main database backup is GUI-created, restore the Neo4j database.
1. Enter the following to switch to the NSP user:
   
   ```
   # su - nsp
   ```

2. Enter the following:
   
   ```bash
   tar -xv -C local_dir -f /opt/nsp/os/backup/backups/n/nspos-neo4j_backup_timestamp.tar.gz
   ```
   
   where

   - `local_dir` is an empty local directory
   - `n` is the backup number
   - `timestamp` is the backup creation time

3. Enter the following:
   
   ```bash
   /opt/nsp/os/neo4j/bin/neo4j-admin restore --from=local_dir --database=graph.db --force=true
   ```
   
   where `local_dir` is the directory specified in substep 2

   The Neo4j database is restored.

34 In an NSP system that does not include the NSD and NRC, a main database backup performed using the NFM-P client GUI also backs up the local PostgreSQL database on the main server; a backup performed from a CLI does not. When you restore a main database in such a system using a GUI-created backup, you must also restore the local PostgreSQL database.

If the main database backup is GUI-created, restore the PostgreSQL database.
1. Enter the following:
As required maintenance
Restoring and reinstantiating the main database
To restore a standalone main database

```
bash$ tar -xv -C local_dir -f /opt/nsp/os/backup/backupset_n/nspos-postgresql_backup_timestamp.tar.gz 
where
local_dir is an empty local directory
n is the backup number
timestamp is the backup creation time
```

2. Enter the following:

```
bash$ /opt/nsp/os/pgsql/scripts/pg-restore.sh -f /local_dir/nspdb.custom 
where local_dir is the directory specified in substep 2
```

The following prompt is displayed:

Do you want to DROP and recreate the NSP database?
1) Yes
2) No

3. Enter 1 

The following prompt is displayed:

You are about to drop and recreate the NSP database
Any existing DATA will be LOST — Are you sure?
1) Yes
2) No

4. Enter 1 

The restore begins, and progress messages are displayed.

When the restore is complete, the following is displayed:

Database restore completed successfully!
Stopping nspos-postgresql ...

5. Enter the following to switch back to the root user:

```
bash$ exit 
```

Enter the following to enable the automatic main server startup.

```
# systemctl enable nfmp-main.service 
```

36

Start the main server.

1. Enter the following to switch to the nsp user:

```
# su - nsp 
```

2. Enter the following:

```
bash$ /opt/nsp/nfmp/server/nms/bin/nmsserver.bash start 
```

The main server starts.
Close the open console windows, as required.

38

Perform a full network resynchronization to discover the interim changes in the managed network.

END OF STEPS

14.31 To restore the primary main database in a redundant system

14.31.1 Purpose

The following steps describe how to restore the primary main database in a redundant NFM-P system using a backup file set created on the same station. The station is called the primary database station in the procedure.

To regain main database redundancy after the database restore, you must reinstantiate the restored database on the standby main database station. See 14.32 “To reinstantiate the main database from the client GUI” (p. 373) and 14.33 “To reinstantiate the main database from a CLI” (p. 374) for information.

You require the following:

• a main database backup file set from the same NFM-P release
• the original file path of the database backup
• root user privileges on the main server and main database stations
• nsp user privileges on each main server station
• Oracle management user privileges on each main database station

Note: In an NSP system that does not include the NSD and NRC, a main database backup performed using the NFM-P client GUI also backs up the local Neo4j and PostgreSQL databases; a backup performed from a CLI does not.

In such a deployment, when you restore a main database using a backup created from the GUI, you must also restore the local Neo4j and PostgreSQL databases, as described in the procedure.

14.31.2 Steps

1

If the database backup file set is on the primary database station, copy the file set to a different station for safekeeping.

2

Stop the standby main server.

1. Log in to the standby main server station as the nsp user.
2. Open a console window.
3. Enter the following:
   bash$ cd /opt/nsfmp/server/nms/bin

4. Enter the following:
   bash$ ./nmsserver.bash stop

5. Enter the following to display the server status:
   bash$ ./nmsserver.bash appserver_status

   The server status is displayed; the server is fully stopped if the status is the following:

   Application Server is stopped

   If the server is not fully stopped, wait five minutes and then repeat this step. Do not perform
   the next step until the server is fully stopped.

3

Enter the following to switch to the root user:
bash$ su

4

Enter the following to disable the automatic main server startup.

# systemctl disable nfmp-main.service

5

Stop the standby database:
1. Log in to the standby database station as the root user.
2. Open a console window.
3. Enter the following to stop the Oracle proxy:
   # systemctl stop nfmp-oracle-proxy.service
4. Enter the following to stop the database:
   # systemctl stop nfmp-main-db.service

6

Stop the primary main server.
1. Log in to the primary main server station as the nsf user.
2. Open a console window.
3. Enter the following:
   bash$ cd /opt/nsfmp/server/nms/bin
4. Enter the following:
   bash$ ./nmsserver.bash stop
5. Enter the following to display the server status:
   bash$ ./nmsserver.bash appserver_status

   The server status is displayed; the server is fully stopped if the status is the following:
Application Server is stopped
If the server is not fully stopped, wait five minutes and then repeat this step. Do not perform the next step until the server is fully stopped.

7
Enter the following to switch to the root user:
```
bash$ su 
```

8
Enter the following to disable the automatic main server startup.
```
# systemctl disable nfmp-main.service 
```

9
If you are restoring the database on a new station, for example, if the current primary database station is unusable, go to Step 15.

10
Log into the primary database station as the root user.

11
Open a console window.

12
Enter the following to uninstall the primary database:
```
# yum remove nsp-nfmp-main-db 
```
The yum utility displays the following prompt:
```
Installed size: nn G
Is this ok [y/N]:
```

13
Enter y. The following is displayed:
```
Downloading packages:
Running transaction check
Running transaction test
Transaction test succeeded
Running transaction
Uninstalling the NFM-P Database...
When the uninstallation is complete, the following is displayed:
Complete!
```
When the uninstallation is complete, enter the following to reboot the primary database station:

```
# systemctl reboot
```

The station reboots.

Log in as the root user on the primary database station.

Open a console window.

Remove any files in the /opt/nsp/nfmp/db/tablespace and /opt/nsp/nfmp/db/archivelog directories.

Copy the database backup file set to the primary database station.

**Note:** The path to the backup file set must be the same as the path to the file set at creation time.

If you are restoring the database on a new station, for example, if the current primary database station is unusable, download or copy the following files for the installed NFM-P release to an empty directory on the database station:

- nsp-nfmp-jre-\textit{R}.\textit{r}.\textit{p}-rel.\textit{v}.rpm
- nsp-nfmp-config-\textit{R}.\textit{r}.\textit{p}-rel.\textit{v}.rpm
- nsp-nfmp-oracle-\textit{R}.\textit{r}.\textit{p}-rel.\textit{v}.rpm
- nsp-nfmp-main-db-\textit{R}.\textit{r}.\textit{p}-rel.\textit{v}.rpm
- OracleSw_PreInstall.sh

where

\textit{R}.\textit{r}.\textit{p} is the NSP release identifier, in the form \textit{MAJOR.minor.patch}

\textit{v} is a version identifier

Navigate to the directory that contains the NFM-P installation files.

Enter the following:

```
# chmod +x *
```
Enter the following:

```
# ./OracleSw_PreInstall.sh
```

**Note:** The default values displayed by the script are shown as [default]. To accept a default value, press ⎮. The following prompt is displayed:

This script will prepare the system for a new install/restore of an NFM-P Version R.r Rn database. Do you want to continue? [Yes/No]:

---

Enter Yes. The following prompt is displayed:

Enter the Oracle dba group name [group]:

---

Enter a group name and press ⎮.

**Note:** To reduce the complexity of subsequent software upgrades and technical support activities, it is recommended that you accept the default. The following message is displayed:

Creating group group if it does not exist...

If you specify a new group, the following message is displayed:

done

---

If you specify an existing group, the following prompt is displayed:

WARNING: Group group already exists locally.

Do you want to use the existing group? [Yes/No]:

Perform one of the following.

a. Enter Yes ⎮.

b. Enter No ⎮. Go to Step 24.

---

If the default user exists in the specified group, the following prompt is displayed:

The user [username] for the group [group] already exists locally.

Do you want to use the existing user? [Yes/No]:

---

Perform one of the following.

a. Enter Yes ⎮; the following messages are displayed:
Checking or Creating the Oracle user home directory
/opt/nsp/nfmp/oracle12r1...
Checking user username...
WARNING: Oracle user with the specified name already exists locally.
Redefining the primary group and home directory of user username ...
usermod: no changes
Changing ownership of the directory /opt/nsp/nfmp/oracle12r1 to
username:group.
About to unlock the UNIX user [username]
Unlocking password for user username
passwd: Success
Unlocking the UNIX user [username] completed

b. Enter No ↵. The following prompt is displayed:
Enter the Oracle user name:

Type a username and press ↵.
The following messages and prompt are displayed:
Oracle user [username] new home directory will be
[/opt/nsp/nfmp/oracle12r1].
Checking or Creating the Oracle user home directory
/opt/nsp/nfmp/oracle12r1..
Checking user username...
Adding username...
Changing ownership of the directory /opt/nsp/nfmp/oracle12r1 to
username:group.
About to unlock the UNIX user [username]
Unlocking password for user username.
pwd: Success
Unlocking the UNIX user [username] completed
Please assign a password to the UNIX user username ..
New Password:

Perform one of the following.
a. If you specify a new user in Step 27, the following prompt is displayed:
Please assign a password to the UNIX user username ..
New Password:
Perform the following steps.
1. Type a password and press ↵. The following prompt is displayed:
   Re-enter new Password:
2. Retype the password and press ↵. The following message is displayed if the password update is successful:

    passwd: password successfully changed for username

b. If you specify an existing user in Step 27, the following prompt is displayed:

    Do you want to change the password for the UNIX user username? [Yes/No]:
    Type No ↵.

The following prompt is displayed:

Specify whether an NFM-P server will be installed on this workstation. The database memory requirements will be adjusted to account for the additional load.

Will the database co-exist with an NFM-P server on this workstation [Yes/No]:

Enter Yes or No, as required, and press ↵.

Messages like the following are displayed as the script execution completes:

INFO: About to set kernel parameters in /etc/sysctl.conf...
INFO: Completed setting kernel parameters in /etc/sysctl.conf...
INFO: About to change the current values of the kernel parameters
INFO: Completed changing the current values of the kernel parameters
INFO: About to set ulimit parameters in /etc/security/limits.conf...
INFO: Completed setting ulimit parameters in /etc/security/limits.conf...
INFO: Completed running Oracle Pre-Install Tasks

When the script execution is complete, enter the following to reboot the database station:

    # systemctl reboot ↵

The station reboots.

When the reboot is complete, log in as the root user on the primary database station.

Navigate to the directory that contains the NFM-P installation files.

Perform one of the following:

a. If you are restoring the database on the same station, enter the following:
# yum install nsp-nfmp-main-db*

b. If you are restoring the database on a new station, enter the following:

# yum install *.rpm

The yum utility resolves any package dependencies, and displays the following prompt:

Total size: nn G
Installed size: nn G

Is this ok [y/N]:

Enter y. The following and the installation status are displayed as each package is installed:

Downloading packages:
Running transaction check
Running transaction test
Transaction test succeeded
Running transaction

The package installation is complete when the following is displayed:

Complete!

Perform one of the following.

a. If you are restoring the primary database on the same station, enter the following:

# samrestoreDb path

where path is the absolute path of the database backup file set

b. If you are restoring the database on a new primary database station, enter the following:

# samrestoreDb path -standbyinstance instance -standbyip IP_address

where

path is the absolute path of the database backup file set
instance is the standby database instance name
IP_address is the standby database IP address

The database restore begins, and messages like the following are displayed as the restore progresses.

Restore log is /opt/nsp/nfmp/db/install/NFM-P_Main_Database.restore.
yyyy.mm.dd-hh.mm.ss.stdout.txt
<date time> working..
<date time> Performing Step 1 of 7 - Initializing ..
<date time> Executing StartupDB.sql ...
<date time> Performing Step 2 of 7 - Extracting backup files .....
Performing Step 3 of 7 - Restoring archive log files..
Performing Step 4 of 7 - Executing restore.rcv ............
Performing Step 5 of 7 - Restoring Accounting tablespaces ........
Performing Step 6 of 7 - Opening database ......
Performing Step 7 of 7 - Configuring SAM Server settings ...

The following is displayed when the restore is complete:

Database restore was successful

DONE

When the database restore is complete, close the console window.

If the NSP system includes the NSD and NRC, go to Step 40.

In an NSP system that does not include the NSD and NRC, a main database backup performed using the NFM-P client GUI also backs up the local Neo4j database on the main server; a backup performed from a CLI does not. When you restore a main database in such a system using a GUI-created backup, you must also restore the local Neo4j database.

If the database backup is GUI-created, when the database restore is complete, restore the Neo4j database. Perform the following steps on each main server station.

**Note:** You must perform the steps first on the standby main server station, and then on the primary main server station.

1. Log in to the main server station as the nspt user.
2. Enter the following:

   ```bash
   tar -xv -C local_dir -f /opt/nspos/os/backup/backupset_n/nspos-neo4j_backup_timestamp.tar.gz
   ``

   where
   - `local_dir` is an empty local directory
   - `n` is the backup number
   - `timestamp` is the backup creation time

3. Enter the following:

   ```bash
   /opt/nspos-neo4j/bin/neo4j-admin restore --from=local_dir --database=graph.db --force=true
   ```
Where `local_dir` is the directory specified in substep 2.

The Neo4j database is restored.

In an NSP system that does not include the NSD and NRC, a main database backup performed using the NFM-P client GUI also backs up the local PostgreSQL database on the main server; a backup performed from a CLI does not. When you restore a main database in such a system using a GUI-created backup, you must also restore the local PostgreSQL database.

If the database backup is GUI-created, restore the PostgreSQL database.

1. Enter the following:
   ```bash
   tar -xv -C local_dir -f /opt/nsp/os/backup/backupset_n/nspos-postgresql_backup_timestamp.tar.gz
   ```
   Where
   - `local_dir` is an empty local directory
   - `n` is the backup number
   - `timestamp` is the backup creation time

2. Enter the following:
   ```bash
   /opt/nsp/os/pgsql/scripts/pg-restore.sh -f /local_dir/nspdb.custom
   ```
   Where `local_dir` is the directory specified in substep 2.

   The following prompt is displayed:
   Do you want to DROP and recreate the NSP database?
   1) Yes
   2) No

3. Enter 1. The following prompt is displayed:
   You are about to drop and recreate the NSP database
   Any existing DATA will be LOST - Are you sure?
   1) Yes
   2) No

4. Enter 1. The restore begins, and progress messages are displayed.
   When the restore is complete, the following is displayed:
   Database restore completed successfully!
   Stopping npos-postgresql ...

5. Log in to the standby main server station as the nsp user.

6. Enter the following:
   ```bash
   /opt/nsp/os/pgsql/scripts/repmgr-standby-bootstrap.sh
   ```

Log in to the primary main server station as the root user.
Enter the following to enable the automatic main server startup:

```
# systemctl enable nfmp-main.service
```

Start the primary main server.
1. Enter the following to switch to the nsp user::

   ```
   # su - nsp
   ```

2. Enter the following:

   ```
   bash$ cd /opt/nsp/nfmp/server/nms/bin
   ```

3. Enter the following:

   ```
   bash$ ./nmsserver.bash start
   ```

4. Enter the following to display the server status:

   ```
   bash$ ./nmsserver.bash appserver_status
   ```

   The server status is displayed; the server is fully initialized if the status is the following:

   Application Server process is running. See nms_status for more detail.

   If the server is not fully initialized, wait five minutes and then repeat this step. Do not perform the next step until the server is fully initialized.

Perform a full resynchronization of the network to discover the interim changes in the managed network.

Start the standby database.
1. Log in to the standby main database station as the root user.
2. Enter the following to start the Oracle proxy:

   ```
   # systemctl start nfmp-oracle-proxy.service
   ```

3. Enter the following to start the database:

   ```
   # systemctl start nfmp-main-db.service
   ```

Log in to the standby main server station as the root user.

Enter the following to enable the automatic main server startup:

```
# systemctl enable nfmp-main.service
```
Start the standby main server.
1. Enter the following to switch to the nsp user:
   ```
   # su - nsp
   ```
2. Enter the following:
   ```
   bash$ cd /opt/nsp/nfmp/server/nms/bin
   ```
3. Enter the following:
   ```
   bash$ ./nmsserver.bash start
   ```
4. Enter the following to display the server status:
   ```
   bash$ ./nmsserver.bash appserver_status
   ```
   The server status is displayed; the server is fully initialized if the status is the following:
   Application Server process is running. See nms_status for more detail.
   If the server is not fully initialized, wait five minutes and then repeat this step. Do not perform
   the next step until the server is fully initialized.

To restore the database redundancy, reinstantiate the primary database on the standby
database station, as described in 14.32 “To reinstantiate the main database from the client
GUI” (p. 372) or 14.33 “To reinstantiate the main database from a CLI” (p. 374).

### 14.32 To reinstantiate the main database from the client GUI

#### 14.32.1 Purpose

Perform this procedure to use the NFM-P GUI to restore the main database redundancy in a
redundant NFM-P system by reinstantiating the primary main database on the standby database
station. Database reinstatement is required after a main database failure, or a maintenance activity
such as a database switchover.

If automatic database reinstatement is enabled, a failed manual reinstatement attempt does not
affect the reinstatement timer. If a manual reinstatiation is successful, the NFM-P does not attempt
a subsequent reinstantiation.

Before you attempt to perform this procedure, the following conditions must be true:

- The primary database proxy and the standby database proxy are in contact with the primary
  main server.
- The database listener is operating.
14.32.2 Steps

1. Log in to a GUI client as a user with an assigned admin scope of command role.

2. Choose Administration→System Information from the NFM-P main menu. The System Information form opens.

3. If you are performing this procedure after a database failover or switchover, ensure that the Failover State or Switchover State on the form is Successful.

   **Note:** The state must read Successful before you can continue.

4. Click Re-Instantiate Standby, and then click Yes. The database reinstatiation begins.

   **Note:** The Re-Instantiate Standby button is displayed only if your user account has an appropriate scope of command.

   The client GUI status bar and the System Information form display the reinstatiation status. The Standby Re-instantiation State changes from In Progress to Success when the reinstatiation is complete. The Last Attempted Standby Re-instantiation Time displays the start time of the current reinstatiation.

5. When the reinstatiation is complete, close the System Information form.

6. View the NFM-P GUI status bar to verify that the NFM-P main servers and main database are communicating and operational.

END OF STEPS

14.33 To reinstantiate the main database from a CLI

14.33.1 Purpose

Perform this procedure to use a CLI to restore the main database redundancy in a redundant NFM-P system by reinstating the primary main database on the standby database station. Database reinstatiation is required after a main database failure, or a maintenance activity such as a database switchover.

If automatic database reinstatiation is enabled, a failed manual reinstatiation attempt does not affect the reinstatiation timer. If a manual reinstatiation is successful, the NFM-P does not attempt a subsequent reinstatiation.
Before you attempt to perform this procedure, the following conditions must be true:

- The primary database proxy and the standby database proxy are in contact with the primary main server.
- The database listener is operating.

**Note:** You require nsp user privileges on the primary main server station.

### 14.33.2 Steps

1. Log in to the primary main server station as the nsp user.

2. Open a console window.

3. Navigate to the /opt/nsp/nfmp/server/nms/bin directory.

4. Enter the following:
   ```bash
   ./reinstantiatedb.bash -u username -p password
   ```
   where
   - `username` is the name of an NFM-P user account that has an assigned admin scope of command role
   - `password` is the password for the user account
   
   The following prompt is displayed:
   ```
   This action will rebuild the standby database.
   Do you want to proceed? (YES/no) :
   ```
   
5. Enter the following:
   ```YES```

   The NFM-P begins to reinstantiate the main database on the standby main database station. Progress is indicated by a rolling display of dots in the console window. The reinstantiation is complete when the CLI prompt reappears.

6. When the reinstantiation is complete, close the console window.

7. Open an NFM-P GUI client.
View the NFM-P GUI status bar to verify that the NFM-P main servers and main database are communicating and operational.

END OF STEPS
Main database export and import

14.34 To export a main database

14.34.1 Purpose

Perform this procedure to export a main database to a file set.

You require the following user privileges:

- on each main server station:
  - root
  - nsp
- on the standalone or primary database station:
  - root
  - Oracle management

CAUTION

Service Disruption

A database export operation requires a shutdown of each main server, which causes a network management outage.

You must perform this procedure only during a scheduled maintenance period.

Note: The passwords that you enter in this procedure are not displayed.

14.34.2 Steps

General preparation

1.

Clear all outstanding failed deployments. See “To view and manage failed deployments” in the NSP NFM-P User Guide for information about how to clear a failed deployment.

2.

Obtain the following main database information; in a redundant deployment, you must obtain the primary database information.

- Oracle database instance name
- Oracle database user password
- Oracle SYS user password
Stop main servers

Perform the following steps on each main server station to stop the main server.

**Note:** In a redundant deployment, you must stop the standby main server first.
1. Log in to the main server station as the nsps user.
2. Open a console window.
3. Enter the following:
   
   ```
   bash$ cd /opt/nsps/nfmp/server/nms/bin
   ```
4. Enter the following to stop the main server:
   
   ```
   bash$ ./nmsserver.bash stop
   ```
5. Enter the following to display the main server status:
   
   ```
   bash$ ./nmsserver.bash appserver_status
   ```
   
   The server status is displayed; the server is fully stopped if the status is the following:
   
   **Application Server is stopped**
   
   If the server is not fully stopped, wait five minutes and then repeat this step. Do not perform the next step until the server is fully stopped.

Run database export script

Log in to the main database station as the Oracle management user.

Open a console window.

If the directory that is to hold the database export file set does not exist, create the directory.

**Note:** The database export operation fails if the directory that is to contain the exported database file set does not exist.

The directory must be a directory on the local file system.

Enter the following:

```bash
bash$
/opt/nsps/nfmp/db/install/config/samdb/SAMDb_exportImport.sh -e destination
```
**Note:** To display the script usage, specify the `-h` option, as follows:

```
SAMDb_exportImport.sh -h
```

The following messages and prompts are displayed:

- Using `DB_INSTALL_BASE = /opt/nsp/nfmp/db/install`
- Using `ORACLE_SID = maindb1`
- Using `ORACLE_HOME = /opt/nsp/nfmp/oracle12r1`

Enter the password for the "sys" user (terminal echo is off):

```
8
```

Enter the Oracle SYS user password and press `<return>`.

The following prompt is displayed:

Enter the password for database_user (terminal echo is off):

```
9
```

Enter the database user password and press `<return>`.

The following prompt is displayed:

Enter the export encryption password (terminal echo is off):

```
10
```

Create and record a database export encryption password. The password is required for a subsequent database import operation.

**Note:** The password can be of any length and use any characters.

```
11
```

Type the created password and press `<return>`.

The following prompt is displayed:

Confirm export encryption password (terminal echo is off):

```
12
```

Retype the password and press `<return>`.

The following message and prompt are displayed:

- This tool will shutdown the db listener disconnecting any connections to the database.
- Have the SAM servers been shutdown? [y/n/q] (y):

```
13
```

Press `<return>`.

The following message and prompt are displayed:

To optimize the speed of the export this script will use as many CPUs as you allow it to.
The maximum number of CPUs available are n
How many CPUs will be used for this export? (1):

14

Type the number of CPUs to use for the export operation, and press ↵.
The following prompt is displayed:
Do you want to perform an export size estimate first? [y/n/q] (y):

15

Press ↵ to direct the script to estimate the amount of disk space that the export requires.
The script displays an estimate of the required disk space, the available space in the partition that contains the destination directory, and the following prompt:
Do you have enough space? [y/n/q] (n):

16

Perform one of the following.
a. Confirm the space requirement and proceed with the export.
   1. Type y ↵ if the partition has sufficient capacity to hold the exported file set.
      The following prompt is displayed:
      Proceed with the export? [y/n/q] (y):
   2. Press ↵. The database export begins.
      The script displays information that includes the export log filename and a series of progress indicators.

b. Press ↵ if the partition lacks sufficient capacity to hold the exported file set.
   The following message is displayed and the script exits:
   Cancelling export...

17

Close the open console windows, as required.

END OF STEPS

14.35 To import a main database

14.35.1 Purpose
Perform this procedure to import a main database from an exported file set.
You require the following user privileges:
• on each main server station:
  - root
  - nsp
As required maintenance

Main database export and import

To import a main database

- on the standalone or primary database station:
  - root
  - Oracle management

CAUTION

Service Disruption

A database import operation requires a shutdown of each main server, which causes a network management outage.

You must perform this procedure only during a scheduled maintenance period.

Note: The passwords that you enter in this procedure are not displayed.

14.35.2 Steps

Stop main servers

1. Perform the following steps on each main server station to stop the main server.

   Note: In a redundant deployment, you must stop the standby main server first.

   1. Log in to the main server station as the nsp user.
   2. Open a console window.
   3. Enter the following:
      
      bash$ cd /opt/nsp/nfmp/server/nms/bin
      
   4. Enter the following to stop the main server:
      
      bash$ ./nmsserver.bash stop
      
   5. Enter the following to display the main server status:
      
      bash$ ./nmsserver.bash appserver_status
      
      The server status is displayed; the server is fully stopped if the status is the following:
      Application Server is stopped
      
      If the server is not fully stopped, wait five minutes and then repeat this step. Do not perform the next step until the server is fully stopped.

Install database

2. You can perform a main database import only on a station that has a newly installed main database.

   1. If the station on which you are performing the import hosts a main database that is not newly installed, uninstall the database, as described in the *NSP NFM-P Installation and Upgrade Guide*. 
2. If the station on which you are performing the import has no main database installed, install a main database on the station, as described in the *NSP NFM-P Installation and Upgrade Guide*.

**Run database import script**

3. Copy the exported database file set to the database station.

![](Note: The directory to which you copy the file set must contain no other files.  
The Oracle management user requires read access to the database file set on the station.

4. Log in to the database station as the Oracle management user.

5. Open a console window.

6. Enter the following:

   ```bash
   bash$
   /opt/nsp/nfmp/db/install/config/samdb/SAMDb_exportImport.sh -i source 
   ```

   where *source* is the absolute path of the directory that contains the exported database file set

   ![](Note: To display the script usage, specify the -h option, as follows:
   
   ```bash
   SAMDb_exportImport.sh -h 
   ```

   The following messages and prompt are displayed:

   - Using DB_INSTALL_BASE = /opt/nsp/nfmp/db/install
   - Using ORACLE_SID = maindb1
   - Using ORACLE_HOME = /opt/nsp/nfmp/oracle12r1
   - Enter the password for the "sys" user (terminal echo is off):

7. Enter the Oracle SYS user password and press ↵.

   The following prompt is displayed:

   Enter the password for database_user (terminal echo is off):

8. Enter the database user password and press ↵.

   The following prompt is displayed:

   Enter the export encryption password (terminal echo is off):
Enter the database export encryption password created during the database export operation.
The following messages and prompt are displayed:

In order to optimize the speed of this import, this script needs to know how many CPUs are available on this machine and how many data files there are to import.
This machine appears to have \( n \) CPUs
Is this correct? [y/n/q] (y):

Type the number of CPUs to use for the export operation, and press \( \downarrow \).
The following message and prompt are displayed:

There appears to be \( n \) data files to import  Is this correct? [y/n/q] (y):

Press \( \downarrow \) if the number of data files to import is correct.
The following message and prompt are displayed:

Log of import command will be written to log_file
Proceed with the import? [y/n/q] (y):

Press \( \downarrow \) to proceed with the database import.
The script generates messages like the following as it begins to import the database.
Adding addition datafiles to existing tablespaces
Restore wallet file
Restarting the database...
Shutting down the listener
Starting import: timestamp
where \( \text{timestamp} \) is the start time of the import operation
The script displays a series of progress indicators.
The following messages are displayed when the import operation is complete:

Executing recreate TI_BULK\* packages body
Import done: timestamp
Starting up the listener
Here is the import log: log_file
where

log_file is the name of a log file that the script creates
timestamp is the start time of the import operation
13. Close the open console windows, as required.

END OF STEPS
Clearing inactive residential subscriber instances

14.36 Overview

14.36.1 Description

It is recommended that you periodically remove the inactive subscriber instance records from the main database. A subscriber instance becomes inactive when the associated subscriber is deleted from an NE. The inactive instances accumulate rapidly, for example, in a Wi-Fi offload deployment.

Note: Before you execute the script, it is recommended that you disable the GUI client timeout so that you can use the client GUI to monitor the script execution. Otherwise, if the execution takes longer than the GUI client timeout, you can monitor the script execution using the NFM-P user activity log.

14.37 To delete the inactive residential subscriber instances

14.37.1 Purpose

Perform this procedure to configure and execute a script that removes the inactive subscriber instance records from the main database.

14.37.2 Steps

If required, disable the GUI client timeout

1


2

Set the Client Timeout (minutes) parameter to 0, which specifies no timeout.

Setting the parameter to 0 ensures that the NFM-P GUI client session does not close because of user inactivity while the script execution is in progress.

3

Save your changes and close the form.

Configure a script bundle

4

Choose Tools→Scripts from the NFM-P main menu. The Scripts form opens.
Choose Script Bundle (Scripting) from the drop-down menu and click Search. A list of script bundles is displayed.

If a subscriber instance deletion script bundle is listed, go to Step 12.

Click Browse Examples. The Browse Examples of Scripts form opens.

Navigate to the required bundle example. The path is Script Bundle Examples → Miscellaneous → Remove Inactive Residential Subscriber Instances Bundle.

Select the bundle example and click Create Bundle. The Script Bundle (Create) form opens.

Configure the Name parameter.

Save your changes and close the forms.

**Execute the script bundle**

Select the script bundle in the Scripts form and click Properties. The Script Bundle (Edit) form opens.

Select Remove Residential Subscriber CTL and click Execute Script. The Execute Script form opens.

Configure the parameter on the form to specify the number of days of inactivity that qualify a subscriber instance for deletion.

**Note:** If the NFM-P forwards statistics or billing information to the NSP Analytics application, ensure that the parameter value is greater than the billing period in days to ensure that no inactive subscriber instances are deleted before the billing occurs.

Click Execute. The script execution begins.
While the script runs, a new item with an hourglass symbol is displayed in the navigation panel on the left side of the form. When the script execution is complete, the symbol changes to a green check mark.

16  Close all forms.

17  If required, restore the GUI client timeout to its original value.

End of steps
14.38 Overview

14.38.1 Description

Customer service information is recorded in order to:

- document which devices and interfaces are used to handle customer traffic
- provide raw data for post-processing customer trends and customer information

14.39 To save a list of service information

14.39.1 Steps

Generate a list of service information

1. Choose Manage→Service→Services from the NFM-P main menu. The Manage Services form opens.

2. Perform one of the following:
   a. Generate a list of services in the network.
      1. Specify a filter to narrow the services listed. You can filter based on service ID, customer name, or other criteria as required.
      2. Order the columns of service data as required. For example, you can click on the Service Name heading to sort the services by name.
   b. Generate a list of access interfaces on a service.
      1. Select a service and click Properties. The service properties form opens.
      2. Click on the Interfaces tab and select an interfaces tab. For example, you can click on the L3 Access Interfaces tab if it is available for the selected service type.
      3. Order the columns of the interface data as required. For example, you can click on the Service Name heading to sort the access interface data based on the service name.

Save the list of service information

3. Right-click on a column header and choose Save To File. The Save form opens.

4. Enter a filename and specify a file type.
5  Browse to a location in which to save the file.

6  Click Save. The service information is saved in the specified location.

7  Close the forms.

END OF STEPS
Checking for duplicate service or resource names

14.40 Overview

14.40.1 Description

It is recommended that you develop standardized naming conventions before you configure network objects, in order to:

- facilitate identifying the object type
- ensure that data passed to a northbound interface or southbound in a data file for processing is named consistently throughout the management domain

It is good practice to include information such as the following when creating or configuring an object using the object properties form:

- the object type; for example, VPRN
- a customer association to the object; for example, site 1.1.1.1 for XYZ Industries
- source and destination endpoint identifiers; for example, the devices at each end of an LSP
- ports and IP addresses used

You can check for duplicate names to ensure that naming conventions are followed and to help prevent confusion when you deal with customers or operations staff. 14.41 “To check for duplicate port descriptions” (p. 390) uses ports as the objects to check for duplicate names.

14.41 To check for duplicate port descriptions

14.41.1 Purpose

Perform this procedure to check for duplicate object descriptions on all managed devices. This procedure uses ports as an example. You can also check logical entity names; for example, service or policy names. This procedure assumes that the Description parameter uniquely identifies each port.

14.41.2 Steps

1. Choose Manage→Equipment→Equipment from the NFM-P main menu. The Manage Equipment form appears.

2. Generate a list of all ports:
   1. Choose Port (Physical Equipment) from the drop-down menu.
   2. Configure the filter for the Administrative State column to display devices that are administratively up.
3 Click on the Description heading to list ports alphabetically by description.

4 Scan the list for duplicate names.

**Note:** By default, ports are assigned a description based on the card type when the Description parameter is not configured.

5 If you find a duplicate description, modify the description based on your naming conventions.
   1. Select the port and click Properties. The Physical Port (Edit) form opens.
   2. Configure the Description parameter to uniquely describe the port.
   3. Save your changes and close the forms.

**END OF STEPS**
14.42 Description

14.42.1 Overview

The following sections describe system administrator tasks for alarm management. For more information on how to filter, view alarm information and manage alarms from the NFM-P, see the NSP NFM-P User Guide.

14.43 Alarm thresholds

14.43.1 Overview

The NFM-P provides configurable alarm parameters to escalate and de-escalate the severity of alarms, as described in 14.50 “To customize the default behavior of alarm policies” (p. 398).

Figure 14-1, “Alarm thresholds without de-escalation policies” (p. 392) shows an example of what happens when an alarm threshold escalation is reached, and a policy is applied. Figure 14-2, “Alarm thresholds with de-escalation policies” (p. 393) shows two escalation and two de-escalation policies applied to an alarm.

![Alarm thresholds without de-escalation policies diagram](image-url)
The preceding figure shows two escalation policies applied to an alarm. Escalation rules are applied when the number of instances of the alarm, also called the frequency, reaches the configured value. De-escalation rules are applied when the number of instances of the alarm is less than the configured frequency value. If the escalation value is reached, the alarm is escalated to the configured value. As shown in the figure, the first escalation is to major priority and then to critical priority. When the appropriate frequency to escalate and de-escalate is reached, the alarm is first escalated in severity and then de-escalated. However, if the alarm is deleted, then the frequency calculation is affected.

**Note:** When no de-escalation policy is applied, escalated alarms are not de-escalated once the frequency of the alarm is less than the alarm escalation threshold.

*Figure 14-2  Alarm thresholds with de-escalation policies*

Escalation policies are affected by the Auto Deletion Rule parameter of the global alarm deletion policy. See 14.51 “To configure alarm severity and deletion behavior” (p. 400) for more information. When an escalation policy uses the “Delete Alarms when Cleared” default option for the Automatic Alarm Deletion Settings parameter, the escalation policy is not applied, unless alarm debouncing is enabled for the particular alarm type. You must configure the parameter to a value other than “Delete Alarms when Cleared” to ensure that the escalation policy is applied.
14.44 Alarm suppression

14.44.1 Overview

The NFM-P is designed to not generate alarms when numerous SNMP traps are sent in quick succession for the same type of event. This prevents alarm storms during intermittent outages in the network caused by bouncing NEs; for example, if links go up and down rapidly. The NFM-P continues to resynchronize the network. If the bouncing NEs continue to send down state SNMP traps, the NFM-P eventually receives the trap and generates the appropriate alarm.

To indicate how often an alarm is generated, the number of occurrences of each instance of the alarm is tracked in the alarm record of the initial alarm. Click on the Statistics tab of an Alarm Info form to display how often the alarm was generated.

To escalate the alarm severity if an alarm reoccurs a specific number of times, use the threshold crossing alert functionality. Configure the escalation or the de-escalation parameter as described in 14.50 “To customize the default behavior of alarm policies” (p. 398).

The NFM-P uses a trap throttling process to prevent the NFM-P system from being overloaded with traps if a failure occurs. Trap throttling does not affect the sequencing of traps. The trap throttling process allows the NFM-P to process traps when time permits. As a result, the NFM-P keeps track of the traps that the software missed and resynchronizes only the missed traps. Trap throttling is supported and configured using the CLI on each Nokia NE. See the NE System Management Guides for configuration information.

14.45 Automatic purging of alarms

14.45.1 Overview

Because a large number of outstanding alarms can affect system performance, the NFM-P purges outstanding alarms. The alarm purge algorithm sorts alarms using the following criteria:

- lower severity alarms are deleted before higher severity alarms
- within a severity, the oldest alarms are always deleted first

Note: The alarm purge algorithm is not applied to the following correlating—or root cause—alarms unless the red threshold has been crossed:

- EquipmentRemoved
- EquipmentMismatch
- EquipmentDown
- EquipmentAdministrativelyDown
- ContainingEquipmentMissing
- ContainingEquipmentMismatch
- ContainingEquipmentAdministrativelyDown
- ContainingEquipmentOperationallyDown
- TunnelDown
- TunnelAdministrativelyDown
When an alarm policy does not exist, the NFM-P purges alarms as follows:

For collocated systems:
- If the outstanding alarm count reaches 45,000, the NFM-P:
  - raises an alarm to indicate that an alarm purge is in progress
  - purges non-critical alarms not in the exclusions list to the historical alarm log until the count drops to 45,000
- If the outstanding alarm count reaches 60,000, the NFM-P:
  - raises an alarm to indicate that an alarm purge is in progress
  - purges alarms to the historical alarm log, starting with the oldest lowest severity alarms, until the count drops to 45,000
  - displays “Max alarm count exceeded” in the status bar

For distributed systems:
- If the outstanding alarm count reaches 200,000, the NFM-P:
  - raises an alarm to indicate that an alarm purge is in progress
  - purges non-critical alarms not in the exclusions list to the historical alarm log until the count drops to 200,000
- If the outstanding alarm count reaches 250,000, the NFM-P:
  - raises an alarm to indicate that an alarm purge is in progress
  - purges alarms to the historical alarm log, starting with the oldest lowest severity alarms until the count drops to 200,000
  - displays “Max alarm count exceeded” in the status bar

To ensure that purged alarms are logged, you must enable alarm history logging. See 14.52 “To configure alarm history database management behavior” (p. 401) for information about configuring alarm history logging and purging policies.

### 14.46 Automatic deletion of correlated alarms

#### 14.46.1 Overview

You can configure the NFM-P to automatically delete correlated alarms when the correlating alarm is deleted, as described in 14.51 “To configure alarm severity and deletion behavior” (p. 400). You can also configure NFM-P alarm settings to specify whether a user notification is displayed before you delete one or more correlated alarms.

To prevent cleared alarms from persisting in the NFM-P, alarm severity is not promoted by alarm correlation when you choose one of the following options for automatic alarm deletion. The options disable the correlation of alarm severity in the NFM-P network.

- Disable Automatic Alarm Deletion
- Delete Alarms when Acknowledged
- Delete Alarms when Cleared and Acknowledged
14.47 Alarm debouncing

14.47.1 Overview

Bouncing alarms, or flapping alarms, occur when an alarm is raised and cleared several times by the network within a short period of time. For example, an alarm can be generated several thousand times in a 24–hour period. When an alarm is generated, the alarm is typically cleared very shortly after being raised.

Alarm debouncing using the NFM-P allows you to detect and reduce the number of deleted, or cleared, alarms that are logged in the historical database, while allowing alarm events and related statistics to be kept up to date.

You can configure debouncing on alarm policies for implicitly cleared alarms only, that is, alarms which are automatically cleared by the NFM-P when a condition is met. You can configure alarm debouncing only on policies for which the auto-deletion rule cannot be configured, in which case “N/A” appears under the Auto Deletion Rule column on the Policies tab of the Alarms Settings form. Alarm debouncing is not configurable for policies for which No Deletion Rule or a configured deletion rule appears under the Auto Deletion Rule column on the Policies tab of the Alarm Settings form.

Although alarm events that occur are processed normally when alarm debouncing is enabled, alarm clear events that occur are not processed immediately. The alarm clear events are held in a separate cache until the hold period, which you configure in the debouncing policy, has elapsed. If another clear event occurs before the hold period has elapsed for the previous clear event of the same alarm, the more recent clear event replaces the older clear event in the cache. After the hold period has elapsed, the alarm clear event is removed from the cache, queued and processed.

If an alarm clear event is on hold in the cache and an alarm raise event for that same alarm is received, the clear event is removed from the cache and dropped. Because the alarm was not cleared and not raised again, the raise event is processed as an update event and the existing alarm instance is updated.

When an escalation policy uses the “Delete Alarms when Cleared” default option for the Automatic Alarm Deletion Settings parameter, the escalation policy is not applied, unless alarm debouncing is enabled for the particular alarm type. See 14.51 “To configure alarm severity and deletion behavior” (p. 400) for more information about how to configure escalation policies.

See 14.54 “To configure alarm debouncing” (p. 402) for information about how to configure alarm debouncing policies.

Note: E-mail notifications that you can configure for the Fault Management application send E-mails for alarm create events. However, if you have enabled E-mail notifications for alarm events and alarm debouncing is also enabled, any new alarms that are raised within the debounce interval are handled as an update and not a create event, and no E-mail is sent. See the Fault Management online help for more information about E-mail notification policies.
14.47.2 Purging the debouncing cache

By default, up to 5000 clear events for different alarms can be held in the debouncing cache at one time.

When the alarm debouncing cache reaches capacity with excess bouncing alarms, the NFM-P raises the AlarmDebouncingThresholdReached alarm. When this occurs, alarm debouncing is temporarily disabled and at least 70% of the alarm clear events that are being debounced are processed immediately. Alarm debouncing is re-enabled after the processing of cached events completes.

14.47.3 XML API and alarm debouncing

When debouncing is enabled, JMS listeners handle alarm events received differently from when debouncing is disabled. For example, when a raise/clear raise/clear raise/clear sequence occurs when debouncing is not enabled, JMS listeners receive and handle one update event, but the three clear events are processed by the NFM-P, and three historical alarms are logged. When this sequence occurs when debouncing is enabled, JMS listeners receive and handle a raise, update, update, clear, and only one clear event is processed by the NFM-P.

14.48 Filtering alarms for XML API clients using the NFM-P GUI

14.48.1 Overview

You can use a GUI client to configure an alarm filter for XML API clients. See 14.55 “To configure alarm filters for XML API clients using the NFM-P GUI” (p. 403) and the *NSP NFM-P XML API Developer Guide*.

Consider the following:

- Only public filters can be applied to XML API clients.
- When a user logs in to the NFM-P GUI, filters that were created for XML API applications are not applied to GUI alarms.
- Filters that are applied using the NFM-P GUI apply only to the fault (5620-SAM-topic-xml-fault) and filter (5620-SAM-topic-xml-filtered) JMS topics. Filters are not supported for the 3GPP CNBI.
- When the NFM-P GUI is used to apply or remove a filter, you do not need to disconnect or reconnect an XML API session.
- When a filter is defined and enabled, and the client does not have an XML API connection, the filter is applied when the XML API client connects.
- When a filter is defined and enabled, and the user has one or more XML API connections, the filter is applied to all of the user XML API connections.
- When an alarm filter is in use with an XML API session and an NFM-P operator changes the contents of the filter, the NFM-P user is informed that the filter is in use and who is using the filter. The NFM-P user is prompted with the option to save the change or cancel the change.
- Alarm filters that are applied to XML API sessions appear in the Sessions tab on the NFM-P User Security-Security Management form.
Alarm management workflow and procedures

14.49 Workflow to manage alarms

14.49.1 Stages

1 Configure the NFM-P system-wide alarm settings, as required to meet your specific operational requirements. These changes affect all users. You must have a user account with the administrator scope of command role to perform these procedures.

   a. Enable or disable alarm severity and alarm deletion settings and customize their default values; see 14.51 “To configure alarm severity and deletion behavior” (p. 400).

   b. Configure when alarms are logged to the alarm history database; see 14.52 “To configure alarm history database management behavior” (p. 401).

   c. Customize the default behavior of specific alarm policies; see 14.50 “To customize the default behavior of alarm policies” (p. 398).

   d. Reload alarms to ensure that the alarm service cache is up-to-date and synchronized with the historical alarm database; see 14.56 “To reload all alarms from the historical alarm database” (p. 404).

14.50 To customize the default behavior of alarm policies

14.50.1 Purpose

Perform this procedure to customize the default settings of individual NFM-P alarm policies such as severity assignments, alarm intervals, and escalation/de-escalation thresholds.

You can also perform this procedure to customize the default settings of multiple instances of alarm policies; this customization is limited to a subset of what can be performed on individual alarm policies.

14.50.2 Steps

1 Choose Administration→Alarm Settings from the NFM-P main menu. The Alarm Settings form opens.

2 Click on the Policies tab and perform one of the following:

   a. Customize the default behavior of a specific alarm policy. Go to Step 3.

   b. Customize the default behavior of multiple alarm policies. Go to Step 9.
Note: You can determine the applicable alarm policy for an alarm by searching for the base alarm name in the NFM-P Alarm Search Tool. The name format is package.AlarmName. For example, the GlobalAppProfileCreated alarm search result shows that the alarm is associated with the aapolicy.GlobalAppProfileCreated policy.

3 Choose an alarm type or multiple alarms. The alarm types are listed by policyGroup.AlarmPolicy.

4 Click Properties. The Specific Alarm Policy (Edit) form opens.

5 Configure the required parameters on the General tab.

6 Configure the alarm type escalation thresholds, as required. You can escalate or de-escalate the severity of an alarm based on how frequently the alarm is processed by the NFM-P.

   Use the following steps:
   1. Enable the Escalation parameter and click Add.
   2. Configure the Frequency parameter. The frequency is the threshold in a 24-hour period of how often the alarm must arrive before the severity is escalated. The alarms are analyzed at faster, non-configurable intervals to determine whether the Frequency value is reached.
   3. Configure the Severity parameter to specify a different severity to be applied to the alarm if the escalation threshold is reached.
   4. Click OK. The new escalation policy is applied to the alarm.

7 Configure the alarm type de-escalation thresholds, as required. You can escalate or de-escalate the severity of an alarm based on how frequently the alarm is processed by the NFM-P.

   Use the following steps:
   1. Enable the De-escalation parameter and click Add.
   2. Configure the Frequency parameter. The frequency is the threshold in a 24-hour period of how often the alarm must arrive before the severity is de-escalated. The alarms are analyzed at faster, non-configurable intervals to determine whether the Frequency value is reached.
   3. Configure the Severity parameter to specify a different severity to be applied to the alarm if the de-escalation threshold is reached.
   4. Click OK. The new de-escalation policy is applied to the alarm.
8 Go to Step 12.

9 Shift-click to choose multiple alarms. The alarm types are listed by policy group.alarm policy.

10 Click Properties. The Specific Alarm Policy (Edit) form opens.

11 Configure the required parameters on the General tab.

12 Save your changes and close the forms.

END OF STEPS

14.51 To configure alarm severity and deletion behavior

Note: You must have a user account with the administrator scope of command role or write access to the fm.GlobalPolicy class to perform this procedure.

14.51.1 Steps

1 Choose Administration→Alarm Settings from the NFM-P main menu. The Alarm Settings form opens.

2 In the Alarm Severity Settings panel, enable or disable alarm severity settings and specify the behavior for automatic and manual alarm settings.

Use the following steps:

1. Configure the Enable Severity Settings parameter, as required. You cannot configure additional parameters in the Alarm Severity Settings panel unless the parameter is enabled.

2. Configure the required parameters in the Manual panel.

3. Configure the required parameters in the Automatic panel.
CAUTION

Service Disruption

Deleting an alarm resets the frequency of the alarm to 1.
This may cause conflicts with configured alarm escalation and de-escalation policies.

In the Alarm Deletion Settings panel, enable or disable alarm deletion settings and specify the behavior for manual and automatic alarm deletion settings.
1. Configure the Enable Deletion Settings parameter. You cannot configure parameters in the Alarm Deletion Settings panel unless the parameter is enabled.
2. Configure the other parameters in the Alarm Deletion Settings panel, as required.

See 14.52 “To configure alarm history database management behavior” (p. 400) for information about configuring parameters in the Alarm History DB Behavior panel.

To reset all parameters on the General tab to their default values, click Reset To Default.

Save your changes and close the form.

END OF STEPS

14.52 To configure alarm history database management behavior

14.52.1 Purpose

The NFM-P stores alarms in the alarm history database for record-keeping and trend analysis. You can specify when alarms are logged to the alarm history database.

Note: When the maximum number of alarms allowed in the alarm history database is reached, the NFM-P deletes the oldest alarms. If you need to save information about the alarms, save a file that contains the alarm log information, as described in the NSP NFM-P User Guide.

14.52.2 Steps

1. Choose Administration—>Alarm Settings from the NFM-P main menu. The Alarm Settings form opens.
Configure the required parameters in the Alarm History DB Behavior panel.

**Note:** Nokia recommends that you enable the Log On Deletion parameter to ensure that the alarm history log records all deleted alarms.

To reset all parameters on the General tab to their default values, click Reset To Default.

Save your changes and close the form.

**End of steps**

### 14.53 To display the Additional Text Find button on object properties forms

#### 14.53.1 Steps

1. Choose Administration→Alarm Settings from the NFM-P main menu. The Alarm Settings form opens.

2. Click on the Additional Text tab and enable or disable the Show Additional Text Button on Properties Forms parameter.

3. Save your changes and close the form.

**End of steps**

### 14.54 To configure alarm debouncing

#### 14.54.1 Steps

1. Choose Administration→Alarm Settings from the NFM-P main menu. The Alarm Settings form opens.

2. Click on the Policies tab and choose one or more alarm policies. In the policies table, only policies which show "N/A" under Auto Deletion Rule are configurable with alarm debouncing. If
you select one or more alarm policies for which the Auto Deletion Rule parameter is a value other than “N/A”, the alarm debouncing parameters do not appear.

Choose the policy and click Properties. The Specific Alarm Policy (Edit) form opens.

**Note:** You can also open the Specific Alarm Policy (Edit) form from the Alarm Info form, by clicking on the View Policy button.

Configure the Enable Alarm Debouncing parameter.

Configure the Hold Period (seconds) parameter to specify the debouncing time interval. If you are enabling alarm debouncing for this policy for the first time, the default value is automatically set to 180. If alarm debouncing was previously enabled, then disabled, the value of the Hold Period (seconds) parameter remains as the last configured value.

Save and close the forms.

**END OF STEPS**

### 14.55 To configure alarm filters for XML API clients using the NFM-P GUI

#### 14.55.1 Purpose

Perform this procedure to configure a filter to control or limit the alarms that the NFM-P forwards to XML API clients over JMS. See 14.48 “Filtering alarms for XML API clients using the NFM-P GUI” (p. 397) and the *NSP NFM-P XML API Developer Guide* for more information.

**Note:** The procedure requires an existing XML API client user account. See Chapter 3, “NFM-P user security” for information about creating a user account for XML API client access.

#### 14.55.2 Steps


2. Click on the Users tab.
Choose a user from the list and click Properties. The User (Edit) form opens.

In the XML API Session panel, click Select to assign a public alarm filter. The Select Public Alarm Filter for XML API form opens.

Perform one of the following:

a. Select a filter in the list. Go to Step 6.

b. Create an alarm filter.

Use the following steps:

1. Click Create. The Create Alarm Object Filter form opens.

2. Configure an appropriate filter for the XML API client by selecting a filter from the Attribute parameter pull-down menu. You can modify the filter string to meet the operational requirements for an XML API client by configuring the Function, Value, and Operators pull-down menus as appropriate.

3. Click Add to add the filter.

4. Add additional filter criteria for the alarm filter as required.

5. Click Save. The Save Filter form opens.

6. Configure the required parameters.

   Note:
   The Public parameter must be enabled. Only public filters are applied to XML API clients.

7. Save your changes and close the Save Filter and Select Public Alarm Filter for XML API forms.

Choose the newly created filter from the list, and click OK. The Select Public Alarm Filter for XML API-User form closes, and the selected filter is applied.

Save your changes and close the forms.

**END OF STEPS**

---

**14.56 To reload all alarms from the historical alarm database**

**14.56.1 Purpose**

The NFM-P uses an alarm service to cache alarm information. To ensure the cache is current with all alarms stored in the historical alarm database, administrators can reload all alarms from the

---

**END OF STEPS**
database. To perform this procedure, you must have a user account with the administrator scope of command role or a scope of command role with write access permissions to the fm.FaultManager class.

**CAUTION**

Service Disruption

*After the procedure is complete, client GUI users viewing open alarm forms and windows may have out-of-date information. Operators must close all open windows and forms, then relaunch -open the windows or forms. This includes windows and forms that display alarm status information, for example, the navigation tree.*

**14.56.2 Steps**

1. Choose Administration→Reload Alarm Information from the NFM-P main menu.

2. Click OK to confirm you are aware that all other users will be affected by the alarm reload. Alarm information is reloaded and all active client GUIs are updated with the confirmation message that the alarms have been reloaded. Client GUI users can close and then reopen the Alarm Window to refresh the information.

**END OF STEPS**

**14.57 To manually promote or demote the severity of an alarm**

**14.57.1 Purpose**

Operators with the appropriate scope of command permissions can change the severity of alarms when alarm settings are configured appropriately. See **14.51 "To configure alarm severity and deletion behavior" (p. 400)** for more information about configuring global alarm settings.

**14.57.2 Steps**

1. Perform one of the following to open the Severity Assignment form:
   a. From the dynamic alarm list:
      
      Use the following steps:
      1. Filter the alarms. See the *NSP NFM-P User Guide* for information about creating search filters.
      2. Right-click on an alarm in the list and choose Assign Severity. The Severity Assignment form opens and displays the selected alarm(s).
b. From the alarm list on the Faults tab of the object properties form:

Use the following steps:

1. Open the object properties form for the required object.
2. Click on the Faults tab.
3. Click on a sub-tab. A list of object alarms appears.
4. Filter the alarms. See the NSP NFM-P User Guide for information about creating alarm filters.
5. Right-click on an alarm in the list and choose Assign Severity. The Severity Assignment form opens and displays the selected alarm(s).

**Note:** You can choose multiple alarms at the same time. When you choose multiple alarms, the new severity level is applied to all selected alarms.

2 Configure the Assigned Severity parameter.

**Note:** Before you close the form, you can click Reset to restore the original severity setting.

3 Save the changes and close the forms.

**END OF STEPS**

### 14.58 To configure alarm filters for XML API clients using the NFM-P GUI

#### 14.58.1 Purpose

Perform this procedure to configure a filter to control or limit the alarms that the NFM-P forwards to XML API clients over JMS. See 14.48 “Filtering alarms for XML API clients using the NFM-P GUI” (p. 397) and the NSP NFM-P XML API Developer Guide for more information.

**Note:** The procedure requires an existing XML API client user account. See Chapter 3, “NFM-P user security” for information about creating a user account for XML API client access.

#### 14.58.2 Steps


2. Click on the Users tab.
Choose a user from the list and click Properties. The User (Edit) form opens.

In the XML API Session panel, click Select to assign a public alarm filter. The Select Public Alarm Filter for XML API form opens.

Perform one of the following:

a. Select a filter in the list. Go to Step 6.

b. Create an alarm filter.

Use the following steps:
1. Click Create. The Create Alarm Object Filter form opens.
2. Configure an appropriate filter for the XML API client by selecting a filter from the Attribute parameter pull-down menu. You can modify the filter string to meet the operational requirements for an XML API client by configuring the Function, Value, and Operators pull-down menus as appropriate.
3. Click Add to add the filter.
4. Add additional filter criteria for the alarm filter as required.
5. Click Save. The Save Filter form opens.
6. Configure the required parameters.

Note:
The Public parameter must be enabled. Only public filters are applied to XML API clients.
7. Save your changes and close the Save Filter and Select Public Alarm Filter for XML API forms.

Choose the newly created filter from the list, and click OK. The Select Public Alarm Filter for XML API-User form closes, and the selected filter is applied.

Save your changes and close the forms.

END OF STEPS

14.59 To create an alarm e-mail policy

14.59.1 Purpose

An NFM-P administrator can create up to five policies for e-mail notifications with alarm notification rules and a list of recipients. When a filter is matched, an e-mail is sent to the list of recipients. The
e-mail is a text version of a set of alarm fields, and includes a URL to the Impact Analysis tool in the NFM-P Fault Management application in the context of the alarm.

**Note:** You must have permissions to access the Fault Management application to use the Impact Analysis tool. Contact your system administrator for more information.

Your administrator must ensure that the outgoing SMTP e-mail server is configured.

LI alarms are not sent in the e-mails.

E-mails are not sent for alarm attribute change events, only for alarm creation. For example, if an alarm is created with a severity of major, and the severity is subsequently changed to critical, alarm e-mail policy filters for critical alarms will not include this alarm.

When you modify the e-mail policy properties form, the e-mail counts for the e-mail policy are reset. If you select a different filter for the e-mail policy, the e-mail counts are reset. If you modify the contents of the saved filter from the alarm table, the e-mail counts for the e-mail policy are not reset.

### 14.59.2 Steps

1. Choose Administration→Alarm Settings from the NFM-P main menu. The Alarm Settings form opens.

2. Click on the E-mail tab and click Create. The Alarm Email Filter (Create) form opens.

3. Configure the Name and Max Emails Per Hour parameters.

4. Select an alarm filter. To configure and apply an advanced search filter using the filter configuration form, see the *NSP NFM-P User Guide* for information.

5. Click on the Users tab, then on Add to create a list of e-mail recipients. The e-mail is sent to the e-mail address configured for the selected users.

You can add up to 20 users as recipients of an e-mail for each policy.

6. Save the changes and close the forms.

**END OF STEPS**
14.60 **To optimize alarm event notifications**

14.60.1 **Purpose**

The alarm event buffer receives all alarm events that must be broadcast to JMS clients. For optimization purposes, the buffer fills up alarm events and flushes the queue every 3 seconds. During these 3 seconds, if a creation event is queued followed by a deletion event for that same object, both of these events cancel each other out, and no event is sent. However, the alarm corresponding to the deletion event is still logged into historical alarms.

You can disable the canceling of creation and deletion event pairs. All of the events are reported to all subscribed JMS listeners and are displayed in the Active Alarm list of each GUI client. When this option is deselected, the user receives a warning that this will impact alarm event processing. If optimization is not enabled, third-party JMS listeners may be affected as they may not be able to handle the increased rate of incoming events.

14.60.2 **Steps**

1. Choose Administration→Alarm Settings from the NFM-P main menu. The Alarm Settings form opens.

2. Ensure the Optimize Alarm Event Notifications parameter is enabled.

3. Save the changes and close the form.

**END OF STEPS**
Configuring OLC states

14.61 Introduction

14.61.1 Description

Performing a maintenance operation on an NE can generate a considerable number of NFM-P alarms that are not of interest to an operator. You can configure the OLC state of a service or equipment object to specify whether the object is in service or in maintenance mode. During a subsequent maintenance operation, you can filter alarms using the OLC state as a criterion in order to display only the alarms of interest.

Note: The NFM-P raises alarms against service and equipment objects regardless of the OLC state, which is not deployed to NEs.

You can set the OLC state on the following equipment and service objects:

- network elements
- power supply trays
- card slots
- daughter cards
- ports
- LAGs
- composite services
- services
- sites
- SAPs

Note: A shelf OLC state is inherited from the parent NE, and is not configurable.

On equipment and service properties forms, you can configure the NFM-P to change the OLC state of an object after a specified time, depending on the current OLC state. In a device discovery rule, you can configure the default OLC state for NEs, and can specify that the current OLC state reverts when the NE discovery is complete. You can also specify that the NFM-P raise an informational alarm about an object OLC state reverting to the opposite state. See the NSP NFM-P User Guide for information about device discovery rules and OLC states.

14.61.2 Setting the OLC state

CAUTION

Service Disruption

Changing the OLC state of an object also changes the OLC state of child objects that are not locked in maintenance mode, and may affect NFM-P system performance.

Ensure that you change the OLC state of an object that has many child objects only during a period of low NFM-P activity, such as during a scheduled maintenance period.

Note: An OLC state change operation may take several minutes to complete, depending on the number of objects that the state change affects.
A child object inherits the OLC state of the parent object. However, you can lock the OLC state of a child object in maintenance mode to prevent the inheritance in the event that the parent OLC state changes. Locking the OLC state of an object also locks the OLC state of each child object.

You can specify a global default OLC state for discovered services; see 6.34 “To configure NFM-P system preferences” (p. 191).

During a shutdown or turn-up operation, the OLC state of the parent object overwrites the OLC state of each child object, unless the OLC state of a child object is locked in maintenance mode. The NFM-P Task Manager logs the OLC state change of an object, but does not log the OLC state changes of the child objects.

**Note:** When an OLC state change affects a large number of objects, alarms raised against affected objects before the state change is propagated show the previous OLC state. Also, if an operator shuts down an equipment or service object via CLI, the associated NE trap handling for the child objects requires additional processing which can cause the same propagation delay and OLC state misrepresentation in alarms.

### 14.61.3 Functional description

When the OLC state of an NE is set to maintenance mode, all child objects such as access interfaces, card slots, daughter cards, and ports are set to maintenance mode, as is each service site on the NE.

When the OLC state of a composite service or service is set to the maintenance mode, the following child objects are affected:

- service sites
- L2 and L3 SAPs
- SDP bindings

When the OLC state of a composite service or services changes to in service, the OLC states of the associated sites and SAPs do not change if they are on equipment objects that are in maintenance mode.

The OLC state of an object must be in service before you can change the OLC state of a child object. You can change the OLC state of a parent object regardless of the OLC state of a child object, but if a child object has more than one parent object and the OLC state of one parent is set to maintenance, the child object is set to maintenance. You cannot change the OLC state of an object when a parent OLC state is set to maintenance.

You can configure the default OLC state for objects that become administratively down from the OLC tab of the System Preferences form; see “System preferences configuration procedures” (p. 191).

You must add the OLC state property to manually created service templates, as described in 14.68 “To add the OLC state property to a manually created service template” (p. 416).
14.62 To display equipment or service OLC states

14.62.1 Steps

1. Choose Administration→OLC from the NFM-P main menu. The OLC form opens.

2. Choose a service or network object from the drop-down menu and click Search. A list of objects is displayed.

3. View the Current OLC State and Lock OLC State values.

4. Close the OLC form.

END OF STEPS

14.63 To display the OLC state change schedules

14.63.1 Steps

1. Choose Administration→OLC from the NFM-P main menu. The OLC form opens.

2. Click on the Schedules tab. A list of scheduled OLC state changes is displayed.

3. View the following information:
   • object ID and name
   • current OLC state
   • OLC state to which the object reverts at the scheduled time
   • time when the OLC state changes

4. As required, select an entry and click Properties to view more information.
5

Close the open forms.

END OF STEPS

14.64 To change the OLC state of one or more objects

CAUTION

Service Disruption

Changing the OLC state of an object also changes the OLC state of child objects that are not locked in maintenance mode, and may affect NFM-P system performance.

Ensure that you change the OLC state of an object that has many child objects only during a period of low NFM-P activity, such as during a scheduled maintenance period.

Note: You can change the OLC state of multiple services at once only if the services are of the same type.

Note: An OLC state change operation may take several minutes to complete, depending on the number of objects that the state change affects.

14.64.1 Steps

1 Perform one of the following.

a. Use the OLC form.

   1. Choose Administration→OLC from the NFM-P main menu. The OLC form opens.
   2. Choose a service or network object type from the drop-down menu and click Search. A list of objects is displayed.
   3. Select one or more entries and click OLC State→Maintenance or OLC State→In Service.

b. Use an object properties form.

   1. Open the object properties form of one object, or the multi-instance properties form of multiple objects. A properties form opens.
   2. Configure the Current OLC State parameter.

The OLC state of each selected object changes.

2 Save the changes and close the open forms.

END OF STEPS
14.65 To lock the OLC state

14.65.1 Purpose

You can lock the OLC state of a child object that is in maintenance mode to prevent the OLC state from changing in the event that the parent object OLC state changes to In Service. Locking the OLC state of an object disables any associated scheduled OLC state change. Also, when the OLC state of an object is locked, you cannot configure the Revert OLC State parameter of the object.

Note: You can lock the OLC state of multiple objects at once.

14.65.2 Steps

1. Choose Administration→OLC from the NFM-P main menu. The OLC form opens.

2. Choose a service or network object type from the drop-down menu and click Search. A list of objects is displayed.

3. Select one or more entries and click Properties. The object or multi-instance properties form opens.

4. Configure the Lock OLC State parameter.

   Note: You can lock the OLC state only when the Current OLC State parameter is set to Maintenance.

   Note: If all selected objects have an OLC state of Maintenance and one or more objects is locked in maintenance mode, the Lock OLC State parameter is selected and dimmed, but is configurable.

5. Save the changes and close the OLC form.

End of steps
14.66 To schedule an OLC state change

**CAUTION**

**Service Disruption**

*Changing the OLC state of an object also changes the OLC state of child objects that are not locked in maintenance mode, and may affect NFM-P system performance.*

*Ensure that you schedule the OLC state change of an object that has many child objects to occur during a period of low NFM-P activity, such as during a scheduled maintenance period.*

14.66.1 Steps

1. Choose Administration→OLC from the NFM-P main menu. The OLC form opens.

2. Choose a service or network object type from the drop-down menu and click Search. A list of objects is displayed.

3. Select one or more entries and click Properties. The object properties or multi-instance properties form opens.

4. Configure the Revert OLC State parameter. If you set the parameter to Custom, use the calendar tool to specify a time and date at which the OLC state is to change.

    **Note:** If multiple objects are selected, a schedule is created for each object. Also, the OLC State Will Revert To and Revert OLC Time indicators are not shown on multi-instance properties forms; you must open the properties form for one object to view the indicators.

5. Save the changes and close the OLC form.

END OF STEPS

14.67 To change the OLC state assigned to one or more alarms

14.67.1 Steps

1. If required, create an alarm filter.
   1. Click on the filter icon in the Alarm Window. A filter form opens.
2. Choose Assigned OLC State from the Attribute drop-down menu.
3. Configure the filter, as required. See the NSP NFM-P User Guide for information about creating alarm filters.

2 Select one or more alarms in the alarm list.

3 Right-click on the selected alarms and choose Assign OLC State. The OLC State Assignment form opens.

4 Configure the Assigned OLC State parameter.

5 Save the changes and close the OLC State Assignment form.

END OF STEPS

14.68 To add the OLC state property to a manually created service template

14.68.1 Purpose
You cannot configure the OLC state property of a service object during object creation. The OLC state property is automatically included in an NFM-P-created service template, but not in a manually created service template.

14.68.2 Steps

1 Open the GUI builder, as described in the NSP NFM-P Scripts and Templates Developer Guide.

2 Create a combo box component and enter olcState as the Name attribute value.

3 Enter the following as the List attribute values:
  • inService
  • maintenance

4 Enter one of the following as the Default attribute value:
• inService
• maintenance

5

Save the changes and close the open forms.

END OF STEPS
As required maintenance
Configuring OLC states
To add the OLC state property to a manually created service template
Part V: Appendices

Overview

Purpose

This part provides information about the NFM-P scope of command roles and permissions.

Contents

| Appendix A, Scope of command roles and permissions | 421 |
A Scope of command roles and permissions

A.1 Overview

A.1.1 Purpose
Appendix A describes the scope of command roles and permissions.

A.1.2 Contents

<table>
<thead>
<tr>
<th>A.1 Overview</th>
<th>421</th>
</tr>
</thead>
<tbody>
<tr>
<td>A.2 Predefined scope of command profiles and roles</td>
<td>421</td>
</tr>
<tr>
<td>A.3 Permissions assignable to NFM-P scope of command roles</td>
<td>424</td>
</tr>
<tr>
<td>A.4 Permissions access for scope of command roles</td>
<td>457</td>
</tr>
</tbody>
</table>

A.2 Predefined scope of command profiles and roles

A.2.1 General information
This appendix describes the predefined NFM-P scope of command profiles and roles, and the access permissions for each predefined role. Predefined scope of command profiles and roles cannot be deleted.

Table A-1 Summary of command profiles, roles, and permission information

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Table A-2, “Predefined scope of command profiles” (p. 422)</td>
<td>Lists the predefined scope of command profiles, the assigned roles for each profile, and a description for each profile.</td>
</tr>
<tr>
<td>Table A-3, “Predefined scope of command roles” (p. 422)</td>
<td>Lists the NFM-P predefined scope of command roles and provides a description of the user security access provided for each role.</td>
</tr>
<tr>
<td>A.3 “Permissions assignable to NFM-P scope of command roles” (p. 424)</td>
<td>Lists the permissions that can be assigned to an NFM-P scope of command role and a description of the permission.</td>
</tr>
<tr>
<td>A.4 “Permissions access for scope of command roles” (p. 457)</td>
<td>Describes the access levels that can be assigned for permissions in a scope of command role, and how to view the permission configuration of a role.</td>
</tr>
</tbody>
</table>
### A.2.2 Predefined scope of command profiles

**Table A-2 Predefined scope of command profiles**

<table>
<thead>
<tr>
<th>Profile name</th>
<th>Assigned roles</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>admin</td>
<td>Administrator</td>
<td>Default administrative scope of command profile with access to all menus accessible from the NFM-P GUI with the exception of LI menu functions. This profile also has no XML API access.</td>
</tr>
</tbody>
</table>

### A.2.3 Predefined scope of command roles

**Table A-3 Predefined scope of command roles**

<table>
<thead>
<tr>
<th>Role</th>
<th>Access provided</th>
</tr>
</thead>
<tbody>
<tr>
<td>Base Read-only</td>
<td>Read-only to all objects except for the objects in the NFM-P Security and Mirror Service Management roles.</td>
</tr>
<tr>
<td>Administrator</td>
<td>GUI access, but no XML API access, to all objects. Create, modify, delete, import, and export public workspaces. View private or public workspaces in the Manage Workspaces list.</td>
</tr>
<tr>
<td>User Management</td>
<td>NFM-P user and group management. Create, modify, delete, import, and export public workspaces. View private or public workspaces in the Manage Workspaces list.</td>
</tr>
<tr>
<td>NFM-P Management and Operations</td>
<td>Database functions such as backup, restore, reinstatement, and switchover. Alarm administration such as acknowledgement, clearing, and setting severity-change thresholds. General NE management functions such as discovery, deployment, mediation, polling, statistics management, and security management that includes modifying spans. Create, modify, delete, import, and export public workspaces. View private or public workspaces in the Manage Workspaces list.</td>
</tr>
<tr>
<td>Network Element Equipment Management</td>
<td>Physical equipment configuration and management.</td>
</tr>
<tr>
<td>Service Management</td>
<td>Service, service component, and service template management functions, excluding mirror-service management.</td>
</tr>
<tr>
<td>Old Service Template Management</td>
<td>Management of service templates deprecated; see Template Script Management in this table.</td>
</tr>
<tr>
<td>Subscriber Management</td>
<td>Customer and residential subscriber management.</td>
</tr>
<tr>
<td>QoS/ACL Policy Management</td>
<td>General QoS and ACL policy management, Ethernet service and time of day suite policy management.</td>
</tr>
<tr>
<td>Policy Management (except QoS/ACL)</td>
<td>Management of policies other than those in the QoS/ACL Policy Management role.</td>
</tr>
<tr>
<td>Routing Management</td>
<td>Routing protocol, L2 forwarding, and bandwidth management.</td>
</tr>
<tr>
<td>Tunnel Management</td>
<td>Service tunnel and underlying transport management.</td>
</tr>
</tbody>
</table>
### Table A-3  Predefined scope of command roles (continued)

<table>
<thead>
<tr>
<th>Role</th>
<th>Access provided</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Network Element Software Management</strong></td>
<td>NE software management functions.</td>
</tr>
<tr>
<td><strong>Fault Management</strong></td>
<td>Functions such as alarm management and remote network monitoring.</td>
</tr>
<tr>
<td><strong>Service Test Management</strong></td>
<td>STM functions such as creating, running and scheduling OAM tests.</td>
</tr>
<tr>
<td><strong>Script Management</strong></td>
<td>XML API and CLI script management, excluding execution.</td>
</tr>
<tr>
<td><strong>Script Execution</strong></td>
<td>XML API and CLI script execution.</td>
</tr>
<tr>
<td><strong>Mirror Service Management</strong></td>
<td>Creation and management of mirror services and mirror-service components using the GUI.</td>
</tr>
<tr>
<td><strong>XML API Management</strong></td>
<td>Use of the XML API.</td>
</tr>
<tr>
<td><strong>Telnet/SSH Management</strong></td>
<td>Telnet or SSH access to NEs from the GUI.</td>
</tr>
<tr>
<td><strong>CPAM OSS PCA</strong></td>
<td>Route Analysis of ISIS Topology, OSPF Topology, and MPLS Topology for CPAM routing.</td>
</tr>
<tr>
<td><strong>Root Cause Analysis (RCA) Object Verification</strong></td>
<td>RCA functions.</td>
</tr>
<tr>
<td><strong>Lawful Interception Management</strong></td>
<td>LI configuration for mirror services, mediation policies, and NE security.</td>
</tr>
<tr>
<td><strong>Template Script Management</strong></td>
<td>Service and tunnel template script management.</td>
</tr>
<tr>
<td><strong>Service Template Script Execution</strong></td>
<td>Service template script execution.</td>
</tr>
<tr>
<td><strong>Tunnel Template Script Execution</strong></td>
<td>Tunnel template script execution.</td>
</tr>
<tr>
<td><strong>Application Assurance (AA) Management</strong></td>
<td>AA policy management.</td>
</tr>
<tr>
<td><strong>Format and Range Policy Management</strong></td>
<td>Format and range policy management, service-creation span rules.</td>
</tr>
<tr>
<td><strong>Work Order Activation</strong></td>
<td>The ability to perform CM work order activation.</td>
</tr>
<tr>
<td><strong>Configuration Snapshot Export</strong></td>
<td>The ability to perform export CM configuration snapshots.</td>
</tr>
<tr>
<td><strong>Create and Delete Access</strong></td>
<td>The ability to create and/or delete eNodeB objects via the XML API.</td>
</tr>
<tr>
<td><strong>Configuration Management which causes node reset</strong></td>
<td>The ability to configure objects which causes a full or partial reset of the node.</td>
</tr>
<tr>
<td><strong>EPC Operator</strong></td>
<td>Read and write permission on all Evolved Packet Core classes.</td>
</tr>
</tbody>
</table>
Table A-3  Predefined scope of command roles  (continued)

<table>
<thead>
<tr>
<th>Role</th>
<th>Access provided</th>
</tr>
</thead>
<tbody>
<tr>
<td>eNodeB NEM Operator</td>
<td>The ability to launch the 9400 NEM eNodeB parameter configuration tool.</td>
</tr>
<tr>
<td>Admin Neto Launch</td>
<td>The ability to open the NEtO with the administration profile.</td>
</tr>
<tr>
<td>Viewer Neto Launch</td>
<td>The ability to open the NEtO with the viewer profile.</td>
</tr>
<tr>
<td>Default Neto Launch</td>
<td>The ability to open the NEtO with the null profile.</td>
</tr>
<tr>
<td>Ageout Constraint Policy Management</td>
<td>The ability to configure Ageout Constraint Policies.</td>
</tr>
<tr>
<td>Purge Records</td>
<td>The ability to purge historical records from the NFM-P such as statistics logs, event logs, etc.</td>
</tr>
</tbody>
</table>

Wireless configuration management with full service impact

Allows users to resynchronize the Network Element and perform configuration with no, partial or critical service impact. In wireless, user configuration has a critical service impact if the updated parameters are class 0 (A) and the created or deleted objects have an impact of ‘critical’ for creation and deletion. The user can reconfigure the Network Element using the configuration stored in the main database.

Wireless configuration management with partial service impact

Allows users to resynchronize the Network Element and perform configuration with no or partial service impact. In wireless, user configuration has partial impact if the updated parameters are class 2 (B) and the created or deleted objects have an impact of ‘partial’ for creation and deletion.

Wireless configuration management without service impact

Allows users to resynchronize the Network Element and perform configuration with no service impact. In wireless, user configuration has no service impact if the updated parameters are class 3 (C) and the created or deleted objects have an impact of ‘none’ for creation and deletion.

eNodeB pre-provisioning and configuration with full service impact

Allows users to manage Network Element configuration with full service impact (as described in the 'Wireless configuration management with full service impact' role) and pre-provision eNodeBs. The span of control can be used to limit this role to pre-provisioning only.

A.3  Permissions assignable to NFM-P scope of command roles

A.3.1  Permissions assignable to NFM-P scope of command roles

Table A-4  Permissions assigned to NFM-P scope of command roles

<table>
<thead>
<tr>
<th>Package,Class,Method/Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>aaa</td>
<td>AAA - Configurations for authentication, authorization, and accounting.</td>
</tr>
<tr>
<td>Package.Class.Method/Property</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------------------------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>aapolicy</td>
<td>Application Assurance - AA policies, configuration, protocol, group, filter, and profiles.</td>
</tr>
<tr>
<td>aapolicy.DbInfoTransitSubscriberManager.property_</td>
<td>Db Info Transit Subscriber Manager - property_ DbInfoTransIpAddrRtrvTimeOut - Service preferences can only be modified by a user with an administrator role.</td>
</tr>
<tr>
<td>aapolicy.DbInfoTransitSubscriberManager.property_</td>
<td>Db Info Transit Subscriber Manager - property_ DbInfoTransPrfxAddrRtrvTimeOut - Service preferences can only be modified by a user with an administrator role.</td>
</tr>
<tr>
<td>aapolicy.DbInfoTransitSubscriberManager.property_</td>
<td>Db Info Transit Subscriber Manager - property_ DbInfoTransSubscrRtrvMax - Service preferences can only be modified by a user with an administrator role.</td>
</tr>
<tr>
<td>accessuplink</td>
<td>Access Uplink - Configuration of 7210 Access Uplink Specifics for physical ports and LAG interfaces.</td>
</tr>
<tr>
<td>accounting</td>
<td>Accounting Policy - Statistics Accounting Policies.</td>
</tr>
<tr>
<td>aclfilter</td>
<td>ACL Filter Policy - MAC, IP, and IPv6 ACL Filters.</td>
</tr>
<tr>
<td>aclfilterli</td>
<td>ACL Filter LI - All configurations for mirroring of packets matching entries of Lawful intercept ACL filters to mirror destinations.</td>
</tr>
<tr>
<td>activation</td>
<td>Activation - Used to define, manage, and deploy work orders used in activation.</td>
</tr>
<tr>
<td>activation.Session</td>
<td>Activation Session - Used to manage activation sessions and activate work orders.</td>
</tr>
<tr>
<td>activation.Snapshot</td>
<td>Snapshot - Used to manage CM configuration snapshots.</td>
</tr>
<tr>
<td>activation.SnapshotEntity</td>
<td>Snapshot Entity - Used to manage snapshot entities.</td>
</tr>
<tr>
<td>activation.WebDAVSharedData</td>
<td>activation.WebDAVSharedData - Ability to restrict access to CM data (CM work orders and configuration snapshots) via the WebDAV protocol.</td>
</tr>
<tr>
<td>activation.WorkOrder</td>
<td>Work Order - Used to manage work orders.</td>
</tr>
<tr>
<td>ageoutcstr</td>
<td>Ageout Constraint - Configurations related to Ageout Constraint.</td>
</tr>
<tr>
<td>aggregator</td>
<td>Aggregation - Aggregation Manager.</td>
</tr>
<tr>
<td>analytics</td>
<td>Analytics - Analytics Manager.</td>
</tr>
<tr>
<td>ancp</td>
<td>ANCP - Access Node Control Protocol (ANCP) policy and configuration.</td>
</tr>
<tr>
<td>ancp.AncpLoopback</td>
<td>ANCP Loopback - Access to ANCP Loopback tests, ANCP Loopback test definitions, and ANCP Loopback deployed tests.</td>
</tr>
<tr>
<td>antispooof</td>
<td>Anti-Spoofing - Anti-Spoofing for L2/L3 Access Interfaces and Filter configuration.</td>
</tr>
<tr>
<td>Package.Class.Method/Property</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------------------------------</td>
<td>------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>aosqos</td>
<td>AoS QoS - Quality of Service for Application over Signaling (AoS QoS) Policy and conditions, AoS QoS configuration for Physical Port and Layer 2 Bridge.</td>
</tr>
<tr>
<td>aosredundancy</td>
<td>Aos-Redundancy - AOS Multichassis.</td>
</tr>
<tr>
<td>aossas</td>
<td>AOS SAS - OAM tests specific to AOS nodes.</td>
</tr>
<tr>
<td>aossas.CPETestGroupHead</td>
<td>CPE SLA Test Group - Access to CPE SLA tests, CPE SLA test definitions, and CPE SLA deployed tests.</td>
</tr>
<tr>
<td>aossas.CPETestHead</td>
<td>CPE SLA Test - Access to CPE SLA tests, CPE SLA test definitions, and CPE SLA deployed tests.</td>
</tr>
<tr>
<td>apipe</td>
<td>APIpe - All contained objects are listed. Package access is not currently used.</td>
</tr>
<tr>
<td>apipe.Site</td>
<td>Apipe Site - Access to Apipe Sites.</td>
</tr>
<tr>
<td>aps</td>
<td>APS - Automatic Protection Switching (APS) Groups.</td>
</tr>
<tr>
<td>arp</td>
<td>ARP - ARP host and configurations on service interfaces.</td>
</tr>
<tr>
<td>assurance</td>
<td>Assurance - Parent package for all Assurance event classes.</td>
</tr>
<tr>
<td>atm</td>
<td>ATM - ATM configuration for Service interfaces and routers, ATM Connections, ILM Link, and other ATM related objects.</td>
</tr>
<tr>
<td>atm.AtmPing</td>
<td>ATM Ping - Access to ATM Ping tests, ATM Ping test definitions, and ATM Ping deployed tests.</td>
</tr>
<tr>
<td>atmpolicy</td>
<td>ATM QoS Policy - ATM Traffic Descriptor Policy.</td>
</tr>
<tr>
<td>audit</td>
<td>Resource Audit - Ability to execute audits and view audit results.</td>
</tr>
<tr>
<td>autoconfig</td>
<td>Automatic Configuration - Auto-Config Source and Target Node Profiles.</td>
</tr>
<tr>
<td>autoconfig.AutoConfigScriptManager.method_configure</td>
<td>Automatic Configuration - method_configure - Ability to create/modify/delete an auto-config script.</td>
</tr>
<tr>
<td>autoconfig.AutoConfigScriptManager.method_copyContents</td>
<td>Automatic Configuration - method_copyContents - Ability to copy the contents of one auto-config script to new one.</td>
</tr>
<tr>
<td>bgp</td>
<td>Routing Management: BGP - Border Gateway Protocol (BGP) configuration for routers, policies, peers, groups, MD5, and Confederations.</td>
</tr>
<tr>
<td>bgp.Site</td>
<td>BGP Site - Access to a BGP protocol site on a router.</td>
</tr>
<tr>
<td>bulk</td>
<td>Bulk Operations - Not currently used.</td>
</tr>
<tr>
<td>bulk.BulkChange</td>
<td>Bulk Change - The ability to create, modify, and/or delete bulk changes.</td>
</tr>
</tbody>
</table>
### Table A-4  Permissions assigned to NFM-P scope of command roles  (continued)

<table>
<thead>
<tr>
<th>Package.Class.Method/Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>bulk.BulkManager.method_execute</td>
<td>Bulk Operations Manager - method_execute - The ability to execute bulk operations.</td>
</tr>
<tr>
<td>bulk.BulkManager.method_generateBatches</td>
<td>Bulk Operations Manager - method_generateBatches - The ability to generate batches for bulk operations.</td>
</tr>
<tr>
<td>bundle</td>
<td>Bundle - Bundle configuration for T1/E1 Multilink Group and channel members, APS, Multichassis and Service interfaces.</td>
</tr>
<tr>
<td>cac</td>
<td>CAC - CAC configuration for Physical Links, Physical Port and other CAC related objects.</td>
</tr>
<tr>
<td>calltrace.WebDAVSharedData</td>
<td>calltrace.WebDAVSharedData - Ability to restrict access to call traces via the WebDAV protocol.</td>
</tr>
<tr>
<td>ccag</td>
<td>CCAG - Cross-Connect Aggregation Group (CCAG) MDA card and forwarding path configuration.</td>
</tr>
<tr>
<td>cflowd</td>
<td>Cflowd - CFLOWD Objects.</td>
</tr>
<tr>
<td>cflowd.NeCflowd</td>
<td>Cflowd Configuration - Ability to configure cflowd params for SR.</td>
</tr>
<tr>
<td>cflowd.NeCollector</td>
<td>Cflowd Collector Configuration - Ability to configure collector for cflowd params for SR.</td>
</tr>
<tr>
<td>clear</td>
<td>Clear - Clear application commands and requests.</td>
</tr>
<tr>
<td>cli</td>
<td>CLI - Ability to connect to open NE sessions from the NFM-P.</td>
</tr>
<tr>
<td>cli.SSH</td>
<td>SSH Session - Ability to open an SSH Telnet session to the node from the NFM-P.</td>
</tr>
<tr>
<td>cli.Telnet</td>
<td>Telnet Session - Ability to open a Telnet session to the node from the NFM-P.</td>
</tr>
<tr>
<td>connprof</td>
<td>Connection Profile - Connection Profile configuration.</td>
</tr>
<tr>
<td>cpipe</td>
<td>CPipe - Access to this package is for configuring CES Interface Specifics for Cpipe specific SAPs.</td>
</tr>
<tr>
<td>cpipe.Cpipe</td>
<td>Cpipe Service - Access to VLL Circuit Emulation Pipe (Cpipe) Service objects themselves.</td>
</tr>
<tr>
<td>cpipe.Site</td>
<td>Cpipe Site - Access to Cpipe Sites.</td>
</tr>
<tr>
<td>crdtctrl</td>
<td>Credit Control - Credit Control configuration.</td>
</tr>
<tr>
<td>customproperties</td>
<td>Custom Properties - Custom properties configuration.</td>
</tr>
<tr>
<td>db</td>
<td>Database - Configuration for Size constraint policies and Database file policies.</td>
</tr>
<tr>
<td>db.AuxiliaryDbBackup.method_AuxDbBackup</td>
<td>Auxiliary Database Backup - method_AuxDbBackup - Ability to perform a auxiliary database backup.</td>
</tr>
<tr>
<td>db.DatabaseManager.method_backup</td>
<td>Database Manager - method_backup - Ability to perform a database backup.</td>
</tr>
<tr>
<td>db.DatabaseManager.method_reinstantiateStandby</td>
<td>Database Manager - method_reinstantiateStandby - Ability to reinstantiate the standby database.</td>
</tr>
</tbody>
</table>
### Table A-4  Permissions assigned to NFM-P scope of command roles  (continued)

<table>
<thead>
<tr>
<th>Package.Class.Method/Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>db.DatabaseManager.method_switchover</td>
<td>Database Manager - method_switchover - Ability to perform a database switchover.</td>
</tr>
<tr>
<td>dctr</td>
<td>Data Center - Data Center information and configurations.</td>
</tr>
<tr>
<td>dctr.PortProfile</td>
<td>Port Profile - Configuration of Port Profile.</td>
</tr>
<tr>
<td>dctr.VlanRange</td>
<td>VLAN Range - Configuration of Vlan Entry.</td>
</tr>
<tr>
<td>dctr.VplsVirtualSite</td>
<td>Virtual Site VPLS - Access to VPLS eVPN-Sites on a VPLS Service.</td>
</tr>
<tr>
<td>dctr.VprnVirtualSite</td>
<td>Virtual Site VPRN - Access to VPLS eVPN-Sites on a VPLS Service.</td>
</tr>
<tr>
<td>diameter</td>
<td>Diameter - Access to this package is for configuring Diameter related configurations, e.g. Diameter Policy.</td>
</tr>
<tr>
<td>dns</td>
<td>Domain Name System - Domain Name System.</td>
</tr>
<tr>
<td>dynsvc</td>
<td>Dynamic Services - Dynamic Services Configuration.</td>
</tr>
<tr>
<td>entity</td>
<td>Physical Entity Management.</td>
</tr>
<tr>
<td>epipe</td>
<td>EPipe - Access to this package is for configuring CES Interface Specifics and FR Interface Specifics for Epipes specific SAPs.</td>
</tr>
<tr>
<td>epipe.Epipe</td>
<td>Epipe Service - Access to VLL Ethernet Pipe (Epipe) Service objects themselves.</td>
</tr>
<tr>
<td>epipe.PbbMacName</td>
<td>PBB MAC Name - Ability to configure the MAC Name Address for a Network Element.</td>
</tr>
<tr>
<td>epipe.Site</td>
<td>Epipe Site - Access to Epipes Sites.</td>
</tr>
<tr>
<td>equipment</td>
<td>Physical Equipment - General equipment configuration.</td>
</tr>
<tr>
<td>equipment.PortPolicy</td>
<td>Port Policy - Access to Port Policy for 7750 nodes.</td>
</tr>
<tr>
<td>equipment.Shelf.method_rebootUpgrade</td>
<td>Shelf - method_rebootUpgrade - Ability to perform node reboot upgrade.</td>
</tr>
<tr>
<td>ethernetequipment</td>
<td>Ethernet Equipment - Ethernet Equipment configuration.</td>
</tr>
<tr>
<td>ethernetoam</td>
<td>Ethernet OAM - Maintenance Domains and Maintenance Entity Groups, autogeneration of the MEPs on each SAP or Binding in a Service.</td>
</tr>
<tr>
<td>ethernetoam.CcmTest</td>
<td>CFM Continuity Check - Access to Continuity Check tests, Continuity Check test definitions, and Continuity Check deployed tests.</td>
</tr>
<tr>
<td>ethernetoam.CcTest</td>
<td>Global Maintenance Entity Group - Access to Continuity Check tests, Continuity Check test definitions, and Continuity Check deployed tests.</td>
</tr>
<tr>
<td>ethernetoam.CfmDmmBin</td>
<td>CFM DMM Session Bin - Access to CFM DMM Test Session, CFM DMM Test Session definitions.</td>
</tr>
<tr>
<td>Package.Class.Method/Property</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------------</td>
<td>-------------</td>
</tr>
<tr>
<td>ethernetoam.CfmDmmSession</td>
<td>CFM DMM Test Session - Access to CFM DMM Test Session, CFM DMM Test Session definitions.</td>
</tr>
<tr>
<td>ethernetoam.CfmLinkTrace</td>
<td>CFM Link Trace - Access to Link Trace tests, Link Trace test definitions, and Link Trace deployed tests.</td>
</tr>
<tr>
<td>ethernetoam.CfmLmmSession</td>
<td>CFM LMM Test Session - Access to CFM LMM Test Session, CFM LMM Test Session definitions.</td>
</tr>
<tr>
<td>ethernetoam.CfmLMTest</td>
<td>CFM LM Test - Access to CFM LM tests, CFM LM test definitions, and CFM LM deployed tests.</td>
</tr>
<tr>
<td>ethernetoam.CfmLoopback</td>
<td>CFM Loopback - Access to CFM Loopback tests, CFM Loopback test definitions, and CFM Loopback deployed tests.</td>
</tr>
<tr>
<td>ethernetoam.CfmOneWayDelayTest</td>
<td>CFM One Way Delay Test - Access to CFM One Way Delay tests, CFM One Way Delay test definitions, and CFM One Way Delay deployed tests.</td>
</tr>
<tr>
<td>ethernetoam.CfmOneWaySlm</td>
<td>CFM One Way SLM Test - Access to CFM One Way SLM tests, CFM One Way SLM test definitions, and CFM One Way SLM deployed tests.</td>
</tr>
<tr>
<td>ethernetoam.CfmSlmSession</td>
<td>CFM SLM Test Session - Access to CFM SLM Test Session, CFM SLM Test Session definitions.</td>
</tr>
<tr>
<td>ethernetoam.CfmTwoWaySlm</td>
<td>CFM Two Way SLM Test - Access to CFM Two Way SLM tests, CFM Two Way SLM test definitions, and CFM Two Way SLM deployed tests.</td>
</tr>
<tr>
<td>ethernetoam.EthSession</td>
<td>Ethernet Test Session - Access to Ethernet Test Session, Ethernet Test Session definitions.</td>
</tr>
<tr>
<td>ethertunnel</td>
<td>Ethernet Tunnel - Ethernet Tunnel configuration.</td>
</tr>
<tr>
<td>ethring</td>
<td>Ethernet Ring - Ethernet Ring Configuration.</td>
</tr>
<tr>
<td>event</td>
<td>events - Parent package for all event classes.</td>
</tr>
<tr>
<td>file</td>
<td>File Policy - File creation on the NE for events and accounting.</td>
</tr>
<tr>
<td>filter</td>
<td>Filter - Public search filters.</td>
</tr>
<tr>
<td>filterprefixlist</td>
<td>Filter Policy - Filter PrefixList and PortList Policies.</td>
</tr>
<tr>
<td>firewall</td>
<td>Firewall - All Firewall configurations.</td>
</tr>
</tbody>
</table>
### Table A-4  Permissions assigned to NFM-P scope of command roles  (continued)

<table>
<thead>
<tr>
<th>Package.Class.Method/Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>fm</td>
<td>Fault Management - Alarm policies, Severity change thresholds, Alarms, Notes, and History.</td>
</tr>
<tr>
<td>fm.AlarmHistoryDatabase.method_purge</td>
<td>Alarm History Database - method_purge - Ability to purge the alarm history database.</td>
</tr>
<tr>
<td>fm.FaultManager</td>
<td>Fault Manager - Access to assign OLC state, alter severity, clear, acknowledge, and remove faults.</td>
</tr>
<tr>
<td>fm.FaultManager.method_editNote</td>
<td>Fault Manager - method_editNote - Ability to edit an alarm note.</td>
</tr>
<tr>
<td>fm.SpecificPolicy</td>
<td>Specific Alarm Policy - Access to configure specific alarm policies.</td>
</tr>
<tr>
<td>fpipe</td>
<td>FPipe - All contained objects are listed. Package access is not currently used.</td>
</tr>
<tr>
<td>fpipe.Fpipe</td>
<td>Fpipe Service - Access to Frame Relay Pipe (Fpipe) Service objects themselves.</td>
</tr>
<tr>
<td>fpipe.Site</td>
<td>Fpipe Site - Access to Fpipe Sites.</td>
</tr>
<tr>
<td>fr</td>
<td>Frame Relay - Frame Relay configuration for Service interfaces and routers.</td>
</tr>
<tr>
<td>generic</td>
<td>Generic - Generic configuration for NFM-P objects, deployment, and administrative state changes for DHCP and Multichassis objects, Maintenance Association End Points (MEP), and SRRP instances.</td>
</tr>
<tr>
<td>genericlog</td>
<td>Log Viewer - Display logs in Log Viewer.</td>
</tr>
<tr>
<td>genericne</td>
<td>Generic NE - Generic NE Interface and Profile configuration.</td>
</tr>
<tr>
<td>genericne.GenericNeProfileManager.method_checkFileContent</td>
<td>Generic NE Profiles - method_checkFileContent - Checks the descriptor installation package content for validity.</td>
</tr>
<tr>
<td>genericne.GenericNeProfileManager.method_installFile</td>
<td>Generic NE Profiles - method_installFile - Ability to install a descriptor driver.</td>
</tr>
<tr>
<td>gmpls</td>
<td>ASON Domain Management - GMPLS Management.</td>
</tr>
<tr>
<td>gmplsWithuni</td>
<td>GMPLS-UNI - GMPLS-UNI Configuration.</td>
</tr>
<tr>
<td>gsmp</td>
<td>GSMP - General Switch Management Protocol (GSMP) configuration for VPLS, MVPLS and VPRN routing instances.</td>
</tr>
<tr>
<td>hip</td>
<td>Horizontal Integration Protocol - Access to HIP managed Element Managers and subtending nodes.</td>
</tr>
<tr>
<td>hip.EMServer</td>
<td>Element Manager - Access to HIP managed Element Managers.</td>
</tr>
<tr>
<td>histcorr</td>
<td>Historical Correlation - Historical Correlation configuration.</td>
</tr>
</tbody>
</table>
### Table A-4 Permissions assigned to NFM-P scope of command roles (continued)

<table>
<thead>
<tr>
<th>Package.Class.Method/Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>hpipe</td>
<td>HPipe - All contained objects are listed. Package access is not currently used.</td>
</tr>
<tr>
<td>hpipe.Hpipe</td>
<td>Hpipe Service - Access to HPipe (Hpipe) Service objects themselves.</td>
</tr>
<tr>
<td>hpipe.Site</td>
<td>Hpipe Site - Access to Hpipe Sites.</td>
</tr>
<tr>
<td>icmp</td>
<td>ICMP - Internet Control Message Protocol (ICMP) and Domain Name System (DNS) test results.</td>
</tr>
<tr>
<td>icmp.DnsPing</td>
<td>DNS Ping - Access to DNS Ping tests, DNS Ping test definitions, and DNS Ping deployed tests.</td>
</tr>
<tr>
<td>icmp.IcmpPing</td>
<td>ICMP Ping - Access to ICMP Ping tests, ICMP Ping test definitions, and ICMP Ping deployed tests.</td>
</tr>
<tr>
<td>icmp.IcmpTrace</td>
<td>ICMP Trace - Access to ICMP Trace tests, ICMP Trace test definitions, and ICMP Trace deployed tests.</td>
</tr>
<tr>
<td>ies</td>
<td>IES - Access to this package is for configuring Group Interfaces, SAPs, MSAPs, IGMP Host Tracking on Sites and SAPs, and FR Interface Specifics for IES specific SAPs.</td>
</tr>
<tr>
<td>ies.AaInterface</td>
<td>IES AA Interface - Access to IES AA Interfaces.</td>
</tr>
<tr>
<td>ies.Ies</td>
<td>IES Service - Access to Internet Enhanced Service (IES) Service objects themselves.</td>
</tr>
<tr>
<td>ies.Site</td>
<td>IES Site - Access to IES Sites.</td>
</tr>
<tr>
<td>ies.SubscriberInterface</td>
<td>IES Subscriber Interface - Access to IES Subscriber Interfaces.</td>
</tr>
<tr>
<td>igh</td>
<td>IGH - Interface-Group-Handlers.</td>
</tr>
<tr>
<td>igmp</td>
<td>IGMP - Internet Group Management Protocol (IGMP) configuration for Service interfaces and routers.</td>
</tr>
<tr>
<td>igmp.Site</td>
<td>IGMP Site - Access to IGMP Sites.</td>
</tr>
<tr>
<td>impact.FullReset</td>
<td>Full Reset - Ability to configure objects which will result in a full reset of the node. Currently applies to 9412 node.</td>
</tr>
<tr>
<td>impact.PartialReset</td>
<td>Partial Reset - Ability to configure objects which will result in a partial reset of impacted SW/HW unit. Currently applies to 9412 node.</td>
</tr>
<tr>
<td>ipdr</td>
<td>IPDR File Transfer Policies - IPDR file transfer policies.</td>
</tr>
<tr>
<td>ipfix</td>
<td>IPFIX - IPFIX Policy.</td>
</tr>
<tr>
<td>ipipe</td>
<td>IPipe - Access to this package is for configuring IPCP on L2 Access Interfaces and FR Interface Specifics for Ipipe specific SAPs.</td>
</tr>
<tr>
<td>ipipe.Ipipe</td>
<td>Ipipe Service - Access to IP Interworking Pipe (Ipipe) Service objects themselves.</td>
</tr>
<tr>
<td>ipipe.Site</td>
<td>Ipipe Site - Access to Ipipe Sites.</td>
</tr>
</tbody>
</table>
### Table A-4 Permissions assigned to NFM-P scope of command roles  (continued)

<table>
<thead>
<tr>
<th>Package.Class.Method/Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>isa</td>
<td>ISA - ISA-IPsec, ISA-MG, and ISA-AA configuration on a MDA card for IP Security, LTE, and Application Assurance.</td>
</tr>
<tr>
<td>isa.IPSecMgIsaGroup</td>
<td>ISA IPSMG Group - Configuration of IPSec ISA-MG Group.</td>
</tr>
<tr>
<td>isa.IPSecMgIsaGroupMdaAssociation</td>
<td>ISA-IPSMG Group MDA Association - Configuration of ISA-IPSMG Group MDA Association.</td>
</tr>
<tr>
<td>isa.MgGroupMember</td>
<td>ISA-MG Group Member - Configuration of ISA-MG Group Member.</td>
</tr>
<tr>
<td>isis</td>
<td>Routing Management: ISIS - IS-IS configuration for Service interfaces and routers, Area, Adjacency, Neighbors, Policies and other IS-IS related objects.</td>
</tr>
<tr>
<td>l2fib</td>
<td>L2 FIB - Layer 2 Forwarding Information Base (FIB) configuration for Multicast and Non-Multicast.</td>
</tr>
<tr>
<td>l2fwd</td>
<td>L2 Forwarding - All Layer 2 Forwarding configuration for Service interfaces and routers, circuits, ports, Spanning Tree, Registration, FIB, Mac Protection, IGMP Snooping, etc.</td>
</tr>
<tr>
<td>l2tp</td>
<td>L2TP - L2TP configuration for Service interfaces and routers, Groups, Tunnels, PeersRPs, and other L2TP related objects.</td>
</tr>
<tr>
<td>l3fwd</td>
<td>L3 Forwarding - All Layer 3 Forwarding configuration for Service interfaces and routers, Import and Export policies, Dot1p and DSCP for VPRNs.</td>
</tr>
<tr>
<td>lag</td>
<td>LAG - Link Aggregation Group (LAG) configuration for Service interfaces and routers.</td>
</tr>
<tr>
<td>layer2</td>
<td>Layer 2 - All Layer 2 configuration: Bridges, Transparent LAN Service (TLS), and VLAN interfaces.</td>
</tr>
<tr>
<td>lldp</td>
<td>LLDP - Link Layer Discovery Protocol (LLDP) configuration on equipment. PhysicalPort.</td>
</tr>
<tr>
<td>lmg</td>
<td>LMG - All LMG configurations and status.</td>
</tr>
<tr>
<td>lmgperf</td>
<td>LMG Performance Management - All LMG configurations.</td>
</tr>
<tr>
<td>lmp</td>
<td>LMP - LMP Configuration for Sites.</td>
</tr>
<tr>
<td>localuserdb</td>
<td>Local User DB - DHCP or PPPoE configuration for Local User Databases on a router.</td>
</tr>
<tr>
<td>log</td>
<td>Statistics - Parent package for all statistics classes.</td>
</tr>
<tr>
<td>log.LogToFileManager.property_jmsRetries</td>
<td>Log To File Manager - property_jmsRetries - LogToFile preferences can only be modified by a user with an administrator role.</td>
</tr>
</tbody>
</table>
Table A-4  Permissions assigned to NFM-P scope of command roles  (continued)

<table>
<thead>
<tr>
<th>Package.Class.Method/Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>log.LogToFileManager.property_retention</td>
<td>Log To File Manager - property_retention - LogToFile preferences can only be modified by a user with an administrator role.</td>
</tr>
<tr>
<td>log.LogToFileManager.property_rollover</td>
<td>Log To File Manager - property_rollover - LogToFile preferences can only be modified by a user with an administrator role.</td>
</tr>
<tr>
<td>log.LogToFileManager.property_storeAccountingStatsInDB</td>
<td>Log To File Manager - property_storeAccountingStatsInDB - LogToFile preferences can only be modified by a user with an administrator role.</td>
</tr>
<tr>
<td>log.LogToFileManager.property_storePerformanceStatsInDB</td>
<td>Log To File Manager - property_storePerformanceStatsInDB - LogToFile preferences can only be modified by a user with an administrator role.</td>
</tr>
<tr>
<td>lps</td>
<td>LPS - Learned Port Security (LPS) configuration for layer2.Bridge and MAC Entries for ports.</td>
</tr>
<tr>
<td>lte</td>
<td>LTE - All LTE configurations and status.</td>
</tr>
<tr>
<td>lte.ApnFqdnIpEntry</td>
<td>FQDN IP Entry - Configuration of FqdnGroup IP Entry.</td>
</tr>
<tr>
<td>lte.ApnTaiLaiList</td>
<td>TAI-LAI List Binding - Configuration of TAI-LAI List Binding.</td>
</tr>
<tr>
<td>lte.CreditPoolProfile</td>
<td>Credit Pool Profile - Credit Pool Profile.</td>
</tr>
<tr>
<td>lte.DccaApServiceType</td>
<td>DCCA Assume Positive Service type - Configuration of DCCA Assume Positive Service type.</td>
</tr>
<tr>
<td>lte.DccaProfile</td>
<td>DCCA Profile - Configuration of DCCA Profile.</td>
</tr>
<tr>
<td>lte.DiameterPeerProfile</td>
<td>Diameter Peer Profile - Configuration of Diameter Peer Profile.</td>
</tr>
<tr>
<td>lte.DiameterProfile</td>
<td>Diameter Profile - Configuration of Diameter Profile.</td>
</tr>
<tr>
<td>lte.DiameterRateLimitProfile</td>
<td>Diameter Rate Limit Profile - Configuration of Diameter Rate Limit Profile.</td>
</tr>
<tr>
<td>lte.DiscoveryLog</td>
<td>Drill Down Log - Creation of Drill Down Log.</td>
</tr>
<tr>
<td>lte.DupRadiusAccServerGroup</td>
<td>Duplicate Accounting RADIUS Server Group - Configuration of Serving Gateway APN.</td>
</tr>
</tbody>
</table>
Table A-4 Permissions assigned to NFM-P scope of command roles  (continued)

<table>
<thead>
<tr>
<th>Package.Class.Method/Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>lte.ENBEquipment.method_execPing</td>
<td>ENB Equipment - method_execPing - Ability to run a ping test from the eNodeB.</td>
</tr>
<tr>
<td>lte.ENBEquipment.method_execTraceroute</td>
<td>ENB Equipment - method_execTraceroute - Ability to run a traceroute test from the eNodeB.</td>
</tr>
<tr>
<td>lte.ENBEquipment.method_getLongActions</td>
<td>ENB Equipment - method_getLongActions - Ability to list the last ten long actions on the eNodeB.</td>
</tr>
<tr>
<td>lte.ENBEquipment.method_getPingResult</td>
<td>ENB Equipment - method_getPingResult - Ability to get the result of a ping test on the eNodeB.</td>
</tr>
<tr>
<td>lte.ENBEquipment.method_getTracerouteResult</td>
<td>ENB Equipment - method_getTracerouteResult - Ability to get the result of a traceroute test on the eNodeB.</td>
</tr>
<tr>
<td>lte.ENBEquipment.method_launchNEM</td>
<td>ENB Equipment - method_launchNEM - Ability to launch NEM.</td>
</tr>
<tr>
<td>lte.ENBEquipment.method_startLoopbackServer</td>
<td>ENB Equipment - method_startLoopbackServer - Ability to start a loopback server on the eNodeB.</td>
</tr>
<tr>
<td>lte.EPSPathDiscoveredLinkComponent</td>
<td>EPS Path Discovery Link Component - Configuration of EPS Path Discovery Link Component.</td>
</tr>
<tr>
<td>lte.EPSPathDiscoveryHint</td>
<td>EPS Path Drill Down Hint - Configuration of EPS Path Drill Down Hint.</td>
</tr>
<tr>
<td>lte.EPSPathDiscoveryProfile</td>
<td>Path Drill Down Profile - Configuration of Path Drill Down Profile.</td>
</tr>
<tr>
<td>lte.EPSPathInterfaceComponent</td>
<td>EPS Path Interface Component - Configuration of EPS Path Interface Component.</td>
</tr>
<tr>
<td>lte.EPSPathLinkComponent</td>
<td>EPS Path Link Component - Configuration of EPS Path Link Component.</td>
</tr>
<tr>
<td>lte.EPSPathSapComponent</td>
<td>EPS SAP Component - Configuration of EPS SAP Component.</td>
</tr>
<tr>
<td>lte.EPSPathSegment</td>
<td>EPS Path Segment - Configuration of EPS Path Segment.</td>
</tr>
<tr>
<td>lte.EPSPathServiceComponent</td>
<td>EPS Path Service Component - Configuration of EPS Path Service Component.</td>
</tr>
<tr>
<td>lte.EPSPathSiteComponent</td>
<td>EPS Path Site Component - Configuration of EPS Path Site Component.</td>
</tr>
<tr>
<td>lte.FqdnGroupProfile</td>
<td>FQDN Group Profile - Configuration of FQDN Group Profile.</td>
</tr>
<tr>
<td>lte.FqdnNameEntry</td>
<td>FQDN Name Entry - Configuration of FQDN Name Entry.</td>
</tr>
<tr>
<td>lte.GbrQciPolicing</td>
<td>GBR Policing - Disable GBR Policing Qci.</td>
</tr>
<tr>
<td>lte.GtpLoadControl</td>
<td>GTP Load Control - Configuration of GTP Load Control.</td>
</tr>
<tr>
<td>lte.GtpOverloadControl</td>
<td>GTP Overload Control - Configuration of GTP Overload Control.</td>
</tr>
<tr>
<td>lte.GtpPrimaryServerListEntry</td>
<td>GTP Primary Server List Entry - Configuration of GTP Primary Server List Entry.</td>
</tr>
<tr>
<td>lte.GtpPrimeServerGroupProfile</td>
<td>GTP Prime Server Group Profile - Configuration of GTP Prime Server Group Profile.</td>
</tr>
<tr>
<td>lte.GtpProfile</td>
<td>GTP Profile - Configuration of GTP Profile.</td>
</tr>
<tr>
<td>lte.GxProfile</td>
<td>Gx Profile - Configuration of Gx Profile.</td>
</tr>
</tbody>
</table>
### Table A-4 Permissions assigned to NFM-P scope of command roles (continued)

<table>
<thead>
<tr>
<th>Package.Class.Method/Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>lte.GxProfileMessageEntry</td>
<td>Gx Message Entry - Configuration of Gx Message Entry.</td>
</tr>
<tr>
<td>lte.GxProfileResultCodeEntry</td>
<td>Gx Result Code Entry - Configuration of Gx Result Code Entry.</td>
</tr>
<tr>
<td>lte.IpPool</td>
<td>IP Address Pool - Configuration of IP Address Pool.</td>
</tr>
<tr>
<td>lte.IpPoolBinding</td>
<td>IP Address Pool Binding - Configuration of IP Address Pool Binding.</td>
</tr>
<tr>
<td>lte.IpPoolEntry</td>
<td>IP Address Pool Entry - Configuration of IP Address Pool Entry.</td>
</tr>
<tr>
<td>lte.LoopbackServer</td>
<td>ENodeB Loopback Server - Ability to start a loopback server on the eNodeB.</td>
</tr>
<tr>
<td>lte.LTEEquipment.methodLaunchQoSAnalyzer</td>
<td>lte.LTEEquipment - method_launchQoSAnalyzer - Ability to launch LTE QoS Analyzer.</td>
</tr>
<tr>
<td>lte.LTEGlobalCfg</td>
<td>LTE Global Config - Configuration of LTE System Parameters.</td>
</tr>
<tr>
<td>lte.MobileNodeRegion</td>
<td>Mobile Node Region/Public Land Mobile Network (PLMN) - Configuration of Mobile Node Region.</td>
</tr>
<tr>
<td>lte.NETCELinkState</td>
<td>TCE Assignment Status of eNodeB - TCE Assignment Status of eNodeB.</td>
</tr>
<tr>
<td>lte.PcmdProfile</td>
<td>PCMD Profile - Configuration of PCMD Profile.</td>
</tr>
<tr>
<td>lte.PdnApn</td>
<td>PDN APN - Configuration of PDN APN.</td>
</tr>
<tr>
<td>lte.PDNServer</td>
<td>PDN Gateway - Configuration of PDN Gateway.</td>
</tr>
<tr>
<td>lte.PdnGxReferencePoint</td>
<td>PDN Gx Reference Point - Configuration of Pdn Gx Reference Point.</td>
</tr>
<tr>
<td>lte.PdnRfReferencePoint</td>
<td>PDN Rf Reference Point - Configuration of PGW Rf Reference Point.</td>
</tr>
<tr>
<td>lte.PdnS5ReferencePoint</td>
<td>PDN S5 Reference Point - Configuration of PGW S5 Reference Point.</td>
</tr>
<tr>
<td>lte.PdnS8ReferencePoint</td>
<td>PDN S8 Reference Point - Configuration of PGW S8 Reference Point.</td>
</tr>
<tr>
<td>lte.PdnSignalling</td>
<td>PGW Signalling - Configuration of PGW Signalling.</td>
</tr>
<tr>
<td>lte.PgwChargingProfile</td>
<td>PGW Charging Profile - Configuration of PGW Charging Profile.</td>
</tr>
<tr>
<td>lte.Ping</td>
<td>ENodeB Ping - Ability to run a ping test from the eNodeB.</td>
</tr>
<tr>
<td>lte.PlmnListPolicy</td>
<td>PLMN List Profile - Configuration of PLMN List Profile.</td>
</tr>
<tr>
<td>lte.QciPolicy</td>
<td>QCI Policy - Configuration of QCI Policy.</td>
</tr>
<tr>
<td>lte.RTCountersENBStatus</td>
<td>Real Time Counters Status for ENB - Real Time Counters Session.</td>
</tr>
<tr>
<td>lte.RTCountersSession</td>
<td>Real Time Counters Session - Real Time Counters Session.</td>
</tr>
<tr>
<td>lte.S1ReferencePoint</td>
<td>S11 Reference Point - Configuration of S11 Reference Point.</td>
</tr>
<tr>
<td>lte.S1uReferencePoint</td>
<td>S1-u Reference Point - Configuration of S1u Reference Point.</td>
</tr>
<tr>
<td>Package, Class, Method/Property</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------------------</td>
<td>-------------</td>
</tr>
<tr>
<td>lte.ServingGateway</td>
<td>Serving Gateway - Configuration of Serving Gateway.</td>
</tr>
<tr>
<td>lte.SgwApn</td>
<td>Serving Gateway APN - Configuration of Serving Gateway APN.</td>
</tr>
<tr>
<td>lte.SgwChargingProfile</td>
<td>SGW Charging Profile - Configuration of SGW Charging Profile.</td>
</tr>
<tr>
<td>lte.SgwRfReferencePoint</td>
<td>SGW Rf Reference Point - Configuration of SGW Rf Reference Point.</td>
</tr>
<tr>
<td>lte.SgwS5ReferencePoint</td>
<td>SGW S5 Reference Point - Configuration of SGW S5 Reference Point.</td>
</tr>
<tr>
<td>lte.SgwS8ReferencePoint</td>
<td>SGW S8 Reference Point - Configuration of SGW S8 Reference Point.</td>
</tr>
<tr>
<td>lte.SteeringEntry</td>
<td>Steering Entry - Configuration of Steering Entry.</td>
</tr>
<tr>
<td>lte.SubscAndEquipmentTraces</td>
<td>Subsc And Equipment Traces - Configuration of Call Traces.</td>
</tr>
<tr>
<td>lte.TaiLaiListEntry</td>
<td>TAI-LAI List Entry - Configuration of TAI-LAI Entry.</td>
</tr>
<tr>
<td>lte.TaiLaiListProfile</td>
<td>TAI-LAI List Profile - Configuration of TAI-LAI List Profile.</td>
</tr>
<tr>
<td>lte.Traceroute</td>
<td>ENodeB Traceroute - Ability to run a traceroute test from the eNodeB.</td>
</tr>
<tr>
<td>lte.TrustedPeerListEntryUnlisted</td>
<td>Unlisted Peer - Configuration of Unlisted Trusted Peer List Entries.</td>
</tr>
<tr>
<td>lte.TrustedPeerListPolicy</td>
<td>Trusted Peer List Policy - Configuration of Trusted Peer List Policy.</td>
</tr>
<tr>
<td>lte.anr</td>
<td>LTE - Access to LTE ANR profiles.</td>
</tr>
<tr>
<td>lte.epdg</td>
<td>LTE - All LTE configurations and status.</td>
</tr>
<tr>
<td>lte.epdg.EpdgChargingProfile</td>
<td>EPDG Charging Profile - Configuration of EPDG Charging Profile.</td>
</tr>
<tr>
<td>lte.epdg.IPsecProfile</td>
<td>IPSec Profile - Configuration of IPSec Profile.</td>
</tr>
<tr>
<td>lte.epdg.SwmAvpOptionProfile</td>
<td>SWm AVP Option Profile - Configuration of SWm AVP Option Profile.</td>
</tr>
<tr>
<td>lte.epdg.SwmReferencePoint</td>
<td>SWm Reference Point - Configuration of SWm Reference Point.</td>
</tr>
<tr>
<td>lte.epdg.SwuReferencePoint</td>
<td>SWu Reference Point - Configuration of SWu Reference Point.</td>
</tr>
<tr>
<td>lte.ggsn</td>
<td>LTE - All LTE configurations and status.</td>
</tr>
<tr>
<td>lte.ggsn.CdrAvpOptionProfile</td>
<td>CDR AVP Option Profile - Configuration of CDR AVP Option Profile.</td>
</tr>
<tr>
<td>lte.ggsn.GyAvpOptionProfile</td>
<td>Gy AVP Option Profile - Configuration of Gy AVP Option Profile.</td>
</tr>
<tr>
<td>lte.ggsn.PdnGyReferencePoint</td>
<td>Gy Reference Point - Configuration of Gy Reference Point.</td>
</tr>
<tr>
<td>lte.ggsn.PgwGaReferencePoint</td>
<td>PGW Ga Reference Point - Configuration of PGW Ga Reference Point.</td>
</tr>
<tr>
<td>lte.ggsn.SgwGaReferencePoint</td>
<td>SGW Ga Reference Point - Configuration of SGW Ga Reference Point.</td>
</tr>
</tbody>
</table>
### Table A-4  Permissions assigned to NFM-P scope of command roles  (continued)

<table>
<thead>
<tr>
<th>Package.Class.Method/Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ltegw</td>
<td>LTE - All LTE configurations and status.</td>
</tr>
<tr>
<td>ltegw.ApnListPolicy</td>
<td>APN List Profile - Configuration of APN List Profile.</td>
</tr>
<tr>
<td>ltegw.DiameterPeerRedirHostEntry</td>
<td>Diameter Peer Redirect Host Entry - Configuration of Diameter Peer Redirect Host Entry.</td>
</tr>
<tr>
<td>ltegw.PcscfGroupProfile</td>
<td>P-CSCF Group Profile - Configuration of P-CSCF Group Profile.</td>
</tr>
<tr>
<td>ltegw.PcscfPeerEntry</td>
<td>P-CSCF Peer Entry - Configuration of P-CSCF Peer Entry.</td>
</tr>
<tr>
<td>ltegw.PcscfResolvedPeerIPEntry</td>
<td>P-CSCF Resolved Peer Ip Entry - Configuration of P-CSCF Peer Entry.</td>
</tr>
<tr>
<td>ltegw.SCTPProfile</td>
<td>SCTP Profile - Configuration of SCTP Profile.</td>
</tr>
<tr>
<td>ltegw.UMTSQoSPolicy</td>
<td>UMTS QoS Policy - Configuration of UMTS QoS Policy.</td>
</tr>
<tr>
<td>ltehomeagent</td>
<td>LTE - All LTE configurations and status.</td>
</tr>
<tr>
<td>ltehomeagent.DNSRedirectServer</td>
<td>DNS Redirect Server - Configuration of DNS Redirect Server.</td>
</tr>
<tr>
<td>ltehomeagent.FAHAPeerList</td>
<td>FA-HA Peer List - Configuration of FA-HA Peer List.</td>
</tr>
<tr>
<td>ltehomeagent.MobileIpv4Profile</td>
<td>Mobile IPv4 Profile - Configuration of Mobile IPv4 Profile.</td>
</tr>
<tr>
<td>ltehomeagent.PiReferencePoint</td>
<td>Pi Reference Point - Configuration of Pi Reference Point.</td>
</tr>
<tr>
<td>ltei</td>
<td>LTE LI - All LTE LI configurations and status.</td>
</tr>
<tr>
<td>ltei.DFPeer</td>
<td>LTE LI Delivery Function Peer - Configuration of LTE LI Delivery Function Peer.</td>
</tr>
<tr>
<td>ltei.GxTarget</td>
<td>LTE LI Gx Target - Display of LTE LI GxTarget.</td>
</tr>
<tr>
<td>ltei.GxTargetChrgRule</td>
<td>LTE LI Gx Target Charging Rule - Display of LTE LI GxTarget Charging Rule.</td>
</tr>
<tr>
<td>ltei.InterceptionTarget</td>
<td>LTE LI Interception Target - Configuration of LTE LI Interception Target.</td>
</tr>
<tr>
<td>ltei.LILteCfg</td>
<td>LTE LI Pre Configuration - Contains system Lawful Intercept Configuration for MG.</td>
</tr>
<tr>
<td>itemme</td>
<td>LTE-2G3G - All LTE MME configurations.</td>
</tr>
<tr>
<td>itemme.MmeInstance.method_abortMmeLoadBalance</td>
<td>WMM Instance - method_abortMmeLoadBalance - Ability to abort MME load balancing operation.</td>
</tr>
<tr>
<td>itemme.MmeInstance.method_deployGcToNode</td>
<td>WMM Instance - method_deployGcToNode - Ability to deploy a GC to a node.</td>
</tr>
<tr>
<td>itemme.MmeInstance.method_intraMmeLoadBalance</td>
<td>WMM Instance - method_intraMmeLoadBalance - Ability to perform intra MME load balancing operation.</td>
</tr>
</tbody>
</table>
## Permissions assigned to NFM-P scope of command roles (continued)

<table>
<thead>
<tr>
<th>Package.Class.Method/Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Itemme.MmeInstance.method_lockMmeAggregateService</td>
<td>WMM Instance - method_lockMmeAggregateService - Ability to lock the MME aggregate service.</td>
</tr>
<tr>
<td>Itemme.MmeInstance.method_unlockMmeAggregateService</td>
<td>WMM Instance - method_unlockMmeAggregateService - Ability to unlock the MME aggregate service.</td>
</tr>
<tr>
<td>lteperf</td>
<td>LTE Performance Management - All LTE configurations : SGW, PGW, eNodeB.</td>
</tr>
<tr>
<td>ltepmip</td>
<td>LTE - All LTE configurations and status.</td>
</tr>
<tr>
<td>ltepmip.Pmipv6Profile</td>
<td>PMIPv6 Profile - Configuration of PMIPv6 Profile.</td>
</tr>
<tr>
<td>ltepmip.S2aReferencePoint</td>
<td>S2a Reference Point - Configuration of S2a Reference Point.</td>
</tr>
<tr>
<td>ltepmip.S2bReferencePoint</td>
<td>S2b Reference Point - Configuration of S2b Reference Point.</td>
</tr>
<tr>
<td>ltepmip.S6bAvpOptionProfile</td>
<td>S6b AVP Option Profile - Configuration of S6b AVP Option Profile.</td>
</tr>
<tr>
<td>ltepmip.S6bReferencePoint</td>
<td>S6b Reference Point - Configuration of S6b Reference Point.</td>
</tr>
<tr>
<td>ltepolicyoptions</td>
<td>LTE - All LTE configurations and status.</td>
</tr>
<tr>
<td>ltepolicyoptions.ActionRuleUnitProfile</td>
<td>Action Rule Unit Profile - Configuration of Action Rule Unit Profile.</td>
</tr>
<tr>
<td>ltepolicyoptions.AsoOptions</td>
<td>ASO Options Profile - Configuration of ASO Options Profile.</td>
</tr>
<tr>
<td>ltepolicyoptions.ChargingRuleUnit</td>
<td>Charging Rule Unit Profile - Configuration of ChargingRuleUnit Profile.</td>
</tr>
<tr>
<td>ltepolicyoptions.DhcpServerGroupProfile</td>
<td>DHCP Server Group Profile - Configuration of DHCP Server Group Profile.</td>
</tr>
<tr>
<td>ltepolicyoptions.DhcpSGPeerEntry</td>
<td>DHCP Peer Entry - Configuration of DHCP Peer Entry.</td>
</tr>
<tr>
<td>ltepolicyoptions.GxAvpOptionProfile</td>
<td>Gx AVP Option Profile - Configuration of Gx AVP Option Profile.</td>
</tr>
<tr>
<td>ltepolicyoptions.PolRuleUnitFlwDescription</td>
<td>Policy Rule Unit Flow Description Entry - Configuration of Flow Description Entry.</td>
</tr>
<tr>
<td>ltepolicyoptions.ServiceClassIndicator</td>
<td>Service Class Indicator - Configuration of ServiceClassIndicator Profile.</td>
</tr>
<tr>
<td>ltepolicyoptions.TrafficHashProfile</td>
<td>Traffic Hash Profile - Configuration of Traffic Hash Profile.</td>
</tr>
<tr>
<td>ltepolicyoptions.TrafficRedirectProfile</td>
<td>Traffic Redirect Profile - Configuration of Traffic Redirect Profile.</td>
</tr>
<tr>
<td>ltepolicyoptions.TrafficRedirectTarget</td>
<td>Traffic Redirect Target Entry - Configuration of Traffic Redirect Target Entry.</td>
</tr>
<tr>
<td>Package.Class.Method/Property</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------------</td>
<td>-------------</td>
</tr>
<tr>
<td>ltepool</td>
<td>LTE POOL - All LTE POOL configurations.</td>
</tr>
<tr>
<td>ltepool.MmeInstanceBinding</td>
<td>MME Instance Binding - Ability to configure associations between an MME Instance and an MME Pool.</td>
</tr>
<tr>
<td>ltepool.TaBinding</td>
<td>Tracking Area Binding - Ability to configure associations between a Tracking Area and an MME Pool.</td>
</tr>
<tr>
<td>Iteradius</td>
<td>LTE - All LTE configurations and status.</td>
</tr>
<tr>
<td>Iteradius.RadiusGroupProfile</td>
<td>RADIUS Group Profile - Configuration of Radius Group Profile.</td>
</tr>
<tr>
<td>Iteradius.RadiusPeerProfile</td>
<td>RADIUS Peer Profile - Configuration of RADIUS Peer Profile.</td>
</tr>
<tr>
<td>Iteradius.RadiusProfile</td>
<td>RADIUS Profile - Configuration of RADIUS Profile.</td>
</tr>
<tr>
<td>Ites1mme</td>
<td>LTES1MME - All LTE S1MME Configurations and Monitoring Status.</td>
</tr>
<tr>
<td>Itesas</td>
<td>GTP Ping - GTP Ping test results.</td>
</tr>
<tr>
<td>Itesas.GtpPing</td>
<td>GTP Ping - Access to GTP Ping tests, GTP Ping test definitions, and GTP Ping deployed tests.</td>
</tr>
<tr>
<td>Itesecurity</td>
<td>LTE Security - All LTE configurations : SGW, PGW, Bearers, and more.</td>
</tr>
<tr>
<td>Iteservice</td>
<td>LTE - All LTE configurations and status.</td>
</tr>
<tr>
<td>Itesgsn</td>
<td>LTE - All LTE configurations and status.</td>
</tr>
<tr>
<td>Itesgsn.SgwS4ReferencePoint</td>
<td>S4 Reference Point - Configuration of S4 Reference Point.</td>
</tr>
<tr>
<td>Itessg</td>
<td>LTE - All LTE SSG configurations and status.</td>
</tr>
<tr>
<td>Itessg.AddressListProfile</td>
<td>Address List Profile - Configuration of Address List Profile.</td>
</tr>
<tr>
<td>Itessg.SdReferencePoint</td>
<td>Sd Reference Point - Configuration of Sd Reference Point.</td>
</tr>
<tr>
<td>Itessg.SteeringProfile</td>
<td>Steering Profile - Configuration of Steering Profile.</td>
</tr>
<tr>
<td>Itessg.TdfChargingProfile</td>
<td>TDF Charging Profile - Configuration of TDF Charging Profile.</td>
</tr>
<tr>
<td>Itethreshold</td>
<td>LTE - All LTE configurations and status.</td>
</tr>
<tr>
<td>Itetwag</td>
<td>LTE - All LTE configurations and status.</td>
</tr>
<tr>
<td>Itetwag.DhcpServerProfile</td>
<td>DHCPv4 Server Profile - Configuration of DHCPv4 Server Profile.</td>
</tr>
<tr>
<td>Itetwag.SwwReferencePoint</td>
<td>Sww Reference Point - Configuration of Sww Reference Point.</td>
</tr>
<tr>
<td>Itetwag.SwwTunnelMapEntry</td>
<td>Sww Tunnel Map Entry - Configuration of Sww Tunnel Map Entry.</td>
</tr>
<tr>
<td>Itetwag.SwwTunnelProfile</td>
<td>Sww Tunnel Profile - Configuration of Sww Tunnel Profile.</td>
</tr>
<tr>
<td>Iteluserstats</td>
<td>LTE - All LTE configurations and status.</td>
</tr>
<tr>
<td>Iteluserstats.UserStatsQuery</td>
<td>User Stats Query - Configuration of User Stats Queries.</td>
</tr>
<tr>
<td>Package.Class.Method/Property</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>mirror</td>
<td>Mirror - All configurations for Service Mirroring.</td>
</tr>
<tr>
<td>mirror.Endpoint</td>
<td>Endpoint - Access to MIRROR Endpoints.</td>
</tr>
<tr>
<td>mirror.Mirror</td>
<td>Mirror Service - Access to Mirror Service objects themselves.</td>
</tr>
<tr>
<td>mirror.Site</td>
<td>Mirror Site - Access to Mirror Sites.</td>
</tr>
<tr>
<td>mld</td>
<td>MLD - Multicast Listener Discovery Protocol (MLD) configuration for a Service interfaces and routers.</td>
</tr>
<tr>
<td>mmepolicy</td>
<td>WMM Policies - Management of policies associated with 9471 WMM.</td>
</tr>
<tr>
<td>mmepolicy.MMEEmergencyNumListPolicy</td>
<td>WMM Emergency Number List - Configuration of Emergency Number List.</td>
</tr>
<tr>
<td>mmepolicy.MMEEmergencyNumListTblPolicy</td>
<td>WMM Emergency Number List Table - Configuration of Emergency Number List Table.</td>
</tr>
<tr>
<td>mmepolicy.MMEGTPProfile</td>
<td>WMM GTP Profile - Configuration of GTP Profile.</td>
</tr>
<tr>
<td>mmepolicy.MMESCTPProfile</td>
<td>WMM SCTP Profile - Configuration of SCTP Profile.</td>
</tr>
<tr>
<td>mmepolicy.WMMInterfaceProfile</td>
<td>WMM Interface Profile - Configuration of Interface Profile.</td>
</tr>
<tr>
<td>mmepolicy.WMMPfmJobSched</td>
<td>WMM Performance Measurement Job Schedules - Configuration of Performance Measurement Job Measurements.</td>
</tr>
<tr>
<td>mmepolicy.WMMPfmMeasGroupName</td>
<td>WMM Performance Measurement Group Name - Configuration of Performance Measurement Group Name.</td>
</tr>
<tr>
<td>mmepolicy.WMMSVCAgreementProfile</td>
<td>WMM UE PLMN and Served PLMN Service Agreement Profile - Configuration of UE PLMN and Served PLMN Service Agreement Profile.</td>
</tr>
<tr>
<td>monitor</td>
<td>Monitor - Subscriber Host monitoring and SAP monitoring.</td>
</tr>
<tr>
<td>monpath</td>
<td>Monitored Path - IP path monitoring and LSP monitoring.</td>
</tr>
<tr>
<td>mpls</td>
<td>Path/Routing Management: MPLS - Multiprotocol Label Switching (MPLS) configuration on a rtr.VirtualRouter, LSPs, Segments, Hops, Tunnels, CrossConnects, and other MPLS related objects.</td>
</tr>
</tbody>
</table>
Table A-4  Permissions assigned to NFM-P scope of command roles  (continued)

<table>
<thead>
<tr>
<th>Package.Class.Method/Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>mpls.LdpTreeTrace</td>
<td>LDP Tree Trace - Access to LDP Tree Trace tests, LDP Tree Trace test definitions, and LDP Tree Trace deployed tests.</td>
</tr>
<tr>
<td>mpls.LspPing</td>
<td>LSP Ping - Access to LSP Ping tests, LSP Ping test definitions, and LSP Ping deployed tests.</td>
</tr>
<tr>
<td>mpls.LspTrace</td>
<td>LSP Trace - Access to LSP Trace tests, LSP Trace test definitions, and LSP Trace deployed tests.</td>
</tr>
<tr>
<td>mpls.P2MPLspPing</td>
<td>P2MP LSP Ping - Access to P2MP LSP Ping tests, P2MP LSP Ping test definitions, and P2MP LSP Ping deployed tests.</td>
</tr>
<tr>
<td>mpls.P2MPLspTrace</td>
<td>P2MP LSP Trace - Access to P2MP LSP Trace tests, P2MP LSP Trace test definitions, and P2MP LSP Trace deployed tests.</td>
</tr>
<tr>
<td>mpls.LstP</td>
<td>MPLS TP - MPLS TP Configuration for Sites.</td>
</tr>
<tr>
<td>mpr</td>
<td>9500 MPR - 9500 Microwave Packet Radio (MPR) VLAN Paths and Hops.</td>
</tr>
<tr>
<td>mpr.Cpipe</td>
<td>9500 MPR Cpipe Service - Access to VLL Circuit Emulation Pipe (Cpipe) Service objects themselves.</td>
</tr>
<tr>
<td>mpr.Epipe</td>
<td>9500 MPR Epipe Service - Access to VLL Ethernet Pipe Service objects themselves.</td>
</tr>
<tr>
<td>mpr.Esite</td>
<td>9500 MPR Epipe Site - Access to the service instance objects.</td>
</tr>
<tr>
<td>mpr.Site</td>
<td>9500 MPR Cpipe Site - Access to the service instance objects.</td>
</tr>
<tr>
<td>msappolicy</td>
<td>MSAP Policy - MSAP policy configuration.</td>
</tr>
<tr>
<td>msdp</td>
<td>MSDP - Multicast Source Discovery Protocol (MSDP) configuration for a rtr.VirtualRouter, MD5 Key, Peers, Policies and Source.</td>
</tr>
<tr>
<td>multicast</td>
<td>Multicast - Multicast Connection Admission Control (CAC) Policies and Bandwidth Policies.</td>
</tr>
<tr>
<td>multicast.CustomerVlanTag</td>
<td>Customer Vlan Tag - Configuration of Customer VLAN Tags for a Multicast VLAN.</td>
</tr>
<tr>
<td>multicast.MfibPing</td>
<td>MFiB Ping - Access to MFiB Ping tests, MFiB Ping test definitions, and MFiB Ping deployed tests.</td>
</tr>
<tr>
<td>multicast.Mrinfo</td>
<td>Mrinfo - Access to Mrinfo tests, Mrinfo test definitions, and Mrinfo deployed tests.</td>
</tr>
<tr>
<td>multicast.Mtrace</td>
<td>Mtrace - Access to Mtrace tests, Mtrace test definitions, and Mtrace deployed tests.</td>
</tr>
<tr>
<td>multicastmgr</td>
<td>CPAM: Multicast - All CPAM Multicast related objects: PIM Domain, VPLS Domain, Groups, and Sources.</td>
</tr>
</tbody>
</table>
### Table A-4  Permissions assigned to NFM-P scope of command roles  (continued)

<table>
<thead>
<tr>
<th>Package.Class.Method/Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>multichassis</td>
<td>Multi-Chassis - Multi-Chassis configuration for a router; LAGs, Rings, Syncs, Peers, VLAN Ranges, IPsecs.</td>
</tr>
<tr>
<td>mvpls</td>
<td>MVPLS - All contained objects are listed. Package access is not currently used.</td>
</tr>
<tr>
<td>mvpls.BSite</td>
<td>MVPLS B-Site - Access to MVPLS B-Sites.</td>
</tr>
<tr>
<td>mvpls.EvpnSite</td>
<td>MVPLS EVPN-Site - Access to MVPLS EVPN-Sites on a MVPLS Service.</td>
</tr>
<tr>
<td>mvpls.ISite</td>
<td>MVPLS I-Site - Access to MVPLS I-Sites.</td>
</tr>
<tr>
<td>mvpls.Site</td>
<td>MVPLS Site - Access to MVPLS Sites (except I and B).</td>
</tr>
<tr>
<td>mvrp</td>
<td>MVRP - MVRP global configuration and for Interfaces (Ports and LAG’s).</td>
</tr>
<tr>
<td>mwa</td>
<td>Microwave Aware - Access to MW (Microwave) Link and MW Link Members configuration for Service interfaces and routers.</td>
</tr>
<tr>
<td>nat</td>
<td>Network Address Translation - NAT Policy.</td>
</tr>
<tr>
<td>nat.LsnSubSession</td>
<td>LSN Subscriber Session - Access to NAT Package.</td>
</tr>
<tr>
<td>neaudit</td>
<td>NE Audit Management - Ability to manage NE Audits.</td>
</tr>
<tr>
<td>negcss</td>
<td>Network Element Golden Config Snapshot - Golden Config Webapp.</td>
</tr>
<tr>
<td>nelicense</td>
<td>NeLicense - Apply License on the node.</td>
</tr>
<tr>
<td>netca</td>
<td>NE Threshold Crossing Alerts - Manage NE Threshold Crossing Alert profiles.</td>
</tr>
<tr>
<td>netw</td>
<td>Network - Network objects: groups and links.</td>
</tr>
<tr>
<td>netw.AdvertisedNode</td>
<td>Advertised Node - Control of Discovered Nodes.</td>
</tr>
<tr>
<td>netw.NeLimitHolder</td>
<td>NE Limits - Access to NE Limit configuration.</td>
</tr>
</tbody>
</table>
### Table A-4  Permissions assigned to NFM-P scope of command roles  (continued)

<table>
<thead>
<tr>
<th>Package.Class.Method/Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>netw.NetworkElement.method_GUICrossLaunch</td>
<td>Network Element - method_GUICrossLaunch - The ability to launch LTE web-browser based tools.</td>
</tr>
<tr>
<td>netw.NetworkElement.method_NetoAdminProfileBasedLaunch</td>
<td>Network Element - method_NetoAdminProfileBasedLaunch - The ability to launch Neto with Admin profile.</td>
</tr>
<tr>
<td>netw.NetworkElement.method_NetoViewerProfileBasedLaunch</td>
<td>Network Element - method_NetoViewerProfileBasedLaunch - The ability to launch Neto with Viewer profile.</td>
</tr>
<tr>
<td>netw.NetworkElement.property_elementManagerCmd</td>
<td>Network Element - property_elementManagerCmd - Ability to update the ‘Alternate Element Manager’ command for a GNE.</td>
</tr>
<tr>
<td>netw.NodeDiscoveryControl</td>
<td>Node Discovery Control - Control of Discovered Nodes.</td>
</tr>
<tr>
<td>netw.Topology</td>
<td>Discovery Manager - Access to the Discovery Manager.</td>
</tr>
<tr>
<td>netw.Topology.method_move</td>
<td>Discovery Manager - method_move - Ability to move a node or group on the NFM-P Client GUI maps.</td>
</tr>
<tr>
<td>netw.UplinkBofConfiguration</td>
<td>Uplink Bof Configuration - Ability to configure the Uplink BOF for a 7210 node.</td>
</tr>
<tr>
<td>netw.UplinkRouteConfiguration</td>
<td>Uplink Route Configuration - Ability to configure the Uplink Routes for a 7210 node.</td>
</tr>
<tr>
<td>nfv</td>
<td>NFV - Configurations and Management of NFV.</td>
</tr>
<tr>
<td>nge</td>
<td>NetworkGroupEncryption - Network Group Encryption configuration on 7705 router.</td>
</tr>
<tr>
<td>nodelog</td>
<td>Node Log Policy - Filter Log and Sys Log Target Policies.</td>
</tr>
<tr>
<td>nqueue</td>
<td>Network Queue Policy - Network Queue QoS Policies.</td>
</tr>
<tr>
<td>ntp.NTPBroadcast</td>
<td>NTP Broadcast - Ability to configure broadcast for ntp params.</td>
</tr>
<tr>
<td>ntp.NTPMulticast</td>
<td>NTP Multicast - Ability to configure multicast for ntp params.</td>
</tr>
<tr>
<td>olc</td>
<td>Object Life Cycle.</td>
</tr>
<tr>
<td>olc.OLCSchedulerManager.property_autosetMaintenanceOLCStateOnAdminDown</td>
<td>OLC Scheduler Manager - property_autosetMaintenanceOLCStateOnAdminDown - Service preferences can only be modified by a user with an administrator role.</td>
</tr>
<tr>
<td>olc.OLCSchedulerManager.property_createAlarmNotification</td>
<td>OLC Scheduler Manager - property_createAlarmNotification - OLC preferences can only be modified by a user with an administrator role.</td>
</tr>
<tr>
<td>olc.OLCSchedulerManager.property_leadTimeForNotification</td>
<td>OLC Scheduler Manager - property_leadTimeForNotification - OLC preferences can only be modified by a user with an administrator role.</td>
</tr>
<tr>
<td>openflow</td>
<td>OpenFlow - OpenFlow configuration and status on a router.</td>
</tr>
<tr>
<td>optical</td>
<td>Optical Management - Optical NE Specific Information.</td>
</tr>
</tbody>
</table>
### Table A-4  Permissions assigned to NFM-P scope of command roles  (continued)

<table>
<thead>
<tr>
<th>Package.Class.Method/Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>optical.OCHTrail</td>
<td>OCH Trail - Access for all OCH trails.</td>
</tr>
<tr>
<td>optical.ODUTrail</td>
<td>ODU Trail - Access for all ODU trails.</td>
</tr>
<tr>
<td>optical.OMSTrail</td>
<td>OMS Trail - Access for all OMS trails.</td>
</tr>
<tr>
<td>optical.OTSTrail</td>
<td>OTS Trail - Access for all OTS trails.</td>
</tr>
<tr>
<td>optical.OTUTrail</td>
<td>OTU Trail - Access for all OTU trails.</td>
</tr>
<tr>
<td>optical.STMTrail</td>
<td>STM Trail - Access for all STM trails.</td>
</tr>
<tr>
<td>optical.TransportService</td>
<td>Optical Transport Service - Access for all optical services.</td>
</tr>
<tr>
<td>opticacl</td>
<td>Optical Access Control Lists - ACL Management.</td>
</tr>
<tr>
<td>opticaquipment</td>
<td>Optical Management - Optical NE Specific Configuration.</td>
</tr>
<tr>
<td>opticalrouting</td>
<td>Optical Routing - Optical Routing Meta.</td>
</tr>
<tr>
<td>opticsperf</td>
<td>Optics Specifics - All 1830 PSS configurations.</td>
</tr>
<tr>
<td>ospf</td>
<td>Routing Management: OSPF - OSPF configuration for Service interfaces and routers, Area, Adjacency, MDS Key, Virtual Links Neighbors, LSAs, Policies and other OSPF related objects.</td>
</tr>
<tr>
<td>ospf.Site</td>
<td>OSPF Site - Access to OSPF Sites.</td>
</tr>
<tr>
<td>oss</td>
<td>XMLAPI - Ability to connect to the NFM-P through the XML API interface.</td>
</tr>
<tr>
<td>oth</td>
<td>Optical Transport Hierarchy - OTH Management.</td>
</tr>
<tr>
<td>pae802_1x</td>
<td>PAE 802.1x - Port Access Entity (PAE) configuration for a router and physical port; RADIUS Server Policy.</td>
</tr>
<tr>
<td>pbbvlan</td>
<td>PBBVLAN - Access to this package is for configuring SPB-BVLAN Service, Site, SAPs, MeshSDPs and site statistics.</td>
</tr>
<tr>
<td>pbbvlan.Site</td>
<td>SPB Site - Access to SPB Services.</td>
</tr>
<tr>
<td>pim</td>
<td>PIM - PIM configuration for Service interfaces and routers, MDT Threshold, Policies, Neighbors, Groups, RPs, Multicast CAC Level and LAG Port Down events, and other PIM related objects.</td>
</tr>
<tr>
<td>pim.Site</td>
<td>PIM Site - Access to PIM Sites.</td>
</tr>
<tr>
<td>policing</td>
<td>Policing Policy - Policer Control.</td>
</tr>
<tr>
<td>policy</td>
<td>Policy - Parent package for all policies; Policy Audits, Policy Export/Imports.</td>
</tr>
<tr>
<td>policy.PolicyDefinition.method_setConfigurationModeToReleased</td>
<td>Policy Definition - method_setConfigurationModeToReleased - Ability set Configuration Mode to Released and distribute the global policy to the local definitions network-wide.</td>
</tr>
</tbody>
</table>
### Table A-4  Permissions assigned to NFM-P scope of command roles  (continued)

<table>
<thead>
<tr>
<th>Package.Class.Method/Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>policy.PolicyDefinition.method_setDistributionModeToLocalEditOnly</td>
<td>Policy Definition - method_setDistributionModeToLocalEditOnly - Ability set Configuration Mode to Local Edit Only for local policies and ignore changes to the global policy.</td>
</tr>
<tr>
<td>policy.PolicyDefinition.method_setDistributionModeToSyncWithGlobal</td>
<td>Policy Definition - method_setDistributionModeToSyncWithGlobal - Ability set Configuration Mode to Sync with Global and synchronize local policies with the most recent released global policy.</td>
</tr>
<tr>
<td>policy.PolicyNameManager.property_autoDistributeOnRelease</td>
<td>Policies - property_autoDistributeOnRelease - Policy preferences can only be modified by a user with an administrator role.</td>
</tr>
<tr>
<td>policy.PolicyNameManager.property_localEditOnly</td>
<td>Policies - property_localEditOnly - Policy preferences can only be modified by a user with an administrator role.</td>
</tr>
<tr>
<td>policy.PolicyNameManager.property_localEditOnlyOnCLIClause</td>
<td>Policies - property_localEditOnlyOnCLIClause - Policy preferences can only be modified by a user with an administrator role.</td>
</tr>
<tr>
<td>policy.PolicyNameManager.property_maxScheduledAuditResultPerLocalPolicy</td>
<td>Policies - property_maxScheduledAuditResultPerLocalPolicy - Policy preferences can only be modified by a user with an administrator role.</td>
</tr>
<tr>
<td>policy.PolicyNameManager.property_securityZoneDiscoveredInLocalEditOnlyMode</td>
<td>Policies - property_securityZoneDiscoveredInLocalEditOnlyMode - Policy preferences can only be modified by a user with an administrator role.</td>
</tr>
<tr>
<td>policy.PolicyNameManager.property_showFilterDisplayName</td>
<td>Policies - property_showFilterDisplayName - Policy preferences can only be modified by a user with an administrator role.</td>
</tr>
<tr>
<td>policy.PolicyNameManager.property_showQoSPolicyDisplayName</td>
<td>Policies - property_showQoSPolicyDisplayName - Policy preferences can only be modified by a user with an administrator role.</td>
</tr>
<tr>
<td>policy.PolicySyncGroupManager</td>
<td>Policy Sync Group Manager - Ability to configure and control policy sync group.</td>
</tr>
<tr>
<td>policy.ProfileManager</td>
<td>Profile Manager - Ability to configure and control profiles.</td>
</tr>
<tr>
<td>policytestutil</td>
<td>Policy Test Utility - TODO.</td>
</tr>
<tr>
<td>port.RestrictModeConfigModify</td>
<td>port.RestrictModeConfigModify - Ability to restrict Port Mode modification for Ports with dependencies.</td>
</tr>
<tr>
<td>portscheduler</td>
<td>Port Scheduler Policy - Port Scheduler and HSMDA Scheduler Policies.</td>
</tr>
<tr>
<td>ppp</td>
<td>PPP - Point-to-Point Protocol (PPP) configuration on a router.</td>
</tr>
<tr>
<td>pppoe</td>
<td>PPP Policy and Session - Point-to-Point Protocol over Ethernet over ATM (PPPoE/PPPoEoA/PPPoA) Policies and Sessions.</td>
</tr>
<tr>
<td>propertyrules</td>
<td>Property Rules - Range and Format Value Policies.</td>
</tr>
<tr>
<td>ptp</td>
<td>Precision Timing Protocol - Access to this package is for configuring Precision Timing Protocol.</td>
</tr>
<tr>
<td>pxc</td>
<td>PXC - Port Cross Connect.</td>
</tr>
<tr>
<td>qgroup</td>
<td>Queue Group Policy - Queue Group Policies.</td>
</tr>
<tr>
<td>qosprefixlist</td>
<td>QoS Policy - QoS PrefixList Policy.</td>
</tr>
</tbody>
</table>
## Table A-4  Permissions assigned to NFM-P scope of command roles  (continued)

<table>
<thead>
<tr>
<th>Package.Class.Method/Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>radioequipment</td>
<td>Radio Equipment - Radio Equipment configuration.</td>
</tr>
<tr>
<td>radiusaccounting</td>
<td>Radius Accounting - Radius Accounting Policy.</td>
</tr>
<tr>
<td>ranlicense</td>
<td>NE License Management - Ability to manage NE licenses.</td>
</tr>
<tr>
<td>ranradiom</td>
<td>eNodeB Router Admin: radio measurement - eNodeB Router administration: radio measurement.</td>
</tr>
<tr>
<td>rca</td>
<td>RCA - Root Cause Analysis (RCA) for verification applications (OSPF Area, IS-IS Area, BGP AS, ...).</td>
</tr>
<tr>
<td>rca.RcaManager.method_fixProblem</td>
<td>Rca Manager - method_fixProblem - Ability to fix a problem on an object.</td>
</tr>
<tr>
<td>rca.RcaManager.method_preFixProblem</td>
<td>Rca Manager - method_preFixProblem - Ability to determine if a problem can be fixed, and the fix impact.</td>
</tr>
<tr>
<td>redirectfilter</td>
<td>Redirect Filter Policy - Redirect Filters.</td>
</tr>
<tr>
<td>resiliency</td>
<td>HSDPA Resiliency - HSDPA Resiliency for services.</td>
</tr>
<tr>
<td>resources</td>
<td>NFM-P Resources - NFM-P Resource Pools as configured in the nms-server.xml file.</td>
</tr>
<tr>
<td>ressubscr</td>
<td>Residential Subscriber - All Residential Subscriber configuration including Connectivity Verifications (SHCV), SAPs, Packages, Hosts, QoS, and other related objects.</td>
</tr>
<tr>
<td>ressubscr.ResidentialSubscriberManager.property_hostTrkSubscrRtrvTimeOut</td>
<td>Residential Subscriber Manager - property_hostTrkSubscrRtrvTimeOut - Service preferences can only be modified by a user with an administrator role.</td>
</tr>
<tr>
<td>ressubscr.ResidentialSubscriberManager.property_qblUeRtrvTimeOut</td>
<td>Residential Subscriber Manager - property_qblUeRtrvTimeOut - Service preferences can only be modified by a user with an administrator role.</td>
</tr>
<tr>
<td>ressubscr.ResidentialSubscriberManager.property_resSubscrInstRtrvTimeOut</td>
<td>Residential Subscriber Manager - property_resSubscrInstRtrvMax - Service preferences can only be modified by a user with an administrator role.</td>
</tr>
<tr>
<td>ressubscr.ResidentialSubscriberManager.property_retrieveAcclpEncap</td>
<td>Residential Subscriber Manager - property_retrieveAcclpEncap - Service preferences can only be modified by a user with an administrator role.</td>
</tr>
<tr>
<td>ressubscr.ResidentialSubscriberManager.property_retrieveBgpPeerInfo</td>
<td>Residential Subscriber Manager - property_retrieveBgpPeerInfo - Service preferences can only be modified by a user with an administrator role.</td>
</tr>
<tr>
<td>ressubscr.ResidentialSubscriberManager.property_retrieveBgpPeerV6Info</td>
<td>Residential Subscriber Manager - property_retrieveBgpPeerV6Info - Service preferences can only be modified by a user with an administrator role.</td>
</tr>
</tbody>
</table>
### Table A-4 Permissions assigned to NFM-P scope of command roles (continued)

<table>
<thead>
<tr>
<th>Package.Class.Method/Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ressubscr.ResidentialSubscriberManager.property_retrieveManagedRoutes</td>
<td>Residential Subscriber Manager - property_retrieveManagedRoutes - Service preferences can only be modified by a user with an administrator role.</td>
</tr>
<tr>
<td>ressubscr.ResidentialSubscriberManager.property_retrieveQoSOr</td>
<td>Residential Subscriber Manager - property_retrieveQoSOr - Service preferences can only be modified by a user with an administrator role.</td>
</tr>
<tr>
<td>ressubscr.ResidentialSubscriberManager.property_retrieveSlaachHostAddr</td>
<td>Residential Subscriber Manager - property_retrieveSlaachHostAddr - Service preferences can only be modified by a user with an administrator role.</td>
</tr>
<tr>
<td>ressubscr.ResidentialSubscriberManager.property_subscriberHostRtrvTimeOut</td>
<td>Residential Subscriber Manager - property_subscriberHostRtrvTimeOut - Service preferences can only be modified by a user with an administrator role.</td>
</tr>
<tr>
<td>rip</td>
<td>Routing Management: RIP - Routing Information Protocol (RIP) configuration for Service interfaces and routers, Authentication Key, Groups, Export and Import Policies.</td>
</tr>
<tr>
<td>rip.Site</td>
<td>RIP Site - Access to RIP Sites.</td>
</tr>
<tr>
<td>rmd</td>
<td>Remote Managed Device - Remote Managed Device Management.</td>
</tr>
<tr>
<td>rollback</td>
<td>Rollback - All scheduled tasks; Cron Actions, XML API Commands, CLI Scripts and Schedules.</td>
</tr>
<tr>
<td>rp</td>
<td>Routing Policy - Policy Statements, Prefix Lists, Communities, Damping, and AS Paths.</td>
</tr>
<tr>
<td>rtr</td>
<td>Routing Management: General - General rtr:VirtualRouter configurations including Neighbor Discovery, DHCP Relays, Interfaces, Peers, Address Ranges and ARP, Routes and Router Advertisement.</td>
</tr>
<tr>
<td>rules</td>
<td>Rules - Rule Repository and Sets of rules that may get invoked when a rule engine is fired.</td>
</tr>
<tr>
<td>sas</td>
<td>Assurance - Parent package for all tests; Service Test Manager.</td>
</tr>
<tr>
<td>sas.IPSession</td>
<td>IP Session - Access to IP Session, IP Test Session definitions.</td>
</tr>
<tr>
<td>sas.TestManager.property_contextNonSapMax</td>
<td>Service Test Manager - property_contextNonSapMax - OAM Context preferences can only be modified by a user with an administrator role.</td>
</tr>
<tr>
<td>sas.TestManager.property_contextSapMax</td>
<td>Service Test Manager - property_contextSapMax - OAM Context preferences can only be modified by a user with an administrator role.</td>
</tr>
<tr>
<td>sas.TestManager.property_defaultTestResultStorage</td>
<td>Service Test Manager - property_defaultTestResultStorage - These preferences can only be modified by a user with an administrator role.</td>
</tr>
</tbody>
</table>
## Table A-4  Permissions assigned to NFM-P scope of command roles  (continued)

<table>
<thead>
<tr>
<th>Package.Class.Method/Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>sas.TestManager.property_sasNumberOfHours</td>
<td>Service Test Manager - property_sasNumberOfHours - These preferences can only be modified by a user with an administrator role.</td>
</tr>
<tr>
<td>sas.TestManager.property_sasRetention</td>
<td>Service Test Manager - property_sasRetention - LogToFile preferences can only be modified by a user with an administrator role.</td>
</tr>
<tr>
<td>sas.TestManager.property_sasRollover</td>
<td>Service Test Manager - property_sasRollover - LogToFile preferences can only be modified by a user with an administrator role.</td>
</tr>
<tr>
<td>sas.TWLBin</td>
<td>TWAMP Light Session Bin - Access to TWAMP Light Test Session, TWAMP Light Test Session definitions.</td>
</tr>
<tr>
<td>sas.TwLReflector</td>
<td>TWAMP Light Reflector - Access to TWAMP Light Reflector.</td>
</tr>
<tr>
<td>sas.TWLSession</td>
<td>TWAMP Light Test Session - Access to TWAMP Light Test Session, TWAMP Light Test Session definitions.</td>
</tr>
<tr>
<td>sas.VxlanPing</td>
<td>VXLAN Ping - Access to VXLAN Ping tests, VXLAN Ping test definitions, and VXLAN Ping deployed tests.</td>
</tr>
<tr>
<td>saspm</td>
<td>SAS PM - Access to OAM Performance Monitoring Objects.</td>
</tr>
<tr>
<td>sasqos</td>
<td>7210 and 1830 QoS - QoS Policies for 7210 and 1830 nodes.</td>
</tr>
<tr>
<td>schedule</td>
<td>Schedule - All scheduled tasks; Cron Actions, XML API Commands, CLI Scripts and Schedules.</td>
</tr>
<tr>
<td>script</td>
<td>Scripting - Script Management and execution of Service and Tunnel Template, XML API, and CLI scripts.</td>
</tr>
<tr>
<td>script.AbstractScript.method_configureTarget</td>
<td>Script - method_configureTarget - Ability to configure targets and instances.</td>
</tr>
<tr>
<td>script.AbstractScript.method_configureTargets</td>
<td>Script - method_configureTargets - Ability to configure targets and instances.</td>
</tr>
<tr>
<td>script.Bundle</td>
<td>Script Bundle - Ability to configure script bundles.</td>
</tr>
<tr>
<td>script.ControlScript</td>
<td>Control Script - Ability to configure control scripts.</td>
</tr>
<tr>
<td>script.ControlScriptVersion</td>
<td>Control Script Version - Ability to configure Control script versions.</td>
</tr>
<tr>
<td>script.HandlerBinding</td>
<td>Handler Script Binding - Ability to configure associations between scripts and control scripts.</td>
</tr>
<tr>
<td>script.InvokerBinding</td>
<td>Invoker Script Binding - Ability to configure associations between scripts and control scripts.</td>
</tr>
<tr>
<td>script.JsonTargetParameter</td>
<td>JSON Target Parameter - Ability to configure target/instance JSON parameters.</td>
</tr>
<tr>
<td>script.LargeTextTargetParameter</td>
<td>Large Text Target Parameter - Ability to configure target/instance large text parameters.</td>
</tr>
<tr>
<td>script.Result</td>
<td>Result - Ability to create script results.</td>
</tr>
<tr>
<td>script.Script</td>
<td>CLI Script - Ability to configure CLI scripts.</td>
</tr>
</tbody>
</table>
Table A-4  Permissions assigned to NFM-P scope of command roles  (continued)

<table>
<thead>
<tr>
<th>Package.Class.Method/Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>script.Script.method_createTargetScript</td>
<td>CLI Script - method_createTargetScript - Ability to configure targets.</td>
</tr>
<tr>
<td>script.Script.method_createTargetScripts</td>
<td>CLI Script - method_createTargetScripts - Ability to configure targets.</td>
</tr>
<tr>
<td>script.ScriptManager</td>
<td>Script Manager - Ability to configure and control scripts and script operations.</td>
</tr>
<tr>
<td>script.ScriptManager.method_configure</td>
<td>Script Manager - method_configure - Ability to configure scripts.</td>
</tr>
<tr>
<td>script.ScriptManager.method_copyContents</td>
<td>Script Manager - method_copyContents - Ability to copy scripts.</td>
</tr>
<tr>
<td>script.ScriptManager.method_exportBundle</td>
<td>Script Manager - method_exportBundle - Ability to export bundle.</td>
</tr>
<tr>
<td>script.ScriptManager.method_importBundle</td>
<td>Script Manager - method_importBundle - Ability to import bundle.</td>
</tr>
<tr>
<td>script.ScriptManager.method_importBundleSimulation</td>
<td>Script Manager - method_importBundleSimulation - Ability to import bundle.</td>
</tr>
<tr>
<td>script.ScriptScheduledTask</td>
<td>Script Scheduled Task - Ability to schedule a script.</td>
</tr>
<tr>
<td>script.TargetParameter</td>
<td>Target Parameter - Ability to configure target/instance parameters.</td>
</tr>
<tr>
<td>script.TargetParameterItem</td>
<td>Target Parameter Item - Ability to configure target/instance parameter items.</td>
</tr>
<tr>
<td>script.TargetParameterList</td>
<td>Target Parameter List - Ability to configure target/instance parameter lists.</td>
</tr>
<tr>
<td>script.TargetScript</td>
<td>Target Script - Ability to configure targets and instances.</td>
</tr>
<tr>
<td>script.TemplateBinding</td>
<td>Template Binding - Ability to configure associations between templates.</td>
</tr>
<tr>
<td>script.XmlApiConfigTemplate</td>
<td>Template - Ability to configure XML API templates.</td>
</tr>
<tr>
<td>script.XmlApiConfigTemplate.method_execute</td>
<td>Template - method_execute - Ability to create an object from a template.</td>
</tr>
<tr>
<td>script.XmlApiConfigTemplate.method_executeMulti</td>
<td>Template - method_executeMulti - Ability to create an object from a template.</td>
</tr>
<tr>
<td>script.XmlApiConfigTemplate.method_executeScript</td>
<td>Template - method_executeScript - Ability to create an object from a template.</td>
</tr>
<tr>
<td>script.XmlApiConfigTemplate.method_serviceTemplateExecute</td>
<td>Template - method_serviceTemplateExecute - Ability to execute a service template.</td>
</tr>
<tr>
<td>script.XmlApiConfigTemplate.method_tunnelTemplateExecute</td>
<td>Template - method_tunnelTemplateExecute - Ability to execute a tunnel template.</td>
</tr>
<tr>
<td>script.XmlApiScript</td>
<td>XMLAPI Script - Ability to configure XML API scripts.</td>
</tr>
<tr>
<td>script.XmlApiVersion</td>
<td>XMLAPI Version - Ability to configure XML API script versions.</td>
</tr>
<tr>
<td>security</td>
<td>Security - NFM-P User security including Sessions, TCP KeyChains, and SSH2 Known Host Keys.</td>
</tr>
<tr>
<td>security.CpamLicense</td>
<td>CPAM License - Read-only view of the CPAM License.</td>
</tr>
</tbody>
</table>
### Table A-4 Permissions assigned to NFM-P scope of command roles (continued)

<table>
<thead>
<tr>
<th>Package.Class.Method/Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>security.CpamLicense.method_clearRouterLimitExceedDueToMultiAdditions</td>
<td>CPAM License - method_clearRouterLimitExceedDueToMultiAdditions - Ability to clear the isRouterLimitExceedDueToMultiAdditions flag on the license.</td>
</tr>
<tr>
<td>security.CpamLicenseScenario</td>
<td>CPAM License Scenario - Read-only view of the CPAM Impact Analysis Application License.</td>
</tr>
<tr>
<td>security.MessagingConnection</td>
<td>Messaging Connection - Ability to view messaging connections.</td>
</tr>
<tr>
<td>security.RoleBasedAccess</td>
<td>security.RoleBasedAccess - Ability to restrict online object creation and deletion to a specific role. Currently applies to 9412 node.</td>
</tr>
<tr>
<td>security.ScopeOfCommandProfile</td>
<td>Profile - Access to Scope of Command Profile configuration.</td>
</tr>
<tr>
<td>security.ScopeOfCommandRole</td>
<td>Role - Access to Scope of Command Role configuration.</td>
</tr>
<tr>
<td>security.Span</td>
<td>Span - Access to Span configuration. Used in conjunction with security.SpanObjectBinding.</td>
</tr>
<tr>
<td>security.SpanObjectBinding</td>
<td>Span Objects - Access to Span object configuration. Used in conjunction with security.Span.</td>
</tr>
<tr>
<td>security.SpanOfControlProfile</td>
<td>Profile - Access to Span of Control Profile configuration.</td>
</tr>
<tr>
<td>security.User</td>
<td>User - Access to User object configuration and password changes.</td>
</tr>
<tr>
<td>securitypolicy</td>
<td>Security Policy - All Security configurations including security policy,profile,zone,NAT.</td>
</tr>
<tr>
<td>selfconfig</td>
<td>Self Config - Ability to configure self config objects.</td>
</tr>
<tr>
<td>server</td>
<td>NFM-P Server - NFM-P Servers (JMS, Main, Auxiliary Server, Auxiliary Database) as configured in the nms-server.xml file.</td>
</tr>
<tr>
<td>service</td>
<td>Service Management - Parent package for all services; Composite Services and Connectors and Access Policy Queue Override Policies.</td>
</tr>
<tr>
<td>service.AarpInterface</td>
<td>AARP Interface - Access to AARP Interface configuration between AARP.</td>
</tr>
<tr>
<td>service.CpePing</td>
<td>CPE Ping - Access to CPE Ping tests, CPE Ping test definitions, and CPE Ping deployed tests.</td>
</tr>
<tr>
<td>service.GneSite</td>
<td>GNE Site - Access to GNE Sites.</td>
</tr>
<tr>
<td>service.MacPing</td>
<td>MAC Ping - Access to MAC Ping tests, MAC Ping test definitions, and MAC Ping deployed tests.</td>
</tr>
<tr>
<td>service.MacPopulate</td>
<td>MAC Populate - Access to MAC Populate tests, MAC Populate test definitions, and MAC Populate deployed tests.</td>
</tr>
<tr>
<td>Package.Class.Method/Property</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------------------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>service.MacPurge</td>
<td>MAC Purge - Access to MAC Purge tests, MAC Purge test definitions, and MAC Purge deployed tests.</td>
</tr>
<tr>
<td>service.MacTrace</td>
<td>MAC Trace - Access to MAC Trace tests, MAC Trace test definitions, and MAC Trace deployed tests.</td>
</tr>
<tr>
<td>service.RedundantInterface</td>
<td>Redundant Interface - Access to Redundant Interface configuration between SRPP instances.</td>
</tr>
<tr>
<td>service.Service.method_create</td>
<td>Service - method_create - Ability to create a service via the NFM-P Client GUI.</td>
</tr>
<tr>
<td>service.Service.property_svcPriority</td>
<td>Service - property_svcPriority - Service priority can only be modified by a user with an administrator role.</td>
</tr>
<tr>
<td>service.ServiceManager.property_alarmAggregationCompositeService</td>
<td>Service Manager - property_alarmAggregationCompositeService - Service preferences can only be modified by a user with an administrator role.</td>
</tr>
<tr>
<td>service.ServiceManager.property_alarmAggregationSdp</td>
<td>Service Manager - property_alarmAggregationSdp - Service preferences can only be modified by a user with an administrator role.</td>
</tr>
<tr>
<td>service.ServiceManager.property_autoDiscoverCompositeSvc</td>
<td>Service Manager - property_autoDiscoverCompositeSvc - Service preferences can only be modified by a user with an administrator role.</td>
</tr>
<tr>
<td>service.ServiceManager.property_enableCac</td>
<td>Service Manager - property_enableCac - Service preferences can only be modified by a user with an administrator role.</td>
</tr>
<tr>
<td>service.ServiceManager.property_enableRTConnection</td>
<td>Service Manager - property_enableRTConnection - Service preferences can only be modified by a user with an administrator role.</td>
</tr>
<tr>
<td>service.ServiceManager.property_generateReservedRrcAlarm</td>
<td>Service Manager - property_generateReservedRrcAlarm - Service preferences can only be modified by a user with an administrator role.</td>
</tr>
<tr>
<td>service.ServiceManager.property_maxNumberOfMoveSites</td>
<td>Service Manager - property_maxNumberOfMoveSites - Service preferences can only be modified by a user with an administrator role.</td>
</tr>
<tr>
<td>service.ServiceManager.property_multiSegmentTunnelSelection</td>
<td>Service Manager - property_multiSegmentTunnelSelection - Service preferences can only be modified by a user with an administrator role.</td>
</tr>
<tr>
<td>service.ServiceManager.property_propagateServiceNameToSites</td>
<td>Service Manager - property_propagateServiceNameToSites - Service preferences can only be modified by a user with an administrator role.</td>
</tr>
<tr>
<td>service.ServiceManager.property_propagateSiteNameToService</td>
<td>Service Manager - property_propagateSiteNameToService - Service preferences can only be modified by a user with an administrator role.</td>
</tr>
<tr>
<td>service.ServiceManager.property_propagateSvcNameDesc</td>
<td>Service Manager - property_propagateSvcNameDesc - Service preferences can only be modified by a user with an administrator role.</td>
</tr>
<tr>
<td>service.ServiceManager.property_removeEmptyService</td>
<td>Service Manager - property_removeEmptyService - Service preferences can only be modified by a user with an administrator role.</td>
</tr>
<tr>
<td>service.ServiceManager.property_safeSvcDelete</td>
<td>Service Manager - property_safeSvcDelete - Service preferences can only be modified by a user with an administrator role.</td>
</tr>
<tr>
<td>Package.Class.Method/Property</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------------</td>
<td>-------------</td>
</tr>
<tr>
<td>service.ServiceManager.property_supVprnSnmpCommunityStringMsg</td>
<td>Service Manager - property_supVprnSnmpCommunityStringMsg - Service preferences can only be modified by a user with an administrator role.</td>
</tr>
<tr>
<td>service.ServiceManager.property_svcPriority</td>
<td>Service Manager - property_svcPriority - Service priority can only be modified by a user with an administrator role.</td>
</tr>
<tr>
<td>service.MemberAuditPolicyEntry</td>
<td>Service Membership Audit Policy Entry - Access to Service Member Audit Policy Entry to configure service membership RCA audit behavior.</td>
</tr>
<tr>
<td>service.SitePing</td>
<td>Service Site Ping - Access to Service Site Ping tests, Service Site Ping test definitions, and Service Site Ping deployed tests.</td>
</tr>
<tr>
<td>service.TemplateService.method_constructServiceTemplate</td>
<td>Service Template - method_constructServiceTemplate - Ability to construct a Template from a Service.</td>
</tr>
<tr>
<td>service.TemplateService.method_constructTemplatedService</td>
<td>Service Template - method_constructTemplatedService - Ability to construct a Service from a Template.</td>
</tr>
<tr>
<td>service.Y1564TestHeadBiDirectional</td>
<td>Y1564 Bi-Directional Test - Access to Y1564 Bi-Directional tests, Y1564 Bi-Directional test definitions, and Y1564 Bi-Directional deployed tests.</td>
</tr>
<tr>
<td>sflow</td>
<td>sFlow - SFLOW Objects.</td>
</tr>
<tr>
<td>shaperqos</td>
<td>Shaper QoS Policies - Shaper QoS policy.</td>
</tr>
<tr>
<td>shg</td>
<td>Split Horizon Group - Split Horizon Groups for VPLS services.</td>
</tr>
<tr>
<td>simulator</td>
<td>CPAM: Simulator - Parent package for all CPAM simulated objects; Scenarios, Sessions, Change and Action events.</td>
</tr>
<tr>
<td>simulator.SimSession</td>
<td>Session - Access to simulation sessions for CPAM Impact Analysis.</td>
</tr>
<tr>
<td>sitesec</td>
<td>NE Security - All Network Element security configuration including NE System Security, RADIUS, TACACS+ and AOS Authentication, Site Management Access and CPM Filters, DoS Protection, Password Policy, Users and Profiles.</td>
</tr>
<tr>
<td>sitesec.LocalUser</td>
<td>NE User - Access to NE Site User configuration.</td>
</tr>
<tr>
<td>sitesec.UserProfile</td>
<td>Site User Profile - Access to NE Site User Profile configuration.</td>
</tr>
<tr>
<td>sitesec.UserPublicKey</td>
<td>RSA Key - Public keys(SSHv2) configuration for the system users.</td>
</tr>
<tr>
<td>slaprofile</td>
<td>SLA Profile - SLA Profiles for QoS Policies.</td>
</tr>
<tr>
<td>Package.Class.Method/Property</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>sonet</td>
<td>SONET Sync - SONET Synchronization for Shelf and Processor Cards.</td>
</tr>
<tr>
<td>sonet.equipment</td>
<td>SONET Equipment - SONET Equipment configuration.</td>
</tr>
<tr>
<td>spanrules</td>
<td>Span Rules - Span Rules for service creation.</td>
</tr>
<tr>
<td>spb</td>
<td>SPB - Access to this package is for configuring SPB site and site statistics.</td>
</tr>
<tr>
<td>squeue</td>
<td>Shared Queue Policy - Shared Queue Policies.</td>
</tr>
<tr>
<td>srmrmtauth</td>
<td>NFM-P Remote Authentication - Remote Authentication for NFM-P configuration of RADIUS, TACACS+, and LDAP authentication servers.</td>
</tr>
<tr>
<td>srpythonmgmt</td>
<td>Python Management - Python Management.</td>
</tr>
<tr>
<td>srrp</td>
<td>SRRP - Subscriber Routed Redundancy Protocol (SRRP) configuration for IES and VPRN services.</td>
</tr>
<tr>
<td>statsplot</td>
<td>Statistics Plotter - Statistics Plotter.</td>
</tr>
<tr>
<td>subscr</td>
<td>Subscriber Management - Customers configuration.</td>
</tr>
<tr>
<td>subscr.Site</td>
<td>Subscriber Site - Access to Subscriber Sites.</td>
</tr>
<tr>
<td>subscr.auth</td>
<td>Subscriber Authentication - Subscriber Authentication Policy using RADIUS for DHCP sessions.</td>
</tr>
<tr>
<td>subscr.expmap</td>
<td>Subscriber Explicit Map - Subscriber Explicit Map Entry.</td>
</tr>
<tr>
<td>subscr.incident</td>
<td>Subscriber Identification - Subscriber Identification Policy.</td>
</tr>
<tr>
<td>subscr.profile</td>
<td>Subscriber Profile - Subscriber Profile, SLA Entries, Access Policy Queue Overrides and Scheduler Policy Entry Overrides.</td>
</tr>
<tr>
<td>sup</td>
<td>Supervision - NFM-P Supervision (Dashboard).</td>
</tr>
<tr>
<td>svq</td>
<td>Aggregation Scheduler - Service and Subscriber Aggregation Scheduler, Ingress and Egress Aggregation Scheduler Overrides.</td>
</tr>
<tr>
<td>svr</td>
<td>Service Routing - All contained objects are listed. Package access is not currently used.</td>
</tr>
<tr>
<td>svt</td>
<td>Service Tunnel Management - All Service Tunnel configurations including Clouds, Service Distribution Path (SDP) Bindings and Pseudo Wires.</td>
</tr>
</tbody>
</table>
Table A-4  Permissions assigned to NFM-P scope of command roles  (continued)

<table>
<thead>
<tr>
<th>Package.Class.Method/Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>svt.BvlanTunnel</td>
<td>SPB BVLAN Tunnel (SDP) - Access to vlan Tunnel (SDP) configuration.</td>
</tr>
<tr>
<td>svt.L2TPv3Tunnel</td>
<td>L2TPv3 Tunnel (SDP) - Access to l2tpV3 Tunnel (SDP) configuration.</td>
</tr>
<tr>
<td>svt.MtuPing</td>
<td>MTU Ping - Access to MTU Ping tests, MTU Ping test definitions, and MTU Ping deployed tests.</td>
</tr>
<tr>
<td>svt.SpokeSdpBinding</td>
<td>Spoke SDP Binding - Access to Spoke SDP Binding configuration.</td>
</tr>
<tr>
<td>svt.Tunnel</td>
<td>Tunnel - Access to Tunnel (or SDP object) configuration.</td>
</tr>
<tr>
<td>svt.TunnelPing</td>
<td>Tunnel Ping - Access to Tunnel Ping tests, Tunnel Ping test definitions, and Tunnel Ping deployed tests.</td>
</tr>
<tr>
<td>svt.VccvPing</td>
<td>VCCV Ping - Access to VCCV Ping tests, VCCV Ping test definitions, and VCCV Ping deployed tests.</td>
</tr>
<tr>
<td>svt.VccvTrace</td>
<td>VCCV Trace - Access to VCCV Trace tests, VCCV Trace test definitions, and VCCV Trace deployed tests.</td>
</tr>
<tr>
<td>svt.VlanPBBEdgeSdpBinding</td>
<td>PBB VLAN Mesh SDP Binding - Access to PBB VLAN Mesh SDP Binding configuration.</td>
</tr>
<tr>
<td>sw.BackupRestoreManager.method_backup</td>
<td>Backup/Restore Status - method_backup - Ability to perform a Network Element backup.</td>
</tr>
<tr>
<td>sw.BackupRestoreManager.method_restore</td>
<td>Backup/Restore Status - method_restore - Ability to perform a Network Element restore.</td>
</tr>
<tr>
<td>sysact</td>
<td>User Activity - User Activity.</td>
</tr>
<tr>
<td>taskmgmt</td>
<td>Task Management - Monitor the tasks being executed in the server.</td>
</tr>
<tr>
<td>tca</td>
<td>TCA Policy - Parent package for all TCA classes.</td>
</tr>
<tr>
<td>tca.TCAManager.property_maxTCAAlarmLimit</td>
<td>TCAManager - property_maxTCAAlarmLimit - TCA preferences can only be modified by a user with an administrator role.</td>
</tr>
<tr>
<td>tca.TCAManager.property_maxTCAAlarmResetInterval</td>
<td>TCAManager - property_maxTCAAlarmResetInterval - TCA preferences can only be modified by a user with an administrator role.</td>
</tr>
<tr>
<td>tdm</td>
<td>Optical Transport Hierarchy - TDM Management.</td>
</tr>
<tr>
<td>tdmequipment</td>
<td>TDM Equipment - TDM Equipment configuration.</td>
</tr>
<tr>
<td>template</td>
<td>Service Template - Deprecated 6.0: use XML API based configuration templates (see class script.XmlApiConfigTemplate).</td>
</tr>
<tr>
<td>tod</td>
<td>TOD - Time Of Day Range Policy.</td>
</tr>
<tr>
<td>Package.Class.Method/Property</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>-------------</td>
</tr>
<tr>
<td>todsuite</td>
<td>TOD Suite - Time Of Day Suite Policy for Egress and Ingress Entries.</td>
</tr>
<tr>
<td>topology</td>
<td>CPAM: Topology - All CPAM topology configurations including BGP, IS-IS, OSPF, CPAA, Links, Routers, Areas, Subnets, Checkpoints, and Route Alarms.</td>
</tr>
<tr>
<td>topologysim</td>
<td>CPAM: Simulated Topology - CPAM simulated IGP topology including Links, Routers, Areas, Subnets, and IP Paths.</td>
</tr>
<tr>
<td>trapmapper</td>
<td>Trap to Alarm Mapper - Trap to Alarm Mapper.</td>
</tr>
<tr>
<td>tunnelmgmt</td>
<td>Tunnel Management - All Tunnel related objects including Hubs, Spokes, Meshes, Chains, Rings, Two Neighbor, Class Forwarding and Rule-based Groups.</td>
</tr>
<tr>
<td>udprelay</td>
<td>UDP Relay - UDP Relay configuration and services for layer2.Bridge, DHCP Snooping for VLANs and Ports.</td>
</tr>
<tr>
<td>udptunnel</td>
<td>UDP Tunnel - Access to UDP Tunnel.</td>
</tr>
<tr>
<td>user</td>
<td>User Preference - NFM-P Client GUI preferences for Info Tables.</td>
</tr>
<tr>
<td>vlan</td>
<td>VLAN - Access to this package is for configuring TLS, MVR, Super VLAN, Customer VLAN, SAP and MSAP, Network Interfaces (Uplink Ports) and VLAN configuration for a MST Instance.</td>
</tr>
<tr>
<td>vlan.Site</td>
<td>VLAN Site - Access to VLAN Sites.</td>
</tr>
<tr>
<td>vlan.Vlan</td>
<td>VLAN Service - Access to Virtual LAN (VLAN) Service objects themselves.</td>
</tr>
<tr>
<td>vll</td>
<td>VLL - All contained objects are listed. Package access is not currently used.</td>
</tr>
<tr>
<td>vll.Endpoint</td>
<td>Endpoint - Access to VLL Endpoints.</td>
</tr>
<tr>
<td>vpls</td>
<td>VPLS - Access to this package is for configuring MLD Snooping, PIM Snooping, DHCP Relay, Multicast CAC Level and LAG Port Down events, and discovered VLAN Elements.</td>
</tr>
<tr>
<td>vpls.BSite</td>
<td>VPLS B-Site - Access to VPLS B-Sites on a VPLS Service.</td>
</tr>
<tr>
<td>vpls.EvpnSite</td>
<td>VPLS eVPN-Site - Access to VPLS eVPN-Sites on a VPLS Service.</td>
</tr>
<tr>
<td>vpls.ISite</td>
<td>VPLS I-Site - Access to VPLS I-Sites on a VPLS Service.</td>
</tr>
</tbody>
</table>
### Table A-4 Permissions assigned to NFM-P scope of command roles (continued)

<table>
<thead>
<tr>
<th>Package.Class.Method/Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>vpls.L2AccessInterface</td>
<td>VPLS L2 Access Interface - Access to VPLS L2 Access Interfaces (except I and B) on a VPLS Service.</td>
</tr>
<tr>
<td>vpls.L2ManagementInterface</td>
<td>VPLS L2 Management Interface - Access to VPLS L2 Management Interfaces on a VPLS Service.</td>
</tr>
<tr>
<td>vpls.Site</td>
<td>VPLS Site - Access to VPLS Sites (except I and B) on a VPLS Service.</td>
</tr>
<tr>
<td>vprn</td>
<td>VPRN - Access to this package is for configuring VPRN Router Instance Sites, SNMP Community, IPSec Interfaces, Group Interfaces, SAPs, MSAPs, IGMP Host Tracking on Sites and SAPs, and FR Interface Specifics for VPRN specific SAPs.</td>
</tr>
<tr>
<td>vprn.DVRSSite</td>
<td>VPRN dVRS Site - Access to dVRS VPRN Sites on a VPRN service.</td>
</tr>
<tr>
<td>vprn.IPMirrorInterface</td>
<td>IP Mirror Interface - Access to VPRN IP Mirror Interfaces.</td>
</tr>
<tr>
<td>vprn.Site</td>
<td>VPRN Site - Access to VPRN Sites.</td>
</tr>
<tr>
<td>vprn.SubscriberInterface</td>
<td>VPRN Subscriber Interface - Access to VPRN Subscriber Interfaces.</td>
</tr>
<tr>
<td>vprn.Vpm</td>
<td>VPRN Service - Access to Virtual Private Routed Network (VPRN) Service objects themselves.</td>
</tr>
<tr>
<td>vprn.VpmPing</td>
<td>VPRN Ping - Access to VPRN Ping tests, VPRN Ping test definitions, and VPRN Ping deployed tests.</td>
</tr>
<tr>
<td>vprn.VpmTrace</td>
<td>VPRN Trace - Access to VPRN Trace tests, VPRN Trace test definitions, and VPRN Trace deployed tests.</td>
</tr>
<tr>
<td>vs</td>
<td>Scheduler Policy - Scheduler Policies.</td>
</tr>
<tr>
<td>wlanw</td>
<td>WLAN Gateway - WiFi Offload.</td>
</tr>
<tr>
<td>workspace</td>
<td>Workspace - Ability to view workspaces, and Create/Edit/Delete private workspaces.</td>
</tr>
<tr>
<td>workspace.WorkspaceManager.method_publicControl</td>
<td>Workspace Manager - method_publicControl - Ability to create/edit/delete public workspaces.</td>
</tr>
<tr>
<td>wpp.Site</td>
<td>WPP Site - Access to WPP Sites.</td>
</tr>
</tbody>
</table>
A.4 Permissions access for scope of command roles

A.4.1 Overview

Each predefined scope of command role has defined access levels to the available permissions based on what the role is designed to do. Permissions grant the following levels of access to an object package, class, method or property:

- **Read-only**—provides read access to an object class without the ability to create or delete objects.
- **Read/write**—provides full access to an object class that includes read, create, update/execute, and delete access.
- **Read/update/execute**—provides read and update/execute access to an object package or property, but does not provide delete access.
- **Update/execute**—provides update/execute access on class methods, and is typically combined with read access on the parent object package.
- **No access**.

To view the permission configuration of a scope of command role (default or custom), open the properties form of the role by performing the following steps:

2. Click on the Scope of Command tab.
3. Select Role (Security) from the drop-down menu and click Search.
4. Select the required role and click Properties. The Role (Edit) form opens.
5. Click on the Permissions tab.

The Permissions tab lists all permissions and the current access level configured on the scope of command role.